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Safety

Before installing this product, read the Safety information.
3\44.4(}1\ Cllaadlall E¢\)§ s ‘Gm\ 138 A_x;aS): Ja

Antes de instalar este produto, leia as Informagdes de Seguranga.

A ML, EFHEEE Safety Information
(Z2ER).

RREARESBZA]  HAME T eaEM, o

Prije instalacije ovog produkta obavezno procitajte Sigurnosne Upute.

Pred instalaci tohoto produktu si prectéte prirucku bezpec¢nostnich instrukci.

Lees sikkerhedsforskrifterne, for du installerer dette produkt.

Lees voordat u dit product installeert eerst de veiligheidsvoorschriften.

Ennen kuin asennat timén tuotteen, lue turvaohjeet kohdasta Safety Information.
Avant d’installer ce produit, lisez les consignes de sécurité.

Vor der Installation dieses Produkts die Sicherheitshinweise lesen.

Mpwv eykataotoete To MPOIGV auTd, dlaBacTe TI§ MANPOPOPIEG ACPAAELAS
(safety information).

JINM0AN MR IR IRIAP AT 130 07pPNno 197

Atermék telepitése el6tt olvassa el a Biztonsagi elirasokat!

Prima di installare questo prodotto, leggere le Informazioni sulla Sicurezza.
HADREDHIZ, REFRELTA SN,
2 MSs 2Xob] &80l &8 22 SN,

IIpen na ce mHCTAIMPA OBOj MPOJYKT, MPOUYNTAjTe HHPOpMaIjaTa 3a 6e30€IHOCT.
Les sikkerhetsinformasjonen (Safety Information) for du installerer dette produktet.

Przed zainstalowaniem tego produktu, nalezy zapoznac¢ sig
z ksiazka "Informacje dotyczace bezpieczenstwa" (Safety Information).

Antes de instalar este produto, leia as Informagdes sobre Seguranca.

Mepen ycTaHOBKOM NpoAyKTa NPOYTUTE NMHCTPYKLMN MO
TexXHUKe 6e30nacHOCTMU.

Pred inStalaciou tohto zariadenia si pecitaje Bezpe€nostné predpisy.

Pred namestitvijo tega proizvoda preberite Varnostne informacije.

Antes de instalar este producto, lea la informacién de seguridad.

Las sdkerhetsinformationen innan du installerar den har produkten.

© Copyright IBM Corp. 2004 xi



Caution notice

The following Caution notice is printed in English throughout this document. For a
translation of this notice, see IBM® Safety Information.

Statement 5:

A A

CAUTION:

The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current from
the device, ensure that all power cords are disconnected from the power source.

VAN

2 ) mp =mm—
1 [ mp =mm—

Safety information

Before you service an IBM computer, you must be familiar with the following
safety information.

General safety

Follow these rules to ensure general safety:

* Observe good housekeeping in the area of the machines during and after
maintenance.

* When lifting any heavy object:
1. Ensure that you can stand safely without slipping.
2. Distribute the weight of the object equally between your feet.

3. Use a slow lifting force. Never move suddenly or twist when you attempt to
lift.

4. Lift by standing or by pushing up with your leg muscles; this action removes
the strain from the muscles in your back. Do not attempt to lift any objects that
weigh more than 16 kg (35 Ib) or objects that you think are too heavy for you.

* Do not perform any action that causes hazards to the customer, or that makes
the equipment unsafe.

* Before you start the machine, ensure that other service representatives and the
customer’s personnel are not in a hazardous position.

* Place removed covers and other parts in a safe place, away from all personnel,
while you are servicing the machine.

* Keep your tool case away from walk areas so that other people will not trip over
it.

* Do not wear loose clothing that can be trapped in the moving parts of a
machine. Ensure that your sleeves are fastened or rolled up above your elbows.
If your hair is long, fasten it.

xii IBM TotalStorage FAStT: Problem Determination Guide



Insert the ends of your necktie or scarf inside clothing or fasten it with a
nonconductive clip, approximately 8 centimeters (3 in.) from the end.

Do not wear jewelry, chains, metal-frame eyeglasses, or metal fasteners for your
clothing. Remember: Metal objects are good electrical conductors.

Wear safety glasses when you are doing any of the following: hammering,
drilling soldering, cutting wire, attaching springs, using solvents, or working in
any other conditions that might be hazardous to your eyes.

After service, reinstall all safety shields, guards, labels, and ground wires.
Replace any safety device that is worn or defective.

Reinstall all covers correctly before returning the machine to the customer.

Grounding requirements

Electrical grounding of the computer is required for operator safety and correct
system function. Proper grounding of the electrical outlet can be verified by a
certified electrician.

Electrical safety

Important

Use only approved tools and test equipment. Some hand tools have handles that are covered with a soft material
that does not insulate you when working with live electrical currents.

Many customers have, near their equipment, rubber floor mats that contain small conductive fibers to decrease
electrostatic discharges. Do not use this type of mat to protect yourself from electrical shock.

Observe the following rules when working on electrical equipment.

Find the room emergency power-off (EPO) switch, disconnecting switch, or
electrical outlet. If an electrical accident occurs, you can then operate the switch
or unplug the power cord quickly.

Do not work alone under hazardous conditions or near equipment that has
hazardous voltages.

Disconnect all power before doing any of the following tasks:
— Performing a mechanical inspection

— Working near power supplies

— Removing or installing main units

Before you start to work on the machine, unplug the power cord. If you cannot
unplug it, ask the customer to power-off the wall box that supplies power to the
machine and to lock the wall box in the off position.

If you need to work on a machine that has exposed electrical circuits, observe the
following precautions:

— Ensure that another person, familiar with the power-off controls, is near you.

Remember: Another person must be there to switch off the power, if
necessary.

— Use only one hand when working with powered-on electrical equipment;
keep the other hand in your pocket or behind your back.

Remember: There must be a complete circuit to cause electrical shock. By
observing the previous rule, you might prevent a current from passing
through your body:.

— When using testers, set the controls correctly and use the approved probe
leads and accessories for that tester.
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— Stand on suitable rubber mats (obtained locally, if necessary) to insulate you
from grounds such as metal floor strips and machine frames.

Observe the special safety precautions when you work with very high voltages;
these instructions are in the safety sections of maintenance information. Use
extreme care when measuring high voltages.

Regularly inspect and maintain your electrical hand tools for safe operational
condition.

Do not use worn or broken tools and testers.

Never assume that power has been disconnected from a circuit. First, check that it
has been powered-off.

Always look carefully for possible hazards in your work area. Examples of these
hazards are moist floors, nongrounded power extension cables, power surges,
and missing safety grounds.

Do not touch live electrical circuits with the reflective surface of a plastic dental
mirror. The surface is conductive and can cause personal injury and machine
damage.

Do not service the following parts (or similar units) with the power on when they
are removed from their normal operating places in a machine. This practice
ensures correct grounding of the units.

— Power supply units

— Pumps

— Blowers and fans

— Motor generators

If an electrical accident occurs:

— Use caution; do not become a victim yourself.
— Switch off power.

— Send another person to get medical aid.

Handling ESD-sensitive devices

Any computer part that contains transistors or integrated circuits (ICs) should be
considered sensitive to electrostatic discharge (ESD). ESD damage can occur when
there is a difference in charge between objects. Protect against ESD damage by
equalizing the charge so that the machine, the part, the work mat, and the person
that is handling the part are all at the same charge.

Notes:

1.

Use product-specific ESD procedures when they exceed the requirements noted
here.

Make sure that the ESD protective devices that you use have been certified
(ISO 9000) as fully effective.

Use the following precautions when handling ESD-sensitive parts:

Keep the parts in protective packages until they are inserted into the product.
Avoid contact with other people.
Wear a grounded wrist strap against your skin to eliminate static on your body.

Prevent the part from touching your clothing. Most clothing is insulative and
retains a charge even when you are wearing a wrist strap.

Select a grounding system, such as those listed below, to provide protection that
meets the specific service requirement.
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Note: The use of a grounding system is desirable but not required to protect
against ESD damage.

— Attach the ESD ground clip to any frame ground, ground braid, or green-wire
ground.

— Use an ESD common ground or reference point when working on a
double-insulated or battery-operated system. You can use coax or
connector-outside shells on these systems.

— Use the round ground-prong of the ac plug on ac-operated computers.

* Use the black side of a grounded work mat to provide a static-free work surface.
The mat is especially useful when handling ESD-sensitive devices.

Safety inspection procedure

Use this safety inspection procedure to identify potentially unsafe conditions on a
product. Each machine, as it was designed and built, had required safety items
installed to protect users and service personnel from injury. This procedure
addresses only those items. However, good judgment should be used to identify
any potential safety hazards due to attachment of non-IBM features or options not
covered by this inspection procedure.

If any unsafe conditions are present, you must determine how serious the apparent
hazard could be and whether you can continue without first correcting the
problem.

Consider these conditions and the safety hazards they present:

* Electrical hazards, especially primary power (primary voltage on the frame can
cause serious or fatal electrical shock).

* Explosive hazards, such as a damaged cathode ray tube (CRT) face or bulging
capacitor

* Mechanical hazards, such as loose or missing hardware

Complete the following checks with the power off, and with the power cord
disconnected.

1. Check the exterior covers for damage (loose, broken, or sharp edges).
2. Check the power cord for the following conditions:

a. A third-wire ground connector in good condition. Use a meter to measure
third-wire ground continuity for 0.1 ohm or less between the external
ground pin and frame ground.

b. The power cord should be the appropriate type as specified in the parts
listings.
. Insulation must not be frayed or worn.
3. Remove the cover.

4. Check for any obvious non-IBM alterations. Use good judgment as to the safety
of any non-IBM alterations.

5. Check the inside the unit for any obvious unsafe conditions, such as metal
filings, contamination, water or other liquids, or signs of fire or smoke damage.

6. Check for worn, frayed, or pinched cables.

7. Check that the power supply cover fasteners (screws or rivets) have not been
removed or tampered with.

Safety XV
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About this document

This document provides information about problem determination for the IBM
TotalStorage® FAStT product line. Use this document for the following tasks:

* Diagnose and troubleshoot system faults
* Configure and service hardware
* Determine system specifications

* Interpret system data

Who should read this document

This document is intended for system operators and service technicians who have
extensive knowledge of fibre channel and network technology.

How this document is organized

The IBM TotalStorage FAStT Problem Determination Guide contains information that
you can use to isolate and solve problems that might occur in your fibre channel
configurations. It provides problem determination and resolution information for
the issues most commonly encountered with IBM fibre channel devices and
configurations.

Attention: Beginning with the first edition of this document, the IBM TotalStorage
FAStT Hardware Maintenance Manual and the IBM TotalStorage FAStT Problem
Determination Guide are published as separate documents. In addition, the
hardware maintenance information for new IBM FAStT products released with or
after this document is included in the Installation, User’s, and Maintenance Guide
for those products.

This document contains the following chapters:

[Chapter 1, “About problem determination,” on page 1| provides a starting point for
the problem determination information found in this document.

(Chapter 2, “Problem determination starting points,” on page 3| provides an
introduction to problem determination tools and techniques that are contained in
this document.

IChapter 3, “Problem determination maps,” on page Y provides a series of
flowcharts that help you to isolate and resolve hardware issues.

(Chapter 4, “Introduction to FAStT MS],” on page 55 introduces the IBM Fibre
Array Storage Technology Management Suite Java  (FAStT MS)).

(Chapter 5, “Introduction to SANavigator,” on page 103|provides an overview of
the functions of SANavigator.

(Chapter 6, “PD hints: Common path/single path configurations,” on page 135
provides problem determination hints for common path or single path
configurations.
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Chapter 7, “PD hints: RAID controller errors in the Windows NT event log,” on|
page 137 provides problem determination hints for event log errors stemming from
the RAID controller.

(Chapter 8, “PD hints: Configuration types,” on page 151| provides the various
configuration types that can be encountered.

(Chapter 9, “PD hints: Passive RAID controller,” on page 157 provides instructions
on how to isolate problems that occur in a passive RAID controller.

(Chapter 10, “PD hints: Performing sendEcho tests,” on page 161| contains
information on how to perform loopback tests.

(Chapter 11, “PD hints: Tool hints,” on page 165 contains information on
generalized tool usage.

(Chapter 12, “PD hints: Drive side hints and RLS diagnostics,” on page 193] contains
problem determination information for the drive or device side as well as read link
status diagnostics.

(Chapter 13, “PD hints: Hubs and switches,” on page 217 provides information on
hub and switch problem determination.

(Chapter 14, “PD hints: Wrap plug tests,” on page 223 provides information about
tests that you can perform with wrap plugs.

[Chapter 15, “Heterogeneous configurations,” on page 227| contains information on
heterogeneous configurations.

[Chapter 16, “Using IBM Fast!UTIL,” on page 231|provides detailed configuration
information for advanced users who want to customize the configuration of the
IBM fibre-channel PCI adapter (FRU 01K7354), the IBM FAStT host adapter (FRU
09N7292), and the IBM FAStT FC2-133 Adapter (FRU 24P0962).

Chapter 17, “Frequently asked questions about FAStT Storage Manager,” on page]
239| contains frequently asked questions about FAStT Storage Manager.

Chapter 18, “pSeries supplemental problem determination information,” on page|
249| discusses Fibre Channel specific problems and information that might be
necessary to resolve them.

[Chapter 19, MEL data format,” on page 279 fliscusses MEL data format.

FAStT installation process overview

xviii

The following flow chart gives an overview of the FAStT hardware and the FAStT
Storage Manager software installation process. Lined arrows in the flow chart
indicate consecutive steps in the hardware and software installation process.
Labeled arrows indicate which current documents provide detailed information
about those steps.
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Figure 1. Installation process flow by current publications

FAStT Storage Server publications

The following tables present an overview of the FAStT900, FAStT700, FAStT600,
and FAStT100 Fibre Channel Storage Server product libraries, as well as other
related documents. Each table lists documents that are included in the libraries and
what common tasks they address. Click on active links in the tables to access those
documents currently available on the Internet. You can access documentation for
the other FAStT products at the following Web site:

|www—1 .ibm.com /servers/storage/support/fastt/ index.htmll

FAStT900 Fibre Channel Storage Server library

associates each document in the FAStT900 Fibre Channel Storage Server
library with its related common user tasks.

Table 1. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks
Title User Tasks

Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation | Installation Administration |Maintenance

IBM TotalStoraga
FAStT900 Installation|
ind Support Guide

GC26-7530|
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www-1.ibm.com/servers/storage/support/fastt/index.html
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf

Table 1. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks (continued)

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

[nstructions, 24P8135)|

IBM TotalStora
[FAStT900 Storage|

Server User’s Guide)

GC26-7534|

IBM TotalStoragd
FAStT FC2-133 Duall
[Port Host Bud
Adapter Installation|

lind User’s Guide
GC26-7532,

[BM FAStT FC2-133)|
[Host Bus Adapter
Installation an

Instructions, 19K0900|

IBM Fibre Channel|

IBM FAStil

Management Suite

Java User’s Guide),
32P0081]

IBM TotalStomga

FASIT Fibre Channel]

Hardwar
Maintenanc

Manual, GC26-7640|

IBM TotalStorag
FAStT Fibre Channell
Problem|
Determination Guide)

GC26-7642]
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf

FAStT700 Fibre Channel Storage Server library

associates each document in the FAStT700 Fibre Channel Storage Server
library with its related common user tasks.

Table 2. TotalStorage FAStT700 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM FAStT700 Fibre|
Channel Cabling]
[nstructions, 32P0343|

‘/

IBM FAStT700 Fibre|
Channel Storage|
Server User’s Guide)
32170341

[BM EASIT FC2-133|
Dual Port Host Bus|
Adapter Installation|
ind User’s Guide,
GC26-7532]

IBM TotulStomga
FASIT FC2-133 Host|
Bus Adapte

IBM FAStil

Management Suite|

ava User’s Guide,
32170081

IBM TotalStomga

FAStT Fibre Channel]

Hardwar
Maintenanc

Manual, GC26-7640)

[BM TotalStoragd

FAStT Fibre Channell
Problem|
Determination Guide)

GC26—7642|
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf

FAStT600 Fibre Channel Storage Server library

associates each document in the FAStT600 Fibre Channel Storage Server
library with its related common user tasks.

Table 3. TotalStorage FAStT600 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStomg(-el

FAStT Fibre Channell

Hardwargl
Maintenanc

Manual GC26-7640|

[BM TotalStomga
FASIT Fibre Channel|
Probleml|
Determination Guide)

GC26-7642|

IBM TotalStomga

FAStT FC2-133 Dual|
Port Host Bus
(Adapter Installation)

ind User’s Guide,
GC26-7532,

IBM TotalStora
IFAStT600 Rac
IMountin

Instructions, 24P8125|

IBM TotalStora
IFAStT600 Fibre
Channel Cablin
[nstructions, 24P8126|

FAStT100 Storage Server library

associates each document in the FAStT100 Storage Server library with its
related common user tasks.

Table 4. TotalStorage FAStT100 Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStora
IFAStT10
Installation, User’s|

ind Maintenance|
Guide, GC26-7641]

xxii

IBM TotalStorage FAStT: Problem Determination Guide


ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600cabling.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600cabling.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600cabling.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600cabling.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
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Table 4. TotalStorage FAStT100 Storage Server document titles by user tasks (continued)

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

Guide, 24P897.

,/

IBM TotalStorag

FAStT FC2-133 Dual|
Port Host Bus|
Adapter Installation]

lind User’s Guide,
GC26-7532]

[BM FAS!T FC2-133)|
[Host Bus Adapter
Installation an

IBM TotalStomga

FASIT Fibre Channel]

[Hardwar
Maintenanca

Manual GC26-7640)

IBM TotulStomg(-el
FAStT Fibre Channell
Problem|
Determination Guide)

GC26-7642|
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/pdg00mst.pdf

FASiT-related hardware publications
associates each of the following documents related to FAStT operations

with its related common user tasks.

Table 5. TotalStorage FAStT related document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM Safety
Information,
P48P9741

’/

[BM TotalStoragd

FAStT Quick Start]
Guide,, GC26-7662|

IBM TotalStora
[FAStT EXP100
Storage Expansion
Unit Release Notes))
GC26-7619

IBM TotalStora
FAStT EXP100]
Storage Expansion
Unit Installation and|
Users Guide,
GC26-7601

Fibre Channel
Solutions - IB
FAStT EXP500
Installation and

User’s Guide,
59563

IBM TotalStomga

FAStT Hard Drive)
1nd Storagel
Expansion Enclosurd
Installation an
IMigration Guide
GC26-7639

IBM Netfinity® Fibre|
Channel Cabling]
[nstructions, 19K0906|

IBM Fibre Channel|
SAN Configuration|
Setup Guide, 25P2509|

FASIT Storage Manager Version 9 publications

[Table 6 on page xxv| associates each document in the FAStT Storage Manager
library with its related common user tasks.
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf

Table 6. TotalStorage FAStT Storage Manager Version 9 titles by user tasks

Title

User Tasks

Planning

Software
Installation

Hardware
Installation

Configuration |Operation and

Administration

Diagnosis and
Maintenance

IBM TotalStoraa
FAStT Storag
Manager Version 9|
[nstallation an
Support Guide for]
[ntel-based Operating]

System Environments)
GC26-7649

L

IBM TotulStoméa
IFAStT Storag
Manager Version 9|
[nstallation an
Support Guide fo
AIX, UNIX, Solaris|
ind Linux on Power)|

C26-7648

Q

IBM TotalStora
[FAStT Storag
Manager Version 9|

Copy Services User’s|
Guide, GC26-7660|

IBM FAStT Storage
Manager Script
Commands (see
product CD)

[BM TotalStora
[FAStT Storag
Manager Version 9|

IConcepts Guide,
GC26-7661

Notices used in this document

This document can contain the following notices that are designed to highlight key
information:

Note: These notices provide important tips, guidance, or advice.

Important: These notices provide information that might help you avoid
inconvenient or problem situations.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice is placed just before the instruction or situation in which
damage could occur.

Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

Danger: These statements indicate situations that can be potentially lethal or
extremely hazardous to you. A danger statement is placed just before the
description of a potentially lethal or extremely hazardous procedure step or
situation.
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Getting information, help, and service

XXV1

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your IBM @server xSeries " or IntelliStation® system, and whom to call for
service, if it is necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

* Check all cables to make sure that they are connected.
* Check the power switches to make sure that the system is turned on.

* Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system.

* Check for technical information, hints, tips, and new device drivers at the IBM

Support Web site:
[www.ibm.com/storage /techsup.htm|

* Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
documents that are provided with your system and software. The information that
comes with your system also describes the diagnostic tests that you can perform.
Most xSeries and IntelliStation systems, operating systems, and programs come
with information that contains troubleshooting procedures and explanations of
error messages and error codes. If you suspect a software problem, see the
information for the operating system or program.

Using the documentation

Information about your xSeries or IntelliStation system and preinstalled software, if
any, is available in the documents that come with your system. This includes
printed documents, online documents, readme files, and help files. See the
troubleshooting information in your system documentation for instructions for
using the diagnostic programs. The troubleshooting information or the diagnostic
programs might tell you that you need additional or updated device drivers or
other software.

Web sites

IBM maintains pages on the World Wide Web where you can get the latest
technical information and download device drivers and updates.

» For FAStT information, go to the following Web site:
[www.ibm.com /storage/techsup.htm|

The support page has many sources of information and ways for you to solve
problems, including:

— Diagnosing problems, using the IBM Online Assistant

— Downloading the latest device drivers and updates for your products
- Viewing frequently asked questions (FAQ)

— Viewing hints and tips to help you solve problems

— Participating in IBM discussion forums

IBM TotalStorage FAStT: Problem Determination Guide
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— Setting up e-mail notification of technical updates about your products

* You can order publications through the IBM Publications Ordering System at the
following Web site:
[www.elink.ibmlink.ibm.com /public/applications/publications/cgibin /pbi.cgi /|

* For the latest information about IBM xSeries products, services, and support, go
to the following Web site:
[www.ibm.com/eserver /xseries/|

* For the latest information about the IBM IntelliStation information, go to the
following Web site:
[www.ibm.com /pc/intellistation /|

* For the latest information about operating system and HBA support, clustering
support, SAN fabric support, and FAStT Storage Manager feature support, see
the TotalStorage FAStT Interoperability Matrix at the following Web site:

[www.storage.ibm.com /disk /fastt /supserver.htm|

Software service and support

Through IBM Support Line, for a fee you can get telephone assistance with usage,
configuration, and software problems with xSeries servers, IntelliStation
workstations, and appliances. For information about which products are supported
by Support Line in your country or region, go to the following Web site:
fwww.ibm.com/services/sl/products/|

For more information about the IBM Support Line and other IBM services, go to
the following Web sites:

+ lwww.ibm.com /services /|

* [www.ibm.com/planetwide /|

Hardware service and support

You can receive hardware service through IBM Integrated Technology Services or
through your IBM reseller, if your reseller is authorized by IBM to provide
warranty service. Go to the following Web site for support telephone numbers:
fwww.ibm.com /planetwide]

In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K,, these services are available Monday through Friday,
from 9 am. to 6 p.m.

Fire suppression systems

A fire suppression system is the responsibility of the customer. The customer’s own
insurance underwriter, local fire marshal, or a local building inspector, or both,
should be consulted in selecting a fire suppression system that provides the correct
level of coverage and protection. IBM designs and manufactures equipment to
internal and external standards that require certain environments for reliable
operation. Because IBM does not test any equipment for compatibility with fire
suppression systems, IBM does not make compatibility claims of any kind nor
does IBM provide recommendations on fire suppression systems.

See the IBM TotalStorage FAStT Hardware Maintenance Manual for environmental
specifications of the various FAStT storage server models.

About this document ~ XXVil


http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi
http://www.ibm.com/eserver/xseries/
http://www.ibm.com/pc/intellistation
http://www.storage.ibm.com/disk/fastt/supserver.htm
http://www.ibm.com/services/sl/products
http://www.ibm.com/services
http://www.ibm.com/planetwide
http://www.ibm.com/planetwide

How to send your comments

Your feedback is important to help us provide the highest quality information. If
you have any comments about this document, you can submit them in one of the
following ways:

e E-mail

Submit your comments electronically to:

starpubs@us.ibm.com

Be sure to include the name and order number of the document and, if
applicable, the specific location of the text you are commenting on, such as a
page number or table number.

e Mail
Fill out the Readers’” Comments form (RCF) at the back of this document and

return it by mail or give it to an IBM representative. If the RCF has been
removed, you can address your comments to:

International Business Machines Corporation
Information Development

Department GZW

9000 South Rita Road

Tucson, Arizona 85744-0001

US.A.

When you send information to IBM, you grant IBM a nonexclusive right to use or

distribute the information in any way it believes appropriate without incurring any
obligation to you.
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Chapter 1. About problem determination

The procedures in this document are designed to help you isolate problems. They
are written with the assumption that you have model-specific training on all
computers, or that you are familiar with the computers, functions, terminology,
and service-related information provided in this document and the appropriate
IBM server hardware maintenance manual.

This guide provides problem determination and resolution information for the
issues most commonly encountered with IBM fibre channel devices and
configurations. This manual contains useful component information, such as
specifications, replacement and installation procedures, and basic symptom lists.

Note: For information about how to use and troubleshoot problems with the FC
6228 2 Gigabit fibre channel adapter in IBM @server pSeries AIX hosts, see
Fibre Channel Planning and Integration: User’s Guide and Service Information,
SC23-4329.

Where to start

To use this document correctly, begin by identifying a particular problem area from
the lists provided in [“Starting points for problem determination” on page 5] The
starting points direct you to the related PD maps, which provide graphical
directions to help you identify and resolve problems. The problem determination
maps in might also refer you to other PD maps or to other chapters or
appendices in this document. When you complete tasks that are required by the
PD maps, it might be helpful to see the component information that is provided in
the FAStT Hardware Maintenance Manual.

Related documents

For information about managed hubs and switches that might be in your network,
see the following publications:

* IBM 3534 SAN Fibre Channel Managed Hub Installation and Service Guide,
SY27-7616

e IBM SAN Fibre Channel Switch 2109 Model S08 Installation and Service Guide,
SC26-7350

e IBM SAN Fibre Channel Switch 2109 Model S16 Installation and Service Guide,
SC26-7352

This installation and service information can also be found at the following Web
site:

www.ibm.com/storage/ibmsan/products.htm

© Copyright IBM Corp. 2004 1
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Chapter 2. Problem determination starting points

This chapter contains information to help you perform the tasks required when

you follow PD procedures. Review this information before you attempt to isolate
and resolve Fibre Channel problems. This chapter also provides summaries of the
tools that might be useful in following the PD procedures provided in

|”Problem determination maps,” on page 9.|

Note: The PD maps in this document are not to be used in order of appearance.

Always begin_working with the PD maps from the starting points provided in this
chapter (see [‘Starting points for problem determination” on page 5). Do not
use a PD map unless you are directed there from a particular symptom or

problem area in one of the lists of starting points, or from another PD map.

Problem determination tools

The PD maps in [Chapter 3, “Problem determination maps,” on page 9| rely on
numerous tools and diagnostic programs to isolate and fix the problems. You use
the following tools when performing the tasks directed by the PD maps.

Loopback Data Test

Host bus adapters type 2200 and above support loopback testing, which
has now been integrated in the Fast!UTIL utility that can be invoked
during system POST. Depending on the BIOS level or the type of adapter,
the Alt+Q or Ctrl+Q key sequence starts the Fast!/UTIL utility. (For more

information on Fast!UTIL, see [Chapter 16, “Using IBM Fast!UTIL,” on page]

231)) The Loopback Data Test is a menu item in the utility. The Loopback
Data Test can also be run from the FAStT MS]J diagnostics. (For more
information on FAStT MS], see|Chapter 4, “Introduction to FAStT MS],” on|

Wrap plugs

Wrap plugs are required to run the Loopback test at the host bus adapter
or at the end of cables. There are two types of wrap plugs: SC and LC. SC
wrap plugs are used for the larger connector cables. LC wrap plugs are
smaller than SC wrap plugs and are used for the IBM FAStT700 storage
server and the IBM FAStT FC-2 HBA. A coupler is provided for each
respective form-factor to connect the wrap plugs to cables. The part
numbers for the wrap plugs are:

* SC: 75G2725 (wrap and coupler kit)

+ LC
— 24P0950 (wrap connector and coupler kit)
— 11P3847 (wrap connector packaged with FAStT700 storage server)
— 05N6766 (coupler packaged with FAStT700 storage server)

Note: Many illustrations in this document depict the SC wrap plug.
Substitute the LC wrap plug for the FAStT700 storage server (1742)
and the IBM FAStT FC-2 HBA (2300).

SANavigator
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SANavigator is a SAN discovery tool that displays link, device, and
interconnecting problems. It monitors the health of the SAN and identifies
problem areas. It provides a topological view of the SAN, displaying the
devices, the interconnection, and the switch and controller port
assignments. The SAN discovery is accomplished out-of-band through the
network and (optionally) in-band through the Fibre medium. The HBA API
library (supplied) is required for in-band management.

Install SANavigator to help you monitor your SAN and diagnose
problems. See [Chapter 5, “Introduction to SANavigator,” on page 103| for
further details.

FAStT Management Suite Java® (FAStT MSJ)

FAStT MS] is a network-capable application that can connect to and
configure remote systems. With FAStT MS], you can perform loopback and
read /write buffer tests to help you isolate problems.

See [Chapter 4, “Introduction to FAStT MS],” on page 55 for further details
on FAStT MS].

IBM FAStT Storage Manager

FAStT Storage Manager enables you to monitor events and manage storage
in a heterogeneous environment. These diagnostic and storage
management capabilities fulfill the requirements of a true SAN, but also
increase complexity and the potential for problems. |Chapter 15]
[“Heterogeneous configurations,” on page 227 shows examples of
heterogeneous configurations and the associated profiles from the FAStT
Storage Manager. These examples can help you identify improperly
configured storage by comparing the customer’s profile with those
supplied (assuming similar configurations).

Event Monitoring has also been implemented in these versions of FAStT
Storage Manager. The Event Monitor handles notification functions (e-mail
and SNMP traps) and monitors storage subsystems whenever the
Enterprise Management window is not open. The Event Monitor is a
separate program bundled with the FAStT Storage Manager client software;
it is a background task that runs independently of the Enterprise
Management window.

FAStT Storage Manager implements controller run-time diagnostics for
Storage Controllers types 3526, 3542, 3552, and 1742. FAStT Storage
Manager also implements Read Link Status (RLS), which enables
diagnostics to aid in troubleshooting drive-side problems. FAStT Storage
Manager establishes a time stamped "baseline” value for drive error counts
and keeps track of drive error events. The end user receives deltas over
time as well as trends.

Considerations before starting PD maps

4

Because a wide variety of hardware and software combinations are possible, use
the following information to assist you in problem determination. Before you use
the PD maps, perform the following actions:

* Verify any recent hardware changes.

* Verify any recent software changes.
* Verify that the BIOS is at the latest level. See [‘File updates” on page 5/and

IBM TotalStorage FAST:
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* Verify that device drivers are at the latest levels. See the device driver
installation information in the installation guide for your device.

* Verify that the configuration matches the hardware.

* Verify that FAStT MS] is at the latest level. For more information, see

[“Introduction to FAStT MSJ,” on page 55/

If SANavigator is not installed, install it to assist you in isolating problems. For
more information, see [Chapter 5, “Introduction to SANavigator,” on page 103 |
After SANavigator is installed, export the SAN to capture its current state. This
will be useful in later diagnoses.

As you go through the problem determination procedures, consider the following
questions:

* Do diagnostics fail?
* Is the failure repeatable?
* Has this configuration ever worked?

e If this configuration has been working, what changes were made prior to it
failing?

* Is this the original reported failure? If not, try to isolate failures using the lists of

indications (see [“General symptoms” on page 6}[“Specific problem areas” on|
[page 6,|and [“PD maps and diagrams” on page 6).

Important

To eliminate confusion, systems are considered identical only if the following are exactly identical for each system:

* Machine type and model

e BIOS level

* Adapters and attachments (in same locations)

* Address jumpers, terminators, and cabling

e Software versions and levels

Comparing the configuration and software setup between working and non-working systems will often resolve

problems.

File updates

You can download diagnostic, BIOS flash, and device driver files from the
following Web site:

www.ibm.com/pc/support/
SANavigator automatically links to the xSeries Fibre Channel Solutions Web site.

Right-click the desired device (a host bus adapter or a controller) and select IBM
Solutions Support.

Starting points for problem determination

The lists of indications contained in this section provide you with entry points to
the problem determination maps found in this chapter. (Links to useful appendix

materials are also provided.) Use the following lists of problem areas as a guide for

determining which PD maps will be most helpful.

Chapter 2. Problem determination starting points
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General symptoms

* RAID controller passive

If you determine that a RAID controller is passive, go to[’RAID Controller|
[Passive PD map” on page 11/

¢ Failed or moved cluster resource

If you determine that a cluster resource failed or has been moved, go to
[Resource PD map” on page 12.|

e Startup long delay

If at startup you experience a long delay (more than 10 minutes), go to
[Delay PD map” on page 13.]

* Systems Management or FAStT Storage Manager performance problems

If you discover a problem through the Systems Management or Storage
Management tools, go to|“Systems Management PD map” on page 14

Specific problem areas
* FAStT Storage Manager
See [‘Systems Management PD map” on page 14/

See also |Chapter 17, “Frequently asked questions about FAStT Storage|
[Manager,” on page 239

* Port configuration (Linux)

See [‘Linux Port Configuration PD map 1” on page 41|
« Windows NT® Event Log
See [Chapter 7, “PD hints: RAID controller errors in the Windows NT event log,”]

|on page 137.|

* Indicator lights on devices

See [‘Indicator lights and problem indications” on page 202.|
¢ Major Event Log (MEL)

See ['MEL data format” on page 279.
* Control panel or SCSI adapters

See the driver installation information in the appropriate hardware chapter of
the installation guide for your device.

* Managed hub or switch logs

See [Chapter 13, “PD hints: Hubs and switches,” on page 217
* Cluster Administrator
+ IBM pSeries® servers with 6228 HBAs

|“pSeries PD map” on page 44|

PD maps and diagrams
* Configuration Type Determination

To determine whether your configuration is type 1 or type 2, go to
[“Configuration Type PD map” on page 10/

In order to break larger configurations into manageable units for debugging, see
[Chapter 8, “PD hints: Configuration types,” on page 151)

¢ Hub or Switch PD

If you determine that a problem exists within a hub or switch, go to
[“Hub /Switch PD map 2” on page 17

e Fibre Path PD

IBM TotalStorage FAStT: Problem Determination Guide



If you determine that a problem exists within the Fibre Path, go to
[PD map 1” on page 20.|
e Device PD
If you determine that a problem exists within a device, go to ["Device PD map 1”]
* SANavigator PD

If SANavigator is installed (as is strongly suggested), go to|“Diagnosing with|
[SANavigator PD map 1” on page 28

Chapter 2. Problem determination starting points 7
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Chapter 3. Problem determination maps

This chapter contains a series of PD maps that guide you through problem
isolation and resolution. Before you use any of the following PD maps, you should
have reviewed the information in [Chapter 2, “Problem determination starting]
|points," on page 3.|

The PD maps in this chapter are not to be used in order of appearance. Always
begin working with the PD maps from the starting points provided in the previous chapter
(see [“Starting points for problem determination” on page 5). Do not use a PD map
unless you are directed there from a particular symptom or problem area in one of
the lists of starting points, or from another PD map.

© Copyright IBM Corp. 2004 9



Configuration Type PD map

To perform certain problem determination procedures, you need to determine
whether your fibre configuration is Type 1 or Type 2. Use this map to make that
determination. You will need this information for later PD procedures.

Configuration Type PD map

— Type 2 <+—Yes

Entry
Point

Additional
information: See

Chapter 8, “PD hints;|

Logically break
large configurations
into sections
representing
Type 1 and 2

Configuration types,”

Is MSCS
being used?

No

Are external

Yes
f

Yes

Fully redundant
configuration?

No

Return to
PD Starting
Points

concentrators
used?

No

3526 or
3542
unit?

Yes

on page 151.|

Note: Repeat this
process for each
section.

To return to the PD starting points, go to page @

10 1BM TotalStorage FAStT: Problem Determination
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RAID Controller Passive PD map

From: ['General symptoms”

on page 6} [’Cluster Resource PD map” on page 12|

Controller Passive PD map

Controller
Passive?

Return to PD entry [«—No

No NT event 18?

Yes
v

Any yellow lights
on concentrator/

Save date/time
and SRB info

NoO—— P

ﬁ No Y

Find earliest
event 18

More nodes
sharing RAID
Controller?

Yes

To
Fibre Path
PD map 2

Yes

Additional information: See

Chapter 9, “PD hints: Passive|

RAID controller,” on page 157.|

Additional information: Use
MEL information to find the
approximate fail time in the

Windows NT Event Log. See

"MEL data format” on page
281.

Additional information: See

Chapter 7, “PD hints: RAID|

controller errors in the|

Windows NT event log,” on|

page 137.|

Additional information: See

Chapter 7, “PD hints: RAID|

controller errors in the|

Windows NT event log,” on|

page 137]

To see Fibre Path PD map 2, go to[“Fibre Path PD map 2” on page 21

Chapter 3. Problem determination maps 11



Cluster Resource PD map

From: |"General symptoms” on page 6

Cluster Resource PD map

Was Cluster
Resource
Moved?

Was
resource
moved by
administrator?

Problem solved Yes

No
h 4

Check
RAID
Controllers

Check SM

' M, Controller
Indicator Lights, r€¢—No Passive?

cluster log

Yes

To
Controller
Passive
PD map

Cluster
Resource
Failed?

Yes

v

Check SM,
Indicator Lights,
cluster log

v

Debug one failure
at a time

i

Additional
information: This
situation can occur
only from multiple
concurrent fails (if not
moved by the

administrator).

Additional
information: This
situation can occur
only from multiple
concurrent fails.

To see the Controller Passive PD map, go to ['/RAID Controller Passive PD map” on|
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Boot-up Delay PD map

From: |“General symptoms” on page 6.

Boot-up Delay PD map

Is the start-up
screen hanging No
for long time?

Return to
PD Starting
Yes Points
h 4
Unplug HBA(s)
Fibre connection
at device

(concentrator,

controller, etc.)

Pometn orcblom:
Pl No— pLook at Done
quickly? 0k ¢

applications

Yes

Insert wrap plug /
HBA at the cable end.

Have you been Restart system and

here ves Type? No press Alt +Q or Ctrl+Q.
already? 21007 Select loopack
data test
‘ Yes ‘
No
* »
Loopback Insert wrap plug
Replug fibre test No™®  atHBA run
Passes?
cables and Restart system and loopback data test
restart use FAStT MSJ
to enable HBA(s)
Yes
To i
Fibre Path Replug
PD map 2 cables

Replace Replace
Cable HBA

See |[“Boot-up delay”|

on page 168 and

Chapter 7, “PD hints:|

RAID controller errors

in the Windows NT|

event log,” on page|

Operating
System Symptoms
Entry Windows NT Blue screen — no dot crawl activity
Point ] Windows 2000 Starting Up >
Windows 2000 progress bar
» Startup sequence frozen: waiting
v Linux for LIP to complete, kernel panic,
no log-in dialog

137]
See |”Linux porﬂ

configuration” on|

[page 189.|

Additional
information: See

Chapter 16, “Using]

IBM Fast!UTIL,” on|

page 231]

To return to the options for PD entry, go to page @

To see Fibre Path PD map 2, go to [“Fibre Path PD map 2” on page 21

Chapter 3. Problem determination maps 13



Systems Management PD map

From: |"General symptoms” on page 6

Systems Management

Entry
Point

A

Using SYS MGMT
alert info, look at
SM/Recovery
Guru

Is the
problem
fixed?

Call IBM Support

Additional information:
See |E hapter 17,|

“Frequently asked|

questions about FAStT]

Storage Manager,” on|

page 239
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Hub/Switch PD map 1

From: ["PD maps and diagrams” on page & [“Single Path Fail PD map 2” on page|

Hub/Switch PD map 1

Reconnect cable

Yes

replaced?

Yes

Replace hub

Read/Write
to
Fibre Path
PD Map 2

sendEcho to hub port
test
passes? Run sendEcho
Yes test
Path good. No
Retry Read/Write
buffer test for this
HBA using
FAStT MSJ
Replace GBIC
GBIC already No# inhub port

Unmanaged
hub?

No
v

Reconnect cable
to hub/switch port

Run sendEcho
test

To
Hub/Switch
PD map 2

For information about sendEcho tests, see [Chapter 10, “PD hints: Performing|

sendEcho tests,” on page 161.|

For information about Read/Write Buffer tests, see [Chapter 4, “Introduction to|

[FAStT MSJ,” on page 55.|

To see Hub/Switch PD map 2, go to [“Hub/Switch PD map 2” on page 17)

Chapter 3. Problem determination maps
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To see Fibre Path PD map 2, go to [“Fibre Path PD map 2” on page 21
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Hub/Switch PD map 2
From: ["Hub/Switch PD map 1” on page 15/

Hub/Switch PD map 2

sendEcho
test
passes?

Yes

Additional information:

See [Chapter 13, “PD| | Configure for
|hlntS Hubs and| crossport test
[switches,” on page 217

No

Replace Hub if not
GBIC port
Configure for
Replace GBIC if A | crossport test
Switch or hub

GBIC

Crossport test
passes?

No»

Yes
Crossport test
passes?

Additional information:
See |Chapter 13, “PD|

. . GBIC and
[hints: Hubs and| — Req:ut:::t%r:que switch or hub Y:s
[switches,” on page 217| all replaced?

Reconnect cable
to hub/switch port

No Run sendEcho
test

Replace
Switch

sendEcho
test
passes?

To Check
Connections
PD map

Problem resolved

For information about sendEcho tests, see [Chapter 10, “PD hints: Performing]
lsendEcho tests,” on page 161.|

Chapter 3. Problem determination maps 17



To see the Check Connections PD map, see [“Check Connections PD map” on page|
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Check Connections PD map
From: ["Hub/Switch PD map 2” on page 17/

Check Connections PD map

Check
Connections
and replug last
changed

Previous
fail now
good?

No

To Fibre Path
PD map 2

Yes

Problem resolved

To see Fibre Path PD map 2, go to|“Fibre Path PD map 2” on page 21

Chapter 3. Problem determination maps
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Fibre Path PD map 1

From: |["Common Path PD map 2” on page 25}|“Diagnosing with SANavigator PD|
fmap 2” on page 31

Fibre Path PD map 1

Entry
Point

HBA Type 2200 and above

Run Run
FAStT MSJ ) Loopback ) Replace
Loopback test Fail —» Have you been No —» p Fail —p] HBA

at cable here before? teHth:t and replug path

Pass

PASS

Call IBM Support

Replace
Cable

and replug path

Have you been
here before?

Call IBM Support 4-Yes

No
v
Replug
Path
To
Fibre Path
PD map 2

For information about how to run loopback tests, see [Chapter 4, “Introduction to|
[FAStT MSJ],” on page 55,

To see Fibre Path PD map 2, go to|“Fibre Path PD map 2” on page 21
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Fibre Path PD map 2
From: |“Fibre Path PD map 1” on page 20} [“Check Connections PD map” on page]

[19}['RAID Controller Passive PD map” on page 11} ['Boot-up Delay PD map” on]

page 13 |"Hub /Switch PD map 1” on page 15} [‘Diagnosing with SANavigator PD|

map 2” on page 31

Additional information:
Start FAStT MSJ (see
Chapter 4, “Introduction|
to FAStT MS],” on page|
55). If you are here after
repair, refresh the FAStT
MS]J database.

Additional information:
If the controller was
passive, change the state
to active and redistribute
the LUNSs.

Path good - Done

Fibre Path PD map 2

Any devices seen
by FASIT MSJ?

Yes

PASS

buffer test

FAIL

How many

1 fail

To Single
Path Fail
PD map 1

fails?

More than 1 fails

To Common
Path PD
map 1

To see Single Path Fail PD map 1, go to [‘Single Path Fail PD map 1” on page 22|

To see Common Path PD map 1, go to [“Common Path PD map 1” on page 24/

Chapter 3. Problem determination maps

21



Single Path Fail PD map 1
From: |"Fibre Path PD map 2” on page 21} ['Diagnosing with SANavigator PD map]|

[1” on page 28 ['Diagnosing with SANavigator PD map 3” on page 33

Single Path Fail PD map 1

»

Entry
Point

Disconnect cable
from failed path at
controller end

Replace minihub
or controller

+
No

Have minihub
and controller
been replaced?

I
Yes

Call IBM Support

[

A

Replace
MIA if 3526

Replace GBIC
if other

+

No

Have
MIA/GBIC
already been
replaced?

To Single
Path Fail
PD map 2

Yes

Insert wrap plug at
controller end

Run sendEcho
test

sendEcho
test

passes?

Yes

Additional information:
See [Chapter 14, “PD|

hints: Wrap plug tests,”]

on page 223,

Additional information:
See [Chapter 10, “PD|

hints: Performing]

sendEcho tests,” onl

page 161.|

Additional information:
See |”Controlle;|

diagnostics” on page]

Run Controller
Run Time
Diagnostic for both
controllers

Diagnostics
Pass?

157]

To see Single Path Fail PD map 2, go to [‘Single Path Fail PD map 2” on page 23]
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Single Path Fail PD map 2
From: |“Single Path Fail PD map 1” on page 22.|

Single Path Fail PD map 2

Entry
Point

4

Remove wrap plug.
Replace cable at
Controller.
Remove cable at
concentrator end.

4

Insert wrap plug
on cable end

Replace cable
Run sendEcho

test
A
No
Cable already send Echo
replaced? No passes? ves

h 4
To
Hub/Switch
PD map 1

Yes

4

Call IBM Support

Additional
information: See

Chapter 14, “PD hints/|

Wrap plug tests,” on|

[page 223.|

Additional
information: See

Chapter 10, “PD hints|

Performing sendEcho

tests,” on page 161

To see Hub/Switch PD map 1, go to[“Hub/Switch PD map 1” on page 15]
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Common Path PD map 1

From: |["Fibre Path PD map 2” on page 21

Common Path PD map 1

Are
Both hub port
lights off?

Unmanaged

hub in path? Yes

Yes
A 4

No

Check GBIC
seating in hub

Is
Yellow on-
Green off?

Are
Both hub port
lights on?

No

Yes Yes
A 4 A 4
Replace GBIC Check C?ble
connections

Disconnect cable
from common path
at concentrator
going to HBA

I

A

Replace Hub if not
GBIC port Insert wrap plug at

concentrator port

where cable was

removed

Replace GBIC if
Switch or Hub
GBIC

No

Is
Green light
on port?

concentrator
already been
replaced?

Call IBM Support Yes

Yes

To
Common Path
PD map 2

Additional information: See
Chapter 6, “PD hints: Common|
path/single path configurations,”|
on page 135.

Is
problem
resolved?

No
. A

Replace hub

Yes

Is
problem
resolved?

No

Call IBM Support

Done. Return to main to
check for other problems

To see Common Path PD map 2, go to[“Common Path PD map 2” on page 25|
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Common Path PD map 2

From: ["Common Path PD map 1” on page 24}|“Diagnosing with SANavigator PD|
fmap 1” on page 28|

Common Path PD map 2

Entry
Point

No HBA type
21007

Yes

3

v

Configure for crossport Additional information:

test using cable "
disconnected at HBA ——— S?e IC.hapter 13, PDl
end and wrap plug on hints: Hubs and|

cable switches,” on page 217

Crossport test
passes?

v
To Retplacte 210_0- Yes
Fibre Path return to main

PD map 1
No

Replace cable-
return to main

To see Fibre Path PD map 1, go to [“Fibre Path PD map 1” on page 20/
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Device PD map 1

From: ["PD maps and diagrams” on page 6.

Device PD map 1

Yes
Check SM and
Problem use gifﬁvery «Yes Device side of 3526
resolved? to determine controller unit?
actions

No No
Call IBM
support

Error
No indicators on device

side units?

Yes

Device
PD map 2

Additional
information: See

“Drive side hints” on|

page 193| in

Chapter 12, “PD hints|

Drive side hints and]

RLS diagnostics.”

To see Device PD map 2, go to [‘Device PD map 2” on page 27
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Device PD map 2

From: |“Device PD map 1” on page 26.|

Device PD map 2

Entry
Point

Fault indicator

on? Yes

Here before at
same unit?

Call IBM
Yes
support

No
A 4
Replace GBIC
Yes Fixed? N Replace unit that <
shows fault
Any
Bypass light
On in device
Yes
Problem solved
To
PD Hints-
Device
side
Additional information: See[“Drive side hints” on| ~ Additional information: If the faulty component
|Eage 193.| causes an ESM in an EXP500 or EXP100 to fail,

unplug and replug the ESM after the fix.

To see PD hints about troubleshooting the device (drive) side, go to [Chapter 12)
[PD hints: Drive side hints and RLS diagnostics,”|[’Drive side hints” on page 193/
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Diagnosing with SANavigator PD map 1

From: ["PD maps and diagrams” on page 6.
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Diagnosing with SANavigator PD map 1

Is
Concentrator
Present
(Switches,
Manage
Hub)?

No v

To Diagnosing

If unsure, see SANVavciT;ator
“Configuration| PD map 2

Type PD map” on|

[page 10.|

Additional /

information: See
Chapter 5,|
“Introduction to
SANavigator,” on|

[page 103.| Verify

Topology
Being
Discovered?

No—v

Are all
Connections to
Concentrator or
Concentrator icon
RED?

To Diagnosing
with SANavigator
Intermittent

Connections
or Devices

that both In-band Failures RED?
PD map ’
and Out-of-band Check
are enabled. Ethernet
Connections
Determine
Device Port
Connections
SDG (2309) ‘ ‘ HBA Controller
Go to[Table 18 on]  « |
|]:_)age 183I
HBA HBA All Storage All Storage Action
Inner Outer Devices Inner Devices Outer
Diamond| Diamond | Diamond on same | Diamond on same
Concentrator Concentrator
R G R G Suspect HBA. To Common Path PD Map 2
G R R G Suspect cable from HBA, GBIC\Port
at concentrator. To Common Path PD Map 2
R R R G Suspect HBA. To Common Path PD Map 2
C R C G To Common Path PD Map 2
R-Red
G=Green
C=Clear (In-band disabled)

Storage | Storage | Storage Controller HBA on same | HBA on same Action
Server | Server Server Connection to | Concentrator | Concentrator
Icon Inner Outer Concentrator Inner Outer
Diamond | Diamond Diamond Diamond
R RorC R - GorC G Check all cables between Concentrator and Storage
Server. Suspect concentrator or Storage Server.
G R G - R G Make sure in-band is enabled. If enabled, suspect
HBA. Go to Common Path PD Map 2.
G RorC G R GorC G Go to Single Path Fail PD Map 1
R-Red
G=Green
C=Clear (In-band disabled)
--=Don’t care
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To see Diagnosing with SANavigator PD map 2, see |[“Diagnosing with|
[SANavigator PD map 2” on page 31)

To see Common Path PD map 2, see [‘Common Path PD map 2” on page 25]

To see the Intermittent Failures PD map, see [‘Diagnosing with SANavigator
[Intermittent Failures PD map” on page 34

To see Single Path Fail PD map 1, see|“Single Path Fail PD map 1” on page 22|
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Diagnosing with SANavigator PD map 2

From: |"Diagnosing with SANavigator PD map 1” on page 28 This PD map is

applicable only to Direct Connect Configurations (either to Controllers or
un-managed hubs). It assumes that In-Band discovery is enabled.

discovery is enabled.

See Ehapter 4,|
“Introduction to FAStT|
MSJ,” on page 55|

Hint: Verify that in-band

Additional Information:

Diagnosing with SANavigator PD map 2

Entry
Point

Is
SAN
Being
Discovered?

To Diagnosing
with SANavigator
Intermittent
Failures
PD map

Any Inner
Diamonds
RED?

Are All
Connected
Sets RED?

To Diagnosing
with

SANavigator
PD map 3

NO ﬁ
Unplug HBA
Cable at
Device End
Run ¢
FAStT To Fibre Path
MSJ PD map 1
Reo! HBA
eplace Discovered Ye
HBA in HBA I
Tree?
To
Fibre Path
PD map 2

HBA
Discovered
in HBA
Tree?

REFRESH
Configuration

SANavigator Set-up problem:

See [Chapter 5, “Introduction|

to SANavigator,” on page|

103,

Hint: No device is being
detected by HBA and HBA
inner diamond is RED.

To see Fibre Path PD map 1, see[Fibre Path PD map 1” on page 20/

To see Fibre Path PD map 2, see |“Fibre Path PD map 2” on page 21/

To see the Intermittent Failures PD map, see [‘Diagnosing with SANavigator

[Intermittent Failures PD map” on page 34]

Chapter 3. Problem determination maps
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To see Diagnosing with SANavigator PD map 3, see [“Diagnosing with|
[SANavigator PD map 3” on page 33
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Diagnosing with SANavigator PD map 3

From: |["Diagnosing with SANavigator PD map 2” on page 31

Additional
Diagnosing with SANavigator PD map 3 information: See

To Diagnosing
with SANavigator
Intermittent
Failures PD map

Additional
information: See

Run
FAStT
MSJ

4

Inner
Diamond of
HBA Connected
to Storage
Server
Red?

Failed
Controller
Seen?

Refresh N
Configuration [« No

Additional

Yes

Disconnect

Yes FQflt:jlePfr?th information: See
» 7 alle atn al
Run FAStT i Controller End
MSJ A

:

Insert wrap

Failed
Controller

Seen?
plug
HBA at Cable End
No Type No
21007
A < Yes Reconnect FAStT MSJ
Path Loopback test
Refresh A v Passes?

Configuration
Run FAStT MSJ

Read/Write
Buffer test

Insert wrap
i plug
v at HBA end

To Single
Path Fail
PD Map1

Loopback

Replace
es® Cable

Replace
HBA Yes

Do Discovery Setup;

Clear Current SAN '10
Attention:
Export the SAN before
clearing it. Click SAN -> Export R?_'pEI&ce

Connection
Still
RED?

To see the Intermittent Failures PD map, see ['Diagnosing with SANavigator -
[[ntermittent Failures PD map” on page 34)

To see Single Path Fail PD map 1, see|“Single Path Fail PD map 1” on page 22]
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Diagnosing with SANavigator - Intermittent Failures PD map

From:|"Diagnosing with SANavigator PD map 1” on page 28}|“Diagnosing with|

SANavigator PD map 2” on page 31}|”Diagnosing with SANavigator PD map 3”|

on page 33|

Diagnosing with SANavigator -
Intermittent Failures PD map

Expand
SANavigator
Event Log
Panel

.

Click on Description
Column to sort
for Offline Events

A

Ctrl-Click
on Source and
Node/Port WWN

.

Identify devices
with Multiple
Offline Events

v

Click on Device Log
Entry to Locate the
device in Topology

To Intermittent
PD Map
Matrix

‘ ‘ Controllers ‘

v

To Intermittent
PD Map
Matrix-

Controller

v

To Intermittent
PD Map
Matrix-HBA

Additional information: See [Chapter 5, “Introduction tq|
[SANavigator,” on page 103

Hint: Filter the Event Log to display fatal errors only.

Hint: You can move the columns in the Event Log to any
desired location by clicking and then dragging the title
bar.

Additional information: See [’Event Log behavior” on|

(Hint: Connection Offline events for devices are also
preceded or followed by Concentrator Connection
Offline events. When looking for multiple offline events
to isolate the intermittent device, focus on the device
events rather than the concentrator events.)

34

To see the Intermittent Failures PD table for a host bus adapter, go to [‘Intermittent

[PD table - Host bus adapter” on page 35.|

To see the Intermittent Failures PD table for a controller, go to [“Intermittent PD|

ftable - Controller” on page 35
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Intermittent Failures PD tables

Use the following tables to help you isolate intermittent failures. Use the
SANavigator Event Log to determine which device has a history of intermittent

failures. See[“Event Log behavior” on page 178 to aid your understanding of event

logging.

You can also check the operating status change of your SAN to determine the
online/ offline status of devices. To generate the report, select Monitor -> Reports
and check the "Operating Status Change” box. See [‘Generating, viewing, and|

[printing reports” on page 129]

Intermittent PD table - Controller

From: ["Diagnosing with SANavigator - Intermittent Failures PD map” on page 34/

ID Connection type/device

Offline events
(Out-of-band
discovery)

Offline events
(In-band discovery)

Action*

1 Concentrator

HeA —FET [ ]

Controllers

X

Go to f’Controller Fatail

Event Logged PD map 17

on page 37

2 Unmanaged hub

MBA_—FET 7 ]

3526 Controller

N/A

Not applicable (Out-of-band
discovery requires switch or
managed hubs.)

3 Mini-hubs (Ctrlr)
HBA

N/A

Not applicable (Out-of-band
discovery requires switch or
managed hubs.)

4 MIA (3526 Ctrlr)
HBA

N/A

Not applicable (Out-of-band
discovery requires switch or
managed hubs.)

5 Concentrator

HeA — FET [ ]

Controllers

N/A

Not applicable (Out-of-band
discovery is required.)

6 Unmanaged hub

MBA P77 ]

3526 Controller

Go to f’Controller Fatail

Event Logeed PD map 17

on page 37

7 Mini-hubs (Ctrlr)
HBA

Go to f’Controller Fatail

Event Logeed PD map 17]

on page 37.|

8 MIA (3526 Cirlr)
HBA

Go to f’Controller Fatail

Event Logeed PD map 17]

on page 37.|

9 Concentrator

HBA —FET [ ]

Controllers

Go to f’Controller Fatail

Event Logeed PD map 3’

on page 39.|

* When inspecting the event log, look for devices that consistently go offline and come back online before

suspecting the component.

Note: In these diagrams, the term concentrator refers to either a switch or a managed hub.

Intermittent PD table - Host bus adapter

From: “Diagnosing with SANavigator - Intermittent Failures PD map” on page 34/
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Offline events
(Out-of-band Offline events
ID Connection type/device discovery) (In-band discovery) |Action*
1 Concentrator X Go to I”HBA Fatal Evenﬂ
CO:&LFS;W Logged PD map” on page
40
2 Unmanaged hub N/A Not applicable (Out-of-band
3506 gﬁﬁtmw discovery requires switch or
managed hubs.)
3 Wini-hubs (G N/A Not applicable (Out-of-band
HBA discovery requires switch or
managed hubs.)
4 WiA (@526 i) N/A Not applicable (Out-of-band
HBA discovery requires switch or
managed hubs.)
5 Concentrator N/A Not applicable (Out-of-band
c ommew discovery is required.)
6 Unmanaged hub X Go to I”HBA Fatal Evenﬂ
HBA 7 7 ] 7
3526 Controller ! LoggEd PD map on pagel
10]
7 Mini-hubs (Ctin) X Go to I”HBA Fatal Evel‘lﬂ
HBA Logged PD map” on page|
40
8 MIA (3526 Culr) X Go to I”HBA Fatal Evel‘lﬂ
HBA Logged PD map” on page|
40
9 Concentrator X X Go to I”HBA Fatal Evenﬂ
corBA ——FF] 01 | Logged PD map” on page|
@
* When inspecting the event log, look for devices that consistently go offline and come back online before
suspecting the component.
Note: In these diagrams, the term concentrator refers to either a switch or a managed hub.
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Controller Fatal Event Logged PD map 1

From: ["Intermittent PD table - Controller” on page 35

Hint: SANavigator
displays in-band only
discovered SAN as a
loop topology.

Controller Fatal Event Logged PD map 1

No

A

Suspect
Component
(listed from

highest to
lowest priority)

1. Loose or dirty
cable connection
at HBA and/or
Controller Port

2. Cable from HBA
to Controller Port

3. 1f 3526, MIA for that
Port, otherwise
Controller GBIC

4. For other than 3526
and 3542, Mini Hub
for that Port

5. Controller for
that Port

Event
Logged

In-band
Discovery

Type
Enabled?

Yes

Unmanaged
Hub in
Path?

More than
One Device in
that Loop with
Multiple “In-band
Offline” Events

To Controller
Fatal Event
Logged

PD map 2

Suspect
Component
(listed from

highest to
lowest priority)

1. Loose or dirty
cable connection
at HBA and/or
Hub Port

2. Cable from HBA
to Hub Port

3. GBIC at
Hub Port

4. Hub

Controller Fatal

Out-of-band

Only

Yes

!

Suspect
Component
(listed from

highest to
lowest priority)

. Loose or dirty cable

connection at
Controller Port and/or
Concentrator Port

. Cable from Controller

Port to
Concentrator Port

. GBIC at

Concentrator Port

If 3526, MIA for that

. Port, otherwise

Controller GBIC

. For other than 3526

and 3542, Mini Hub
for that Port

. Controller for

that Port

. Concentrator

To see Controller Fatal Event Logged PD map 2, go to|“Controller Fatal Event|
ogged PD map 2” on page 38.
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Controller Fatal Event Logged PD map 2

From:|"Controller Fatal Event Logged PD map 1” on page 37

Controller Fatal Event
Logged PD map 2

Controller

Type No
35267
v
Suspect
Components
Yes (listed from
highest to
lowest priority)
Suspect
Components 1. Loose or dirty
(listed from cable connection
highest to at HBA or

lowest priority)

. Loose or dirty

cable connection
at HBA and/or
MIA Port

. Cable from HBA

to MIA Port

. MIA

. Controller for that

port

Controller Port

2. Cable from HBA

to Controller Port

3. GBIC at

Controller Port

4. Mini-hub if other

than 3542

5. Controller for that

port
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Controller Fatal Event Logged PD map 3

From: |["Intermittent PD table - Controller” on page 35}|“Controller Fatal Event]

[Logged PD map 1” on page 37

Controller Fatal Event Logged PD map 3

Controller Fatal
Event
Logged

Only
In-band Offline
Events
Logged for that
Controller?

Yes

ﬁNo

Are both
In-band and
QOut-of-band

Offline Events

Logged?

More

No

Only
Out-of-band
Offline Events

than one
device connected

to Concentrator
with Multiple In-band
Events Logged?

No

Yes

v

Suspect Components
(listed from highest to

1. Loose or dirty cable
connection at In-band
Enabled HBA or
Concentrator Port
to Concentrator Port

3. GBIC at Concentrator

4. HBA

5. Concentrator

Suspect Components
(listed from highest to

1.

lowest priority) 3.

2. Cable from HBA 5.

Port 6.

lowest priority)

Loose or dirty cable
connection at
Controller Port and/or
Concentrator Port

Cable from Controller
Port to Concentrator

GBIC at Concentrator
Port

If 3526, MIA for that
Port, other Controllers
GBIC

For other than 3526
and 3542, Mini-Hub
for that Port

Controller for
that Port

Concentrator
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HBA Fatal Event Logged PD map

From: ["Intermittent PD table - Host bus adapter” on page 35.|

HBA Fatal Event Logged PD map

Hint: SANavigator
displays in-band
discovered SAN as a
loop topology.

In-band
Only

No

HBA Fatal
Event
Logged

Discovery

Out-of-band
O

Type
Enabled?

In-band

and Out-of-band

Only

Connection Offline.

Multiple Multiple
“In-band Offline” “In-band Offline” No
Events Events
Logged? Logged?

Only

Y Multiple
Replace es “Out-of-band
HBA Offline Events”
Logged?
v v
Suspect Suspect
Component Component
(listed from (listed from
highest to highest to
lowest priority) lowest priority) Both
“In-band and
i i Out-of-band
1. Loose or dirty 1. Loose or dirty Offline” Events
cable connection cable connection Logged?
at HBA and/or at HBA and/or
Controller/Hub Concentrator Port
2. Cable from HBA 2. Cable from HBA
to Concentrator
g, . 3. HBA one
Hint: All devices 3. GBICat
connected to this Concentrator Port
HBA will also show 4. Concentrator

A

Suspect
Component
(listed from

highest to
lowest priority)

. Loose or dirty

connection at
HBA and/or
Concentrator Port

. Cable from HBA

to Concentrator

. GBIC at

Concentrator Port

. HBA

. Concentrator
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Linux Port Configuration PD map 1

From: |Specific problem areas” on page 6.

Linux Port Configuration PD Map 1 Note: The agent
qlremote does not
start automatically.
Prior to connecting

the host, open a
Run FAStT MSJ . .
connect to the terminal session and
host run glremote. Stop all
— 1/0Os before starting
Iremote.
Yes Expand HBA d
device tree

Run
FAStT MSJ
R/W buffer
test

Any LUN
3l in device
tree?

Incorrect storage
mapping

Fail
No

How many

One fail fails?

Are Luns
sequential and
starting with

To Single
Path Fail
PD map 1

More than one fail

Yes

v

To Common
Path PD Configure —_—
map 1 device Luns See |“Linux por

lick fil . .
(cikcon configure) configuration” on|

page 189.|

Invalid
device and Lun
configuration
detected?

No+

Yes

v

Do auto
discovery

}

Configure devices
No— and LUN
See “Linux Port
Configuration”

Any device
node name
split?

To Linux
Port Configuration
PD map 2

Hint: If a Device node
name is split, then
two entries will
appear for the same
WWN name. (Only
one entry should
appear per controller
WWN name.)

To see Single Path Fail PD map 1, see|“Single Path Fail PD map 1” on page 22|

To see Common Path PD map 1, see [“Common Path PD map 1” on page 24/
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To see Linux Port Configuration PD map 2, see [“Linux Port Configuration PD map|

42 1BM TotalStorage FAStT: Problem Determination Guide



Linux Port Configuration PD map 2

From: [“Linux Port Configuration PD map 1” on page 41|

Linux Port Configuration PD Map 2

Entry
Point

A 4

Right-click on
split controller node
name and select
device information

v

Use Storage Manager
to map the device/LUNs
for Linux and reconfigure

the ports using FAStT MSJ

Hint: Right-click the
Host icon in the HBA
Tree and select
“Adapter Persistent
Configuration Data . .
.7 The Adapter(s)
WWNN displays.
Record this
information as it will
be required by FAStT
Storage Manager to
map your storage to
the Linux OS.

Additional
information: See
“Linux pora

configuration” on|

page 189

To see Single Path Fail PD map 1, see [“Single Path Fail PD map 1” on page 22
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pSeries PD map

Start with this pSeries PD map if you are troubleshooting fibre channel network
SANs with FC 6228 HBAs and IBM pSeries servers running AIX.

AlX/pSeries main PD map

Begin pSeries
PD map

Is the
adapter
available? No
See Fibre
Channel Adapter
Not Available
PD map

Is the
SCsI /0
Protocol

Device
available?

No

See Fibre Channel
SCSI I/0 Controller
Protocol Device Not|
Yes Available PD
map

Are the
appropriate logical
hard disks
available?

See Logical

Hard Disks

Yes Not Available
PD map

Are the
appropriate
logical tape drives
available?

See Logical
Tape Drives
Not Available
PD map

See Fiber Path
Failures PD

Are there
errors reported

Are there
errors reported
by or associated
with a tape
ubsystem?

by or associated with
a disk storage
ubsystem?

No

a SAN Data
Gateway?

Switch?

Yes Yes Yes Yes

Refer to Service Refer to Service Refer to Service Refer to Service Refer to Service
N Manual for the Manual for the
Manual for the disk Manual for the " Manual for the "
t bsyst P bsyst Fibre Channel SAN Data Gatewa Fibre Channel
storage subsystem ape subsystem Switch y Storage Hub

For more detailed information including sample diagnostic information, see
Chapter 18, “pSeries supplemental problem determination information,” on page|

1]

To see Fibre Channel Adapter Not Available PD map, see [“Fibre Channel Adapter]
INot Available PD map” on page 46
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To see Fibre Channel SCSI I/0O Controller Protocol Device Not Available PD map,
see ["Fibre Channel SCSI I/O Controller Protocol Device Not Available PD map” on|

|Eage 47.|

To see Logical Hard Disks Not Available PD map, see[“Logical Hard Disks Nof]
|Available PD map” on page 48]

To see Logical Hard Tapes Not Available PD map, see [“Logical Tape Drives Not|
|Available PD map” on page 50

To see Fiber Path Failures PD map, see|“Fiber Path Failures PD map 1” on page 52}
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Fibre Channel Adapter Not Available PD map
From: ["pSeries PD map” on page 44|

0020 Fibre Channel Adapter Not Available PD map

Continue
from pSeries
PD map

Is the Is the Fibre i ahi
Install Gigabit
adapter Channel adapter ;
defined? No installed in the No— F;,bé? fdh:p'}gf'
AIX system?
Yes Yes
Is the .
adapter defined Are the device Reinstall
or available No —- drivers properly No—»  Dpevice Drivers
now? installed?

Yes Yes

Did the
diagnostics run
on the Fibre

Done

Call IBM
Support

No —P

Yes

Replace Gigabit
Fibre Channel
Adapter

For more detailed information including sample diagnostic information, see
fof PDP PD0020 - Fibre Channel Adapter not Available” on page 260
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Fibre Channel SCSI 1/0 Controller Protocol Device Not Available PD

map

From: ['pSeries PD map” on page 44|

0030 Fibre Channel SCSI I/0 Controller Protocol Device Not Available PD map

Continue from
pSeries
PD map

Are the
device drivers
properly
installed?

Yes

Call IBM
Support

No —»

Device Drivers

For more detailed information including sample diagnostic information, see

Chapter 18, “pSeries supplemental problem determination information,” on page]

1]
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Logical Hard Disks Not Available PD map
From: ["pSeries PD map” on page 44|

0040 Logical Hard Disks Not Available PD map

Continue
from pSeries
PD map

Is the disk
storage subsystem
operational, online
and correctly
set up?

Yes

s the SA
Data Gateway
operational, online,
and correctly

Fibre Channel
Switch operational,
online, and
correctly
et up?

Yes

See Fiber
Path Failures
PD map

No —»r

Refer to the
service manual
for the disk
storage subsystem

No —»

Refer to the
service manual
| for the SAN Data

No —»-

Gatewa
set up? way
Yes
Is the Refer to the

service manual
for the Fibre
Channel Switch
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For more detailed information including sample diagnostic information, see
Chapter 18, “pSeries supplemental problem determination information,” on page|

1]

To see Fiber Path Failures, see [“Fiber Path Failures PD map 1” on page 52
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Logical Tape Drives Not Available PD map

From: ["pSeries PD map” on page 44|

0050 Logical Tape Drives Not Available PD map

Continue
from pSeries
PD map

operational, online,
and correctly

Data Gateway
operational, online,
and correctly
set up?

Yes

See Fiber
Path Failures
PD map

No —»

Are the Refer to the
appropriate installation
logical tape drives No manual for the
defined? tape drives
Yes
Are the Refer to the
tape drives

service manual
for the logical

No —»

set up? tape drives
Yes
Is the SAN Refer to the

service manual
for the SAN Data
Gateway

For more detailed information including sample diagnostic information, see
Chapter 18, “pSeries supplemental problem determination information,” on page|

D]
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To see Fiber Path Failures, see|“Fiber Path Failures PD map 1” on page 52
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Fiber Path Failures PD map 1

Begin Fiber
Path Failures
PDF Map

any reason to
uspect problems with
fiber jumpers, trucks,
patch panels, or other
devices in this

Does the
fiber jumper from
the AIX System Fibre
Channel Adapter provide a
complete signal path to the
disk storage subsystem, tape
drive, patch panel, or other,
device to which it is
connected?

Yes

patch-panels
and interconnecting
trunk or jumper in this
configuration provide
a complete end-
to-end signal

fiber jumpers
plugged into the Fibe
Channel Switch in this
configuration provide a
complete signal

See Fiber
Path Failures
PD map 2

0060 Fiber Path Failures PD map 1

No—»

Call IBM
Support

Correct
the Fault

No—

Correct
the Fault

No—p|

Correct
the Fault

For more detailed information including sample diagnostic information, see
Chapter 18, “pSeries supplemental problem determination information,” on page|

1]

To see Fiber Path Failure PDF Map 2, see [‘Fibre Path Failures PD map 2” on page|
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Fibre Path Failures PD map 2
From: |[“Fiber Path Failures PD map 1” on page 52|

0060-2 Fiber Path Failures PD map 2

Continue from
Fiber Path Failures
PD map 1

Do the fiber
jumper and SCSI
hterface cables plugged
nto the SAN Data Gateway in
this configuration provide
a complete signal

N Correct
—NO=> the Fault

Correct
No—> e Fault

in this configuration
provide a complete

Do the
fiber jumpers
plugged into any
other device provide
a complete signal
path through
this device?,

Correct
No—»  the Fault

Does the fiber
jumper plugged
into this device
provide a complete
signal path to it?

Correct
No—» the Fault

Yes

Call IBM
Support

For more detailed information including sample diagnostic information, see
Chapter 18, “pSeries supplemental problem determination information,” on page|

1]
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Chapter 4. Introduction to FASIT MSJ

This chapter introduces IBM Management Suite Java (FAStT MS]) and includes
background information on SAN environments and an overview of the functions
of FAStT MS].

Note: Read the readme file, located in the root directory of the installation CD, or
see the IBM Web site for the latest installation and user information about

FAStT MSJ at:

www.ibm.com/pc/support/

SAN environment

In a typical Storage Area Network (SAN) environment, a system might be
equipped with multiple host bus adapters (HBAs) that control devices on the local
loop or on the fabric.

In addition, a single device can be visible to and controlled by more than one
HBA. An example of this is dual-path devices used in a primary/failover setup.

In a switched or clustering setup, more than one system can access the same
device; this type of configuration enables storage sharing. Sometimes in this
scenario, a system must access certain LUNs on a device while other systems
control other LUNs on the same device.

Because SAN has scalable storage capacity, you can add new devices and targets
dynamically. After you add these new devices and targets, you need to configure
them.

A SAN can change not only through the addition of new devices, but also through
the replacement of current devices on the network. For device hot-swapping, you
sometimes need to remove old devices and insert new devices in the removed
slots.

In such a complicated environment where there is hot-swapping of SAN
components, some manual configuration is required to achieve proper installation
and functionality.

Overview of the IBM FAStT Management Suite

FAStT MS] is a network-capable application that can connect to and configure
remote systems. FAStT MS] helps you configure IBM Fibre Channel HBAs in a
SAN environment. FAStT MS] uses ONC remote procedure calls (RPC) for network
communication and data exchange. The networking capability of FAStT MS]
enables centralized management and configuration of the entire SAN.

Note: The diagnostic functions of FAStT MS] are available for all supported
operating systems. The configuration functions are available for Linux
operating systems only. IBM FAStT Storage Manager provides management
capability for Microsoft® Windows-based platforms.
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With FAStT MS], you can use the following four types of operations to configure
devices in the system:

Disable (unconfigure) a device on a host bus adapter
When a device is set as unconfigured by the utility, it is not recognized by
the HBA and is inaccessible to that HBA on that system.

Enable a device
This operation adds a device and makes it accessible to the HBA on that
system.

Designate a path as an alternate for preferred path
When a device is accessible from more than one adapter in a system, you
can assign one path as the preferred path and the other path as the
alternate path. If the preferred path fails, the system switches to the
alternate path to ensure that data transfer is not interrupted.

Replace a removed device with a new inserted device
In a hot-plug environment, the HBA driver does not automatically purge a
device that has been physically removed. Similarly, it does not delete a
device that is no longer accessible because of errors or failure. Internally,
the driver keeps the device in its database and marks it as invisible.

The HBA driver adds a new device to the database, even if the device is
inserted into the same slot as the removed device.

FAStT MS] provides the function to delete the removed device’s data from
the driver’s database and to assign the inserted device the same slot as the
one that it replaces.

FASIT MSJ system requirements

56

The FAStT MS]J application consists of the following two components:
* FAStT MS]J client interface
* Host agent

Each component has different system requirements depending on the operating
system.

FAStIT MSJ client interface

FAStT MS]J, which is written in Java, should run on any platform that has a
compatible Java VM installed. The minimum system requirements for FAStT MS]
to run on all platforms are as follows:

* A video adapter capable of 256 colors

* At least 64 MB of physical RAM; 128 MB is preferred. Running with less
memory might cause disk swapping, which has a negative effect on
performance.

* 30 MB of free disk space

Platform-specific requirements for the FAStT MS]J client interface are as follows:
e Linux x86
— PII 233MHz (preferred minimum)

Linux Distribution Kernel
Red Hat Enterprise Linux Advanced Server |2.4.9-e.25 UP, SMP, Enterprise (Bigmem) and
2.1 Summit®
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Linux Distribution Kernel

RedHat Linux 7.x 2.4.18-19.7.x UP, SMP and Enterprise
(Bigmem)

RedHat Linux 8.0 2.4.18-27.8 UP, SMP, and Enterprise
(Bigmem)

United Linux 1.0 with SP2® and 32-bit 2.4.19-333

United Linux 1.0 IA-64 2.4.19 (The client code in this package will
only install and run on 32-bit linux)

SuSE Professional 8.1 2.4.19

Note: United Linux support includes the following distributions:

- SuSE Linux Enterprise Server 8 (SLES 8)
- Turbolinux Enterprise Server 8 (TLES 8)
- Conectiva Linux Enterprise Edition Powered by United Linux

* Microsoft Windows® 2000 and Windows NT

Pentium III processor 450 MHz or greater

* Novell NetWare

Pentium® III processor 450 MHz or greater

Host agent

Host agents are platform-specific applications that reside on a host with IBM HBAs
attached. The minimum system requirements for an agent to run on all platforms
are as follows:

* An IBM FAStT MS]J-supported device driver (see release.txt in the release
package for a list of supported device driver versions for each platform)

* At least 8 MB of physical RAM
* 2 MB of free disk space

Platform-specific requirements for the FAStT MS] host agents are as follows:

* Linux x86 — Agent runs as a daemon

* Microsoft Windows NT or Windows 2000 — Agent runs as a Windows NT
service

* Novell NetWare installation prerequisites

Be sure you have the following items before you install the QLremote NetWare
Agent:

NetWare Client software (from Novell) on the Windows NT or Windows 2000
client

NW.Link IPX/SPX-compatible transport or TCP/IP transport network
protocols

Note: The TCP/IP transport must be loaded to communicate with the FAStT
MSJ agent.

NWLink NetBios

Drive letter mapped to the root of the SYS volume of the NetWare server. By
default, the NetWare Client maps to sys\system or sys\public; however, you
must set the root of SYS volume by assigning a drive letter to sys:\.

Note: You must be logged on as an administrator to map server drive letters.
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— On the NetWare Server — NetWare 5.1 server with Support Pack 6 or later or
NetWare 6.x Support Pack 3 or later.

Limitations

The following is a list of limitations:
* Multiple Network Interface Cards — if multiple Network Interface Cards

(NICs) are present in the system, the FAStT MS] client will broadcast to the first
IP address subnet based on the binding order. Therefore, ensure that the NIC for
the local subnet is first in the binding order. If this is not done, the diagnostics
might not run properly and remote connection might not occur. See the readme
file in the release package for more information.

Host IP Addresses — The FAStT MS] application tries to help in not allowing
the user to connect to the same host more than once (causes issues with policies
and wasted system resources). This adds the requirement that all host IP
addresses MUST resolve to a host name to allow connection to complete.

Local host file — If DNS is not used you must edit the local host file on the
systems where you are running the FAStT MS] GUI and the QLremote agent.
Add the host name to IP mapping manually. Edit the file /etc/hosts.

Firewalls — Having systems with the firewall installed could cause problems
with async alarms from the agent running on Linux to a remote machine.
Problems could also occur if the GUI is running on a Linux Client
communicating to a remote machine. To circumvent this problem, type the
following command at a shell prompt:

chkconfig --Tist

Verify that "ipchains and iptables” in run levels 2, 3, 4, 5 are disabled. To disable
at a specific run level, set the following:

chkconfig --level 2 ipchains off
chkconfig --level 3 ipchains off
chkconfig --level 4 ipchains off
chkconfig --level 5 ipchains off
chkconfig --level 2 iptables off
chkconfig —-level 3 iptables off
chkconfig --level 4 iptables off
chkconfig --level 5 iptables off

HBA connected to a fabric — When a FAStT Fibre Channel HBA (QL2200, 2310,
or 2340) is connected to the fabric (switch), Loopback test is disabled because the
adapter is in a point-to-point mode. Unplugging the cable from the fabric and
inserting a wrap plug at the end of the cable (or at the adapter) will enable
loopback test.

Online Help — The FAStT MS]J online Web help can only be viewed by
Netscape Communicator (version 4.5 or greater).

Configuration refresh — When an online device fails and goes offline and a
subsequent configuration refresh occurs, the loop id for that device does not
reflect the original ID because, in effect, the device is no longer in the loop
(might show x100 or xff).

Restarting after failure detection — When a failure occurs during Diagnostics
(Loopback test and Read/Write Buffer test) and the test is restarted immediately,
FAStT MS] might request whether or not you want to refresh the configuration.
Select NO to continue the test. If YES is selected the host may be disconnected
with the following message:
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Unable to connect to the Host: {Host Name / IP address}. The Host is
currently in diagnostics mode, try again Tater.

To recover, you need to stop (press <CTL - C> in the terminal session where you
started qlremote) and then restart the agent "qlremote”.

Installing and getting started

This section contains procedures for how to install FAStT MS] and how to use the

application.

Initial installation options

FAStT MS] supports stand-alone and network configurations. Install the software
appropriate for your configuration. See for details.

Note: The same version of FAStT MS] must be installed on all systems.

Table 7. Configuration option installation requirements

Configuration

Software Requirements

Stand-alone system: This system monitors
host bus adapters locally.

FAStT MS] GUI

Plus one of the following:

» FAStT MS] Windows NT or Windows
2000 agent

* FAStT MS]J Linux agent

Networked system: This system monitors
host bus adapters locally and monitors
remote systems on the network. Host agents
are required for remote connection (see "Host
agent system” following).

FAStT MSJ GUI

Plus one of the following:

» FAStT MS] Windows NT or Windows
2000 agent

* FAStT MS] Linux agent

Client system: This system monitors host bus
adapters only on remote systems on the
network.

FAStT MS] GUI

Host agents (see requirements for host
agent system)

Host agent system: The host bus adapters on
this system are remotely monitored only from
other systems on the network.

One of the following:

+ FAStT MS] NT4/2000 agent

¢ FAStT MS] NetWare 5.x and 6.x agent
* FAStT MSJ Linux agent

You can install FAStT MSJ either from a GUI or from a Linux command line.

Installing FAStT MSJ from the GUI
The FAStT MS] installer is a self-extracting program that installs the FAStT MS]

application and related software.

Notes:

1. If you have a previous version of FAStT MS] installed, uninstall the previous
version of FAStT MSJ before you install the current version. See

[FAStT MS]” on page 62
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2. You cannot install the FAStT MSJ agent directly on a NetWare server; you must
install the agent on a system connected to the NetWare server. The Netware
server must have a drive mapped to a system running Windows 2000 or
Windows NT.

Perform the following steps to install FAStT MS] on the system or the NetWare

server:

1. Access the FAStT MS] installer by performing one of the following actions:

* If installing FAStT MSJ from a CD, click the IBM FAStT MS]J folder on the
CD.
* If installing FAStT MSJ from the IBM Web site, go to the page from which
you can download FAStT MSJ (this URL is listed in the readme file).
2. From the CD folder or the folder in which you saved the FAStT MS] installer,
select the appropriate install file by performing one of the following actions:

e For Windows 2000, Windows NT, and NetWare, double-click the
FAStTMS]_install.exe file.

Note: For NetWare, save to the system drive mapped to the NetWare

server.

* For Linux, perform the following steps:
a. Open a shell.

b.

Change to the directory that contains the FAStT MS] installer that you
downloaded in Step 1.

At the prompt, type sh ./FAStTMSJ_install.bin, where install is the
FAStT MSJ installer file.

InstallAnywhere prepares to install FAStT MS]. The Installation
Introduction window displays.

3. Click Next. The Choose Product Features window displays. The window
differs, depending on whether you are installing on a system running
Windows 2000, Windows NT, or Linux.

4. Perform one of the following actions to install the software appropriate to
your configuration:

 For a system running Windows 2000 or Windows NT, click one of the
following preconfigured installation sets, then click Next:

Click GUI and NT Agent if the system running Windows 2000 or
Windows NT will monitor host bus adapters on this system and remote
systems on the network.

Click GUI if the system will monitor host bus adapters only on remote
systems on the network.

Click NT Agent if the host bus adapters on the system running Windows
2000 or Windows NT will be remotely monitored only from other
systems on the network.

Click NetWare 5.x and 6.x Agent if the host bus adapters on this
NetWare 5.x or 6.x system will be remotely monitored only from other
systems on the network.

* For Linux systems, click one of the following preconfigured installation sets,
then click Next:

Click GUI if the system will monitor host bus adapters only on remote
systems on the network.

Click Linux Agent if the host bus adapters on this system running Linux
will be remotely monitored only from other systems on the network.
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— Click GUI and Linux Agent if this system running Linux will monitor
host bus adapters on this system and on remote systems on the network.

* For other configuration installation sets, click Customize to create a
customized installation set. The Choose Product Components window
displays. The window differs depending on whether you are installing on a
system running Windows 2000, Windows NT, or Linux. Perform the
following steps to create a custom installation set:

a. In the Feature Set list-box, click Custom Set.
b. Select from the following components:
— For a system running Windows 2000 or Windows NT:
- GUI
- NT Agent
- NetWare 5.x or 6.x Agent
- Help
- For a system running Linux:
- GUI
- Linux Agent
- Help
c. Click Next. The Important Information window displays.
5. Read the information, then click Next.

Note: Information in the readme file supplied with the installation package
takes precedence over the information in the Important Information
window.

The Choose Install Folder window displays.

6. Perform one of the following actions:

Note: For NetWare, click the drive mapped to the NetWare server.

* To select the default destination location displayed in the window, click
Next.

The default location for a system running Windows 2000 or Windows NT is
C:\Program Files\IBM FAStT Management Suite\.

The default location for a system running Linux is /root/IBM_FAStT_MS].

* To select a location other than the default, click Choose, click the desired
location, and click Next.

* To reselect the default location after selecting a different location, click
Restore Default Folder, and click Next.

7. 1If you are installing on a Windows platform, the Select Shortcut Profile

Location window displays. Perform one of the following actions:

* To select the all users profile to install the application program group and
shortcuts, select the All Users Profile radio button, and click Next.

* To select the current users profile to install the application program group
and shortcuts, select the Current Users Profile radio button, and click Next.

8. If you are installing on a NetWare system, the Novell NetWare Disk Selection
window displays. A list of the autodetected, mapped NetWare drives on the
subnet displays in the following format: drive, server name, server IP address.

a. Click the drives on which to install the NetWare agent. Each drive must be
a NetWare drive mapped on the system running Windows 2000 or
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Windows NT. You can select drives by clicking one or more autodetected
drives from the list or by typing the drive letter corresponding to the drive
you want to use.

b. Click Next. The Installing Components window displays. Subsequent
windows inform you that the installation is progressing. When the
installation is complete, the Install Complete window displays.

9. Click Done.

10. Customize the FAStT MS] application and set your security parameters. See
[“Security” on page 67| for details.

Installing FAStT MSJ from a Linux command line
Use the following procedure to install FAStT MS] from the command line of a
Linux system.

Note: The command line installation procedure is not currently supported with the
IA-64 FAStTMS] package.

To perform a command line installation of FAStT MS] and the glremote agent,
perform the following steps:

1. Open a shell and change to the directory that contains the FAStT MS] installer.
2. At the prompt, type: sh FAStTMSJ_install.bin -i silent

3. FAStT MS] installs in the /opt directory. The launch script is located in the /usr
directory.

To perform a command line installation of only the glremote agent, perform the
following steps:

1. Open a shell and change to the directory that contains the FAStT MS]J installer.
2. At the prompt, type:
sh FAStTMSJ_install.bin -i silent -DCHOSEN_INSTALL_SET="QMSJ_LA"

3. FAStT MS] installs in the /opt directory. The launch script is located in the /usr
directory.

Uninstalling FASIT MSJ

You must exit the FAStT MS]J application before you uninstall FAStT MS]. Make
sure you uninstall the NetWare agent from the Windows 2000 or Windows NT
drive mapped to the Novell NetWare server when installing FAStT MS].

Perform the following steps to uninstall FAStT MSJ:
1. Start the FAStT MSJ Uninstaller:

* On a system running Windows 2000 or Windows NT, click Start -> Programs
-> IBM FAStT MS]J -> FAStT MSJ Uninstaller.

* On a system running Linux:

a. Change to the directory where you installed FAStT MS]J. For example,
type:
cd /usr

b. Type the following command to run the InstallAnywhere Uninstaller:
./FAStT_MSJ_Uninstaller

The InstallAnywhere Uninstaller window displays; it lists IBM FAStT

Management Suite Java Vx.x.xx as the program to be uninstalled.

2. Click Uninstall. The InstallAnywhere Uninstaller - Component List window
lists the components to be uninstalled. A message displays informing you that
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the uninstaller is waiting 30 seconds for the agent to shut down. Wait while the
uninstaller removes the components. The InstallAnywhere Uninstaller -
Uninstall Complete window informs you that the uninstall is complete.

3. Click Quit.

4. If any items are not successfully uninstalled, repeat the uninstallation
instructions to remove them.

5. Restart the system.

Getting started

FAStT MS] enables you to customize the GUI and agent. After you install FAStT
MSJ and set your initial parameters, these components activate each time you start
the application.

Starting FAStT MSJ

This section describes how to start FAStT MS] on systems running Windows and
Linux.

Windows 2000 or Windows NT: On a system running Windows 2000 or
Windows NT, double-click the FAStT MSJ icon on your desktop if you selected to
create the icon during installation (see , or click Start -> Programs-> IBM
FAStT MS]J -> FAStT MS]J.

FASET MS]

Figure 2. FAStT MSJ icon

The FAStT MS] main window opens.

Linux: On a system running Linux, perform the following steps to start the FAStT

MSJ:

1. Ensure that you are in a graphical user environment.

2. Open a command terminal.

3. Change to the usr directory in which the IBM FAStT MS] application is
installed by typing cd /usr.

4. Type ./FAStT_MSJ. The FAStT MS] main window opens.

FAStT MSJ main window

The IBM Management Suite Java-HBA View window (hereafter referred to as the
FAStT MS] main window) displays after you start FAStT MS]. See [Figure 3 on page|
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Figure 3. FAStT MSJ main window

The window consists of the following sections:
* Menu bar

* Toolbar

* HBA tree panel

* Tab panel

FAStIT MSJ basic features overview

This section lists FAStT MS] features and contains general information needed to
run FAStT MS] on any supported platform.

Features
FAStT MS] enables you to perform the following actions:
* Set FAStT MS] options
¢ Connect to hosts
* Disconnect from a host
* View extensive event and alarm log information
* Use host-to-host SAN configuration policies
* Configure port devices
* Use LUN Level configuration
* Watch real-time to see when failovers occur with the Failover Watcher

* Control host-side agent operations, including setting the host agent polling
interval

* Review host adapter information, including;:
— General information
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— Statistics
— Information on attached devices
— Attached device link status
* Perform adapter functions, including:
Configure adapter NVRAM settings
— Run fibre channel diagnostics (read/write and loopback tests)

Perform flash updates on an adapter

Perform NVRAM updates on an adapter
* Manage configurations
- Save configurations for offline policy checks and SAN integrity
— Load configurations from file if host is offline for policy checks and SAN
integrity
* Confirm security

Options
To configure FAStT MS], click View -> Options. The Options window opens.

The Options window has four sections and two buttons:
* Event Log

e Alarm Log

* Warning Displays

* Configuration Change Alarm

* OK (save changes) and Cancel (discard changes) buttons

The Options window functions are described in the following sections.

Event log

Event log information includes communication and file system errors. FAStT MS]
stores the event entries in the events.txt file. You can log informational and
warning events.

You can set the maximum size of the event log to be in the range of 20 to 200
event entries; the default is 20 events. When the maximum size of the event log is
exceeded, old entries are automatically deleted to provide space for new entries.

Alarm log

When FAStT MS] communicates with a host, FAStT MS] continually receives
notification messages from the host, indicating changes directly or indirectly made
on adapters. Messages regarding status, configuration, and NVRAM changes are
logged. FAStT MS]J stores these alarm messages in the alarms.txt file.

You can set the maximum size of the alarm log to be in the range of 20 to 200
event entries; the default is 200 entries. When the maximum size of the alarm log
is exceeded, old entries are automatically deleted to provide space for new entries.

Warning displays

FAStT MS] displays additional warning dialogs throughout the application. By
default, the Warning Displays option is enabled. To disable the display of warning
dialogs, clear the Enable warning displays check box in the Options window.
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Configuration change alarm

FAStT MS] tries to keep current the devices and the LUNs that the adapter
displays. During cable disconnects, device hotplugs, or device removal,
configuration change alarms are generated to keep the GUI current. You can
control the way FAStT MS] handles configuration change alarms with the
Configuration Change Alarm option. You can choose from the following options:

* Apply Configuration Changes Automatically

When a configuration change alarm is detected by the GUI, the application
disconnects the host and reconnects to get the new configuration automatically.

* Confirm Configuration Change Applies (default setting)

When a configuration change alarm is detected by the GUI, the application
displays a window that the user clicks Yes or No to refresh the configuration for
the specified host.

* Ignore Configuration Changes

With this setting, a configuration change alarm detected by the GUI is ignored.
For the configuration to be updated, you must perform a manual disconnect and
connect of the host must be performed.

Note: You can refresh the configuration by selecting the desired host and clicking
the Refresh button on the toolbar or by right-clicking the desired host and
clicking Refresh on the pop-up menu.

Connecting to hosts

There are two ways to connect to hosts in a network:
* Manually
* Automatically with the Broadcast function

For multi-homed or multiple IP hosts, FAStT MSJ tries to ensure that a specified
host is not loaded twice into the recognized host tree. If a particular host has
multiple interfaces (NICs), each with its own IP address, and proper
name-resolution-services are prepared, the host will not be loaded twice into the
tree. Problems can occur when one or more IPs are not registered with a host.

A blinking heart indicator (blue pulsating heart icon) indicates that the connection
between the client and remote agent is active for this test.

Manual connection
Perform the following steps to manually connect to a host:

1. From the FAStT MSJ main window, click the Connect button or click Connect
from the Host menu.

The Connect to Host window displays.

2. Type in the host name, or select the host you want to connect to from the
drop-down list. You can use the computer IP address or its host name. If the
computer you want to connect to is the computer on which FAStT MS]J is
running, select localhost from the drop-down list. To delete all user-entered
host names from the drop-down list, click Clear.

3. After you have selected or typed the host name, click Connect to initiate the
connection.

If the connection attempt fails, an error message displays that indicates the
failure and potential causes. If the connection is successfully established, the
host’s name and its adapters are shown on the HBA tree.

Click Cancel to stop the connection process and return to the main window.
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Broadcast connections

FAStT MS] can auto-connect to all hosts running an agent in a network. For
auto-connect to function properly, ensure that the Broadcast setting is enabled. To
enable auto-connect, select the Auto Connect check box from the Host menu. To
disable auto-connect, clear the Auto Connect check box.

Note: If multiple NICs are present in the system, the FAStT MS] client will
broadcast to the first IP address subnet based on the binding order.
Therefore, ensure that the NIC for the local subnet is first in the binding
order. If this is not done, the diagnostics might not run properly and remote
connection might not occur. See the readme file in the release package for
more information.

Disconnecting from a host

Perform the following steps to disconnect from a host:

1. From the FAStT MS] main window HBA tree, click the host that you want to
disconnect from.

2. Click Host -> Disconnect.
When a host is disconnected, its entry in the HBA tree is removed.

Polling interval

You can set polling intervals on a per-host basis to retrieve information. The
polling interval setting can be in the range from 1 second to 3600 seconds (one
hour). Perform the following steps to set the polling interval:

1. Click the host in the HBA tree in the FAStT MS] main window.
2. Click Host -> Polling. The Polling Settings - target window displays.
3. Type the new polling interval and click OK.

Security

FAStT MS] protects everything written to the adapter or adapter configuration
with an agent-side password. You can set the host agent password from any host
that can run the FAStT MS] GUI and connect to the host agent.

When a configuration change is requested, the Security Check window displays to
validate the application-access password. Type the application-access password for
confirmation.

To change the host agent password, select a host by clicking it in the HBA tree.
The Information/Security tab panels display. Click the Security tab to display the
Security panel.

The security panel is divided into two sections: Host Access and Application
Access.

Host access

The Host Access section verifies that the host user login and password has
administrator or root privileges before an application access is attempted. The
login and password values are the same as those used to access the computer.

Login A host user account with administrator or root-level rights.

Password
The password for the host user account.
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Application access

The Application Access section enables you to change the FAStT MSJ host agent
password. To change the password, type the following information into the
following fields:

Old password
The current application-access password for the host. The original default
password is config. Change it immediately to a new password.

New password
The new application-access password for the host.

Verify Password
The new application-access password for host verification.

The Help menu

From the FAStT MS] Help menu, you can specify the location of the browser to
launch when help is requested by a user. You can also view FAStT MS] version
information.

The Help menu contains the following items:
* Set Browser Location

Click this item to display the Browser Location window. Type the file path of the
browser that FAStT MS] will launch when a user requests help, or click Browse
to find the file location.

* Browse Contents
Click this item to access FAStT MS] help.
e About

Click this item to view information about FAStT MS], including the current
FAStT MS]J version number.

Diagnostics and utilities

The diagnostic and utility features of FAStT MS] enable you to perform the
following actions:

* View event and alarm log information
* Review host adapter information
— View general information
— View statistics
— View information on attached devices
— View attached device link status
— View adapter NVRAM settings
* Perform adapter functions, including:
— Configure adapter NVRAM settings
Perform NVRAM updates on an adapter

Perform flash updates on an adapter

Run Fibre Diagnostics (read/write and loopback tests)
* Manage configurations
— Save configurations for offline policy checks and SAN integrity

— Load configurations from file if host is offline for policy checks and SAN
integrity
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Viewing logs
FAStT MS] records an extensive set of information to the event and alarm logs. The
logs are saved as text files (alarms.txt and events.txt) in the folder where FAStT
MS] is installed. FAStT MS]J can parse and view these logs in a window. To view
these logs, click Event Log or Alarm Log from the View menu, or click the
appropriate button on the button bar.

Viewing the event log

The event log window displays events relating to FAStT MS] application
operations. New events display in the window as they occur. There are three types
of time-stamped event messages:

- 8 Informative - an informative or general information event
+ 1 Warning - a non-critical application event

« €3 Error - a critical application event

Click OK to close the Event Log window. Click Clear to purge all event entries
from the log.

Sorting: To sort a column in ascending or descending order, right-click the
column header, and click the desired sorting method.

Details: To view an individual event entry, double-click the entry; a separate
event details window displays. You can navigate individual entries by clicking
Next or Previous.

Viewing the alarm log

The alarm log window displays events that occurred on hosts connected to FAStT
MS]J. New alarms display in the window as they occur. Alarm entries have the
following properties:

¢ Time Stamp — The date and time of the logged alarm
* Host Name — The agent host that sent the alarm

* Adapter ID — The host adapter the alarm occurred on
e Application — The type of device that sent the alarm
* Description — The description of the alarm

Click OK to close the Alarm Log window. Click Clear to purge all alarm entries
from the alarm log.

Sorting: To sort a column in ascending or descending order, right-click the
column header, and click the desired sorting method.

Colors: When the GUI receives an alarm with a status color other than white
(informational), the adapter in the HBA tree with the most severe status blinks
until you view the alarm. The following types of alarms are associated with each
color:

* Informational: Rows in the table are color coded white.
* Unknown: Rows in the table are color coded blue.

¢ Warning: Rows in the table are color coded yellow.

* Bad: Rows in the table are color coded red.

e Loop Down: Adapter in the HBA tree is color coded yellow with a red X (see
[Figure 4 on page 70).
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Details: To view an individual alarm entry, double-click the entry; the Alarm
Details window displays. You can navigate individual entries by clicking Next and

Previous.

Viewing adapter information
To view adapter information, click the adapter in the HBA tree. The Information
panel displays general information about the selected adapter (see .

Host fe-pde Mode Name 20-00-00-E0-8B-00-A4-C4
Adapter 2-2200 Port Hame  21-00-00-E0-8B-00-A4-C4
Port ID» 01-12-00
eneral Information
Serial Number: A50340 Driver Yersion: 8.00.09.06 MY2K IP)
BIOS Version: 1.68 Firmware Version: 2.01.32

Interrupt Level: 16

Figure 5. Adapter Information panel

Viewing adapter statistics
The Statistics panel displays statistical information about the selected adapter (see

[Figure 6 on page 71).
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Figure 6. Adapter Statistics panel

The Statistical panel displays the following information:

Adapter Errors: The number of adapter errors reported by the adapter device
driver

Device Errors: The number of device errors reported by the adapter device
driver

Reset: The number of LIP resets reported by the adapter device driver
I/0 Count: The total number of I/Os reported by the adapter device driver
IOPS (I/0 per second): The current number of I/Os per second

BPS (bytes per second): The current number of bytes per second processed by
the adapter

Use the buttons and check box at the bottom of the Statistics panel to control
sampling:

Set Rate

Click Set Rate to set the polling interval at which the GUI retrieves statistics
from the host. The valid range is 5 to 30 seconds.

Update

Click the Update button to retrieve statistics from the host.

Reset

Click the Reset button to reset all statistics to the initial value of 0.
Auto Poll

Select this check box to use automatic sampling mode. To use manual mode,
clear the check box. If the check box is selected, use Set Rate to define the
sampling rate.
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Device list
The Device List panel displays the following information about the devices
attached to an adapter connected to a host:

* Host: The name of the host

* Adapter: The ID of the adapter

* Node Name: The node name of the adapter (WWN)

* Port Name: The port name of the adapter

¢ Path: The path number

¢ Target: The device ID

* Loop ID: The loop ID of the adapter when operating in loop mode

e Port ID: The port ID of the adapter (the AL-PA if in arbitrated loop
environment)

e Vendor ID: ID of the device manufacturer
¢ Product ID: ID of the device
e Product Revision: Device revision level

Link status
The Link Status panel displays link information for the devices attached to an
adapter connected to a host. See

Link Status

Host target Mode Hame 20-00-00-E0-8B-01-BF-CA
Adapter 0- 2200 Port Hame  21-00-00-E0-8B-01-BF-CA
FPort Mame Link Failure | Sync Loss | Signal Loss | Imvalid CRC
B Adapter (21-00-00-E0-88-01-BF-CA) a 9 4 0
Device (21-00-00-20-37-04-D2-0C) a T168 i 1]
Device {21-00-00-20-37-08-03-68) I I 1] 1]
Device (21-00-00-20-37-08-10-28) 14 138637 i 1]
Refresh Current | | Refresh Total ‘ ‘ Reset Current

Figure 7. Adapter Link Status panel

Click the Link Status tab to display the latest adapter link status from the device
driver and the status for the adapter and all attached targets.

The first column of the Link Status panel is the World Wide Unique Port Name of
the adapter and the attached devices.

The remaining columns display the following diagnostic information about the
adapter and devices (see Table 8).

Table 8. Link status table

Diagnostic information

Definition

Link Failure

A loss of word synchronization for more than 100 msec or loss of signal.

Sync Loss

Four invalid transmission words out of eight (FC-PH rules) cause loss of
synchronization (synch). Only transitions from in sync to out of sync are counted. Three
valid ordered sets in a row are required to reestablish word sync.
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Table 8. Link status table (continued)

Diagnostic information

Definition

Signal Loss

The receiver is not detecting a valid input signal.

Invalid CRC

The number of Cyclic Redundancy Check (CRC) errors that were detected by the
device.

Use the buttons at the bottom of the panel for the following actions:
* Refresh Current

Click this button to query the adapter for updated device link statistics since the
last refresh.

¢ Refresh Total

Click this button to query the adapter for cumulative updated device link
statistics.

* Reset Current
Click this button to initialize link statistics.

Displaying device information: You can view general device information or a
LUN list.

Viewing general device information: To view general information about a device,
click the device in the FAStT MS] main window HBA tree. The Information panel
for the device displays.

Viewing the LUN List: To display information about LUNS, click the device in the
FAStT MSJ main window HBA tree; then, click the LUN List tab. The LUN List

window displays. See
The following LUN list information displays on the LUN List tab:

(Information [LUN List |

Device Vendor: |[EM  Device Product ID: 3552  Dewice Product Rev: 0401

Device Node Mame: 20-26-00-A0-B8-06-61-98

Device Port Name: 20-27-00-A0-B8-06-61-59
Device Port ID: 01-13-00
LM Yendor Froduct D FProduct Rev  [World Wide Unigue LUK Size Disk Mumhber
] [I=10) 3882 0401 B0-0A-0B-80-00-06-61-98 103.93 GH a
31 B Universal X... 0401 60-0A-0B-50-00-06-61-98 0me T4,

Figure 8. LUN List window

e LUN: The LUN number

¢ Vendor: The manufacturer of the LUN

* Product ID: The product ID of the LUN

¢ Product Rev: The product revision level of the LUN

* World Wide Unique LUN Name: The World wide name of the LUN
e Size: The capacity of the LUN

* Disk Number: The disk number of the LUN

Displaying LUN information: To view general information about a LUN, click
the LUN in the FAStT MSJ main window HBA tree; then, click the Information
tab. The Information window for the LUN displays.
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NVRAM settings
The NVRAM Settings panel displays parameters that are saved in the adapter
Non-Volatile RAM (NVRAM).

Note: The NVRAM parameters are preset at the factory. Do not alter them unless
an IBM technical support representative instructs you to do so. Adapter
operation might be adversely affected if you enter the wrong parameters.

The NVRAM Settings panel controls three categories of NVRAM settings: Host
NVRAM Settings, Advanced NVRAM Settings, and Extended NVRAM Settings.
You access sections by clicking an option in the Select NVRAM drop-down list.
The following sections define the NVRAM parameters and do not necessarily
reflect the IBM default values.

Host NVRAM settings: When you click Host NVRAM Settings in the Select
NVRAM section list box, the information shown in displays.

NVYRAM Settings

Host fo-pde Mode Mame 20-00-00-E0-8B-00-8E-C4
Adapter 1-2200 Port Name  21-00-00-ED-8B-00-8E-C4
Select NVRAM section ‘ Host HYRAM Settings b |
Host NWRAM Settings

Hard Loop ID: @E Frame Size: (2048 + Loop Reset Delay: DE

[_] Enable Adapter Hard Loop ID [_] Enable Host Adapter BIOS

| Save H Current H Initial ‘

Figure 9. Host NVRAM Settings panel

The following parameters are available in the Host NVRAM Settings section:

Hard Loop ID
ID used by the adapter when the Enable Adapter Hard Loop ID setting is
enabled.

Frame Size
Specifies the maximum frame length supported by the adapter. The valid
frame sizes are: 512, 1024, and 2048.

Loop Reset Delay
After resetting the loop, the firmware refrains from initiating any loop
activity for the number of seconds specified in this setting. The valid delay
is 0 to 60 seconds.
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Enable Adapter Hard Loop ID
If this setting is enabled, the adapter uses the ID specified in the Hard
Loop ID setting.

Enable Host Adapter BIOS
When this setting is disabled, the ROM BIOS on the host bus adapter is
disabled, freeing space in the upper memory of the system. Do not disable
this setting if you are booting from a fibre channel disk drive attached to
the adapter.

The Initial button restores all parameters to the settings used when the system was
initially started. The Current button restores the updated settings modified by
FAStT MS]. The Save button saves the updated NVRAM settings.

Advanced NVRAM settings: When you click Advanced NVRAM Settings in the
Select NVRAM section list box, the information shown in displays.

HNVRAM Settings

Host fo-pdc Node Name  20-00-00-E0-8B-00-8E-C4
Adapter 1- 2200 Port Hame  21-00-00-E0-8B-00-8E-C4

Select NVRAM section | Advanced NVRAM Settings v |

Advanced NVRAM Settings

Execution Throttle: @’j Login Retry Count: @’j 10CB Allocation: @E
LUNs per Target: 1] - Port Down Retry Count: l@@

[_] Enahle 4GB Addressing |_] Enable Extended Error Logging
[_] Enable Database Updates [¥] Enable Fast Command Posting
[+ Enable LIP Full Login [] Enable LIP Reset

[¥] Enable Drivers Load RISC Code [¥] Enable Target Reset

[_] Disable Database Load

‘ Save H Current H Initial |

Figure 10. Advanced NVRAM Settings panel

The following parameters are available in the Advanced NVRAM Settings section:

Execution Throttle
Specifies the maximum number of commands running on any one port.
When a port execution throttle is reached, no new commands are run until
the current command finishes running. The valid values for this setting are
in the range 1 to 256.

Login Retry Count
Specifies the number of retries the adapter uses during a login. This can be
a value in the range 0 to 255.

IOCB Allocation
Specifies the maximum number of buffers from the firmware buffer pool to
be allocated to any one port. Valid range is 1 to 512.
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LUNSs per Target
Specifies the number of LUNs per target. Multiple LUN support is typical
for Redundant Array of Independent Disk (RAID) boxes that use LUNSs to
map drives. The valid values for this setting are 0, 8, 16, 32, 64, 128, and
256. If you do not need multiple LUN support, set LUNs per Target to 0.

Port Down Retry Count
Specifies the number of times the adapter software retries a command to a
port returning port down status. Valid range is 0 to 255.

Enable 4GB Addressing
When enabled, the adapter is notified if the system has more than 4
gigabytes of memory.

Enable Database Updates
When enabled, the adapter device driver saves loop configuration
information in the flash (EEPROM) when the system is powered down.

Enable LIP Full Login
When this setting is enabled, the adapter logs in to all ports after a loop
initialization process (LIP).

Enable Drivers Load RISC Code
When this setting is enabled, the host adapter uses the RISC firmware that
is embedded in the adapter device driver. If this setting is disabled, the
adapter device driver loads the latest version of RISC firmware found on
the system.

Note: The device driver being loaded must support this setting. If the
device driver does not support this setting, the result is the same as
disabled regardless of the setting. Leaving this option enabled
ensures support of the software device driver and RISC firmware.

Disable Database Load
When enabled, the device database is read from the registry during device
driver initialization. When disabled, the device database is created
dynamically during device driver initialization. The default value is cleared
(Disable Database Load is not enabled).

Note: This option usually applies to Windows NT and Windows 2000
operating environments.

Enable Extended Error Logging
This setting provides additional error and debugging information to the
operating system.

Enable Fast Command Posting
When this setting is enabled, command execution time is decreased by
minimizing the number of interrupts.

Enable LIP Reset
This setting determines the type of LIP reset that is used when the
operating system initiates a bus reset routine. When this setting is enabled,
the adapter device driver initiates a global LIP reset to clear the target
drive reservations. When this setting is disabled, the device driver initiates
a global LIP reset with full login.

Enable Target Reset
When this setting is enabled, the adapter device driver issues a target reset
to all devices on the loop during a SCSI bus reset function call.
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Extended NVRAM settings: When you click Extended NVRAM Settings in the
Select NVRAM section list box, the information shown in displays.

[23 1BM FASET Management Suite Java - HBA V - o] x|
File Host “iew Help
Connect Configuie  Events  Alarms  Refresh —_——_— ==
[HBA | ation stics Link Status | NVRAM Settings | Utilities ||
(@ varid Host nodeh Node Name  20-00-00-E0-8B-01-95-39
¢ &% Host nodeb Adapter 1-2200 Port Name  21-00-00-E0-88-01-95-39
T s 0 Port ID 01-11-00
©- @ Adapter 2200 4 Rl
i Select NVRAM section | Extended NVRAM Settings
| Extended NVRAM Settings
Operation Mode: | 0 - No Multple Responses -
Connection Options: | 3 - Point to Point, Otherwise Loop - |
Response Timer: 1] E Interrupt Delay Timer: (0 E
[v] Enable Extended Control Block [_] Enable Fibre Channel Tape Support
[Z] Enable Fibre Channel Confirm [Z] Enable Command Reference Number
[_] Enable Class 2 Service [Z] Enable Read Transfer Ready
[_] Enable ACKD
| Save | | Current | | Initial |
Adapter 2200

Figure 11. Extended NVRAM Settings panel

The following parameters are available in the Extended NVRAM Settings section:

Operation mode

Specifies the reduced interrupt operation (RIO) modes (see [Table 9). RIO
modes enable posting multiple command completions in a single interrupt.

Table 9. Reduced interrupt operation modes

Bit Description
0 RIO is disabled; enable fast posting by setting the Fast Posting option.
1 Combine multiple responses, 16-bit handles, interrupt the host. The handles
are reported by asynchronous event codes 8031h-8035h or the RIO Type 2
IOCB.
2 Combine multiple responses, 32-bit handles, interrupt the host. The handles
are reported by asynchronous event code 8020h or 8042h or the RIO Type 1
IOCB.
3 Combine multiple responses, 16-bit handles, delay the host interrupt. The
handles are reported by the RIO Type 2 IOCB.
4 Combine multiple responses, 32-bit handles, delay the host interrupt. The
handles are reported by the RIO Type 1 IOCB.

Connection Options
Defines the type of connection (loop or point-to-point) or connection
preference during startup (see [Table 10 on page 78).
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Table 10. Connection type and preference

Bit Description
0 Loop only
1 Point-to-point only
2 Loop preferred, otherwise point-to-point
3 Point-to-point preferred, otherwise loop

Response Timer
Sets the time limit (in 100-microsecond increments) for accumulating
multiple responses. For example, if this field is 8, the time limit is 800
microseconds.

Interrupt Delay Timer
Sets the time to wait (in 100-microsecond increments) between accessing a
set of handles and generating an interrupt. (An interrupt is not generated
when the host updates the queue out-pointer during this period.) For
example, if this field is set to 4, then 400 microseconds pass between the
DMA operation and the interrupt.

Enable Extended Control Block
This setting enables all extended NVRAM settings. The default is enabled.

Enable Fibre Channel Confirm
This setting is reserved for fibre channel tape support.

Enable Class 2 Service
Select this check box to provide class 2 service parameters during all
automatic logins (loop ports). Clear the check box if you do not want to
provide class 2 service parameters during automatic logins.

Enable ACKO
Select this check box to use ACKO when class 2 service parameters are
used. Clear this check box to use ACK1.

Enable Fibre Channel Tape Support
Select this check box to enable the firmware to provide fibre channel tape
support.

Enable Command Reference Number
This setting is reserved. The default is disabled.

Enable Read Transfer Ready
Select this check box to enable the read transfer ready option (XFR-RDY).
The firmware also sends an XPR-RDY IU before transferring read data as a
SCSI target.

Utilities
Within the Utilities panel you can perform adapter-level configurations on a
host-connected adapter. See |[Figure 12 on page 79|
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Host  nodeh Node Name  20-00-00-E0-86-01-95-39
Adapter 1- 2200 Port Name  21-00-00-E0-8B-01-95-39
Port ID 01-11-00
rLitilties
| Update Flash |
| Update NVRAM |

Figure 12. Utilities panel

Update flash: When you click this button (and the adapter accepts the update),
the application prompts for the file name that contains the new flash BIOS. You
can obtain this file from the IBM Web site or service personnel. The file name ends
with .BIN (for example, QL22ROM.BIN).

After you enter a valid flash file, click OK to proceed with the update or click
Cancel to abort.

When you click OK, FAStT MS] verifies the file name and format of the new file. If
the file is valid, the application compares the version of the file with the adapter
flash version. If the adapter version is the same or newer than the file flash
version, the application asks if you still want to update the flash.

If the update fails, an error message displays.

Update NVRAM: When you click this button (and the adapter accepts the
update), the application prompts for the file name that contains the new NVRAM.
You can obtain this file from the IBM Web site or service personnel. The file name
ends with .DAT (for example, NVRM22.DAT).

After you enter a valid NVRAM file, click OK to proceed with the update or click
Cancel to abort.

When you click OK, FAStT MS] verifies the contents of the new file.

If the update fails, an error message displays.

Diagnostics
You can perform the loopback and read/write buffer tests using the Diagnostics
panel (see IFigure 13 on page 8(1).
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[ 1BM FASIT Management Suite Java - HBA View = (O] x|
File Host “iew Help

O I m @& -

. Connect Configure Bvents Alarms Refresh

(HBA | Diagnostics |
i\-’\forld Host nodea Hode Name  20-00-00-E0-8B-01-C6-39
¢ & Hostnodea i Adapter 0- 2200 Port Name  21-00-00-E0-8B-01-C6-39
@ @ Adapter 2200 : o 00-00-01
© G Adapter 2100 o ot

rDiagnostic configuration Error

Data Pattern| 00 - 00000000 - Humber of test(s) (1-10,000):(1

Customized (X2 XX XX XX XX XX XX 22) Test Increment (1-10,000): |1

[_] Test continuoushy

[_] Stop on error

nnae

Test Status | CRC Errar | Disparity Error | Frame lenagth errar
Success o o o

Loopback Test | | ReadWrite Buffer Test

Adapter 2200

Figure 13. Diagnostics panel

The loopback test is internal to the adapter. The test evaluates the fibre channel
loop stability and error rate. The test transmits and receives (loopback) the
specified data and checks for frame CRC, disparity, and length errors.

The read/write buffer test sends data through the SCSI Write Buffer command to a
target device, reads the data back through the SCSI Read Buffer command, and
compares the data for errors. The test also compares the link status of the device
before and after the read /write buffer test. If errors occur, the test indicates a
broken or unreliable link between the adapter and the device.

The Diagnostics panel has the following three main parts:
* Identifying Information

This part of the panel displays information about the adapter being tested. This
information includes:

— Host
— Adapter
— Node Name
— Port Name
Port ID
* Diagnostic Configuration Error
This part of the panel contains the following testing options:

Data Pattern

Sets the test pattern. You can click a data pattern in the list or specify a
customized pattern.
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To specify a customized pattern, click Customized in the list and type
the data pattern in hex format (0x00 - OxFF) into the boxes under
Customized.

When you select the random pattern from the list, a new random 8-byte
pattern is sent to the devices, the adapter, or both (depending on
whether you select the loopback or read/write buffer test).

Number of test(s)
Sets the number of tests you want to run. You can run the test for a
certain number of times (up to 10,000) or continuously. You can also set
the number of test increments per test up to 10,000.

Test continuously
Select this check box to test continuously.

Test Increment
The Test Increment value determines the number of times a test will be
run against a particular device (read/write buffer test). For example if
the value is set to 10, the read /write buffer test will be run 10 times
against that device before moving to the next device in the Device List.
The Number of tests parameter determines the total number of tests that
will be run.

If you select Test continuously, the Test Increment value is set to 125 as
the default value. You can increase this value up to 10,000. While the test
is running, a test progress dialog window displays. You can cancel the
test at any time by clicking the Stop button in this window. FAStT MS]
waits until the Test Increment value is reached before stopping. Thus, a
large Test Increment value will delay the stop action. The delay is
dependent on the number of devices being tested.

Stop on error
Select this check box if you want continuous testing to discontinue when
an error is encountered.

Loopback Test Results

The Loopback Test Results section displays the results of a test. The first column
shows whether the test passed or failed. The remaining columns display error
counters.

For a loopback test, the test result includes the following information: Test
Status, CRC Error, Disparity Error, and Frame Length Error.

For a read/write buffer test, the test result shows the following information:
Loop ID/Status, Data Miscompare, Link Failure, Sync Loss, Signal Loss, and
Invalid CRC.

Some devices do not support read/write buffer commands. FAStT MSJ displays
the result for these devices as Information (blue) with the R/W buffer not
supported message in the Data Miscompare column. The test results are sorted
in the following order:

1. Errors
2. Information

3. Success

Notes:

1. The TotalStorage Fibre Channel host bus adapter (QLA2100) does not
support loopback mode. Use only the read/write test for this type of adapter.

2. A wrap connector and coupler (see the readme file for the part number) is
available to assist in isolating loop problems. When running the loopback
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test, you can plug the wrap connector directly into the FAStT host bus
adapter to verify whether the adapter is functional. You can then move the
wrap connector to other points in the loop (for example, ends of cables,

hubs, and so on) to isolate the point of failure.

3. If the read/write buffer test returns the message The Adapter has no

devices attached, make sure that the HBA is connected to the devices, and

click Refresh. Detected devices will appear in the HBA tree of the selected

host.

Running the diagnostic tests: After you have chosen the loopback and

read /write buffer test parameters as described in|“Diagnostics” on page 79| click

Loopback Test or Read/Write Buffer Test to run the loopback or read/write buffer

test. If displaying warnings is enabled, the warning window shown in

displays.

Diagnostic L

** Warning ***

The Diag ic Loaptk cand Readitrite Buffer T equire that the

adapters have no outstanding input and output operations.

Fle make sure there is no active 0 hefare stating the test.

Do you want to proceed with the t

Yes Ho

Figure 14. Diagnostic Loopback and Read/Write Buffer Test Warning window

Note: To disable the warning message, click View -> Options, and clear the

Enable Warning Messages Displays check box.

If you selected the Test continuously check box or a large value for number of
tests or test increments, the Test Progress dialog window displays (see [Figure 15).

Click Stop to cancel the test.

Read X

Diagnusti"[: testing in progress. Please wait...
Ffdc 05 el 8d 7a A 83

Stop

Figure 15. Test Progress dialog window
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Diagnostic test results: The Test Result section of the Diagnostics panel displays
the results of a test. Descriptions of the loopback and read/write test results
sections follow.

Loopback test results: The Loopback Test Results section provides the following
information:

* Tests Status — whether the test passed or failed. The possible values are:

Success — The test passed.

Error — CRC, disparity, or frame length errors occurred.
— Failed — An error occurred when attempting to issue a command.
— Loop down — The loop is down.

* CRC Error — Number of CRC errors

* Disparity Error — Number of disparity errors

¢ Frame Length Errors — Number of frame length errors

The Test Status column in shows that the loopback test failed.

Diagnostics |

Host fo-pdc Hode Hame 20-00-00-E0-8B-00-A4-C4
Adapter 2-2200 Port Hame  21-00-00-E0-8B-00-A4-C:4
: Port ID 01-12-00
rTest Configuration
!l pata Pattern| 00 - 00000000 - ‘ Number of test{s) (1-10,000}: 1 =
Customized (X2 XX XX XX XX XX KX X=) Test Increment (1-10,000): |1 %

[ Test continuoushy

[_] Stop on error

Loopback Test Results

Test Status CRC Error Disparity Error Frame length error
Failed 1 1] 1]

| Loophack Test | | Read\Write Buffer Test

Figure 16. Test Results section of the Diagnostics panel

Read/Write Buffer Test Results: The Read/Write Buffer Test Results section provides
the following information (see [Figure 17 on page 84):

¢ Loop ID - The loop ID of the adapter when operating in loop mode
* Status — Whether the test passed or failed. The possible values:

— Success — The test passed.

— Error — A data miscompare or link status firmware error occurred.

— Failed - A link status error, SCSI write buffer error, or SCSI read buffer error
occurred.

— Unknown — The target was not present.
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— Unsupported — The device does not support this test.
* Data Miscompare — Type of data miscompare. The possible values:
— 0 (no data miscompares)
— Get link status failed
— Read bulffer failed
— Reserve unit failed
— Release unit failed
— R/W buffer not supported
— Write buffer failed
* Link Failure — Number of link failures
* Sync Loss — Number of sync loss errors
* Signal Loss — Number of signal loss errors
¢ Invalid CRC - Number of CRCs that were not valid

E5IBM FASIT Management Suite Java - HBA Yiew =] 3
File Host “iew Help
O T B @ -

Connect Configure  Events Alarms Refresh -
(HBA | Diagnostics |
(@ wori Host  nodea Hode Name  20-00-00-E0-8B-00-A2-FC

¢ & Hostnodea : Adapter 1-2100 Port Name  20-D0-00-E0-8B-00-A2-FC
&t Adapter 2200 Port ID 01-00-00
& @ Adapter 2100 : o -
:|| FDiagnostic configuration Error
Data Pattern| 00 - 00000000 - Number of test(s) (1-10,000):(1 %
Customized (X2 XX XX XX XX XX XX 22) Test Increment (1-10,000): |1 =
1 Test continuously
[_] Stop on error
rReadWrite Buffer Test Results
Loop ID [ Status  |Data Miscom..| Link Failure Sync Loss | Signal Loss | Invalid CRC
0x5 i Unknown  |RAY buffer n...
0x07 Success 1] 1] 1] 1] 1]
Ox7cfSuccess |0 1] 1] 1] 1]
Loopback Test | | ReadWrite Buffer Test |
Adapter 2100

Figure 17. Read/Writer Buffer Test Results section of the Diagnostics panel

Saving a configuration to a file

You can save a virtual image of a host that has been configured and might no
longer be connected to the network by saving the host configuration to a file. To
load the configuration of the host that has been saved, you must first configure
and save the host information to a file.

To save the host configuration, click File -> Save Configuration to File in the Host
Adapter Configuration window.

You are alerted with the information shown in [Figure 18 on page 85
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E;g Save configuration to file for node: il

@ Host configuration has been successfully saved to file:
‘D:iDocuments and Settings\Administratorinodea_06052001_092839.qic".

OK

Figure 18. Save Configuration to File Notification dialog window

After you save the .qlc file, you can load it.

Loading a configuration from a file

After you save the host configuration to a file, you can load the configuration.
Loading from a file enables you to load a virtual image of a host that was
previously configured and is no longer connected to the network.

To load a configuration from FAStT MS], perform the following steps:
1. Click Host -> Load from File in the Host Adapter Configuration window.

2. In the Open window, click the file you want to load, and then click Open (see
Figure 19)

E’,Dpen il
Look in: 1 Administrator 4 @ @ @ -

I Recent

J SendTo

[ Start Menu

Cd Templates

|__°*| fe-pde_05022001_110440.9lc
|__°*| fe-pde_05032001_102415.qglc
|__°*| nodea_05152001_073705.qlc
|__°*| nodea_06052001_092839 glc

File name:  |nodea_0G052001_092839 gl | | open

Files of type: | QLogic Host Configuration File {*.GLC) - | Cancel

Figure 19. Open window
After you load the file, the adapters under the newly loaded host will appear in

blue in the HBA. Blue adapters indicate that the host was loaded from a file rather
than a live host.
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Opening a group
Opening the group from a file enables the user to reload all the host information
that was previously saved by the Save Group operation. FAStT MS] will then
connect the host and identify any discrepancies between the saved configuration
and the newly discovered one.

To open a host configuration, click File -> Open Group in the host adapter
configuration window. Select the desired .hst file from the Open window. After
the file opens, the newly loaded host will be connected and displayed in the HBA
tree panel.

Saving a group
Saving a Host Group to a file enables the user to save the HBA tree for that host
including the device list and configuration settings. This feature also allows a

system administrator to create Host files to selectively connect a number of hosts
in the same SAN.

To save a host configuration to FAStT MS], you must configure the host adapter.
Click File -> Save Group in the host adapter configuration window.

After you select Save Group, the Save window displays. Select a file name (for
example, Host NodeA.HST) and click Enter.

SAN port configuration on Linux

This section describes the port configuration function of FAStT MSJ and includes
the following information:

* Configuring fibre channel devices

* Configuring LUNs for a device

* Viewing adapter, device, and path information
* Editing persistent configuration data

* Saving and printing the host configuration file
* Using the failover watcher

Note: All of these configuration functions are available for only Linux operating
systems.

Configuring fibre channel devices
Perform the following steps to configure fibre channel devices:
1. Perform one of the following actions from the FAStT MS] main menu:

* In the HBA tree, click the host or an adapter connected to the host. Click
Configure on the toolbar.

* Right-click the host or adapter in the HBA tree. From the pop-up menu, click
Configure. If FAStT MS] detects an erroneous port configuration, the
following message displays. Click OK to continue.

Note: You will see the message shown in [Figure 20 on page 87] prior to
configuring the ports for the first time.
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E%:PD[I Configuration for <hostname:

e An invalid device and LUN configuration has been detected. Please
M this configuration manually, or automatically via the menu items.

OK

Figure 20. Port Configuration Message dialog window

Erroneous port configurations include:

* A device with contradictory visible paths. Only one path can be visible at a
time.

¢ A LUN with contradictory (both disabled and enabled) paths. A
configuration is valid when all paths are either enabled or disabled.

* More than one preferred path in the system. Only one path can be preferred

at a time.
The Fibre Channel Port Configuration window displays (see Figure 21)).

The host name displays in the title bar. The window displays the adapters and

i Fibre Channel Configuration - rh71::
File Adapter Device LUNs Help

Fibre Channel Port Configuration

Device Node Name | Device Port Name T Adapter O (Path/Target/Loop Id) | Adapter 1 (Path/Target/Loop Id) |
[20-04-00-A0-BE-07-3 4-47 | 8 050/ 1- Fabtic
20-04-00-A0-B8-07-54-48
| 20-05-00_A0_B8_07-54-47 |

| Apply H Save || Cancel

Figure 21. Fibre channel port configuration

devices in the computer. The following information displays.
* Device Node Name: World wide device node name
* Device Port Name: World wide device port name

¢ Adapter n (Path/Target/Loop ID): The adapter cell in the table represents a

path (the device is visible to the adapter)
Adapter cell information consists of the following information:

— Path: Path number
- Target: Device ID
— Loop ID: Complement of the arbitrated loop_physical address (AL_PA)

The adapter cells are color-coded to represent path information, as follows:
— White with open eye icon: The path is visible to the operating system.

& 0i0f0- Local

— Black with no icon: The path is hidden from the operating system.

05200- Local

— Gray with stop icon: The device is unconfigured.

Linconfiqured
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— White with no icon: There is no path present.

2. Select the following, as appropriate, from the Fibre Channel Port Configuration
window menu.

* Modify the devices, LUNSs, and paths:

— Editing persistent configuration data (see [“Editing persistent configuration|
[data” on page 98)

— Separating and combining separated device ports (see [“Separating and|
fcombining separated device ports” on page 89)

— Auto configuring device paths (see [“Automatically configuring device]
[paths” on page 90))

— Configuring LUNS for a device (see [Configuring LUNs for a device” on|
page 91)

— Enabling and disabling LUNs (see [“Enabling and disabling all LUNs” on|
|o ge 90

— Load balancing LUN paths on this host (see [‘Load balancing LUN paths
fon this host” on page 90)

- %{ting device path visibility (see [“Setting device path visibility” on page
O1)

¢ View information:

— Adapter information (see |[“Viewing adapter information” on page 97)

— Device information (see [“Viewing device information” on page 97)

— Help information. Click Help -> Browse Contents. The help text for the
Fibre Channel Port Configuration window displays.

3. The modified configuration set up by FAStT MS]J can be applied to the live
system for dynamic updates, or can be saved to the system persistent
configuration file. When you save the configuration, the adapter device driver
retrieves the data from the persistent configuration file at the next system
startup and configures the system accordingly.

Perform one of the following actions:

¢ Click Apply to apply the new configuration. The new configuration is saved
to the persistent configuration file; it will be used the next time you start the
system. The new configuration remains in memory and displays after the
apply operation completes. If configuration is successful, the message shown
in |Figure 22 on page 89|displays. Click OK.

Note: For Linux operating systems, the applied configuration is only
effective after the device driver is unloaded and subsequently reloaded
with modprobe.
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E&fﬁ%ﬁpply Configuration

Ci Configuration Applied
= Changes hawve heen saved to persistent storage
and are effective immediatehy.

OK

Figure 22. Apply Configuration dialog window

¢ Click Save to save the new configuration. The new configuration is saved to
the persistent configuration file; it will be used the next time you start the
system. The current configuration remains in memory and is redisplayed
after the save operation completes.

If the save was successful, the following message displays (see Figure 23).
Click OK.

Eéf’,% Save Configuration

,JQI Configuration Saved
= Changes have heen saved to persistent storage.
You must reboot in order for changes to take effect.

OK

Figure 23. Save Configuration dialog window

If the save failed, the Save Configuration Failed message displays. The
failure is usually caused by communication problems between the GUI and
agent. Click OK.

* Click Cancel on the Fibre Channel Port Configuration window if you do not
want to save the configuration changes.

Note: For Linux operating systems, the saved configuration is effective after the
device driver is reloaded. Restarting is not required.

Separating and combining separated device ports

Failover and currently active paths are usually configured based on the device (as
represented by the device node name). This method allows for adapter level and
port failover. You can, however, separate a device into two devices based on a port
(by device port name), where each device has a subset of paths. This allows only
for adapter level failover.

Forcing separate devices: Perform the following steps to divide a device with two
ports into two distinct devices based on the port. Click Edit -> Force Separate
Devices, or right-click the device node name and click Force Separate Devices.

Combining separated devices: Perform the following steps to combine two
devices with the same device node name (separated based on their port name)
back into one device based on the device node name:

1. Click the device node name in the Fibre Channel Port Configuration window.
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2. Click Edit -> Combine Separated Devices, or right-click the Device Node
Name and click Combine Separated Devices.

Automatically configuring device paths

The Auto Configure option configures all device paths for the selected host to the
default values. The default path for each device is the first available path as
visible, with the other paths hidden. This option prompts for the automatic
configuration of LUNs associated with these devices.

Perform the following steps to configure the device paths, and optionally the LUN
paths, on this host to default values:

1. From the Fibre Channel Port Configuration window, click Tools -> Auto
Configure. The system prompts whether you also want to use default LUN
configurations.

2. Click Yes to change the current LUN configurations to the default values. Click
No to keep the current LUN configuration settings.

Enabling and disabling all LUNs
Perform the following steps to configure all LUNSs attached to devices on this host
as enabled or disabled:

1. From the Fibre Channel Port Configuration window, click Tools -> Enable
LUNSs.

2. Perform one of the following actions:
* Click Enable All to configure all LUNSs as enabled.
* Click Disable All to configure all LUNs as disabled.

¢ Click Inverse State to enable currently disabled LUNs and disable currently
enabled LUNE.

Load balancing LUN paths on this host

The Load Balance option configures all LUN paths on this host to use system
resources most efficiently. The LUNs are staggered between the adapters for load
distribution. You can configure all LUNs or only LUNs that are enabled.

Perform the following steps to configure LUNs on this host:
1. From the Fibre Channel Port Configuration window, click Tools -> Load
Balance.
2. Perform one of the following actions:
* Click Enabled LUNs Only to configure only enabled LUNSs for load
balancing across the paths within this device. When you click this option for

a device with no enabled LUNSs, the message shown in displays.
Click OK.

Eﬁf’g Enabled-LUUMz Configuration for <hostname:

LUNs are currenthy not enabled for this function. Please enahle the
LUNs to he modified, or choose the option to auto-config all LUNs.

S|

OK

Figure 24. Enabled LUNs Only Warning dialog window
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¢ Click All LUNSs to configure all LUNs for load balancing across the paths
within this device.

Setting device path visibility

Perform the following steps to set device path visibility to the operating system.

Note: There must be one visible path for the operating system to see the device.
1.

Eéf’,j' M odified Configuration for <hostname>

In the Fibre Channel Port Configuration window, right-click the cell in the

Adapter n column that contains the adapter name.

From the pop-up menu, click one of the following options:

* Click Set Visible to set this path as visible to the operating system during
the start process.

¢ Click Set Hidden to set this path as not visible to the operating system
during the start process but used in failover conditions.

* Click Set Unconfigured to set this path as not visible to the operating
system. The path is not used in failover conditions. If setting the path has
caused the LUNSs associated with this device to have an invalid

configuration, the error message shown in displays. This problem
is usually the result of changing the configuration state of a device. You must
modify the LUN configuration for this device before you can save or apply

the configuration.

5] This action has caused an invalid LUN configuration. Please
= choose from the menu the option to automatically configure the
whole system, or manually fix the configuration for each device.

OK

Figure 25. Modified Configuration Error dialog window

Configuring LUNs for a device

Perform the following steps to configure individual LUNSs for a selected device:

1.

In the Fibre Channel Port Configuration window, right-click the cell in the
Device Node Name or Device Port Name column that contains the device
name.

From the pop-up menu, click Configure LUNSs.

 If FAStT MSJ detects an erroneous LUN configuration, the message shown
[Figure 26 on page 92| displays. Click OK to continue.
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E%Detected Invalid LUHM Configuration for <hostname>

e An invalid configuration has heen detected. Please fix this
configuration manually, or automatically via the menu options.

OK

Figure 26. Detected Invalid LUN Configuration Error dialog window

Erroneous LUN configurations include:
— A LUN with both enabled and disabled paths. All paths must be either
enabled or disabled.

— Too many preferred paths in the system. Only one path can be preferred
at a time.

* If FAStT MSJ detects an erroneous SAN cloud configuration, the message
shown in displays. Change this configuration before continuing;
FAStT MS] cannot manage erroneous SAN configurations. Click OK to
continue.

The LUN Configuration window for the device displays (see .
Eg,i[)etected Invalid SAM Cloud for <hostname:>

e An invalid SAN cloud has been detected.
Please fix this setup for optimal operation.

0K

Figure 27. Detected Invalid SAN Cloud dialog window

The title displays the host name and world wide device node name. The table

K LUHN Configuration for rh71, for Device Node Hame: 20-04-00-A0-B8-07-54-46
File Tools Help
Fibre Channef LUN Configuration
LUMN Enable Device Port MName [Adapter O (Path/Target/Loop Idi[Adapter 1 (Path/Target/Loop Id)
o = 20-04-00-AD-BE-07-54-47 |(&) 040/ 1 Preferred Fabri...
20-05-00-AD-E5-07-54-47 | ® 0/0/1 Alternate Local
1 o 20-04-00-A0-B8-07-54-47 [ 0/0/1 Alternate Fabric
30-05 -00-AD-EE-07-54-47 | ® 0/0/1 Preferred Local...
5 & 20-04-00-A0-B8-07-54-47 |5} 0/0/1 Preferred Fabri...
30-05 -00-AD-EE-07-54-47 | ® 0/0/1 Alternate Local
3 & 20-04-00-A0-B8-07-54-47 [&) 0/0/1 Alternate Fabric
20-05 -00-AD-BE-07-54-47 | ® 0/0/1 Preferred Local...
4 o 20-04-00-A0-B5-07-54-47 |(&) 0/0/1 Preferred Fabri...
20-05-00-A0-BE-07-54-47 ® 07071 Alternate Local
. o 20-04-00-A0-BE-07-54-47 (&) 07071 Preferred Fabri...
20-05-00-A0-BE-07-54-47 | ® 07071 Alternate Local
I I

Figure 28. LUN Configuration window

displays the following information:
¢ LUN: LUN number
* Enable: Whether the LUN is enabled

* Device Port Name: World wide device port name
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¢ Adapter n (Path/Target/Loop ID): The adapter cell in the table represents a
path (the device is visible to the adapter)

Adapter cell information consists of the following:
— Path: Path number
— Target: Device ID

— Loop ID: Loop IDs are 7-bit values that represent the 127 valid AL_PA
addresses.

— Path type: Preferred or Alternate, and Current
The adapter cells are color-coded to represent path information, as follows:

Cyan with green bull’s-eye: The preferred path to the LUN.

Yellow with blue bull’s-eye: An alternate path to the LUN.

i® 0/0/0- Alternate Local |

Gray with Stop icon: This is an unconfigured device.

Lincanfiqured

— White with no icon: There is no path present.

3. Click the following, as appropriate, from the LUN Configuration window
menu:

* Modify the LUNs and paths for this device:

— Auto configuring LUN paths (see [’Automatically configuring LUN paths”|

- Load balancing LUN paths on this device (see|“Load balancing LUN|
[paths on this device” on page 94)

- Configuring a LUN path using the default (see [‘Configuring a LUN path|
[using the default” on page 95

— Enabling and disabling all LUNSs (see [“Enabling and disabling all LUNs"]

- Enabling and disabling individual LUNSs (see [“Enabling and disabling]
findividual LUNs” on page 95))

— Setting LUN path failover (see[“Setting LUN path failover” on page 95)

e View information:

- Adapter information (see [“Viewing adapter information” on page 97)

— Device information (see [“Viewing device information” on page 97)

— Path information (see |[“Viewing path information” on page 98)

¢ Help information. Click Help -> Browse Contents. The help text for the LUN
Configuration window displays.

4. Click OK to save the changes until you exit the Fibre Channel Port
Configuration window; then, review the configuration changes (see Step . If
FAStT MS] detects an erroneous LUN configuration while saving the
configuration, the Auto LUN Configuration at Exit for <hostname> window
displays (see [Figure 29 on page 94).
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E%%Autu LUN Configuration at Exit for ¢hostname> [E3

An imvalid configuration has heen detected.
Automatically configure invalid LUNsY

=

Yes Ho

Figure 29. Auto LUN Configuration at Exit dialog window

Perform one of the following actions:
* Click Yes if you want the software to configure the invalid LUNs with the
default paths. The confirmation message shown in displays. Click
OK.

E"g’,i-[)efault LUM Configuration for <hostname> at Exit.

ﬁ_ Imvalid LUNSs configured with defaults. Press <0K> to exit.

OK

Figure 30. Invalid LUNs Configured with Defaults Error dialog window

* Click No if you do not want to configure the invalid LUNs. The
configuration changes you made are not saved.

* Click Cancel if you do not want to apply the configuration changes.

Automatically configuring LUN paths

The Auto Configure option configures all LUN paths for the selected device to the
default values. The default path for each LUN is the first available preferred path,
with the other paths as alternates. From the LUN Configuration window Tools
menu, click Auto Configure to configure the LUN paths on this device to the
default values.

Load balancing LUN paths on this device

The Load Balance option configures all LUN paths on this device to use system
resources most efficiently. The LUNSs are staggered between the devices to provide
load distribution. You can configure all LUNs or only LUNSs that are enabled.
Perform the following steps to configure the LUNs on this device:

1. From the LUN Configuration window Tools menu, click Load Balance.
2. Perform one of the following actions:

* Click Enabled LUNs Only to configure only those LUNs enabled for load
balancing across the paths within this device. If you clicked this option for a
device with no enabled LUNSs, the message shown in [Figure 31 on page 95|
displays. Click OK.
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E"g% Enabled-LUNz Configuration for <{hoztname?

LUNs are currenthy not enabled for this function. Please enable the
LUNs to be modified, or choose the option to auto-config all LUNs.

|

OK

Figure 31. Enabled LUNs Configuration Error dialog window

* Click All LUNs to configure all LUNs for load balancing across the paths
within this device.

Configuring a LUN path using the default

Perform the following steps to configure LUN paths to the default values for LUN
failover, with the first configured path as preferred and all other paths as
alternates.

Note: This option is available only if the LUN is enabled and there are at least two
available paths.

1. For the LUN you want to configure, right-click the LUN, Enable, or Device Port
Name column.

2. From the pop-up menu, click Configure Path Using Default.
Enabling and disabling all LUNs

Perform the following steps to configure all LUNSs attached to this device as either
enabled or disabled:

1. In the LUN Configuration window, right-click the Enable heading.
2. From the pop-up menu, click one of the following:

* Enable All LUNs to configure all LUNs as enabled

* Disable All LUNs to configure all LUNSs as disabled

* Inverse State to enable currently disabled LUNs and disable currently
enabled LUNs

Enabling and disabling individual LUNs

To configure a specific LUN as enabled or disabled, in the LUN Configuration
window Enable column perform one of the following actions:

* Select the Enable check box to configure the LUN as enabled.

¢ Clear the Enable check box to configure the LUN as disabled.

Setting LUN path failover

Perform the following steps to set a LUN path as the preferred or alternate path in
a failover condition. You can also click the preferred or alternate path as the
currently active path.

1. In the LUN Configuration window, right-click the cell for the device in the
Adapter n column.

2. From the pop-up menu, click one of the available options.

* Click Set LUN to Preferred to set the alternate path as the preferred path in
a failover condition.

* Click Set LUN to Alternate to set the preferred path as the alternate path in
a failover condition.
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¢ Click Set Path to Current to set this preferred or alternate path as the
currently active path.

Notes:

1. You can set the path of an enabled LUN only. A LUN path can be set as either
preferred or alternate (but not as unconfigured) if the device path is configured
as hidden or visible.

2. You can use the failover watcher to view the failover settings for a selected host
and set the preferred or alternate LUN path as the currently active path (see
[“Using the failover watcher” on page 100).

Configuring LUNs to match FAStT Storage Manager
configuration

To avoid the "Driver not on preferred path” error, perform the following steps to
configure the LUNs to match the FAStT Storage Manager’s configuration:

1. Unload the gla2200 or qla2300 driver module by opening a terminal window
and typing one of the following commands:

# modprobe -r q1a2200 or # modprobe -r qla2300

2. Delete the options string in /etc/modules.conf that is added by the FAStT
MS] load-balancing process. This is typically the last line in the
/etc/modules.conf file:

"options qla2200 ConfigRequired=1 ql2xopts=scsi-qla00- adapter-
port=..."
3. In the terminal windows, type the following command:
depmod -a
4. Reload the gla2200 or qla2300 device drivers by typing one of the following
commands:
# modprobe q1a2200 or # modprobe q1a2300
5. Run the FAStT Storage Manager client to redistribute the logical volumes.
6. Open a terminal windows and run:
qlremote
7. Open another terminal window and run:
/usr/FAStT_MSJ

8. Connect to the local host and configure LUNs to match the preferred paths
shown in IBM FAStT Storage Manager. Click Storage Subsystem -> Profile in
the Subsystem Management window to display the world-wide port name for
each controller. Ensure that the preferred path in the FAStT_MS] LUN
configuration window matches the controller assignment in IBM FAStT
Storage Manager.

9. Save the configuration and exit FAStT MS].

10. Switch to the terminal window that has glremote running and press <CTL -
C> to stop glremote.

11. In the terminal windows type the following command:
depmod -a

12. Unload the qla2200 or gla2300 driver and then reload the driver by using
modprobe so the driver will pull in the new option string that was added by
FAStT_MS].

13. Type the following command:
# mkinitrd -f <ramdisk image file name> <kernel version>
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14.

15.

Note: This step overwrites the original ramdisk image file if it is executed
within the /boot directory. Specify a unique ramdisk image name to
preserve the original ramdisk image.

Copy the file to /boot.

For SuSE Distribution, type the following command:
# /sbin/mk_initrd

Note: By default, the RAMDISK images created are:

/boot/initrd
/boot/initrd.suse

If you are using lilo, in a terminal window type:

/sbin/Tilo
Otherwise, you will not be able to boot your new ramdisk image.
Reboot the system to the ram disk image you just created.

Viewing adapter, device, and path information

You can view adapter, device, and path information in the Fibre Channel Port
Configuration and LUN Configuration windows. In the LUN Configuration

window, you can also view LUN information. See [“Diagnostics and utilities” on|

for information about viewing host, adapter, device, and LUN information
from the tab panel.

Viewing adapter information
Perform the following steps in the Fibre Channel Port Configuration and LUN
Configuration windows to view adapter information:

1. Right-click the Adapter n column heading to display information about a
specific adapter. The Adapter Information window displays. This window lists
the following information:

Number: Adapter number
Type: Type of board. 2200 indicates a QLA22xx
Serial Number: Serial number of the adapter

Driver Version: Version of the adapter driver on the host that controls the
adapter

Firmware Version: Version of the adapter firmware on the host that controls

the adapter

BIOS Version: BIOS version on the adapter

PCI Slot Number: PCI slot number assigned by the host

Node Name: World wide adapter node name

Port Name: World wide adapter port name

Total Number of Devices: Number of devices attached to the adapter

2. Click OK to close the Adapter Information window.

Viewing device information
Perform the following steps in the Fibre Channel Port Configuration and LUN
Configuration windows to view device information.

1. To display information for a device node, perform one of the following actions:

* In the Fibre Channel Port Configuration window, right-click a cell in either

the Device Node Name or Device Port Name column.
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In the LUN Configuration window, right-click a cell in the LUN, Enable, or
Device Port Name column.

The Device Information window displays. This window lists the following
information:

Product Identification: Product ID of the device
Product Vendor: Device manufacturer

Product Revision: Device revision level

Path: Path number

Target: Device number

LUN: The first LUN attached to the device

Loop ID: Loop IDs are 7-bit values that represent the 127 valid AL_PA
addresses.

Port ID: Port ID of the selected device’s port
Node Name: Click World wide node name of the device
Port Name: World wide port name of the selected device’s port

Note: If the Device Node Name was selected, all the device’s port names
display.
Number of LUN(s): Number of LUNs attached to the device

2. Click OK to close the Device Information window.

Viewing path information
Perform the following steps to view path information in the LUN Configuration
window:

1. Right-click the cell for the device in the Adapter n column. The Path
Information window displays the following information:

Device Node Name: World wide node name of the device
Device Port Name: World wide port name of the selected device’s port
LUN: LUN number

Device Port ID: Port ID of the selected device’s port
Vendor ID: Device manufacturer

Product ID: Product ID of the device

Product Revision: Device revision level

For the Preferred Path and Alternate Path sections:

— Adapter Number: Number of the adapter

— Path ID: Path number

— Target ID: Device ID

2. Click OK to close the Path Information window.

Editing persistent configuration data

When you select Persistent Configuration Data, the current configuration data
displays if a configuration exists. You can perform the following actions:

* Click Adapter Persistent Configuration to delete the persistent configuration
data for an adapter and its devices and LUNSs (see [“Deleting adapter persistent|

[configuration data” on page 99).

* (Click Device Persistent Configuration to delete the persistent configuration data
for a_device and its LUNS (see ['Deleting device persistent configuration data”|

fon page 99).
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Deleting adapter persistent configuration data
Perform the following steps to delete the persistent configuration data for an
adapter, its devices, and LUNSs.
1. Perform one of the following actions:
¢ From the FAStT MSJ main window, right-click the host or adapter in the
HBA tree. In the resulting pop-up menu, click Adapter Persistent
Configuration Data.

¢ From the Fibre Channel Port Configuration window Adapter menu, click
Adapter Persistent Configuration Data.

The Fibre Persistent Configuration Editor window displays (see [Figure 32). For
each adapter connected to the host, the current persistent configuration editor lists
the adapter number and its world wide port name.

E'-_j'Hll:—it NODEA . Fibre Persistent Configuration Editor E3

Adapter 1: 20-00-00-E0-8B8-00- CA-56
Adapter 1: 20-00-00-E0-3B-00-F2-2C
Adapter 0 211-00-00-E0-86-00-31-D3
Lolzrder 1- 11000 ELLARO1 . A48T

|_Selact adapter(s) o delete persistent conflguration data.

Delete | cancel

Figure 32. Fibre Persistent Configuration Editor window

2. Perform one of the following actions to delete one or more entries:
¢ Click the adapter entries that you want to delete.
* Click Delete to remove the entries.
The Security Check window displays. Enter the password, and click OK.

Note: Changes made to the persistent configuration are final. If you do not
want the changes, reconfigure the host (see [‘Configuring fibre channell
[devices” on page 86).

Deleting device persistent configuration data
Perform the following steps to delete the persistent configuration data for a device
and its LUNS.

1. Perform the following steps:

e From the FAStT MSJ main window, right-click the device or LUN in the HBA
tree. In the resulting pop-up menu, click Device Persistent Configuration
Data.

¢ From the Fibre Channel Port Configuration window, click Device -> Device
Persistent Configuration Data.

The Device Persistent Configuration Editor window displays.

For each device connected to the adapter, the current persistent configuration

editor displays the device number and its world wide port name.

2. Perform the following steps to delete one or more entries:
a. Click the device entries that you want to delete.
b. Click Delete to remove the entries. The Security Check window displays.
c. Type the password and click OK.
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Note: Changes made to the persistent configuration are final. If you do not
want the changes, reconfigure the host (see [’Configuring fibre|
[channel devices” on page 86).

Saving and printing the host configuration file

You can save the host configuration file and then view a virtual image of the host.
The file name includes the host name, date saved, and time saved. See
lconfiguration to a file” on page 84 for details.

To print a device and LUN configuration, perform the following steps:
1. From the FAStT MS] main window, perform the following steps:
a. In the HBA tree, click the host (or adapter connected to the host).
b. Perform one of the following actions:
* Click Configure on the toolbar.
* Right-click the host (or adapter) in the HBA tree. From the resulting
pop-up menu, click Configure.
The Fibre Channel Port Configuration window displays.
2. Click File -> Print.
3. Select the printer and print the configuration.

Using the failover watcher

The failover watcher enables you to view the failover settings for a selected host
and set a preferred or alternate LUN path as the currently active path.

Note: See|“Setting LUN path failover” on page 95| for more information.
Perform the following steps to view or modify the failover information:

1. In the FAStT MS] main window HBA tree, click the host for which you want to
view failover information.

2. Perform one of the following actions:
* Click Host -> Current Path.

* Right-click the host in the HBA tree. From the pop-up menu, click Current
Path. The HBA View Failover window displays (see [Figure 33 on page 101]).
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E"gg FAStT Management Suite Java - HBA ViewFailover - target
Mode Mame Adapter 0 Adapter 1
§ &= Device 20-00-00-20-37-08-10-28
@ Lun O
o8 71-00-00-20-37-08-10-28 (&) Current: Preferred (%) Alternate
Device 20-00-00-20-37-00-1F-9A
§ @& Device 20-00-00-20-37-08-03-68
@ Lun O
B 21-00-00-20-37-08-03-68 (&) Current : Preferred (%) Alternate
§ @& Device 20-00-00-20-37-04-D2-0C
Q Lun 0
e 21-00-00-20-37-04-D2-0C (&) Current : Preferred  (5) Alternate

Close

Figure 33. HBA View Failover window

The identifying information displays:
* Host

The title displays the host name.
The failover information displays:

* Node Name
Listing of the devices and LUNS.
— Devices
World wide device port name of the devices.
- LUNs

LUNs s are listed under the devices to which they are connected. Includes
the LUN number and world wide LUN port name.

* Adapters
Lists the adapters connected to the host and specifies their path status:
— Preferred

— Alternate
Path status:

— Green bull’s-eye and Current: currently active
- Gray bull’s-eye: not active
— Red bull’s-eye: preferred path that is not active
3. To set the path of a device as currently active, perform the following actions:
a. Right-click the path status in the Adapter column.

b. In the pop-up menu, click Set Current. The bull’s-eye changes to green and
the word Current displays.
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Chapter 5. Introduction to SANavigator

This chapter provides an overview of the functions of SANavigator. See the User
manual (PDF format) located in the SANavigator install folder to learn more about
the features of SANavigator.

SANavigator management software provides easy, centralized management of your
SAN, and quick access to device configuration applications. The complete SAN
displays graphically, so administrators of all levels can manage networks with ease.

Operating in a SAN environment

SANavigator enables you to easily monitor and manage your SAN through the
following features:

1.

Discovery

SANavigator uses TCP/IP (out-of-band) and fibre channel (in-band) to establish
contact with a large number of SAN devices, gather embedded information,
and then depict it all graphically. SANavigator discovers the devices attached
to your SAN. It then presents a visual map of devices and their
interconnections, enabling you to identify any problem components in the map.

Launching Device Applications and Utilities

You can launch applications and utilities such as IBM FAStT Storage Manager
and IBM FAStT MS] from SANavigator by right-clicking the respective devices.
A pop-up menu displays where you select the applications as well as link to
the IBM Fibre Channel Solution Support Web site.

Monitoring

SANavigator generates events and messages about the status of devices and
their respective properties. SANavigator offers self-monitoring event logging
and messaging feature to enable you to stay informed about the current state of
the SAN.

Reporting

SANavigator enables you to generate, view, and print reports.

New features of SANavigator 3.1

Version 3.1 has significantly enhanced the capability of SANavigator. It includes
the following new features:

© Copyright IBM Corp. 2004

Remote Discovery Connector enabling you to In-Band manage remote hosts
from a local Management Station. In previous versions In-Band management
was possible only on the system where the SANavigator Server was installed
and where the HBAs were located.

Login/Logout function that enables you to log in or out of a SANavigator server
without closing the application.

Customizable topology views. You can now select to view a single Fabric or all
Fabrics. You can also customize the Device List (show/hide/relocate columns on
device list).

Improved user administration function
Auto-detection of topology overload
Detachable and scalable mini map to allow a more user-customized desktop
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* Latency graphs to monitor performance
* An improved GUI

System requirements

The following the minimum requirements are for SANavigator:

+ Windows operating systems (NT SP"" 6a and Windows 2000 Professional,
Enterprise Server, and Advanced Server)

- 700 MHz Intel™ Pentium III and up
- CD-ROM
- 512 MB RAM
— Disk Space: 150 MB
— VGA - 256 colors or greater
* Linux operating system (Red Hat 7.2)
700 MHz Intel Pentium III and up
512 MB RAM
Disk Space: 150 MB
— VGA - 256 colors or greater

Installing SANavigator and getting started

This section contains instructions on how to install and uninstall SANavigator on
your system.

You can install SANavigator as a client, a server, both client and server, or as a
Remote Discovery Connector. The major benefit of using the Client/Server feature
is that a SAN running on a server can have a number of clients working
simultaneously on the same SAN. Each client can monitor what all other clients are
doing, whether across the room or halfway around the world. Each client can
access all servers for which it is authorized. Clients can set personal preferences;
preferences are saved locally.

You install the Remote Discovery Connector on host(s) that you want to In-Band
manage remotely. In addition, the hosts must have the HBA API library installed.

Note: When performing any SANavigator install or uninstall, be sure that no part
of the application (client, server, or Remote Discovery Connector) is running.
This could cause a variety of problems, including a system failure.

You can install SANavigator from a CD or by downloading it from the Web.

Note: Always uninstall any prior version of SANavigator before you install a new
version.

Windows installation and uninstallation

This section describes how to install SANavigator for Windows (NT or 2000) from
both a CD and from the Web as well as how to uninstall the software.

Note: To further enhance the SANavigator discovery engine, install the HBA API
library. This library is automatically installed by the IBM FAStT HBA Driver

104 1BM TotalStorage FAStT: Problem Determination Guide



install package (driver version 8.1.5.60 and above). The API library enables
you to discover your SAN through the fibre channel medium in addition to
the Fabric network.

Installing from a CD

To install SANavigator for Windows from a CD, perform the following steps:

1. Insert the SANavigator CD that came with your FAStT storage server into the
CD-ROM drive.

If you have autorun enabled, the install begins automatically. If you do not
have autorun enabled, run the setup.exe application file in the Windows folder.
Follow the instructions that the InstallShield wizard presents.

2. If you want to install a SANavigator client only, clear the SANavigator Client
and Server check box in the Select Components and Destination window and
select Client. If you want this machine to be remotely In-Band managed, select
the Remote Discovery Connector. You will skip installation steps that are not
required.

3. Review the readme_ibm.txt file (located in the root directory of the CD).

Installing from a Web download
To download SANavigator for Windows, go to the IBM Solution Support Web site

http:/ /www.ibm.com/pc/support.

A link to the SANavigator Web site is available to download the IBM version of
SANavigator. You will need to have your FAStT storage server model number and
serial number available.

To install SANavigator from the Web, perform the following steps:

1. After extracting the zip file, run the setup.exe application file in the Windows
folder.

Follow the instructions that the InstallShield wizard presents.

2. If you want to install a SANavigator client only, clear the SANavigator Client
and Server check box in the Select Components and Destination window and
select Client. If you want this Host to be remotely In-Band managed, select the
Remote Discovery Connector. This will skip installation steps that are not
required.

3. Review the readme file (located on the IBM Solution Support Web site).
Uninstalling SANavigator

Note: Before uninstalling SANavigator, the SANavigator Server needs to be
terminated. Make sure that no other client is using the server prior to
ending the process. To terminate the server and client, click Server ->
Shutdown from the menu bar. A dialog displays asking you to confirm the
Shutdown and whether or not you want to also exit the client. If you do not
uncheck the "Shutdown Client also” box, both the Client and Server (on the
local machine) will be terminated provided no other remote clients are
running.

Click Start -> Program -> SANavigator -> Uninstall SANavigator to begin the
uninstall process. You are presented with the following three choices:

* Reinstall - SANavigator will be reinstalled. All SAN files are retained.
* Partial Uninstall - Retain Data and Preference Files - SANavigator will be
uninstalled, but all SAN files are retained.
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* Full Uninstall - SANavigator will be uninstalled and all SAN files are deleted.

In order to retain access to your previous SAN files, be sure to reinstall
SANavigator in the same location that the software was previously installed.

If you must reinstall in a new location, be sure to move your SAN files from the
old install directory to the new directory.

Note: SANavigator 3.1 allows you to import and open SAN files that were created
using version 2.7. See [‘Starting SANavigator server and client” on page 109
for additional information.

nstallation and uninstallation

This section describes how to install SANavigator for Linux from both a CD and
from the Web as well as how to uninstall the software.

Note: To further enhance the SANavigator discovery engine, install the HBA API
library. This library is part of the IBM FAStT HBA Driver install package
(version 6.0 and above). The API library enables you to discover your SAN
through the fibre channel medium in addition to the Fabric network. Review
the readme_ibm.txt file located in the Linux/Redhat folder on the CD for
additional information.

Installing from a CD
To install SANavigator for Linux from a CD, perform the following actions:

1. Insert the SANavigator CD that came with your FAStT storage server into the
CD-ROM drive.

2. Login as root.

3. From the Linux\Redhat directory on the CD, copy the .bin file (for example,
SANav3lirh.bin) to your temp directory.

4. Start the installer (./temp/SANav3lirh.bin or sh ./temp/SANav3lirh.bin)

5. Follow the on-screen instructions.

6. If you want to install a SANavigator client only, clear the SANavigator Client
and Server check box in the Select Components and Destination window and
select Client. If you want this machine to be remotely In-Band managed select
the Remote Discovery Connector. You will skip installation steps that are not
required.

7. Review the readme_ibm.txt file located in the Linux/Redhat folder on the CD
for additional information.

Installing from a Web download
To download SANavigator for Linux, go to the IBM Solution Support Web site

http:/ /www.ibm.com/pc/support

A link to the SANavigator Web site is available to download the IBM version of
SANavigator. You will need to have your FAStT storage server model number and
serial number available. See the readme file on the IBM web site.

To install SANavigator from the Web, perform the following steps:
1. Download the bin file from the SANavigator Web site.
2. Open a terminal session in the GUL
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3. From the directory where you stored the bin file, type one of the following
commands at the prompt:

sh SANav3lirh.bin

or
./SANav3lirh.bin
4. Wait for the introduction window to open.

i

Follow the instructions that the Installer presents.

6. If you want to install a SANavigator client only, clear the SANavigator Client
and Server check box in the Select Components and Destination window and
select Client. If you want this machine to be remotely In-Band managed select
the Remote Discovery Connector. You will skip installation steps that are not
required.

7. Review the readme file (located on the IBM Solution Support Web site).
Uninstalling SANavigator

Note: Before uninstalling SANavigator, the SANavigator Server needs to be
terminated. Make sure that no other client is using the server prior to
ending the process. To terminate the Server and Client click Server ->
Shutdown from the menu bar. A dialog box displays asking you to confirm
the Shutdown and whether or not you want to also exit the client. If you do
not uncheck the Shutdown Client also box, both the Client and Server (on
the local machine) will be terminated provided that no other remote clients
are running.

To begin uninstalling, perform the following actions:

1. Open a terminal session in the GUL

2. From the /usr/ directory, type one of the following commands at the prompt:
sh Uninstall_SANavigator

or
./Uninstall_SANavigator

Note: Uninstall instructions assume that SANavigator was installed using the
default selections.

3. Wait for the introduction window to open.
4. Follow the instructions the Uninstaller presents.

You are presented with the following two choices:
e Partial uninstall

Retain Data and Preference Files - SANavigator will be uninstalled, but all SAN
files are retained.

* Full uninstall
Delete all files - SANavigator will be uninstalled and all SAN files are deleted.

In order to retain access to your previous SAN files, be sure to reinstall
SANavigator in the same location that the software was previously installed.

If you must reinstall in a new location, be sure to move your SAN files from the
old install directory to the new directory.

Chapter 5. Introduction to SANavigator 107



Note: SANavigator 3.1 allows you to import and open SAN files that were created
using version 2.7. See [“Starting SANavigator server and client” on page 109)
for additional information.

SANavigator Help

SANavigator Help enables you to find subjects listed in the online table of contents
or to search for specific keywords. The SANavigator documents are divided into
three parts: HelpSet files, User Manual, and Reference Manual. All are listed in the
table of contents and all are searched when you use the Find feature.

You can print the entire contents of the User Manual from the PDF file
UserManual.pdf located in the SANavigator folder\directory.

For detailed information on how to use any of the following SANavigator features,
start SANavigator and open the online help. Help topics are grouped as follows:

¢ Reference

The Physical Map
Use the Physical Map to display your SAN topology, devices, and their
connections.

The Mini Map
Use the Mini Map to view your entire SAN domain and to move within
that view.

Device Tree/List
The Device Tree/List displays a list of all discovered devices and their
properties.

Event Log
The Event Log displays SAN events.

¢ Tasks

- Configuring Your SAN for Best SANavigator Performance Monitoring
(Premium feature)
The configuration of your SAN can affect the functionality and
performance of SANavigator.

- Compatibility with Other Applications
SANavigator is designed to operate smoothly with other Enterprise
applications and network monitoring programs. Because SANavigator
has fully configurable SNMP trap listening and forwarding functions, it
can act as a primary or secondary network manager.

- Log-in and Log-out to/from a SAN

- Discovering Your SAN
SANavigator uses a unique process to discover devices on your SAN.

- Monitoring Your SAN
SANavigator provides three methods of monitoring your SAN devices:
Physical Map, Event Log, and Event Notification.

- Monitoring the Performance of Your SAN (Premium feature)
SANavigator provides animated, real-time performance information. You
can set thresholds and be notified when they are exceeded.

- Planning a New SAN (Premium feature)
SANavigator provides the means to graphically plan and evaluate a new
SAN.
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- Setting Up E-Mail Notification
Configure event notification so that you can receive messages when
events you want to know about occur.

- Exporting Maps and Information
You can import or export SANavigator SAN files, performance data,
Physical Map, Device Tree, or reports. This process is very useful when
transmitting files to your support center or when capturing network
status at local or remote locations.

* Glossary

Many SAN-specific names and terms are described. See|“Glossary” on page 285

Starting SANavigator server and client

This section provides instructions on how to start SANavigator in Windows and
Linux operating systems.

Starting in Windows

To start both the SANavigator Server and Client in Windows, perform one of the
following actions:

* Click Start -> Programs -> SANavigator x.x -> SANavigator.
* Double-click the SANavigator x.x desktop icon.

To start the SANavigator Client in Windows, perform one of the following actions:
* Click Start -> Programs -> SANavigator x.x -> SANavigator Client.

* Double-click the SANavigator x.x desktop icon.

If you installed the Remote Discovery Connector on a remote Host, click Start ->

Programs -> SANavigator Remote Discovery. Although the process starts, no user
interface displays.

Note: To run Remote Discovery Connector, the server must be configured. See
“Setting up SANavigator Remote Discovery Connection for in-band|
management of remote hosts” on page 186/and the online help provided.

Further problem determination information can be found on the IBM Support Web
site.

Starting in Linux

To start both the SANavigator Server and Client in Linux, open a terminal session
and type one of the following commands from the /usr directory:

sh SANavigator

or
./SANavigator

To start the SANavigator Client in Linux, open a terminal session and type one of
the following commands from the /usr directory:

sh SANavClient

or
./SANavClient
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If you installed the Remote Discovery Connector on a remote Host, open a
terminal session and type one of the following commands from the /usr directory:

sh SANavRemote start

or
./SANavRemote start

To stop the process, type one of the following commands:
sh SANavRemote stop

or

./SANavRemote stop

Note: To run Remote Discovery Connector, the server must be configured. See
“Setting up SANavigator Remote Discovery Connection for in—bandl
management of remote hosts” on page 186/ and the online help provided.

Further problem determination information can be found on the IBM Support Web
site.

Configuration wizard

The first time SANavigator is started the Welcome Wizard displays. The Wizard
allows you to configure SANavigator.

Import Data and Settings
This dialog box allows you to select whether or not you want to import
SANavigator Version 2.7 data and settings into this new version. If you
select Yes, enter the location (path) where the exported .zip files are
located.

Note: You need to export the SAN files from a 2.7 SANavigator session
before uninstalling 2.7. When uninstalling the older version, make
sure that you select Partial Uninstall so that the SAN files are
preserved.

SANavigator Server Name
SANavigator servers are given a name. The name helps you identify
different servers. SANavigator automatically assigns the OS Network
Identification computer name to the server as a default.

SANavigator Administrator
Users are identified and validated in SANavigator by a User ID and
Password. In this dialog box, enter your User ID and Password
information.

SANavigator Win32 Service
If you run SANavigator as a Win32 service, you can log off the network
without closing SANavigator. Click the check box to run SANavigator as a
Service.

Note: Running SANavigator as a Win32 service is not recommended
unless you are familiar with Win32 service behavior.

SANavigator Server License
This dialog box allows you to enter the license key. Once entered, a
summary of the server configuration displays as well as the features that
were enabled by the license key.
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To register SANavigator, perform one of the following actions::

If you have an Internet connection, you can register on the Registration
window. The completion of all fields is required for registration. Free Web
e-mail addresses are not accepted.

If you do not have an Internet connection, the Registration window
contains contact information. Your new license key will be e-mailed to you.
Follow the instructions in the e-mail to enter the license key in the
application after it is running.

Note: The license key is required to enable the premium features. These
include the following features:

* SAN Planning

* SAN Performance Monitoring
* Zoning

* Policy Engine

* Greater than 32 Switch Ports
* Greater than five clients

Premium Features are available for a trial period of 30 days.

Initial discovery when client and server are on one computer
When you start SANavigator, the Login SAN dialog box displays. The Network
Address field contains "localhost”. If SANavigator detected the server, the

informational message "Server Available” displays on the bottom left of the dialog
box. The Server Name field contains the name of the local hardware server.

Perform the following steps to perform initial discovery when the client and server

are on the same computer:

1. Type the user ID and the password specified during the SANavigator
configuration. Select "Save Password” if you want to save the Password.

2. Click OK. SANavigator automatically conducts an out-of-band discovery on
your local subnet and displays any SAN devices that it finds.

Initial discovery when client and server are on different

computers

When you start the SANavigator Client to connect to a remote SANavigator Server

the Log-in SAN dialog box displays. You can enter the IP address of the remote

Host in the Network Address field. If SANavigator connected to the remote server

the informational message "Server Available” displays on the bottom left of the

dialog box. Perform the following steps to perform initial discovery when the

client and server are on different computers:

1. Enter the IP address in the Network field.

2. Type the user ID and the password for the Server on the remote Host.

3. Click OK. The SANavigator Client gathers the topology information from the
remote Server and automatically displays the SAN devices discovered by the
remote Server.

Viewing an existing SAN

Perform the following steps to view a discovered SAN on an existing server:

1. Click Log-in. The Log-in SAN dialog box displays.

2. Type the IP address of the server in the Network Address field and click OK.

Chapter 5. Introduction to SANavigator 111



3.

Type the user ID and password. Click OK. The SAN is discovered and
displayed.

Setting up a new discovery
Perform the following steps to set up a new discovery:

1.

10.

11.

If the Discover Setup dialog box is not open, click Discover -> Setup.

2. Click the General tab and verify that Out-Of-Band is selected.
3.
4

. Review entries in the Selected Subnets and Selected Individual Addresses

Click the Out-of-Band tab.

tables. Click any entries you do not want to discover now, and move them
back to the Available Addresses table by clicking the appropriate arrow
button.

To add new addresses to the Available Addresses table, click Add; the Domain
Information dialog box displays.

Type a description of the IP subnet where your SAN devices are located in the
Description field.

Type the IP Address and Subnet Mask of a device (for example, a switch) on
the SAN you want to discover.

Click OK to return to the Discover Setup dialog box.

In the Available Addresses table, click the address you entered and use the
arrow button to move the address to the Selected Subnets table on the right.

If you want to enable In-band discovery, check the In-Band box in the General
Tab dialog box and select the available HBAs. If no HBA is available, make
sure the HBA API library is installed. See ['In-band discovery” on page 119

Click OK to save the settings and to begin the discovery process.

SANavigator main window

112

The SANavigator main window, shown in [Figure 34 on page 113} displays when
you start SANavigator. By using the drop-down menus, you issue commands to
the SANavigator software. To see how each command works, click the menu, note
the name of the command, and search for the command in the help.
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Figure 34. SANavigator main window

The desktop consists of the following five sections.

Physical Map
The Physical Map displays your SAN topology, devices, and their
connections. For more information, see [‘Physical Map” on page 121

Mini Map/Utilization panel

Use the Mini Map to view your entire SAN domain and to move within
that view. For more information, see [‘Mini Map and Utilization Legend”|
on p 125,

The Utilization legend displays when the Utilization option is selected in
the View -> Connection menu. It depicts the percent of the data
bandwidth that is utilized when I/Os are in progress. This is a Premium
feature.

Event Log

The Event Log displays SAN events. For more information, see
[Log” on page 126

Device Tree/List

The Device Tree/List displays a list of all discovered devices and their
properties. For more information, see [“Device List” on page 128]

Working with SAN files

From the SAN menu, you can perform the following actions:
* Log in to a new SAN

* Log out of an existing SAN

* Change user information
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* Gain remote access

* Export a SAN

* Import a SAN

¢ Plan a new SAN

* Open an existing SAN

These tasks are described in the following sections.

Log in to a new SAN
To log into a new SAN, perform the following steps:
1. Click SAN -> Log in The Log in SAN dialog box appears.

The SANavigator application automatically discovers and opens the local SAN
when you log in.

2. The server’s address displays in the Network Address field. You can specify a
new address by typing it in the field, or selecting one from the list.

Note: In version 3.1, localhost is the default value. The SANavigator
application automatically determines your local IP address and uses that
value as your local host address. If you had previously connected to
another IP address, you can select localhost from the Network Address
drop-down field.

3. Enter your user ID and password.

4. Select whether you want the SANavigator application to remember your
password for the next time you log in.

5. Click OK. SANavigator will perform out-of-band discovery on your local
subnet and display any SAN devices that it finds.

Log out from a current SAN

To log into a different server, you must first log out of the current server.

Select Log out from the SAN menu. You will be logged out of the current server.
Selecting Shutdown shuts down the SANavigator server and client.

Change user information

Click SAN -> SANavigator -> Users to open the SANavigator Server Users dialog
box, where you can add, delete, or change user information. In the Add User
dialog box, you can set access to any of the following levels of permission:

None User has no server access. Use this level to restrict access without deleting
a user’s account, or when a user only needs to receive e-mail.

Browse
User can view almost all information, but cannot make changes to or
configure SAN devices.

Admin
User has access to all SANavigator functions.

You can also determine whether a user receives e-mail notifications of
events by performing the following steps:

1. Select the Enable check box (located under the Email column).

2. Click Filter to set the parameters for e-mail notification.

3. Click Setup to open the Event Notification Setup dialog box.
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You enable all user management on a single dialog box. See
SANavigator Server Users in the help file for specific instructions about
adding, defining, and removing users.

Notes:

1. Two users cannot have the same ID.

2. Each user’s e-mail address and preferences for event notification are
stored with the user’s account.

3. All user actions are logged into either the SAN log file or the server log
file.

4. You cannot delete all users. There must always be at least one user.

Remote access

A SANavigator server can be accessed by multiple clients. The Remote Access
menu function allows you to control whether or not you want multi-client
connections, or select which client is permitted to connect to your server.

From the SAN menu, select SANavigator Server -> Remote Access. The Remote
Access dialog box displays.

Remote Access Dialog

Allow remote management sessions. Select this option to allow remote
management sessions.

Maximum number of remote sessions. Select the number of remote
sessions you want to allow.

Allow Any network address to connect. Select to allow any network
address to connect.

Only network addresses below to connect. Select to allow only the
network addresses specified below to connect.

All network addresses EXCEPT those below to connect. Select to allow all
network addresses except those you specify.

Add button. Click to add network addresses.

Remove button. Click to remove network addresses.

Server Properties

Name

Click SAN -> Properties to open the Server Properties dialog box. You can
use the Name field to change the name of your server. The dialog box
displays information about the server that the client is currently logged
onto.

Name assigned by the user to the portion of the SANavigator program
acting as a server. This property can be set by users with administrative
privileges. This name need not correspond to any other names, including
the host name.

IP Address

Determined by the machine that the SANavigator server program is
running on

Subnet Mask

Determined by the machine that the SANavigator server program is
running on
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Java VM Version
Version of the Java Runtime Environment that is currently running the
SANavigator server that you are talking to

Java VM Vendor
Vendor of the Java Runtime Environment that is currently running the
SANavigator server that you are talking to

Java VM Name
Name of the Java Runtime Environment that is currently running the
SANavigator server that you are talking to

OS Architecture
The SANavigator determines the hardware architecture if available

OS Name and Version
The SANavigator determines the operating system and its version if
available

Region
The SANavigator server program determines the geographical region of
your operating system

Time Zone
The SANavigator server program determines the world time zone of your
server

Free Memory
Unused memory within the total memory

Total Memory
Total memory assigned to your Java Runtime Environment

Exporting a SAN

This feature enables you to capture the current state of a SAN and, at a later time,
replay the SAN in your SANavigator machine or in a remote system that has
SANavigator installed. This is useful in providing a view of the SAN to allow for
remote diagnosis of problems. The following items are exported when you click
SAN -> Export:

* SAN files: These are XML files that define your SAN.
* Physical Map: The Physical Map is exported to a JPEG file.
* Device List: The Device List is exported to a tab-delimited text file.

* Performance Data (Premium feature): This file contains the performance
information that was gathered during the SAN monitoring.

All of these files are automatically zipped when you select the Save to Disk check
box in the Export dialog box. A folder is generated that contains three files. See the
following example:

san011107105249
san011107105249.zip
san011107105249. jpeg
san011107105249.txt

You can also e-mail all three files by selecting the Mail To dialog box. (You need to
have e-mail configured for your system.)
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Importing a SAN

Click SAN -> Import to import a previously exported SAN into any SANavigator
system. This enables you to see the exported SAN, including any problems that
were present at the time of the capture.

In the Import dialog box, either type the SAN file name (for example,
san011107105249.zip) or click Browse to search for the file.

The SAN displays with a time stamp, giving the date and time of capture in the
background. At this point, discovery is disabled until you enable it. If this is the
system from which the SAN was exported, the discovery detects any changes from
the exported SAN to the current view of the SAN.

Important: Turning on discovery replaces the currently-discovered SAN with the
imported data. Only one SAN can be viewed or saved at a time.

Planning a new SAN (premium feature)

You can plan a New SAN or use the current topology as the basis for a planned
SAN. You can add, remove, arrange. and connect planned devices to help you
envision the SAN before implementing it. Perform the following steps to plan a

new SAN:
1. From the SAN menu, select New Plan (or CTRL+N). The New Plan dialog box
displays.

2. In the New Plan field, enter a name for the new plan.

3. Select whether you want to start with a discovered topology or start with an
empty plan.

4. Click OK. The plan displays.

Opening an existing plan
Perform the following steps to open an existing plan
1. From the SAN menu, select Open Plan. The Open Plan dialog box displays.

2. Select a plan from the Open Plan list.
3. Click OK. The plan will be displayed.

Configuring your SAN environment

Two aspects of your SAN configuration can affect the functionality and
performance of SANavigator: LAN configuration and SNMP configuration.

LAN configuration and integration

SANavigator relies on LAN connectivity with the SAN devices to gather
information about the devices and connectivity of the SAN. LAN connectivity
implies the following:

 All switches, hubs, and bridges have been configured with valid and specific IP
addresses.

* The devices are properly cabled and integrated into a functional LAN topology.

* The computer where SANavigator runs has access to the LAN and to the IP
addresses of the SAN devices.
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SNMP configuration

SNMP is a communications protocol used to remotely monitor, configure, and
control network systems. SANavigator acts as a network manager and generates
requests and processes responses from SAN devices. SANavigator also listens for
event reports or traps from SAN devices.

Subnet discovery
There are two methods of subnet discovery that you can use in your SAN
environment:

¢ Broadcast
* Sweep

The Broadcast method of discovery is the most efficient discovery method, and it is
the default method. However, a network administrator can disable this method on
the network router. If broadcasting has been disabled on a network, and
SANavigator has been configured to block the broadcast method, no devices will
be discovered.

The Sweep method of discovery enables SANavigator to broadcast a request to all
the devices on a network simultaneously; this improves SNMP communication
efficiency. When broadcasting is disabled, sending the request to each device on
the network (sweeping) is the only method available to discover SAN devices
across an entire subnet. However, sweeping an entire network can take half an
hour or more. If broadcasting has been disabled, the best method of discovery is to
type the individual IP addresses of the SAN devices into the selected individual
addresses area of the Configure Discovery dialog box. This method produces good
results without unnecessarily waiting for responses from every IP address in the
subnet, especially for IP addresses where no devices are present. However, there
might be times when a full subnet sweep produces valuable diagnostic information
about the configuration of a network or a device.

Trap configuration

In addition to the request-response cycle of communication, SAN devices can
generate event reports or SNMP traps. Most network devices can be configured to
send their traps to port 162 on one or two IP addresses. By default, SANavigator
listens for SNMP traps on port 162 and lists the traps in the Event Log. To make
traps visible in the SANavigator Event Log, configure the SAN devices to send
their trap event notices to the IP address of the computer running SANavigator. If
you want multiple network management applications to receive trap events, see
the SANavigator help topic Compatibility with Other Applications.

Click Monitor -> Trap Forwarding to open the Trap Forwarding dialog box, where
you can specify the IP addresses and ports of other computers to which you want
to forward SNMP traps received by SANavigator. If you select the Enable Trap
Forwarding check box, all traps received by SANavigator are forwarded to the
recipients listed in the Selected Recipients table.

Discovering devices with SANavigator
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SANavigator is able to discover devices using out-of-band or in-band discovery
processes, or both. Out-of-band discovery is required when the SAN configuration
contains switches and managed hubs (a Fabric environment). In-band discovery is
required when no switch or managed hub is present (that is, when the host bus
adapter is connected to a FAStT storage server either directly or through an
unmanaged hub).
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In the Discover dialog box, you can select which of these two processes to use. To
enhance the discovery of your SAN, it is suggested that you use both processes.

There are two methods for In-band Discovery:

* Local Server (default) - Only HBAs on the local server are discovered through
in-band. Any devices on the same subnet (connected through switches) are
discovered out-of-band. HBAs from remote hosts cannot be in-band managed
from the local machine but are discovered if connected to the Fabric.

* Local Server and Remote Discovery Connector - The local server communicates
with the Remote Discovery Connector (SANavRemote.exe) installed in the
remote host. A user can now have In-Band management of the Remote Host
from the local machine.

See [“In-band discovery”for additional information.

Out-of-band discovery

SANavigator uses an out-of-band process to discover SAN devices. During
discovery, the SANavigator logo on the right side of the menu bar is active. If
discovery is turned off, a red circle with a diagonal bar through it appears over the
logo.

Familiarize yourself with the information in the help topic "Configuring Your
SAN" before you proceed.

To discover devices on your SAN, use the Out-of-Band tab in the Discover Setup
dialog box to select the TCP/IP subnets or individual IP addresses. When you
connect to a server and set up discovery, SANavigator performs a discovery of
devices on your SAN. At any time during a SANavigator session, you can turn the
discovery feature off or back on by clicking Discover -> Off or Discover -> On, or
by clicking the Discovery button.

SANavigator servers can run discovery on only one SAN at a time. If you turn
discovery off and another client turns it on, discovery continues to run on the
other client. If you turn discovery on, SANavigator issues a message to the other
client that you are taking over the discovery process. You need to negotiate with
other users about who should use discovery and when.

In-band discovery

In-band discovery requires that the IBM FAStT HBA SNIA API library be installed
on your system. This library is part of the IBM FAStT HBA driver installation
package. When in-band discovery is enabled from the Discover Setup dialog box
(see [Figure 35 on page 120), the supported host bus adapters will be displayed in
the Available HBAs panel. Select the HBA or HBAs that you want to discover
using the in-band process.

Note: In-band discovery is only enabled on the system on which the HBA SNIA
API library is installed and where the host bus adapter or adapters reside.
Both the local host and a remote host (with the Remote Discovery Connector
installed) can be in-band managed. A SANavigator server must be running
in order to perform Remote Discovery (for example, the localhost server can
be used to connect to the remote host). See [“Setting up SANavigator Remotel
Discovery Connection for in-band management of remote hosts” on pagd
186 for In-band management of remote hosts.
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Figure 35. Discover Setup dialog window
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You can determine the discovery method by inspecting the diamonds that are

adjacent to the device icons in the physical map.
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The SAN database is updated continuously by the discovery engine. Thus, when
you change your discovery method, the devices and links that were previously

discovered are maintained.

For example, if you had in-band and out-of-band discovery enabled, and you
subsequently disabled in-band discovery, all devices and connections that were
in-band discovered would be shown in red. You can avoid this by selecting the
Clear Current SAN Devices check box before starting a new discovery. However,
be aware that this will cause any previous configurations to be reset. If you want

to keep a copy of the original SAN, export your SAN (see|“Exporting a SAN” on|

age 116).
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Community strings

You can either specify custom community strings to communicate with SAN
devices or let SANavigator use standard defaults. SNMP protocol enables you to
set community strings for both read and write requests. For most SAN devices, the
default string for read requests is public, and the default for write requests is
private. SANavigator treats custom community strings as secure information,
protecting it during entry and encrypting it for storage in the program.

If you have changed the SNMP community strings on your SAN devices, you need
to use the Community Strings tab in the Domain Information dialog box to enter
your custom strings. SANavigator supports one custom read and one custom write
community string per individual IP address or subnet.

Polling timing and SNMP time-out intervals

The polling rate is the delay between successive discovery processes or how long
discovery waits for responses from the devices on your SAN. To change the
polling rate, click the General tab in the Discover Setup dialog. The polling delay
determines the responsiveness of the map in terms of displaying changes in your
SAN. Short times (3-10 seconds) give an almost real-time indication of the SAN
status. Extended periods reduce network load, but show changes only after each
polling period.

If you have a large number of devices, you might want to extend the polling delay
so the discovery and mapping processes are completed before another discovery is
initiated. Heavy data loads might reduce the responsiveness of SAN devices. You
can edit the SNMP time-out interval to provide more time for the devices to
respond. (The time setting is for one retry only; SANavigator retries three times for
each device.) If SANavigator receives an SNMP trap message, a discovery is
initiated immediately.

Note: Short polling delays (less than 10 seconds) might tax the CPU resources,
especially on slower processors and in larger SANS.

Monitoring the SAN environment

This section discusses the following tools that are available in SANavigator for
monitoring SAN devices:

* Physical Map

* Mini Map and Utilization Legend
* Event Log

* Device Tree

* Device List

* Event Notification

Physical Map

The Physical Map, shown in [Figure 37 on page 122, displays devices, their
connections, and connection failures. SANavigator discovers devices, displays them
on the Physical Map, and monitors communications with the devices. If
communication is lost with any device, the device and its connections turn red. For
instance, if a device is disconnected from the SAN, its icon turns red and its
connections appear red until communications are reestablished with the device or
the device is deleted from the map. If a fabric or group is collapsed to an icon and
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a device in the fabric or group is disconnected from the SAN, the icon appears red.
If you click Delete All in the Edit menu of the desktop, all red devices are deleted.

Note: See|“Physical Map” on page 172 for more detailed information about using
the Physical Map.

#3 view All - SANavigator - |EI|5|
SAM  Edit View  Plan  Discover  Configure  Montor  Tools  Help
& g So H = [ +* @
j @j QJ @ «@' ™ F‘Q“ = E] im - ,:Search ?
Vigy Al |?Policy|
q -~
[
. A - e
E S o
IBM 3526 IBM 3542 i
0401 0401
b
@@ Storage Group Starage Group
IBM 3526 IBM 3542
IBM FASLT
HBEA
Host Group
® © -«-©
& e a”
(=10} IBM_2108_F Pathlight
1742-0900 C_Switch Technologies
Storage Group Switch Group Bridge Group
IBM IBM_2108_F Pathlight
o
IBM 1742 IBM 3552
0500 ikl
Storage Group Storage Group
IBM 1742 IBM 3552
1000006069 |
I

-~

Evert Log Fiter: (@ None (0 Alldevices () Devices inview  Define Kinimzg E"Hn(ﬁ

o

g
[ |4><.‘-' [ Clierts 111 [ Adimin

Delary { [BEh-chani2k [

Figure 37. Physical map

From the Physical Map, you can perform the following actions:

* Determine the source and destination of a connection through the Device Tip.
The Device Tip, shown in [Figure 38 on page 123] pops up when you place the
cursor over the selected connection.

Note: You can disable the Device Tip feature by clicking View -> Device Tips
and unselecting the Device Tips check box.
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Figure 38. Device tip

* Expand multi-port devices to show the port assignments. Right-click the device
and select Ports from the pop-up menu to view the ports. See

Figure 39. Port assignments

* Launch device-specific applications and utilities such as the IBM Storage
Manager and IBM FAStT MS]J diagnostics. You can also go directly to the IBM
Support Web site to access the latest information about IBM FAStT SAN devices,
including firmware updates, drivers, and publications. You can also add other
applications or tools through the Tools dialog box. Right-click the device and the
pop-up menu shown in [Figure 40 on page 124 displays.
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Setup Tools...

IBM FASLT MSJ

IBM Solutions Support
Servers...
Connections
Properties

Figure 40. Device right-click menu
Click Setup Tools to add or modify tools and applications.

Physical Map view buttons
On the right-hand toolbar of the Physical Map, the following buttons allow you to
view the Physical Map in different formats.

Zoom Buttons
The two buttons with the magnifying glass icon allow you to change the
scale of the topology. You can zoom in by clicking on the + magnifying
glass button and zoom out by clicking on the - button. You can also scale
your topology view on a percentage basis. Select View -> Zoom in the

Menu bar and a pop-up menu will be displayed (see . Select the

desired scaling factor. You can also invoke this menu by right-clicking
anywhere outside of the Topology frame and selecting Zoom from the
pop-up menu.

Z0 x|
) 150%
0 100%
) 75%
) 50%
) 25%
) Fit to Screen
) Percentage: —

OK Cancel

Figure 41. Zoom dialog window

Expand/Collapse buttons
You can expand and collapse the topology view by clicking these buttons.
For each click of the Expand button, the topology will expand from Fabric
Only to Groups Only to All Devices and finally to All Ports. The Collapse
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button reverses this sequence. You can also select the View -> Show in the
Menu bar to expand/collapse the map.

Report Button
This button allows you to generate a report of the Physical Map. See
[“Generating, viewing, and printing reports” on page 129| for more
information.

Mini Map and Utilization Legend

Use the Mini Map to view your entire SAN at a glance and to navigate the more
detailed map views. This option can be especially helpful if you have many
devices connected to your SAN.

The Mini Map appears in the lower right-hand corner of the SANavigator main
window.

To facilitate the navigation of your SAN, the Mini Map displays switches as

squares and storage devices as circles. Triangles are reserved for other devices,
such as host bus adapters or routers. See [Figure 42

® — | —®

Figure 42. Mini Map

To move within the view of a map, perform one of the following actions:

¢ Click inside the green-outlined box, which represents the boundaries of the map
window, and drag the box to the area you want to view.

* Click the area in the Mini Map that you want to view and the green-outlined
box will automatically move to that area.

To change the size of the Mini Map, perform one of the following actions:
* Drag the adjoining dividers.
* Click the small triangles on the adjoining dividers.

You can also anchor or float the Mini Map to customize your desktop. To float the
Mini Map and view it in a separate window, click the Detach button in the upper
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right-hand corner of the Mini Map. This will detach the Mini Map and place it on
the desktop. At this time you can scale the Mini Map to the desired size to
facilitate navigation of your SAN.

To return the Mini Map to its original location on the SANavigator desktop, click
the Attach button in the upper right-hand corner of the Mini Map or click the
Close button in the upper right-hand corner of the Mini Map. When in the
Performance mode (Premium feature), the Utilization legend (shown in
displays to the left of the Mini Map. The legend displays the percentage ranges
indicated by the color of each dashed line in the Physical map. When I/Os are
active, the path of the data flow displays in accordance with the bandwidth
utilization legend for that path.

e s e w1 10 1010
B0 to 80
40 to 60
— 21 10 41

a
Legend % LHilization

Figure 43. Utilization legend

In the same manner as the Mini Map, the Utilization legend box can be detached
onto the desktop.

Event Log

All configuration actions made by users are listed as events in the Event Log. The
Event Log appears in the lower left of the SANavigator main window.

The Event Log lists SNMP trap events and SANavigator server and device events

(online, offline, user action, client/server, or performance). The log lists the
following three levels of events:

e Fatal

| ©

* Warning

-
S
(oL
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e Information
|k \}_&"ll

You can sort the Event Log on any column by clicking the column header.

You can filter the Event Log to include or exclude specific types and levels of
events. Click the Define link to define the events you want to display. You can also
define which device event log you want displayed depending on the View you
selected (see [“Physical Map view buttons” on page 124). You can select Devices in
view (those on the current Physical Map) or All devices (those in the current
Physical Map as well as those in all other Fabric for this SAN).

You can locate in the Physical Map the device logged in the Event Log. Click the
device in the log and it will be highlighted automatically on the Physical Map.

If you are experiencing problems with the server, examine the server log for
diagnostic information. The default location for the server event log is:
..\SANavigator3.1\Server\Local_Root\
SANavigatorEventStorageProvider\event.1og).

To examine the event log for the SAN, look at the discovered SAN event log (the
default location for the discovered SAN event log is:
\SANavigator3.1\Server\Universe_Home\TestUniverse\_Working\
SANavigatorEventStorageProvider\event.log).

Note: The date and time need to be reasonably accurate on PCs where
SANavigator is deployed. If the client and server time differ significantly,
there might be problems displaying real-time performance data. Consult
your user manual to see how to set the time and date.

Clearing the Event Log

You can clear the event log by editing the file event.log. This file is located in

\SANavigator3.1\Server\Universe_Home\TestUniverse\_Working\
SANavigatorEventStorageProvider\

Attention: You lose all Event Log information if you delete the contents of this file.
Make a backup copy of the log file for future reference.

Note: The Event Log shown on the desktop only displays events from the
previous 48 hours. The file event.log includes information before this period.

Device Tree

The Device Tree, located on the View tab of the desktop, displays the names and
properties of all discovered devices and ports. The Device Tree is a quick way to
look up device and port information, including serial numbers and IP addresses.
To display the Device Tree, select the View tab on the SANavigator desktop.

You can sort the Device Tree by clicking a column heading.

The Device Tree can be expanded into a Device List by clicking the
expand/contract arrows on the separator bar (or by using the F9 function key).
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Device List

The Device List displays a list of all discovered devices and their properties. To
display the Device List, select the Device List tab in the upper portion of the main
SANavigator display. A table appears with rows that list all devices and columns
with the following information for each device:

* Label

* System Name
* Device Type
* WW Name

e IP Address

e FC Address
* Vendor

* Model

e Serial Number
* Fabric Name
e Port Count

e Firmware

» Status

* Comments

o Text1

* Text 2

e Text 3

* Text 4

In these last four columns, you can create additional properties, such as physical
location, storage capacity, capital cost, and scheduled maintenance.

Note: You can customize the Device List to remove, move, and add columns,
Perform the following steps:
1. From the View menu, select Create View. Enter a name and description
for the view.
2. From the Selected Columns list, select the Device List columns you want
to move or that you do not want to view.

Editing properties

Editable properties can be edited directly within the device list by double-clicking
the field. (A green triangle indicates that a field is editable.) The table is
automatically updated with each discovery cycle.

Sorting properties

You can sort the list by clicking the title bar of the desired column. Each click will
cycle through the following sort options: Ascending, Descending, Discovery
sequence. You can sort on multiple columns by selecting the desired columns with
the Control key pressed.

Locating devices in the Physical Map
With both the Device Tree and the Physical Map displayed, click a device name in
the Device Tree and the device will be highlighted in the Physical Map.
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Event Notification

SANavigator receives, monitors, and generates several types of events that it posts
to the event log. To receive e-mail when events occur, perform the following
actions:

1. Set up event notification to define the mail server, enter the reply to address,
and set the frequency that e-mail is sent to users.

2. Create a SANavigator server user for each of the e-mail recipients and ensure
that their e-mail addresses are correct.

3. Configure an event filter for each recipient so that they are notified only about
the events of interest to them.

For more information, see the SANavigator Help.

Generating, viewing, and printing reports

SANavigator provides you with the capability to generate, view, and print reports.
Generated reports are saved in \SANavigator3.1\Server\Reports\ folder. Exported
reports are saved in the \SANavigator3.1\Client\Data\ folder.

Generating reports

To generate a report select Monitor -> Reports -> Generate in the Menu bar. The
Select Template dialog box displays. Select the information you want to include in
the report. Click OK. SANavigator will begin generating the report. The time it
takes to generate a report is dependent on the size of the SAN.

Viewing a report
The Report Viewer is similar to the Java Help Viewer. The left frame displays a

tree structure that you can use to navigate through reports. In the Menu bar, select
Monitor -> Reports -> View. The SANavigator Reports dialog box displays.

Select one of the following options to view a report:
* Report Type

Reports are grouped according to their report type (for example, "Performance
Data”, "Plan Evaluation”).

* User
Reports are grouped according to the user who generated the report.

e Time
Reports are grouped according to the time and date that the report was
generated.

Exporting reports
To export reports, perform the following steps

1. Select Export from the SAN menu. The Export dialog box displays a list of file
types that can be exported along with their sizes.

Note: Report files will be zipped for convenient e-mail and disk transfer. The
zip file name will be preceded with "rep”, followed by the export’s time
stamp (for example, rep010904115344.zip). Report files will be in
standard HTML format.

2. From the Export To list, select one of the following options:

e Disk
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Saves the exported files to the disk on: ...\ SANavigator3.1\Client\Data\
* E-mail

Mails the exported files as an e-mail attachment directly from the application
¢ Database

Not available when exporting reports

3. Select the Reports option, then click Select Reports. The Selects Reports dialog
box displays.
a. Select the desired reports. To select multiple files, make sure the folders are
fully expanded and press <CTRL> while selecting the reports.

b. ClickOK.

4. On the Export dialog box, click OK. To export to more than one destination,
click Apply after configuring each option to save the changes.

5. Click OK when you are finished.

Deleting a report
To delete a generated report, perform the following actions:
1. Browse to the ...\SANavigator2.x\Client\Reports\ folder.
2. Select the files or folders you want to delete.

Note: Images associated with a report will be stored in a folder that has the
same name as the report.

3. Delete the files.

Printing a report

In the SANavigator Reports dialog box, click the Show in Browser button. In the
Internet browser window, select Print from the File menu.

Note: Set up the printer to print in landscape format to ensure that all information
fits on the page.

Device properties

Use the Device Properties dialog box (see [Figure 44 on page 131)) to view and edit
the properties of a device. You can change the device type when the device is not
directly discovered. Devices that are not directly discovered are usually reported to
SANavigator by other SAN devices (such as a switch). However, some discovered
properties are editable. The vendor can be discovered, but it is always still editable.

Important: Changing the Vendor field of a device disables the auto-launch of
applications for that device.
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Figure 44. Device Properties window

Note: The vendor name in the Properties dialog box must match the vendor name
in the Device Application command in order to launch applications.

To display device properties, right-click the device icon in the Physical Map panel
and click Properties in the pop-up menu, or select the device and click Edit ->
Properties. A dialog box appears with up to three tabs at the top: Common,
Adapter, and Port.

Note: The Adapter and Port tabs are available only if In-Band discovery is
performed; their properties cannot be edited.

Discovery troubleshooting guide

If the SANavigator tool is having difficulty discovering your SAN, or if you
received an error message, there might be one of several problems. This section
lists the most common problems and offers solutions on how to correct them. The
list begins with the simplest problems and moves on to more complex ones.
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* Problem: Discovery is turned off.

Solution: Click Discover -> On from the desktop window.
Problem: Discovery not enabled.

Solution: Perform the following steps:

1. Click Discover -> Setup from the desktop menu bar.

2. Click the General tab on the Discover Setup dialog box.

3. Select the Out-of-Band Discovery check box or the In-Band Discovery check
box, or both.

4. Click OK.

Problem: HBAs are not active for In-Band Discovery.

Solution: Perform the following steps:

1. Click Discover -> Setup from the desktop window.

Click the General tab on the Discover Setup dialog box.

Select the In-Band Discovery check box.

Click the Active column for each HBA you would like to discover.
Click OK.

ok~ wbd

Note: If you cannot set in-band discovery on, check to see whether the HBA
API library has been installed. Click Start -> Settings -> Control Panel
-> Add/Remove Programs and look for the Qlogic SAN/Device
Management entry in the program list.

Problem: Server not found or server not available.

Solution: Verify that the server IP address is present and correct in the
Out-of-band panel of the Discovery Set Up dialog box. All SAN devices should
be on the same subnet as the server. If the server has multiple Network Interface
Cards (NICs), then include their IP address in the Out-of-band panel.

Note: Firewalls might prevent server discovery.

Problem: Switches not connected to LAN.

Solution: Check your physical cables and connectors.

Problem: Unable to detect tape devices attached to a SAN Data Gateway Router.

Solution: Verify that the SAN Data Gateway Router is connected to the network
and that its IP address is set to the same subnet as your server.

Problem: No subnets or addresses selected.

Solution: Perform the following steps:

1. Click Discover -> Setup from the desktop window.

2. Click the Out-of-Band tab on the Discover Setup dialog box.

3. Click the subnet or individual address you would like to discover in the
Available Addresses pane.

4. Click the right arrow (>) to move your choice to the Selected Subnets pane,
or to the Selected Individual Addresses pane.

5. Click OK.

Problem: The wrong IP addresses are selected.

Solution: Perform the following steps:

1. Click Discover -> Setup from the desktop window.

2. Click the Out-of-Band tab on the Discover Setup dialog box.

3. Verify that the IP addresses in the Selected Subnets and Selected Individual
Addresses panes are the correct current addresses for your SAN.
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4. Click OK.
* Problem: The wrong community strings are selected.
Solution: Perform the following steps:
1. Click Discover -> Setup from the desktop window.
Click the Out-of-Band tab on the Discover Setup dialog box.
Select an IP address.
Click Change.
Make your community strings selection.
6. Click OK.

* Problem: Broadcast request is blocked by routers.

S A

Solution: Depending upon the information available about the required IP
addresses, choose one of the following three solutions to this problem:

— If you know the IP addresses and the addresses are not listed in the Available
Addresses pane:

Click Discover -> Setup from the desktop window.

Click the Out-of-Band tab on the Discover Setup dialog box.
Click Add.

Type the required data in the dialog box.

Click OK. Repeat as needed until all your addresses are available.

I

Select the IP Addresses you want to discover in the Available Addresses
pane.

7. Click the right arrow (>) to move your choices to the Selected Individual
Addresses pane.

8. Click OK.

— If you know the IP addresses and the addresses are listed in the Available
Addresses pane:

1. Click Discover -> Setup from the desktop window.
2. Click the Out-of-Band tab on the Discover Setup dialog box.

3. Select the IP Addresses you would like to discover in the Available
Addresses pane.

4. Click the right arrow (>) to move your choices to the Selected Individual
Addresses pane.

5. Click OK.

— If you do not know the specific IP addresses:
1. Click Discover -> Setup from the menu of the desktop window.
2. Click the Out-of-Band tab on the Discover Setup dialog box.

3. Click the Method column for the selected subnet in the Selected Subnets
pane and choose Sweep.

4. Click OK.
The sweep method significantly increases your discovery time.
* Problem: Discovery time is excessive.
Solution 1: Perform the following steps:
1. Click Discover -> Setup from the desktop window.
2. Click the Out-of-Band tab on the Discover Setup dialog box.

3. Click the Method column in the Selected Subnets pane and choose
Broadcast.

4. Click OK.
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Solution 2: In most cases, decreasing the SNMP time-out will decrease the
discovery time.
* Problem: The server does not seem to be starting.

Action: Examine the server log
(\SANavigator2.x\Server\Data\SANs\server.log) for diagnostic information.
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Chapter 6. PD hints: Common path/single path configurations

You should be referred to this chapter from a PD map or indication. If this is not

the case, see [Chapter 2, “Problem determination starting points,” on page 3)

After you read the relevant information in this chapter, return to [“Common Path|

IPD map 1” on page 24|

In the HBA, HBA-to-concentrator cable, and the port that this cable uses

are on the common path to all storage. The other cables and ports to the
controllers are on their own paths so that a failure on them does not affect the

others. This configuration is referred to as single path.
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Figure 45. Common path configuration
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Chapter 7. PD hints: RAID controller errors in the Windows

NT event log

You should be referred to this chapter from a PD map or indication. If this is not
the case, see [Chapter 2, “Problem determination starting points,” on page 3/

After you read the relevant information in this chapter, return to |“RAID Controlled
[Passive PD map” on page 11

This chapter presents general guidelines that explain the errors that can appear in
an event log and what actions to perform when these errors occur.

Note: If you have a system running on Windows NT 4.0, the driver is listed as
SYMarray. If you have a system running on Windows 2000, the driver is
listed as RDACFLTR.

Common error conditions

* Getting a series of SYMarray event ID 11s in the Windows NT event log

Open and review the event log. A series of event ID 11s generally indicates a
number of bus resets and might be caused by a bad host bus adapter or a bad
cable.

* Getting a series of SYMarray event ID 11s and 18s in the Windows NT event
log
Open and review the event log. A series of event ID 11s generally indicates LIPs
(Loop resets). This generally indicates a bad fibre path. It could be an indication
of a problem with a GBIC, an MIA, or an adapter.
Event ID 18s indicate that RDAC failed a controller path. The fault will most
likely be a component in the fibre path, rather than the controller.

* Getting a series of SYMarray event ID 15s in the Windows NT event log

This error is undocumented. A series of event ID 15s indicates that the link is
down. The problem is generally within the Fibre path.

Event log details

In addition to reviewing the SYMplicity Storage Manager log, you can choose to
review the Windows NT event log, which is viewed in a GUI environment (see
. To open the event log, click Start -> Programs -> Administrative Tools
-> Event Viewer.

Date ‘Time Source Category |Event |User
22294 4:35:25 AM Symarray Maone 1 A
@ 2/21949 11:34:35 P Symarray Maone 1 A
§2/18/99 124745 AM SMMP Mone 100 M,

Figure 46. Event log

[Table 11 on page 13§ lists the most common, but not necessarily the only, event IDs
encountered in a SYMarray (RDAC) event.
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Table 11. Common SYMarray (RDAC) event IDs

Event

Microsoft Label Identifier

Description

9

IO_ERR_TIMEOUT

The device %s did not respond within timeout period.

11

IO_ERR_CONTROLLER_ERROR

Driver detected controller failure.

16

ERR_INVALID_REQUEST

The request is incorrectly formatted for %1.

18

IO_LAYERED_FAILURE

Driver beneath this layer failed.

389

STATUS_IO_DEVICE_ERROR

The 1I/0 device reported an I/O error.

138

Event ID 18 is a special case. SYMarray uses event ID 18 to designate a failed
controller path. (The controller on the physical path is the failed controller.) All
LEDs on the controller are usually lit when a failure occurs. This does not
necessarily mean that the controller is defective, but rather that a component along
the path to the controller is generating errors. Possible problem components
include the host adapter, fibre cable, GBIC, hub, and so on.

In a multi-node cluster with multiple event ID 18s, the earliest log entry most
likely initiated the original controller failure. Event ID 18s on other nodes were
most likely responses to the original failure and typically contain an SRB status of
(0x0a - SCSI Selection Timeout). Check the system date and time stamp for
synchronization to validate which entry occurred first. To review an entry in the
Event Viewer, perform the following steps:

1. Double-click the entry you want to review.
2. Select the Words radio button to convert the bottom text from bytes to words.

See

Event Detail E3

Diate: 9/9/939 EventID: 18

Tirne: 7.07:06 PM Sowce  smaray

User: NA4 Tope: Eni

Computer: NODEE Category, Mone:

Bescriphion;

The description far Even |D[1E}1h5amm§¥mmay |couldnotbe = |

found It contans the fallowing inserban
A\Device\H arddizk 1 \Parlitiond.

10107 -eeagi122300000000 00000000 O
Iits l!lll DOO0ETOS, 0 oooaooa
0030. 00000001 nuu 0000900 DODODOOD

"

Cose | Provious |  Nea |  Hep |

Figure 47. Event detail

A. The last 4 digits (2 bytes) in this field indicate the unique error value. In this
example, the error value shown indicates a Controller Failover Event.
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B. For Event ID 18, this offset represents the SCSI operation that was attempted
when the failover event took place.

Table 12. Unique error value - Offset 0x0010

Unique Error Value - Offset 0x0010

Value |Meaning Value |Meaning

100 Media Error (check condition) 110 Device Not Ready (check condition)

101 Hardware Error (check condition) 111 No Sense (check condition)

102 Recovered Error (check condition) 112 Unrecognized Sense Key

103 Default - Controller Error 113 Error being returned to system that would otherwise not
be logged

105 Command Aborted or Timed Out 114 SCSI Release Configuration Error, Multiple paths to the
same controller

106 Phase Sequence Error 115 SCSI Reserve Configuration Error, Multiple paths to the
same controller

107 Request Flushed 116 The driver has discovered more paths to a controller than
are supported (four are supported)

108 Parity Error or Unexpected Bus Free |117 The driver has discovered devices with the same WWN
but different LUN numbers

109 SCSI Bus Error Status (busy, queue 122 Controller Failover Event (alternate controller/path failed)

full, and so on)

10a Bus Reset 123 A path to a multipath controller failed

10e Aborted Command (check condition) |124 A controller failover failed

10f Illegal Request (check condition) 125 A Read/Write error has been returned to the system

The example shown in|Figure 4§ is a recovered drive timeout error on drive 2, 1.

&

Data  Bytes & Words
' SFTTAN006=0001 00000000 cO00

0030; 00000000 0OODOSON unn_

00000001 0000QOQ0 2

062000 15006 -]
0000000 QoOOOOOO 00 Al0000 C

(2101d0gs)

_I_J

A

Figure 48. Unique error value example

A. This error indicates (according to the error codes listed in [Table 12) a recovered

error.

B. This bit indicates validity of the following word. A number 8 means field C is a
valid sense key. A number other than 8 means that field C is not valid and should

be disregarded.
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C. This word represents the FRU code, SCSI sense key, ASC and ASCQ.

ffkkaaqq -

ff = FRU code kk = SCSI sense key aa = ASC qq = ASCQ

Sense Key table

lists Sense Key values and descriptions.
Table 13. Sense Key table

SENSE KEY DESCRIPTION

0x00 No Sense

0x01 Recovered Error

0x02 Not Ready

0x03 Medium Error

0x04 Hardware Error

0x05 Illegal Request

0x06 Unit Attention

0x07 Data Protect (Not Used)
0x08 Blank Check (Not used)
0x09 Vendor Specific (Not used)
0x0A Copy Aborted (Not used)
0x0B Aborted Command

0x0C Equal (Not used)

0x0D Volume Overflow (Not used)
0xOE Miscompare

0xOF Reserved (Not used)

ASC/ASCQ table

This section lists the Additional Sense Codes (ASC) and Additional Sense Code
Qualifier (ASCQ) values returned by the array controller in the sense data. SCSI-2
defined codes are used when possible. Array-specific error codes are used when
necessary, and are assigned SCSI-2 vendor-unique codes 80 through FFH. More
detailed sense key information can be obtained from the array controller command
descriptions or the SCSI-2 standard.

Codes defined by SCSI-2 and the array vendor-specific codes are shown in
Table 14 The sense keys most likely to be returned for each error are also listed in
the table.

Table 14. ASC/ASCQ values

Sense
ASC ASCQ |Key Description

00 00 0 No Additional Sense Information The controller has no sense data available for the
requesting host and addressed logical unit combination.
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Table 14.

ASC/ASCQ values (continued)

ASC

ASCQ

Sense
Key

Description

04

01

2

Logical Unit is in the Process of Becoming Ready

The controller is running its initialization functions on the addressed logical unit. This
includes drive spinup and validation of the drive and logical unit configuration
information.

04

02

Logical Unit Not Ready, Initializing Command Required

The controller is configured to wait for a Start Stop Unit command before spinning up
the drives, but the command has not yet been received.

04

04

Logical Unit Not Ready, Format In Progress

The controller previously received a Format Unit command from an initiator, and is in
the process of running that command.

04

81

Storage Module Firmware Incompatible - Manual Code Synchronization Required

04

Al

Quiescence Is In Progress or Has Been Achieved

0C

00

Unrecovered Write Error

Data could not be written to media due to an unrecoverable RAM, battery, or drive
error.

0C

00

Caching Disabled

Data caching has been disabled due to loss of mirroring capability or low battery
capacity.

0C

01

Write Error Recovered with Auto Reallocation

The controller recovered a write operation to a drive and no further action is required
by the host. Auto reallocation might not have been used, but this is the only standard
ASC/ASCQ that tells the initiator that no further actions are required by the driver.

0C

80

4, (6)

Unrecovered Write Error Due to Non-Volatile Cache Failure

The subsystem Non-Volatile cache memory recovery mechanisms failed after a power
cycle or reset. This is possibly due to some combination of battery failure, alternate
controller failure, or a foreign controller.

User data might have been lost.

0C

81

4, (6)

Deferred Unrecoverable Error Due to Memory Failure
Recovery from a Data Cache error was unsuccessful.

User data might have been lost.

11

00

Unrecovered Read Error

An unrecovered read operation to a drive occurred and the controller has no
redundancy to recover the error (RAID 0, degraded RAID 1, degraded mode RAID 3,
or degraded RAID 5).

11

8A

Miscorrected Data Error - Due to Failed Drive Read

A media error has occurred on a read operation during a reconfiguration operation.

User data for the LBA indicated has been lost.
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Table 14.

ASC/ASCQ values (continued)

ASC

ASCQ

Sense
Key

Description

18

02

1

Recovered Data - Data Auto Reallocated

The controller recovered a read operation to a drive and no further action is required
by the host. Auto reallocation might not have been used, but this is the only standard
ASC/ASCQ that tells the initiator that no further actions are required by the driver.

1A

00

Parameter List Length Error

A command was received by the controller that contained a parameter list and the list
length in the CDB was less than the length necessary to transfer the data for the
command.

20

00

Invalid Command Operation Code

The controller received a command from the initiator that it does not support.

21

00

Logical Block Address Out of Range

The controller received a command that requested an operation at a logical block
address beyond the capacity of the logical unit. This error could be in response to a
request with an illegal starting address or a request that started at a valid logical
block address and the number of blocks requested extended beyond the logical unit
capacity.

24

00

Invalid Field in CDB

The controller received a command from the initiator with an unsupported value in
one of the fields in the command block.

25

00

Logical Unit Not Supported

The addressed logical unit is currently unconfigured. An Add LUN operation in the
Logical Array Mode Page must be run to define the logical unit before it is accessible.

26

00

Invalid Field in Parameter List

The controller received a command with a parameter list that contained an error.
Typical errors that return this code are unsupported mode pages, attempts to change
an unchangeable mode parameter, or attempts to set a changeable mode parameter to
an unsupported value.

28

00

Not Ready to Ready Transition

The controller has completed its initialization operations on the logical unit and it is
now ready for access.

29

00

Power On, Reset, or Bus Device Reset Occurred

The controller has detected one of the above conditions.

29

04

Device Internal Reset

The controller has reset itself due to an internal error condition.

29

81

(6)

Default Configuration has been Created

The controller has completed the process of creating a default logical unit. There is
now an accessible logical unit that did not exist previously. The host should run its
device scan to find the new logical unit.

29

82

Controller Firmware Changed Through Auto Code Synchronization

The controller firmware has been changed through the Auto Code Synchronization
(ACS) process.
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Table 14. ASC/ASCQ values (continued)

Sense

ASC ASCQ |Key Description

2A 01 6 Mode Parameters Changed
The controller received a request from another initiator to change the mode
parameters for the addressed logical unit. This error notifies the current initiator that
the change occurred.
This error might also be reported in the event that Mode Select parameters changed
as a result of a cache synchronization error during the processing of the most recent
Mode Select request.

2A 02 6 Log Parameters Changed
The controller received a request from another initiator to change the log parameters
for the addressed logical unit. This error notifies the current initiator that the change
occurred.
This error is returned when a Log Select command is issued to clear the AEN log
entries.

2F 00 6 Commands Cleared by Another Initiator
The controller received a Clear Queue message from another initiator. This error is to
notify the current initiator that the controller cleared the current initiators commands
if it had any outstanding.

31 01 1,4 Format Command Failed
A Format Unit command issued to a drive returned an unrecoverable error.

32 00 4 Out of Alternates
A Re-assign Blocks command to a drive failed.

3F 01 (6) Drive micro-code changed

3F OE 6 Reported LUNs data has changed

Previous LUN data reported using a Report LUNs command has changed (due to
LUN creation or deletion or controller hot-swap).
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Table 14. ASC/ASCQ values (continued)

ASC

ASCQ

Sense
Key

Description

3F

8N

(6)

Drive No Longer Usable

The controller has set a drive to a state that prohibits use of the drive. The value of N
in the ASCQ indicates the reason why the drive cannot be used.

0 - The controller set the drive state to "Failed - Write failure”
1 - Not used

2 - The controller set the drive state to "Failed” because it was unable to make the
drive usable after replacement. A format or reconstruction error occurred.

3 - Not used

4 - Not used

5 - The controller set the drive state to "Failed - No response”

6 - The controller set the drive state to "Failed - Format failure”

7 - The controller set the drive state to "User failed via Mode Select”

8 - Not used

9 - The controller set the drive state to "Wrong drive removed/replaced”
A - Not used

B - The controller set the drive state to "Drive capacity < minimum”

C - The controller set the drive state to "Drive has wrong block size”

D - The controller set the drive state to "Failed - Controller storage failure”

E - Drive failed due to reconstruction failure at Start of Day (SOD)

3F

98

(6)

Drive Marked Offline Due to Internal Recovery Procedure

An error has occurred during interrupted write processing causing the LUN to
transition to the Dead state. Drives in the drive group that did not experience the read
error will transition to the Offline state (0xOB) and log this error.

3F

BD

(6)

The controller has detected a drive with Mode Select parameters that are not
recommended or which could not be changed. Currently this indicates the QErr bit is
set incorrectly on the drive specified in the FRU field of the Request Sense data.

3F

C3

(6)

The controller had detected a failed drive side channel specified in the FRU Qualifier
field.

3F

c7

(6)

Non-media Component Failure

The controller has detected the failure of a subsystem component other than a disk or
controller. The FRU codes and qualifiers indicate the faulty component.

3F

C8

(6)

AC Power Fail

The Uninterruptible Power Source has indicated that ac power is no longer present
and the UPS has switched to standby power.

3F

9

(6)

Standby Power Depletion Imminent

The UPS has indicated that its standby power source is nearing depletion. The host
should take actions to stop 1O activity to the controller.
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Table 14. ASC/ASCQ values (continued)
Sense

ASC ASCQ |Key Description

3F CA (6) Standby Power Source Not at Full Capability
The UPS has indicated that its standby power source is not at full capacity.

3F CB (6) AC Power Has Been Restored
The UPS has indicated that ac power is now being used to supply power to the
controller.

3F DO (6) Write Back Cache Battery Has Been Discharged
The controllers battery management has indicated that the cache battery has been
discharged.

3F D1 (6) Write Back Cache Battery Charge Has Completed
The controllers battery management has indicated that the cache battery is
operational.

3F D8 (6) Cache Battery Life Expiration
The cache battery has reached the specified expiration age.

3F D9 (6) Cache Battery Life Expiration Warning
The cache battery is within the specified number of weeks of failing.

3F EO (6) Logical Unit Failure
The controller has placed the logical unit in a Dead state. User data, parity, or both
can no longer be maintained to ensure availability. The most likely cause is the failure
of a single drive in non-redundant configurations or a second drive in a configuration
protected by one drive. The data on the logical unit is no longer accessible.

3F EB (6) LUN marked Dead due to Media Error Failure during SOD
An error has occurred during interrupted write processing causing the LUN to
transition to the Dead state.
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Table 14. ASC/ASCQ values (continued)

Sense

ASC ASCQ |Key Description

40 NN 4, (6) Diagnostic Failure on Component NN (0x80 - 0xFF)
The controller has detected the failure of an internal controller component. This failure
might have been detected during operation as well as during an on-board diagnostic
routine. The values of NN supported in this release of the software are as follows:
80 - Processor RAM
81 - RAID Buffer
82 - NVSRAM
83 - RAID Parity Assist (RPA) chip or cache holdup battery
84 - Battery Backed NVSRAM or Clock Failure
91 - Diagnostic Self Test failed non-data transfer components test
92 - Diagnostic Self Test failed data transfer components test
93 - Diagnostic Self Test failed drive Read/Write Buffer data turnaround test
94 - Diagnostic Self Test failed drive Inquiry access test
95 - Diagnostic Self Test failed drive Read/Write data turnaround test
96 - Diagnostic Self Test failed drive Self Test

43 00 4 Message Error
The controller attempted to send a message to the host, but the host responded with a
Reject message.

44 00 4, B Internal Target Failure
The controller has detected a hardware or software condition that does not allow the
requested command to be completed. If the sense key is 0x04, indicating a hardware
failure, the controller has detected what it believes is a fatal hardware or software
failure and it is unlikely that a retry would be successful. If the sense key is 0x0B,
indicating an aborted command, the controller has detected what it believes is a
temporary software failure that is likely to be recovered if retried.

45 00 1,4 Selection Time-out on a Destination Bus
A drive did not respond to selection within a selection time-out period.

47 00 1,B SCSI Parity Error
The controller detected a parity error on the host SCSI bus or one of the drive SCSI
buses.

48 00 1,B Initiator Detected Error Message Received
The controller received an Initiator Detected Error Message from the host during the
operation.

49 00 B Invalid Message Error
The controller received a message from the host that is not supported or was out of
context when received.

49 80 B Drive Reported Reservation Conflict
A drive returned a status of reservation conflict.
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Table 14. ASC/ASCQ values (continued)
Sense

ASC ASCQ |Key Description

4B 00 1,4 Data Phase Error
The controller encountered an error while transferring data to or from the initiator or
to or from one of the drives.

4E 00 B Overlapped Commands Attempted
The controller received a tagged command while it had an untagged command
pending from the same initiator or it received an untagged command while it had one
or more tagged commands pending from the same initiator.

5D 80 6 Drive Reported PFA (Predicted Failure Analysis) Condition

80 02 1,4 Bad ASC code detected by Error/Event Logger

80 03 4 Error occurred during data transfer from SRM host.

84 00 4,5 Operation Not Allowed With the Logical Unit in its Current State
The requested command or Mode Select operation is not allowed with the logical unit
in the state indicated in byte 76 of the sense data. Examples would be an attempt to
read or write a dead logical unit or an attempt to verify or repair parity on a
degraded logical unit.

84 06 4 LUN Awaiting Format
A mode select has been done to create a LUN but the LUN has not been formatted.

85 01 4 Drive IO Request Aborted
IO Issued to Failed or Missing drive due to recently failed removed drive. This error
can occur as a result of IOs in progress at the time of a failed or removed drive.

87 00 4 Microcode Download Error
The controller detected an error while downloading microcode and storing it in
non-volatile memory.

87 08 4 Incompatible Board Type For The Code Downloaded

87 0C 6 Download failed due to UTM LUN number conflict

87 OE 6 Controller Configuration Definition Inconsistent with Alternate Controller

88 0A (6) Subsystem Monitor NVSRAM values configured incorrectly

8A 00 5 Illegal Command for Drive Access
The initiator attempted to pass a command through to a drive that is not allowed. The
command could have been sent in pass-thru mode or by attempting to download
drive microcode.

8A 01 5 Illegal Command for the Current RAID Level
The controller received a command that cannot be run on the logical unit due to its
RAID level configuration. Examples are parity verify or repair operations on a RAID 0
logical unit.

8A 10 5 Illegal Request- Controller Unable to Perform Reconfiguration as Requested
The user requested a legal reconfiguration but the controller is unable to run the
request due to resource limitations.

8B 02 B, (6) Quiescence Is In Progress or Has Been Achieved

8B 03 B Quiescence Could Not Be Achieved Within the Quiescence Timeout Period

8B 04 5 Quiescence Is Not Allowed
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Table 14.

ASC/ASCQ values (continued)

ASC

ASCQ

Sense
Key

Description

8E

01

E, (6)

A Parity /Data Mismatch was Detected

The controller detected inconsistent parity/data during a parity verification.

91

00

General Mode Select Error

An error was encountered while processing a Mode Select command.

91

03

Illegal Operation for Current Drive State

A drive operation was requested through a Mode Select that cannot be run due to the
state of the drive. An example would be a Delete Drive when the drive is part of a
LUN.

91

09

Illegal Operation with Multiple SubLUNs Defined

An operation was requested that cannot be run when multiple SubLUNs are defined
on the drive.

91

33

Illegal Operation for Controller State

The requested Mode Select operation could not be completed due to the current state
of the controller.

91

36

Command Lock Violation

The controller received a Write Buffer Download Microcode, Send Diagnostic, or
Mode Select command, but only one such command is allowed at a time and there
was another such command active.

91

3B

Improper LUN Definition for Auto-Volume Transfer mode - AVT is disabled.

Controller will operate in normal redundant controller mode without performing
Auto-Volume transfers.

91

50

Illegal Operation For Drive Group State

An operation was requested that cannot be run due to the current state of the Drive
Group.

91

51

Illegal Reconfiguration Request - Legacy Constraint

Command could not be completed due to Legacy configuration or definition
constraints.

91

53

Illegal Reconfiguration Request - System Resource Constraint

Command could not be completed due to resource limitations of the controller.

94

01

Invalid Request Due to Current Logical Unit Ownership

95

01

Extended Drive Insertion/Removal Signal

The controller has detected the drive insertion/removal signal permanently active.

95

02

(6)

Controller Removal/Replacement Detected or Alternate Controller Released from
Reset

The controller detected the activation of the signal or signals used to indicate that the
alternate controller has been removed or replaced.

98

01

(6)

The controller has determined that there are multiple sub-enclosures with the same ID
value selected.

98

02

(6)

Sub-enclosure with redundant ESMs specifying different Tray IDs

98

03

(6)

Sub-enclosure ESMs have different firmware levels
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Table 14. ASC/ASCQ values (continued)
Sense
ASC ASCQ |Key Description
A0 00 (6) Write Back Caching Could Not Be Enabled
The controller could not perform write-back caching due to a battery failure or
discharge, Two Minute Warning signal from the UPS, or an ICON failure.
Al 00 (6) Write Back Caching Could Not Be Enabled - RDAC Cache Size Mismatch
The controller could not perform write back caching due to the cache sizes of the two
controllers in the RDAC pair not matching.
A4 00 (6) Global Hot Spare Size Insufficient for All Drives in Subsystem.
A defined Global Hot Spare is not large enough to cover all of the drives present in
the subsystem. Failure of a drive larger than the Global Hot Spare will not be covered
by the Global Hot Spare drive.
Ab 00 (6) Recovered processor memory failure
The controller has detected and corrected a recoverable error in processor memory.
A7 00 (6) Recovered data buffer memory error
The controller has detected and corrected a recoverable error in the data buffer
memory.
Sense bytes 34-36 will contain the count of errors encountered and recovered.
Co0 00 4, (6) The Inter-controller Communications Have Failed
The controller has detected the failure of the communications link between redundant
controllers.
DO 06 4 Drive IO Time-out
The controller destination IO timer expired while waiting for a drive command to
complete.
D1 0A 4 Drive Reported Busy Status
A drive returned a busy status in response to a command.
EO XX 4 Destination Channel Error
XX = 00 through 07 indicates the Sense Key returned by the drive after a check
condition status
XX = 10 indicates that a bus level error occurred
EO XX 6 Fibre Channel Destination Channel Error
XX = 20 indicates redundant path is not available to devices
XX = 21 indicates destination drive channels are connected to each other
Sense Byte 26 will contain the Tray ID.
Sense Byte 27 will contain the Channel ID.
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FRU code table

A nonzero value in the FRU code byte identifies a FRU that failed or a group of
field-replaceable modules that includes one or more failed devices. For some
Additional Sense Codes, the FRU code must be used to determine where the error
occurred. For example, the Additional Sense Code for SCSI bus parity error is
returned for a parity error detected on either the host bus or one of the drive
buses. In this case, the FRU field must be evaluated to determine whether the error
occurred on the host channel or a drive channel.

Because of the large number of replaceable units possible in an array, a single byte
is not sufficient to report a unique identifier for each individual FRU. To provide
meaningful information that will decrease field troubleshooting and problem

resolution time, FRUs have been grouped. The defined FRU groups and their
descriptions are listed in [Table 1

Table 15. FRU codes

FRU code Title Description
0x01 Host Channel Group A FRU group consisting of the host SCSI bus, its SCSI interface chip,
and all initiators and other targets connected to the bus
0x02 Controller Drive A FRU group consisting of the SCSI interface chips on the controller
Interface Group that connect to the drive buses
0x03 Controller Buffer A FRU group consisting of the controller logic used to implement the
Group on-board data buffer.
0x04 Controller Array ASIC | A FRU group consisting of the ASICs on the controller associated with
Group the array functions.
0x05 Controller Other Group | A FRU group consisting of all controller-related hardware not
associated with another group
0x06 Subsystem Group A FRU group consisting of subsystem components that are monitored
by the array controller, such as power supplies, fans, thermal sensors,
and ac power monitors. Additional information about the specific
failure within this FRU group can be obtained from the additional FRU
bytes field of the array sense.
0x07 Subsystem A FRU group consisting of subsystem components that are
Configuration Group configurable by the user, on which the array controller will display
information (such as faults)
0x08 Sub-enclosure Group A FRU group consisting of the attached enclosure devices. This group
includes the power supplies, environmental monitor, and other
subsystem components in the sub-enclosure.
0x09-0x0F Reserved
0x10-0xFF Drive Groups A FRU group consisting of a drive (embedded controller, drive

electronics, and Head Disk Assembly), its power supply, and the SCSI
cable that connects it to the controller; or supporting sub-enclosure
environmental electronics

The FRU code designates the channel ID in the most significant nibble
and the SCSI ID of the drive in the least significant nibble.

Note: Channel ID 0 is not used because a failure of drive ID 0 on this
channel would cause a FRU code of 0x00, which the SCSI-2 standard
defines as no specific unit has been identified to have failed or that the
data is not available.
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Chapter 8. PD hints: Configuration types

You should be referred to this chapter from a PD map or indication. If this is not
the case, see [Chapter 2, “Problem determination starting points,” on page 3)

After you read the relevant information in this chapter, return to the
[“Configuration Type PD map” on page 10|

To simplify a complicated configuration so that it can be debugged readily, reduce
the configuration to subsets that you can use to build the larger configuration. This
process yields two basic configurations. (The type of RAID controller is not
material; FAStT500 is shown in the following examples.) The following two
sections discuss these two basic configurations.

Type 1 configuration

The identifying features of a type 1 configuration (as shown in Figure 49) are:

* Host adapters are connected directly to mini-hubs of Controller A and B, with
one or more host adapters per system.

* Multiple servers can be connected, but without system-to-system failover (no

MSCS).
* Uses some type of isolation mechanism (such as partitions) between server
resources.
FAStT500 RAID Controller Unit
FC host adapter Host side Drive side
- Mini-hub | Ctrl
(Mini-hub | A —{ Mini-hub
—1 Mini-hub
T
FC host adapter -=|_|\4|2|-=h=ug
=— Mini-hub
- Min-hub | Citr] |~ ——————
Minihub | B
|
u
u

Multiple host adapters/servers

Figure 49. Type 1 configuration
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Type 2 configuration

The type 2 configuration can occur with or without hubs and switches, as shown
in [Figure 50| and [Figure 51|

FC host adapter

FAStT500 RAID Controller Unit
.\ Host side Drive side
FC host adapter Mini-hub Ctrl

Minhub | A —{ Mini-hub
Mini-hub
Mini-hub
Mini-hub

ANAAYAN

Mini-hub | Ctrl
—|Mini-hub [ B

—\ FC host adapter

FC host adapter

ANAAYAN

Figure 50. Type 2 configuration - With hubs

The identifying features of a type 2 configuration are:

e Multiple host adapters are connected for full redundancy across systems having
failover support such as MSCS.

* Host adapters are connected either directly to mini-hubs or through managed
hubs or switches (2 GBIC ports per mini-hub are possible).

* A redundant path to mini-hubs can be separated using optional mini-hubs, as
shown in the following figure in red (vs. the green path).

FC host adapter

FAStT500 RAID Controller Unit
.\ Host side Drive side
FC host adapter Mini-hub ctrl

Mnhud | A —{ Mini-hub
Mini-hub
Mini-hub
Mini-hub

\\\\\\

Mini-hub | Ctrl
A Mini-nub | B

~\ FC host adapter

FC host adapter

Figure 51. Type 2 configuration - Without hubs
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Diagnostics and examples

FC host adapter

TR+

—I_- b FAStT500 RAID Controller Unit
&Managed Hub Host side Drive side

Common Path -
Concentrator to HBA

In a type 1 configuration there are no externally managed hubs or switches to aid
in debugging. The diagnostic tools available are FAStT MS]J (from the host adapter
end), the sendEcho command (from the RAID controller end), and SANavigator
(with in-band management). If you intend to diagnose a failed path while using
the alternate path for production, be sure that you are familiar with the tools and
the loop connections so that the correct portion is being exercised and you do not
unplug anything in the active path.

For a type 2 configuration, use the features of the switches and managed hubs and
the capability of MSCS to isolate resources from the bad or marginal path before
beginning debug activities. Switches and managed hubs allow a view of log
information that shows what problems have been occurring, as well as diagnostics
that can be initiated from these managed elements. Also, a type 2 configuration has
the capability to have more than one RAID controller unit behind a switch or
managed hub. In the diagnostic maps, the switches and managed hubs are referred
to generically as concentrators. shows a type 2 configuration with multiple
controller units.

_—p [ Mini-hub Ctrl
e [Vinthab] A Mini-hub
- Mini-hub
'MEEFE‘I‘
h [Minchub | Ctrl Minihuby
Toos] B
n
n
) .
Single Path(s) - FAStT500 RAID Controller Unit
Concentrator to controller(s) Host oido —
___—W [Minihub Ctrl
(Vinihib] A Mini-hub
< Mini-hub
"Mini-hub)
Mini-hub | Ctrl Mini:huby
h iTE] B

Figure 52. Type 2 configuration with multiple controller units

You can also use SANavigator to identify and isolate fibre path and device
problems. SANavigator discovery for a configuration without concentrators
requires that the HBA API Library be installed on the server where SANavigator is
installed and in which the HBAs are located. This is referred to as in-band
management.

For configurations with concentrators, the concentrator (a switch, hub, or router)
must be connected to the same sub-network (through Ethernet) as the server in
order for SANavigator to discover the devices. This is referred to as out-of-band
management.
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Both in-band and out-of-band management can be enabled for a particular SAN
configuration. It is strongly suggested that you enable both management methods.

Debugging example sequence

An example sequence for debugging a type 2 MSCS configuration is shown in the
following sequence of figures.

You can attach multiple server pairs to the switches by using zoning or
partitioning for pair isolation or combinations of type 1 and type 2 configurations.
Break the larger configuration into its smaller subelements and work with each
piece separately. In this way you can remove the good path and leave only the bad
path, as shown in the following sequence.

1. One controller is passive. In the example shown in controller B is
passive.

FC host adapter

FAStT500 RAID Controller Unit

FC
Hﬂg?sﬁi‘:gh Host side Drive side
- FC host adapter poooooo Ii Mini-hub | Ctrl
- [Mini-hub | A — Mini-hub
FC Mini-hub
Managed Mini-hub
Hub/switch Mini-hub
sfulalalsfsf=ls] (Minihub | Ctrl - ===
~\ FC host adapter Mini-hub B

FC host adapter

Figure 53. Passive controller B

2. All I/0 is flowing through controller A. This yields the diagram shown in

for debugging.

FAStT500 RAID Controller Unit

Host side Drive side
FC host adapter
- “‘ M-|n-| hub | Ctrl _
=  Mini-hub |~ A Mini-hub
FC Mini-hub
Managed —
Hub/switch Mini-hub
— Mini-hub
]@:l oooooo Ii_'v“m-hub Ctrl
- | Mini-hub | B
FC host adapter

]

\

Figure 54. All I/O flowing through controller A

3. To see more clearly what is involved, redraw the configuration showing the
path elements in the loop, as shown in [Figure 55 on page 155
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FAStT500 RAID Controller Unit

Host side Drive side
[ ] FChostadapter Mini-hub Ctrl
= Minihdab | A Mini-hub
o FC Mini-hub
Managed Mini-hub
¢ Hublswitch - ® © L
— DooooooQ &) Iinehb] Cirl
 Mini-hub [ B

2200 FC
host adapter

Transceiver / GBIC

Figure 55. Path elements loop

The elements of the paths shown in are as follows:
Host adapter with optical transceiver

Optical transceiver in managed hub or GBIC in switch
GBIC in controller mini-hub

Mini-hub

RAID controller

Optical cables

IR
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Chapter 9. PD hints: Passive RAID controller

You should be referred to this chapter from a PD map or indication. If this is not
the case, see [Chapter 2, “Problem determination starting points,” on page 3)

After you read the relevant information in this chapter, return to |”RAID Controlled
[Passive PD map” on page 11

Use the SM client to view the controller properties of the passive controller, which
appears as a dimmed icon.

As shown in right-click the dimmed controller icon and click Properties.

Cantraller Enclosure

Flace Offline...
Change Mode ¥

List Associated Compaonents
Froperties

Figure 56. Controller right-click menu
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E= Controller Properties X

| Interfaces'

Controller in Slot B

IP address: 192.1658.0.4

Appweare wersion: 04.00.01.00
Bootware version: 04.00.01.00
Status: Optimal

Mode: Active

Board ID: 4766

Froduct ID: 3526

Manufacturer: [B

Serial number: 1790510439

Diate of manufacture: Felbruary 19, 1999
Cachefprocessor size (MB): 128/32

Close | Help |

Figure 57. Controller Properties window

If the Controller Properties view (shown in of the dimmed controller
icon does not include a message about it being cached, then the controller is
passive. Return to the PD map at the page that referred you here
[Controller Passive PD map” on page 11)) and continue.

If the Controller Properties information cannot be retrieved, then call IBM Support.

Perform the following steps when you encounter a passive controller and want to
understand the cause:

1. Check the controller LEDs to verify that a controller is passive and to see
which controller is passive.

2. Look on the system event viewer of the server to find the SYMarray event ID
18. When you find it, write down the date, time, and SRB status. (The SRB
status is found in offset x3A in the Windows NT event log. For an example of
offset x3A, see the fourth row, third column of the figure on page )

3. If multiple servers are involved, repeat step 2 for each server.

4. Look for the first event ID 18 found in step 2. The SRB status provides
information as to why the failure occurred but is valid only if the high order
bit is on (8x, 9x, Ax).

5. Check the history of the event log looking for QL2200/QL2100 events. These
entries will give further clues as to whether the fibre loop was stable or not.

* SRB statuses of 0x0d, 0x0e, and 0x0f point to an unstable loop. (To find the
value, discard the high order "valid” bit. For example, 8d yields an SRB
status of 0d.)

* QL2200/2100 events of 80110000, 80120000 indicate an unstable loop.
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6. If an unstable loop is suspected, diagnose the loop using the fibre path PD
aids (see [“Fibre Path PD map 1” on page 20).

7. If the diagnosis in step 6 does not reveal the problem, then the adapter and
the controller might be the cause. If you determine that the adapter and
controller caused the problem, then reset all fibre components on the path and
retest.

8. If fibre cabling can be rearranged, swap the adapter cabling so that the
adapter communicating to controller A is now connected to controller B (and
vice-versa).

Note: Do not do this in a system that is still being used for business. It is
useful for bring-up debug.

9. When the problem is resolved, set the controller back to active and rebalance
the logical drives.

10. If the problem occurred as the result of an I/O condition, then rerun and
determine whether the failure reoccurs.

Note: If the failure still occurs, then you need to perform further analysis,
including the use of the serial port to look at loop statuses. The previous
steps do not include consideration of switches or managed hubs. If these are
included, then see [“Hub/Switch PD map 1” on page 15| for helpful tools.
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Chapter 10. PD hints: Performing sendEcho tests

You should arrive at this chapter from a PD map or indication. If this is not the
case, see [Chapter 2, “Problem determination starting points,” on page 3

After you read the relevant information in this chapter, return to [“Single Path Fail|
IPD map 1” on page 22|

The 3526 controllers use MIA copper-to-optical converters, while the 3542, 3552,
and 1742 controllers use GBICs. There are times when these devices, and their
corresponding cable mediums, need to be tested to insure that they are functioning

properly.

Note: Running the loopback test for a short period of time might not catch
intermittent problems. It might be necessary to run the test in a continuous
loop for at least several minutes to track down intermittent problems.

Setting up for a loopback test
This section describes how to set up for a loopback test.

Loopback test for MIA or mini-hub testing
Perform the following steps to set up a loopback test:
1. Remove the fiber-optic cable from the controller MIA or mini-hub.

2. Depending on whether you are working with a 3526, 3552, or 1742 controller,
perform one of the following actions to set up a loopback test:

a. For a Type 3526 RAID controller, install a wrap plug to the MIA on
controller A. See

Failed path of read/write buffer test

4 \\ 3526 Controller Unit

Ctrl
\ Ar |||||‘

Install wrap plug to MIA on controller A

Figure 58. Install wrap plug to MIA on controller A
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b. For a Type 3552 or 1742 controller, install a wrap plug to the GBIC in the
mini-hub on controller A. See

Host Side Drive Side
Install Al B1 A2 B2 L4 L3 L2 L1
Wrap slele|e]] |lelelse]|e
Pl o o o ) ) [ ] o
ug @g@g
S =
.%,s& Y T s | |3 === | |E | |8
2\ = S
S o M:::@
‘  — — ) —
| |
8 5B 8 g0

Figure 59. Install wrap plug to GBIC in mini-hub on controller A

3. Go to the appropriate Loopback Test section (either [“Running the loopback test]
on a 3526 RAID controller”| or [“Running the loopback test on a FAStT200
FAStT500, or FAStT700 RAID controller” on page 163).

Loopback test for optical cable testing
Perform the following steps for optical cable testing:
1. Detach the remote end of the optical cable from its destination.

2. Plug the female-to-female converter connector from your kit onto the remote
end of the optical cable.

3. Insert the wrap plug from your kit into the female-to-female converter. See

Figure 60}

\ Plug wrap to cable

Q Host Side Drive Side

A1 Bt A2 B2 L4 L3 L2 L1

efe e\ [fe[e]e]e

SEE
é g

8 |8 3 :::‘: 3 |8 8

DDDD@ ﬁ%@%@ﬂﬂ I

[
%:o

%o

Figure 60. Install wrap plug

4. Go to the appropriate loopback test section (either [“Running the loopback test]
on a 3526 RAID controller”| or [“Running the loopback test on a FAStT200
FAStT500, or FAStT700 RAID controller” on page 163).

Running the loopback test on a 3526 RAID controller

Perform the following steps for a loopback test on a 3526 RAID controller:
1. In the controller shell, type the following command: fc 5

2. From the output, write down the AL_PA (Port_ID) for this controller.
3. Type the command
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isp sendEcho,<AL _PA>,<# of iterations>

It is recommended that you use 50 000 for # of iterations. A value of -1 will
run for an infinite number of iterations. Message output to the controller shell
is generated for every 10 000 frames sent.

4. Type the command stopEcho when tests are complete.

Running the loopback test on a FAStT200, FAStT500, or FAStT700
RAID controller
Perform the following steps for a loopback test on a FAStT200, FAStT500, or
FAStT700 RAID controller:
1. In the controller shell, type the following command: fcATl
2. From the output, write down the AL_PA (Port_ID) for the channel to be tested.

3. Type the command fcChip=X where X=the chip number for the loop to be
tested.

4. Type the command
isp sendEcho,<AL_PA>,<# of iterations>

It is recommended that you use 50 000 for # of iterations. A value of -1 will
run for an infinite number of iterations. Message output to the controller shell
is generated for every 10 000 frames sent.

5. Type the command stopEcho when tests are complete.

If the test is successful, you will receive the following message:
Echo accept (count n)

If you receive the following message:
Echo timeout interrupt: interrupt ... end echo test

or if you receive nonzero values after entering the command isp sendEcho, then
there is still a problem. Continue with the [*Single Path Fail PD map 1” on page 22]
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Chapter 11. PD hints: Tool hints

You should be referred to this chapter from a PD map or indication. If this is not
the case, refer back to [Chapter 2, “Problem determination starting points,” on page|

This chapter contains the following tool hints:

* |“Determining the configuration”|

* |“Boot-up delay” on page 168

« |“Controller units and drive enclosures” on page 170)

* [“SANavigator discovery and monitoring behavior” on page 172

* [“Setting up SANavigator Remote Discovery Connection for in-band management|
of remote hosts” on page 186|

+ [“Controller diagnostics” on page 187]

+ |“Linux port configuration” on page 189

Determining the configuration

Use FAStT MSJ to determine what host adapters are present and where they are in
the systems, as well as what RAID controllers are attached and whether they are
on Fabric (switches) or loops. Alternately, you can click Control Panel -> SCSI
adapters in Windows NT or Control Panel -> System -> Hardware -> Device
Manager -> SCSI and RAID Controllers in Windows 2000.

[Figure 61 on page 166/ shows the FAStT MS] window for a configuration with two
2200 host adapters. When only the last byte of the Port ID displays, this indicates
that the connection is an arbitrated loop.
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: Information
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@ & Host nodeb

o : Host nodeh Hode Hame 20-00-00-E0-8B-04-A1-30

EH Adapter 2200 B

@ Adapter 2200 . Adapter 1- 2200 Port Hame  21-00-00-E0-5B-01-95-39
& @& Davice (20-00-00-40-B8-06-16-37) || Port ID 00-00-01

(9 Device (20-02-00-A0-B8-07-51-85) ||/ General Information
- & Device (20-02-00-40-B8-0C-96-FO) || : ; _

Al serial Number: A30277 Driver Version:  8.00.09.08 (NT4 IP

o @@ Device (20-26-00-A0-B8-06-61-89) ||| oo TR HCEr e (NT4 IF)

BIOS Version: (000

Firmware Yersion: 2.01.32

IBM xSeries x340 Server

Adapter 2200

Figure 61. FAStT MSJ window - Two 2200 host adapters

A different configuration is shown in which shows a 2200 adapter. Its
World Wide Name is 20-00-00-E0-8B-04-A1-30 and it has five devices attached to it.

When the first two bytes of the Port ID display (and they are other than 00), the
configuration is Fabric (switch).

Ef 1BM FASET Management Suite Java - HBA View
File Host Wiew Help

O I m @ ¢

Connect Configure  Events Alarms Refresh

[HBA |
Information

@ vwona
¢ %‘ Host nodeh Host  nodeb Mode Name  20-00-00-E0-8B-04-A1-30
&5 Atapter 2200
o 63 Divice (20-01-00-60-45-1 6-0-E3) Adapter 0- 2200 Port Name  21-00-00-E0-8B-04-&1-30
@ & Device (20-01-00-A0-B8-06-16-37) Port ID 02-12-00
© & Device (20-02-00-A0-B8-0C-86-F1) ||| General Information
& Device (20-03-00-A0-BS-07-51-85) ) ) ;
Serial Humber: C74593 Driver Vi :  8.00.09.06 (NT4IP
- 6 Device (20-26-00-A0-BE-06-51-04) etiatumber rhver Version: {NT4 P}
[og) B Adapter 2200 BIOS Version: 0.00 Firmware Yersion: 2.01.32
IBM xSeries x340 Server
Adapter 2200

Figure 62. FAStT MSJ window - One 2200 host adapter
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As shown in if you select one of the devices beneath a host adapter, you

find that it is a controller in a 3526 controller unit.

I
a
X

[23 1BM FASLT Management Suite Java - HBA Vi =13
File Host Wiew Help

O i =& @& -

Connect Configure Bwents Alarms Refresh

HBA | | nformation |[LUN List|
@ wond
Froduct Vendar: 1B
@ B Hostnodeh
@ B Adapter 2200
@ &= Dewice (20-01-0

Froduct [D: 3526

Froduct Revision: 0401

Mode Mame: 20-00-00-A0-B8-06-16-36

evice (20-03-0

@ = Device (20-26-0

@ B Adapter 2200
© == Davice {20-00-0
& Device (20-02-0

@ &= Dewice (20-02-0

@ &= Device (20-26-0

Port Name: 20-00-00-A0-B8-06-16-37

FortID 00-00-E0

Device (20-00-00-A0-B8-06-16-37)

Figure 63. 3526 controller information
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Boot-up delay

In Windows operating systems, an extended start-up delay indicates that Windows
is not finding the expected configuration that is in its registry. In Linux operating
systems, the delay might also be caused by an incorrectly configured storage
subsystem (see [“Linux port configuration” on page 189|for hints on
troubleshooting this problem.)

The delay in the Windows operating system can be caused by several things, but
the following example shows what typically happens when a fibre channel cable
connecting a host adapter to the storage fails (a failed cable is broken so that no
light makes it through the cable).

Note: The following Bluescreen example describes boot-up delay symptoms in a
Windows NT operating system. In the Windows 2000 operating system, the
Windows 2000 Starting Up progress bar would be frozen. To retrieve the
SCSI information in Windows 2000, use the Computer Management dialog
box (right-click My Computer and select Manage.)

1. Windows NT comes up to the blue screen and reports the first two lines
(version, number of processors, and amount of memory). Windows NT takes a
long time to start. The SCSI Adapters applet in the Control Panel displays the

window shown in for the 2100.

SCSI Adapters ﬂm

Devices | Drivers |

@; SCS| adapters and connected devices are listed below.

= |BM Metfinity OLA2000/QLA2100 PCI Fibre Cﬁanndﬂﬁp&?l
=145 Bus7 - |

- QLOGIC PSEUDO DEVICE
= @—- IBM MNetfinity i annel Adapter

= Bus0
=3 |BM 3526
=~ |Dki 2REIC ¥
4| | b|

Properties

oK Cancel

Figure 64. SCSI adapters

There are no other devices; there should have been a Bus 0 with 21 of the IBM
3526s and one IBM Universal Xport. The 2100 DD shows up as started in the
Drivers tab here and in the Control Panel Devices applet.
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2. WINDISK is started. It takes longer than normal to start (and there is a
particularly long pause at the 100% mark) and then reports the message shown
[Figure 63

in|Fi

Disk Administrator B3

Dizk Adminiztrator haz determined that one or more disks have been remaoved from your computer since Disk
Administrator was lazt run, or that one or more dizks are off-line.

Configuration information about the mizsing disk(g] will be retained.

Figure 65. Disk Administrator information dialog box

3. Because disks were balanced across the two RAID controllers before the error
occurred, every other disk shows in the Disk Administrator as offline, and the
partition information section is grayed out, giving the following message:

Configuration information not available

The drive letters do not change for the drives (they are sticky, even though they
are set only for boot drive). Because the cable to RAID controller A is the failed
cable, it was Disk 0, Disk 2, and so on, that are missing. See .

= Disk Administrator

Pattfion Fault Tolerance Tooks View Options Help

= Disk 0
OFF-LINE Configuration information not available
= Disk 1 F:
MTFS
34635 MB 34635 MB
= Disk 2
OFF-LINE Configuration information not available
= Disk 3 H:
NTFS
17277 MB 17277 MB
= Disk 4
OFF-LINE Configuration information not available i
= Disk 5 J:
NTFS
17277 MB 17277 MB
= Disk 6
OFF-LINE Canfiguration information not available

=1 Disk 7 L:
wc =

| I Fiimany pariion
[

I [ I

Figure 66. Disk Administrator

4. If Done: Return to [“Boot-up Delay PD map” on page 13
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Controller units and drive enclosures

In (an EXP500 fibre channel drive enclosure), there are two loops in the
box. The ESM on the left controls one loop path and the ESM on the right controls
another loop path to the drives. This box can be used with the 3552, 3542, and
1742 Controller Units.

/Oli
I y Y - T TN,
HDDDDD odOOOOQ:D@OOo @OOOOOQZD@OC)@ODD o
D000 =+ S0
DO000)L== ES Ea] pege
ooon =
0
= © 0ooQ
w o @B &@ef
- ) ° 00000

Figure 67. EXP500 fibre channel drive enclosure

Note: In the previous figure, the connections for the GBICs are labeled as In and
Out. This designation of the connections is for cabling routing purposes
only, as all Fibre cables have both a transmit fiber and receive fiber in them.
Any connection can function as either output or input (transmitter or
receiver).

shows the locations of the controller connections in a FAStT500 or
FAStT700 Fibre Channel controller unit.

Note: In a FAStT500 controller unit is shown.

Host Side Drive Side
| Jelelele]] |e|e|e|e
NN =25 MU
[©] I:IEH:I
 —  — — ) S
L E — °
 —  — —
/ D ® M:::@
| — —
Controller A °
R - %\ i}
/

‘ | omiese
Controller B Controller B Controller A/B Controller A/B
Controller A Loop 1 Loop 3
Controller A/B Controller A/B
Loop 2 Loop 4

Figure 68. FAStT500 controller connection locations

[Figure 69 on page 171| shows the locations of the controller units in a FAStT200
Fibre Channel controller and drive enclosure unit.
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Figure 69. FASIT200 fibre channel controller unit locations

shows a configuration containing both controllers. It uses GBICs for the
connection but does not have the mini-hub feature of the 3552. There is a place for
a single host to attach to each controller without using an external concentrator.
The other connection on each is used to attach more drives using EXP500
enclosures.
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Figure 70. EXP500 and FAStT200 configuration
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SANavigator discovery and monitoring behavior

This section provides examples and commentary explaining the use and
interpretation of the SANavigator Physical Map and Event Log.

For more information about using SANavigator, see [Chapter 5, “Introduction to|
[SANavigator,” on page 103

Physical Map

To simplify management, devices display in groups. Groups are shown with

background shading and are labeled appropriately. You can expand and collapse
groups to easily view a large topology. See

This section describes the groups shown on a typical SANavigator representation
of a SAN. The following map shows devices bundled into four types of groups:
Host, Switch, Storage, and Bridge.

Note: In version 2.7, SANavigator displayed the SAN topology as one single
fabric. In version 3.x, each switch (and associated devices) is shown as an
individual Fabric. If the switches are connected through Inter-Switch Link
(ISL), then SANavigator displays the topology as a single fabric and assigns
the WWNN of one of the switches to the fabric.

. J < @@L

-

myHub2 1BM FASIT 1B AASET IBM 3526
HBA HA 0401
Switch| Group fo-pde Storage
miyh{ub2 Group
A
Qlogic Corp. | Qlagic Carp. QUANTLUM
& o & © %
@_/ @ > <+
Qlogic Corp. Qlogic Corp. Qlogic Corp IBM_3109_F PathLight IBM 3552
C_Syvitch 0500
& Switch| Graup Storage
% IBM_2{05_F Group
Qlagic Corp
Host Group
_@9
Glogic Corp.
g &
IBM 3542 Qlogic Carp. 1B 1742
040 0a00

Storage
Group

Storage
Group

Host For Qlogic Corp.

Fabric

Figure 71. SANavigator Physical map

The four types of groups displayed in this Physical map are:
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* Host Groups

Three host groups are shown in this map: Host, Host For Qlogic Corp., and
fe-pdc.

The unassigned host bus adapters are contained within one group (Host). At the
time this map was captured, the discovered HBAs were not associated with their
respective servers.

If a discovered server has identical HBA types (for example, two 2200s or two
2310s), then SANavigator reconciles these HBAs into their respective servers and
assigns the HBA name (for example "Host For Qlogic Corp.”) as the name of the
server. This is shown in the second group on the topology (Server Host For
Qlogic Corp.). This type of automatic association is valid only for Windows
operating systems.

Instructions are provided for changing the name of the server and assigning
HBAs to other servers in [*Associating unassigned HBAs to servers” on page]

HBASs can also be associated automatically to the system on which they reside
provided that in-band management for that system is enabled. A new feature of
SANavigator 3.x is the ability to perform in-band management of remote hosts
from a local management station. The local SANavigator server communicates
with the Remote Discovery Connector (SANavRemote.exe) installed on the
remote host. You need to choose Remote Discovery Connector when installing
SANavigator on the remote Host.

This method of Discovery requires that the HBA API library be installed on the
system (local or remote or both). It is shown in the third group on the topology
(Host fc-pdc). The inner and outer diamonds for each of the HBAs are green;
this indicates that both in-band and out-of band discovery have occurred and
are still active.

* Switch Group

This group represents the switches that are required for SANavigator to perform
out-of-band management. You can expand the switch icon to expose the ports by
right-clicking the icon and selecting Port from the pop-up menu.

Note: If switches or managed hubs are present, then out-of-band management
must be enabled.

* Storage Groups

These groups represent the FAStT storage servers or other storage devices. You
can expand the storage server to expose the ports by right-clicking the icon and
selecting Port from the pop-up menu.

Both inner and outer diamonds for each of the storage servers are green; this
indicates that both in-band and out-of-band discovery have occurred and are
still active. The in-band discovery is accomplished by the HBAs in the fc-pdc
server and is only applicable to that server.

* Bridge Group
The SAN Data Gateway router, like the IBM 2103-R03, displays as a Bridge
Group. The Physical Map shown in this section shows a PathLight SAN Router
connected to port 14 of a switch. The discovery diamond adjacent to the router
shows that the router was discovered through both in-band and out-of-band
discovery methods.

Attached to the router is a Quantum Tape Library. Its discovery diamond shows
that it was discovered only through out-of-band discovery. The out-of-band
discovery was achieved because the router Ethernet port was connected to the
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SAN sub-network. Like the Storage Groups, fc-pdc is the only server in this
SAN that can in-band manage the router.

Associating unassigned HBAs to servers

You can associate unassigned HBAs to their respective systems. To do this, you
need to know in which system they reside and the HBA World Wide Node name.

After you have this information, right-click anywhere in the Host Group box and
select Servers from the pop-up menu.

shows the Server\HBA assignment dialog box. The left panel shows the
unassigned HBAs and the right panel shows those HBAs that were assigned
automatically to their servers. Once an HBA is assigned automatically, you cannot
remove it from the server tree. You can add additional HBAs to the server tree, but
SANavigator does not verify that the HBAs belong to that server.

¥ Servers . =

Create servers and assign HBAs

Unassigned HBAs Servers

Caonnected

fo-pde
HBA HBA Port Mame Device ‘F’ ? & %p,,, 1B FAST HEA |M
<& |BM FASTT HBA  200000E08B00AZFC myhub2 D% 1B FASIT HEA
<2 |BM FASTT HBA 210000E0SB01CR3E IBM_2109_F.. @ & Host for Qlogic Corn.
<@ |BM FASTT HEA 210000E0BB058575 1BM_2109_F... 0% Qlogic Cor
<& |BM FASIT HBA 210000E03B05441B IBM_2108_F... 1 4 i
e

2% Qlogic Com

OK || Cancel || Help

Figure 72. Server/HBA Assignment window

[Figure 73 on page 175/ shows the creation of system Node A with the correct HBAs
assigned to it. This was done by clicking Create, typing Node A in the Name field,
and then moving the appropriate HBAs to the right panel under the newly created
server (select the HBAs to be moved and click the appropriate arrow).
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t & M FASHT HBA,

D% B FASIT HBA

&8 Host for Qlogic Corp.
':ﬂ‘!r”@logic Comp
0% Qlogic Corp

<2 |BM FASIT HBA |210000E08B05A418 1BM_3108_F...| 1

S Node A
< [BM FASIT HBA
== [BM FASHT HBA

Figure 73. System node creation

As shown in [Figure 74 on page 176, the Physical Map now displays the following
three types of association:

 Server fc-pdc (associated through in-band discovery)
* Server Host For Qlogic Corp. (associated through common HBA type)
* Node A (newly created)

Additional servers can be created because not all HBAs were assigned.
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@logic Corp. Qlogic Corp.

Figure 74. Physical map association
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Displaying offline events
shows an example of the SANavigator method for displaying devices
that go offline. The figure shows a FAStT Fibre Channel HBA connected to port 2
of a switch. The discovery diamond adjacent to the HBA shows that it was
discovered through out-of-band (outer diamond is present).

9% e%-..p N
Qlogic Corp,  Qlogic Coarp. Mode A
Z200000E08B
044130
N
s

e K B >

QUANTUM
- HREDRDE
| 1]« L. -«-f&
PathLight IBM 3543
——— _HEBER 0401
Bridge Group Storage

' EHEBEER PathLight Group

Figure 75. Offline HBA

In the scenario shown in a problem has occurred that caused the HBA to
go offline. Note the HBA discovery diamond. The outer diamond is red and the
inner diamond is clear (indicating no in-band management). The HBA icon and the
connecting line to the port are also red, indicating that there is no communication
through the out-of-band network. The loss of the out-of-band connection was most
likely due to a Fibre Path problem.

In this scenario, if in-band discovery had been enabled, then the HBA icon and the
inner diamond would have remained green. In this case, the problem probably lies
in the fibre path between the HBA and the switch; this can be determined because
the HBA is still being in-band managed (that is, it is still responding to SCSI
commands). The cause of the problem might include the HBA (fibre channel
circuitry or transceivers), the cable to the switch, the GBIC for that port, the switch
port, or the switch itself.

As this example shows, enabling both discovery methods increases the power of

SANavigator to isolate problems. If both diamonds had turned red, the HBA
would have most likely been the cause of the problem.
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See ["Event Log behavior”| for additional information on understanding the
SANavigator discovery process.

Exporting your SAN for later viewing (Import)

Exporting a SAN is useful when SAN problems are encountered and your
Technical Support organization (level 2 for example) asks you to provide them
with the SAN database to facilitate troubleshooting the failure.
[“Introduction to SANavigator,” on page 103|provides information on how to
Export/Import SANSs.

In addition, Export/Import is the method by which you save your SAN in version
3.x. In previous versions, SANs could be saved as SAN files (Save, Save as...). This
is no longer available in 3.x.

Event Log behavior

The tables in this section describe the SANavigator Event Log and associated GUI
behavior when problems are encountered relating to the fibre path, controllers,
host bus adapters, and storage servers.

A discovery diamond displays adjacent to each device in the Physical Map.

shows the discovery diamond legend.

Tag Out-of-band In-Band Tag Out-of-band In-Band
& Present Mot Present & Present Present
& Failed Mot Present 2 Present Failed
€ Mot Present Present & Failed Present
% Mot Present Failed \ 4 Failed Failed

Figure 76. Discovery diamond legend
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displays the Event Log behavior for problems that involve host bus

adapters.

Table 16. SANavigator Event Log behavior matrix for HBAs

If the problem is in the Fibre Path,
then the indicator is ...

If the problem is the HBA, then the
indicator is ...

Out-of-band discovery

Event Log entries (fatal events)

Log entry #1

HBA - Out-of-band offline

HBA - Out-of-band offline

Log entry #2

Concentrator port for that HBA -
Connection offline

Concentrator port for that HBA -
Connection offline

Log entry #3

HBA - Connection offline

HBA - Connection offline

Physical Map

HBA outer diamond

Red

Red

HBA inner diamond

Clear (no in-band)

Clear (no in-band)

HBA connection line

Red

Red

HBA icon

Red

Red

Out-of-band and in-band discovery

Event Log entries (fatal events)

Log entry #1

HBA - Out-of-band offline

HBA - Out-of-band offline

Log entry #2

Concentrator port for that HBA -
Connection offline

Concentrator port for that HBA -
Connection offline

Log entry #3

HBA - Connection offline

HBA - Connection offline

Log entry #4

All devices detected by HBA -
In-band offline

HBA - In-band offline

Log entry #5

All devices detected by HBA -
In-band offline

Log entry #6

All devices detected by HBA -
Connection offline

Physical Map

HBA outer diamond Red Red
HBA inner diamond Green Red
HBA connection line Red Red
HBA icon Normal Red

In-band discovery*

Event Log entries (fatal events)

Log entry #1

All devices detected by HBA -
In-band offline

HBA - In-band offline

Log entry #2

All devices detected by HBA -
Connection offline

HBA - Connection offline

Log entry #3

HBA - Connection offline (if
connected to switch)

All devices detected by HBA -
In-band offline

Log entry #4

All devices detected by HBA -
Connection offline
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Table 16. SANavigator Event Log behavior matrix for HBAs (continued)

If the problem is in the Fibre Path,
then the indicator is ...

If the problem is the HBA, then the
indicator is ...

Physical Map

HBA outer diamond

Clear (no out-of-band)

Clear (no out-of-band)

HBA inner diamond Green Red
HBA connection line (or lines) Red (if connected to switch) Red
HBA icon Normal Red

* The HBA inner diamond remains Green (for Fibre Path problems) or Red (for bad HBAs or In-band disabled).

Notes:

not an IBM part number.

2. The term concentrator refers to a switch or managed hub.

1. The log entry sequence is based on the time events were logged; your sequence might differ from this table.

3. You can determine the supported and configured link speed of the HBA by looking at the HBA Properties Port
tab. The Device Tip also shows this information.

4. When in-band discovery is enabled, the HBA names are displayed as IBM FAStT HBA (for 2200 and above HBA
types). If this does not occur, make sure you are running the latest drivers. Otherwise, suspect that the HBA is
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displays the Event Log behavior for problems that involve controllers in
the fibre path.

Table 17. SANavigator Event Log behavior matrix for controllers

If the problem is in the Fibre Path
to one or more (but not all)
controller ports, then the indicators
are ...

If the problem is in the Fibre Path
to all controller ports, or if the
storage server is not discovered,
then the indicators are ...

Out-of-band discovery

Event Log entries (fatal events)

Log entry #1

Concentrator port for that controller
port - Connection offline

Concentrator ports for that storage
server - Connection offline

Log entry #2

Controller port - Connection offline

Storage server - Out-of-band offline
Note: Ignore Port WWN

Log entry #3

Controller ports - Connection offline

Physical Map

Storage server outer diamond

Green

Red

Storage server inner diamond

Clear (no in-band)

Clear (no in-band)

Connection

Red (for that port)

Red

Storage server icon

Normal

Red

Out-of-band and in-band discovery

Event Log entries (fatal events)

Log entry #1

Concentrator port for that controller
port - Connection offline

Concentrator ports for that storage
server - Connection offline

Log entry #2

Controller port - Connection offline

Controller ports - Connection offline

Log entry #3

Controller port - In-band offline

Storage server - Out-of-band offline
Note: Ignore Port WWN

Log entry #4

Storage server - In-band offline Note:
Ignore Port WWN

Physical Map

Storage server outer diamond Green Red
Storage server inner diamond Red Red
Connection Red (for that controller port) Red
Storage server icon Normal Red

In-band discovery*

Event Log entries (fatal events)

Log entry #1

Controller Port - Connection offline

Controller Ports - Connection offline

Log entry #2

Controller Port - In-band offline
Note: Ignore Port WWN

Storage server - In-band offline Note:
Ignore Port WWN

Log entry #3

HBA - Connection offline (if direct
connect to HBA)

Physical Map

Storage server outer diamond

Clear (no out-of-band)

Clear (no out-of-band)

Storage server inner diamond

Red

Red
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Table 17. SANavigator Event Log behavior matrix for controllers (continued)

If the problem is in the Fibre Path
to one or more (but not all)
controller ports, then the indicators
are ...

If the problem is in the Fibre Path
to all controller ports, or if the
storage server is not discovered,
then the indicators are ...

Connection

Red (port to loop)

Red (all ports to loop)

Storage server icon

Normal

Red

* Devices that are in-band discovered have the inner diamond red. The inner diamond of the HBA that is connected
to its respective controller port (or ports if connected to an unmanaged hub) remains Green (for Fibre Path
problems) or Red (for bad HBAs or In-band disabled). See [Table 16 on page 179}

Notes:

1. The log entry sequence is based on the time events were logged; your sequence might differ from this table.

2. The term concentrator refers to a switch or managed hub.

182 1BM TotalStorage FAStT: Problem Determination Guide




displays the Event Log behavior for problems that involve SAN Data

Gateway Routers.

Table 18. SANavigator Event Log behavior matrix for SAN Data Gateway Routers

If the problem is in the
Fibre Path, then the
indicators are ...

If the problem is in the
Ethernet connection to
SDG, then the indicators
are ...

Out-of-band discovery (Ethernet connection to
Concentrator only)

Event Log entries (fatal events)

Log entry #1 SDG - Out-of-band offline N/A
Log entry #2 Concentrator port - N/A
Connection offline

Log entry #3 SDG - Connection offline N/A
Physical Map

SDG outer diamond Red N/A
SDG inner diamond Clear (no in-band) N/A
Connection Red N/A
SDG icon Red N/A

Out-of-band discovery (Ethernet connection to SDG
and Concentrator)

Event Log entries (fatal events)

Log entry #1

SDG - Connection offline

SDG - Out-of-band offline

Log entry #2

Concentrator port -
Connection offline

Tape device - Out-of-band
offline

Log entry #3

Tape device - Connection
offline

Log entry #4

SDG - Connection offline

Physical Map

SDG outer diamond Green Red
SDG inner diamond Clear Clear
Concentrator-to-SDG connection Red Normal
SDG-to-Tape connection Normal Red
SDG icon Normal Normal
Tape device outer diamond Green Red

Tape device inner diamond

Clear (no in-band)

Clear (no in-band)

Tape device icon Normal Red
Out-of-band and in-band discovery (Ethernet

connection to Concentrator only)

Event Log entries (fatal events)

Log entry #1 SDG - Out-of-band offline N/A
Log entry #2 Concentrator port - N/A

Connection offline
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Table 18. SANavigator Event Log behavior matrix for SAN Data Gateway Routers (continued)

If the problem is in the
Fibre Path, then the
indicators are ...

If the problem is in the
Ethernet connection to
SDG, then the indicators
are ...

Log entry #3 SDG - Connection offline N/A
Log entry #4 SDG - In-band offline N/A
Physical Map

SDG outer diamond Red N/A
SDG inner diamond Red N/A
Connection Red N/A
SDG icon Red N/A

Out-of-band and in-band discovery (Ethernet
connection to SDG and Concentrator)

Event Log entries (fatal events)

Log entry #1

SDG - Connection offline

SDG - Out-of-band offline

Log entry #2

Concentrator port -
Connection offline

Tape device - Out-of-band
offline

Log entry #3

SDG - In-band offline

Tape device - Connection
offline

Log entry #4

SDG - Connection offline

Physical Map

SDG outer diamond Green Red
SDG inner diamond Red Green
Concentrator-to-SDG connection Red Normal
SDG-to-Tape connection Normal Red
SDG icon Normal Normal
Tape device outer diamond Green Red
Tape device inner diamond Clear Clear
Tape device icon Normal Red

Notes:

method (Ethernet cable plugged to the SDG)

3. The term concentrator refers to a switch or managed hub.

1. It is not necessary for the SAN Data Gateway (SDG) unit to be connected to the network for it to be discovered
by SANavigator. However, if the SDG is not connected to the network, SANavigator will not be able to detect
devices attached to the SDG. The devices attached to the SDG are only discovered through the out-of-band

2. The log entry sequence is based on the time events were logged; your sequence might differ from this table.

[Table 19 on page 185 describes the conventions for naming FAStT storage server

ports.
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Table 19. FASIT storage server port naming convention

Number of | SANavigator
Machine Type |Ports Port Naming | Algorithm Example
3526, 3542 2 A, B Port A: Last character of the node | Node: 20-00-00-A0-B8-06-16-36
WWN + 1 Port: 20-00-00-A0-B8-06-16-37
Port B: Fourth and last character | Node: 20-00-00-A0-B8-06-16-36
of the node WWN +1 Port: 20-01-00-A0-B8-06-16-37
3552, 1742 4 Al, B1,A2, B2 | Port Al: Last character of the Node: 20-26-00-A0-B8-06-61-98

(Note: The
following
figure shows
the physical
locations of
these ports.)

node WWN + 1

Port B1: Fourth and last character
of the node WWN +1

Port A2: Last character of the
node WWN + 2

Port B2: Fourth character of the
node WWN+1 and last character
of the node WWN+2

Port: 20-26-00-A0-B8-06-61-99

Node: 20-26-00-A0-B8-06-61-98
Port: 20-27-00-A0-B8-06-61-99

Node: 20-26-00-A0-B8-06-61-98
Port: 20-26-00-A0-B8-06-61-9A

Node: 20-26-00-A0-B8-06-61-98
Port: 20-27-00-A0-B8-06-61-9A

shows the physical locations of the ports described in [Table 19

A1 B1

A2 B2

Out

In

Rear view of 3552 or 1742

Figure 77. Rear view of 35652 or 1742
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Setting up SANavigator Remote Discovery Connection for in-band
management of remote hosts

Remote Discovery Connection

In order for Remote Discovery Connection (RDC) to function, install the Remote
Discovery Connector on the host that you want to In-band manage remotely. The
following modifications to the Deployment Property file on the local machine are
required to enable RDC:

1. Navigate to $\Program Files\SANavigator3.1l\resources\Server and edit the
file Deployment.Properties:

Comment out the first two sets of "com.sanavigator” and enable the third set,
as the following examples show:

* Set1l

# Use this for conventional discovery by the server
#com.sanavigator.plugsnpeers.plugs.IContainer = \
#com.sanavigator.server.plugdiscovery.ClassicDiscoveryContainer

* Set 2

# Use this for discovery by all peers (remove the # comment char from the
# next 2 lines, delete or comment the lines above!)
#com.sanavigator.plugsnpeers.plugs.IContainer = \
#com.sanavigator.plugsnpeers.peers.rmi.Peer

* Set3

# Use this for discovery by server and all peers (remove the # comment char
# from the next 3 lines, delete or comment the first lines above!)
com.sanavigator.plugsnpeers.plugs.IContainer = \
com.sanavigator.server.plugdiscovery.ClassicDiscoveryContainer;\
com.sanavigator.plugsnpeers.peers.rmi.Peer

2. You should update the peer (Peer.Properties) file whenever a peer is providing
remote discovery information and is not discovered through a broadcast
discovery on the default subnet.

Navigate to $\Program Files\SANavigator3.1\resources\Server and edit the
file Peers.Properties. Scroll about half-way down the file to the following
section.

# Who you gonna call? (in addition to broadcast)

# HOST:PORT separated by semi-colons

# Example: PeerAddresses=172.23.2.2:333;fred.sanavigator.com
PeerAddresses =

Add each remote peer IP address as follows:
PeerAddresses=172.31.1.3;172.31.3.5

You can also enter the server name followed by the domain name, previously
shown as fred.sanavigator.com. This is just an alternate method to enter the IP
addresses.

Configuring only peers to discover

Important: This configuration is not recommended. The local server should be
allowed to perform discovery as well.
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This method will accept in-band and out-of-band discovery information from
remote peers only. HBAs in the local server will not be displayed in the Discover
Setup dialog box. Out-of-band discovery can still be performed using the local
server. The peer file also needs to be updated for peers not discovered through the
broadcast method.

1. Navigate to $\Program Files\SANavigator3.1\resources\Server and edit the
file Deployment.Properties.

2. Comment out Set 1 and Set 3 and enable Set 2, as the following examples
show:

* Set1l

# Use this for conventional discovery by the server
#com.sanavigator.plugsnpeers.plugs.IContainer = \
#com.sanavigator.server.plugdiscovery.ClassicDiscoveryContainer

* Set2

# Use this for discovery by all peers (remove the # comment char from the
# next 2 lines, delete or comment the lines above!)
com.sanavigator.plugsnpeers.plugs.IContainer = \
com.sanavigator.plugsnpeers.peers.rmi.Peer

* Set3

# Use this for discovery by server and all peers (remove the # comment char
# from the next 3 lines, delete or comment the first Tines above!)
#com.sanavigator.plugsnpeers.plugs.IContainer = \
#com.sanavigator.server.plugdiscovery.ClassicDiscoveryContainer;\
#com.sanavigator.plugsnpeers.peers.rmi.Peer

Controller diagnostics

The FAStT Storage Manager Diagnostics option enables a user to verify that a
controller is functioning properly, using various internal tests. One controller is
designated as the Controller Initiating the Test (CIT). The other controller is the
Controller Under Test (CUT).

The diagnostics use a combination of three different tests: Read Test, Write Test,
and Data Loopback Test. You should run all three tests at initial installation and
any time there are changes to the storage subsystem or components that are

connected to the storage subsystem (such as hubs, switches, and host adapters).

Note: During the diagnostics, the controller on which the tests are run (CUT) will
NOT be available for I/0.
* Read Test
The Read Test initiates a read command as it would be sent over an I/O data
path. It compares data with a known, specific data pattern, checking for data
integrity and redundancy errors. If the read command is unsuccessful or the

data compared is not correct, the controller is considered to be in error and is
failed.

* Write Test

A Write Test initiates a write command as it would be sent over an I/O data
path (to the Diagnostics region on a specified drive). This Diagnostics region is
then read and compared to a specific data pattern. If the write fails or the data
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compared is not correct, the controller is considered to be in error and is failed
and placed offline. (Use the Recovery Guru to replace the controller.)

* Data Loopback Test

Important: The Data Loopback Test does not run on controllers that have SCSI
connections between the controllers and drive (model 3526).

The Data Loopback Test is run only on controllers that have fibre channel
connections between the controller and the drives. The test passes data through
each controller’s drive-side channel, mini-hub, out onto the loop and then back
again. Enough data is transferred to determine error conditions on the channel.
If the test fails on any channel, then this status is saved so that it can be
returned if all other tests pass.

All test results display in the Diagnostics dialog box status area.

Events are written to the FAStT Storage Manager Event Log when diagnostics is
started, and when it is has completed testing. These events will help you to
evaluate whether diagnostics testing was successful or failed, and the reason for
the failure. To view the Event Log, click View -> Event Log from the Subsystem
Management Window.

Running controller diagnostics

Important: If diagnostics are run while a host is using the logical drives owned by
the selected controller, the I/O directed to this controller path is rejected.

Perform the following steps to run various internal tests to verify that a controller
is functioning properly.

1. From the Subsystem Management Window, highlight a controller. Then, either
click Controller -> Run Diagnostics from the main menu or right-click the
controller and click Run Diagnostics from the pop-up menu. The Diagnostics
dialog box displays.

2. Select the check boxes for the diagnostic tests to be run. Choose from the
following list:

* Read Test
* Write Test
¢ Data Loopback Test

3. To run the Data Loopback Test on a single channel, select a channel from the

drop-down list.

4. Select a Data Pattern file for the Data Loopback Test. Select Use Default Data
Pattern to use the default Data Pattern or Use Custom Data Pattern file to
specify another file.

Note: A custom Data Pattern file called diagnosticsDataPattern.dpf is provided
on the root directory of the Storage Manager folder. This file can be
modified, but the file must have the following properties to work
correctly for the test:

* The file values must be entered in hexadecimal format (00 to FF) with
one space ONLY between the values.

* The file must be no larger than 64 bytes in size. (Smaller files will
work but larger files will cause an error.)

5. Click the Run button. The Run Diagnostics confirmation dialog box displays.
6. Type yes in the text box, and then click OK.
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The selected diagnostic tests begin. When the tests are complete, the Status text
box is updated with test results. The test results contain a generic, overall status
message, and a set of specific test results. Each test result contains the following
information:
* Test (Read/Write/Data Loopback)
* Port (Read/Write)
* Level (Internal/External)
* Status (Pass/Fail)

7. Click Close to exit the dialog box.
Important: When diagnostics are completed, the controller should automatically
allow data to be transferred to it. However, if there is a situation where data

transfer is not re-enabled, highlight the controller and click Data Transfer ->
Enable.

Linux port configuration

Linux operating systems do not use the IBM FAStT Storage Manager to configure
their associated Storage Subsystems. Instead, use FAStT MS] to perform Device
and LUN configuration on Linux operating systems. However, the FAStT Storage
Manager is used to map the FAStT storage servers’ logical drives to the
appropriate operating system (in this case, Linux). The following sections provide
you with hints on how to correctly configure your storage for Linux.

FAStT Storage Manager hints

Use the FAStT Storage Manager to map the desired logical drives to Linux storage.
See the Storage Manager User’s Guide for instructions. Note the following:

* Host ports for the Linux host are defined as Linux. See |Chapter 15,

[“Heterogeneous configurations,” on page 227|for more information.

e The Access LUN (LUN 31, also called the UTM LUN) is not present. FAStT MS]
will typically display the following messages when attempting to configure the
storage and LUN 31 is detected:

— An invalid device and LUN configuration has been detected

— Non-SPIFFI compliant device(s) have been separated (by port names)

Note: The Device node name (FAStT storage server World Wide Node name)
should appear once in the FAStT MS]J Fibre Channel Port Configuration
dialog (see the figure following Step for both device
ports. The Device port names reflect the FAStT storage server controller
Port World Wide Node names. If the Device node name is split (that is,
if the Device node name is shown once for each Port name), then an
invalid configuration is present. Check the storage mapping once more
by using the FAStT Storage Manager.

* LUNSs are sequential and start with LUN 0.

* Prior to configuration, all LUNs are assigned to the controller that is attached to
the first HBA.

* Both storage controllers must be active. Failover is only supported in an
ACTIVE/ACTIVE mode.

Linux system hints

After you have properly mapped the storage, you will also need to configure the
Linux host. See the HBA driver readme file for instructions on how to configure
the driver to allow for Failover support.

Chapter 11. PD hints: Tool hints 189



Make sure the HBAs that are installed in your systems are of the same type and
are listed in the modules.conf file in the /etc/ directory. Add the following options
string to allow more than 1 LUN to be reported by the driver:

options scsi_mod max_scsi_luns=32

You might see the following example in the modules.conf file:

alias ethl eeprol00

alias scsi_hostadapter aic7xxx
alias scsi_hostadapterl ql1a2200
alias scsi_hostadapter2 qla2200
options scsi_mod max_scsi_luns=32

FASIT MSJ

Use FAStT MS] to configure the driver for failover. See [Chapter 4, “Introduction to|
[FAStT MSJ,” on page 55| for installation instructions and to familiarize yourself
with this application.

Configuring the driver with FAStT MSJ
To configure the driver, launch FAStT MS] and perform the following steps:

1. Open a new command window and type qlremote; then press Enter. This will
run glremote agent in this command window.

Open a new command window and run /usr./FAStT_MS]J.
Select CONNECT.
Enter the IP address of the server or select LOCALHOST.

Select CONFIGURE. You will then be presented with the Fibre Channel Port
Configuration dialog box (see

ok wn

Figure 78).

K Fibre Channel Configuration - chapeau - - .00 000
File Adapter Device LUNs Help

Fibre Channel Port Configuration

Device Node Name Device Port Name Adapter O (Path/Target/Loop Id) | Adapter 1 (Path/Target/Loop Id)

20-00-00-A0-B8-06-16-36

Z20-00-00-A0-BR-06-16-57

20-01-00-A0-BB-06-16-57

20-02-00-A0-B8-0C-96-EF

Z20-02-00-A0-BB-0C-96-FO0

Z0-02-00-A0-BB-0C-96-F1

20-0A-00-A0-BE-07-51-94

20-0A-00-A0-ER-07-51-95

20-0B-00-A0-B8-07-51-95

20-26-00-A0-B8-06-61-98

20-26-00-A0-BR-06-61-99

20-26-00-A0-B8-06-51-5A

®
B
®
&

0/2/5- Local
0/1/121- Local
0/3/0- Local

0/0/122- Local

| Apply H Save || Cancel |

Figure 78. Fibre Channel Port Configuration window

6. Right-click the Device node name.

7. Click Configure LUNs. The LUN Configuration window opens (see

age 191)).
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K LUN Configuration for chapeau, for Device Node Mame: 20-26-00-A0-B8-06-61-9

File Tools

Help

Fibre Channe! LUN Configuration

LUMN

Enable

Device Fort Mame [Adapter 0 (Path/Target/Loop Id)[Adapter 1 (Path/Target/Loop Id)

[l

20-26-00-A0-B8-06-61-99 |© 0/0/122 Preferred Lo. ..

20-26-00-A0-B3-06-51-0A |

[v]

20-26-00-A0-B8-06-61-99 |() 0/0/122 Preferred Lo. .

20-26-00-A0-B3-06-51-0A |

(O]
(0]

0/0f134 Alternate Fa...

Of0/134 Alternate Fa...

oK || cancel |

Figure 79. Fibre Channel LUN Configuration window

8. Click Tools -> Automatic Configuration.
9. Click Tools -> Load Balance.
Your configuration should then look similar to which shows the

preferred and alternate paths alternating between the adapters.

K LUN Configuration for chapeau, for Device Node Name: 20-26-00-A0-B8-06-61-9;

File Tools Help
Fibre Channel LUN Configuration
LUN Enahle Device Port Mame [Adapter O (Path/Target/Loop Id)/Adapter 1 (Path/Target/Loop Id)
o & 20-26-00-A0-B8-06-61-99 |(&) 070,122 Preferred La...
20-26-00-A0-B3-06-61-9A | @ 0/0f134 Alternate Fa...
20-26-00-A0-B8-06-51-93 |(&) 0/0/122 Alternate Lo
1 ¥
20-26-00-A0-BE-06-51-04 | ® 040/ 134 Preferred Fa..
oK Cancel
I T

Figure 80. Preferred and alternate paths between adapters

10. Click OK.

11. Click Apply or Save.
12. This will save the configuration into the etc/modules.conf file. Verify that the
option string reflecting the new configuration was written to that file. The
string should look like the following example:
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options q1a2300 ConfigRequired=1 ql2xopts=scsi-qla00-adapter
port=210000e08b05e875\;scsi-q1a00-tgt-000-di-00-node=202600a0b8066198\;scsi-
q1a00-tgt-000-di-00-port=202600a0b8066199\;scsi-qla00-tgt-000-di-00-
preferred=fffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffd\;scsi
-q1a00-tgt-000-di-00-control=00\;scsi-qla00-tgt-001-di-00-
node=200200a0b80c96ef\;scsi-qlad0-tgt-001-di-00-port=200200a0b80c96T0O\;scsi-
qla00-tgt-001-di-00-
preferred=ffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffff\;scsi
-q1a00-tgt-001-di-00-control=00\;scsi-qla00-tgt-002-di-00-
node=200000a0b8061636\;scsi-qlad0-tgt-002-di-00-port=200000a0b8061637\;scsi-
qla00-tgt-002-di-00-
preferred=ffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffff\;scsi
-q1a00-tgt-002-di-00-control=00\;scsi-qla00-tgt-003-di-00-
node=200a00a0b8075194\;scsi-q1a00-tgt-003-di-00-port=200a00a0b8075195\;scsi-
ql1a00-tgt-003-di-00-
preferred=ffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffff\;scsi
-q1a00-tgt-003-di-00-control=00\;scsi-qla0l-adapter-port=210000e08b058275\;scsi-
qla0l-tgt-001-di-01-node=200200a0b80c96ef\;scsi-qladl-tgt-001-di-01-
port=200200a0b80c96f1\;scsi-qladl-tgt-001-di-01-control=80\;scsi-qladl-tgt-003-
di-01-node=200a00a0b8075194\;scsi-qla0l-tgt-003-di-01-
port=200b00abb8075195\;scsi-qladl-tgt-003-di-01-control=80\;scsi-qladl-tgt-002-
di-01-node=200000a0b8061636\;scsi-qla0l-tgt-002-di-01-
port=200100a0b8061637\;scsi-qla0l-tgt-002-di-01-control=80\;scsi-qla0l-tgt-000-
di-01-node=202600a0b8066198\;scsi-qladl-tgt-000-di-01-
port=202600a0b806619a\;scsi-qladl-tgt-000-di-01-
preferred=0000000000000000000000000000000000000000000000000000000000000002\ ;scsi

-qla01l-tgt-000-di-01-control=80\;

FAStT MSJ Hints
The following hints are for using FAStT MS] to configure Linux ports:

* FAStT MSJ does not automatically launch the agent glremote. If you are unable
to connect the host or hosts, make sure that you have started glremote.

* Any time a change is made to your storage (for example, if LUNs are added or
removed), you must kill glremote (Ctrl + C), unload your HBA driver, and then
re-load it.

— To unload: modprobe -r qla2x00

— To load: modprobe qla2x00

— To restart: glremote

You will then need to run FAStT MS] to perform failover configuration.

* Do not mix HBA types. For example, qla2200 must be matched with another
qla2200.

 If you replace an HBA, make sure you change the mapping in the FAStT Storage

Manager to point to the WWN name for the new adapter. You will then need to
reconfigure your storage.
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Chapter 12. PD hints: Drive side hints and RLS diagnostics

You should be referred to this chapter from a PD map or indication. If this is not

the case, refer back to [Chapter 2, “Problem determination starting points,” on page|

This chapter contains hints in the following PD areas:

* [“Drive side hints”]

+ [“Read Link Status (RLS) Diagnostics” on page 212|

Drive side hints

When there is a drive side (device side) issue, looking at SM often helps to isolate
the problem. shows the status of drive enclosures attached to the RAID
controller unit. Notice that the windows show that enclosure path redundancy is
lost. This is an indication that a path problem exists between the controllers and

one or more drive enclosures.

% Drive Enclosure 0 Components E3

llll Enclosure path redundancy: Lost

&

2 Fan canisters: OK

*

5 g 2 Power supply canisters: Ok
GBICs: 4 Ok

2 Environmental (ESM) cards: Ok

=

ESM communication: 0K

EO Temperature: Ok

Drive Enclozure 1 Components E3

lIE Enclosure path redundancy: Lost

FLY :
91 2 Fan canisters: Ok
Vi

+
;g 2 Poweer supply canisters: QK

@ GBICs: 3 Ok
m 2 Environmental (ESM) cards: Ok
m ESM communication; Ok

ED Temperature: QK

[Figure 82 on page 194 shows that an ESM failed.

Figure 81. Drive enclosure components

© Copyright IBM Corp. 2004
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% Drive Enclosure 2 Components

lIE Enclosure path redundancy: Lost

@ 2 Fan canisters: Ok

+
; g 2 Power supply canisters: Ok

@ GHICs: 3 Ok

;j")(',- 2 Ervironmental (ESM) cards: 1 Failed, 0 Removed

m ESM communication: Ok

ED Temperature: Ok

Figure 82. Drive enclosure components - ESM failure

When an ESM fails, go to the Recovery Guru for suggestions on resolving the
problem. See [Figure 83 on page 195
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« fute? 1- Recovery Guru M=l E3
Summary Details

& Logical Drive Mot On Preferred Path Storage Subsystem: fluteZ_l

n Failed Ervironmental Card Canister Controller in slot B

¥5f Drive Enclosure - Loss of Path Redundancy Enclosure: Controller enclosure
¥5f Drive Enclosure - Loss of Path Redundancy Serial number: 1T33810188

E Drive Enclosure - Loss of Path Redundancy

Recovery Procedure

Logical Drive Not On Preferred Path :|

What Caused the Problem?

The host is unable to access its logical drives on the preferred path. These logical drives are
nowe assigned to the Storage Subsystern's alternate controller. This may be the result of one of
the following. The Recovery Gurl Details area provides specific information you will need as you
follow the recovery steps.

& Caontroller manually changed to passive mode

o Controller manually taken offline

# Disconnected or faulty cables

& Hub or Fabric switch malfunction =

Recheck Close Help

Figure 83. Recovery Guru window

In the Recovery Guru window, the message Logical drive not on preferred path
does not necessarily pertain to the current problem. The drive could have been
moved to the other controller and not moved back. The loss of redundancy and the
failed ESM are what is important.

Note: [Figure 84 on page 196| also shows the message Failed or Removed Power
Supply Cannister. However, this message is not significant here because the
power supply was removed for purposes of illustration.
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« FluteZ- Recovery Guru o m] |

Summary Details

5@ Failed or Removed Power Supply Canister Storage Subsystem: FluteZ

E Drive Enclosure - Loss of Path Redundancy Enclosure: Driwe Enclosure 22
E Drive Enclosure - Logs of Path Redundancy Working channel: 3

! Drive Enclosure - Loss of Path Redundancy

Recovery Procedure

Drive Enclosure - Loss of Path Redundancy j

What Caused the Problem?

A drive enclosure with redundant drive loops (channels) has lost communication through one of
its loops. The drive enclosure has only one loop available for 10, The Recovery Guru Details
area provides specific information you will need as you follow the recovery steps.

Loss of path redundancy can result from ary of the following:

& Disconnected or faulty drive cable
& Poorly seated environmental card
& Niscnnnected nr fadlty mini-biib canister ra senarate nrmblem shoold be renneds LI

Save As... | Recheck I Close Help

Figure 84. Recovery Guru - Loss of path redundancy

Use the following indicators for drive side problems.
* FAStT200:
— Fault light per controller (1 on single controller model and 2 on redundant)
— Loop bypass per controller (1 or 2)
— Link status per SFP/GBIC port (2) per controller (2 or 4)
* FAStT500, FAStT700, or FAStT900: (mini-hubs)
— Fault
— Loop bypass
— Link status
* FAStT600:
— Fault light per controller 2
— Loop bypass per controller 2
— Link status per SFP port (2) per controller 4
* EXP500:
— Fault per ESM (2)
— Loop bypass per GBIC port per ESM (4)
— Link status per ESM (2)
* EXP700:
— Fault per ESM (2)
— Loop bypass per SFP port per ESM (4)
— Link status per ESM (2)
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Troubleshooting the drive side

Always ensure that you are working on the loop side that is no longer active.
Unplugging devices in a loop that is still being used by the host can cause loss of
access to data.

There are two procedures to troubleshoot problems on the drive side:
troubleshooting optical components and troubleshooting copper cables. If the
components that make up the FC connections in the drive loops consists of optical
FC cables and SFPs/GBICs, see|“Troubleshooting optical components.”] If the
components that make up the FC connections in the drive loops consist of copper
FC cables, see|“Troubleshooting FC copper cables” on page 200

Note: The diagnostic wrap plug mentioned in these troubleshooting procedures is
also known as a loopback adapter.

Troubleshooting optical components
To troubleshoot a problem in the drive side optical components, use the following
procedure:

1. Disconnect the cable from the loop element that has the bypass indicator light

on. See

FAStT500

7| (O 00
OO} exps00
0oog
00000
. 0o00D
00000

Unplug here

Bypass on
Figure 85. Disconnect cable from loop element

2. Insert a wrap plug in the element from which you disconnected the cable. See
[Figure 86 on page 198|

a. Is the bypass light still on? Replace the element (for example, a GBIC). The
procedure is complete.
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IO, 0000 005 0
DDDDD}E*\ 0 ©°° =T

|
000 |
(1T
[] - : EXP500
© / S% O |
wiap pig o [T }
|

Bypass still on

Figure 86. Insert wrap plug

b. If the bypass light is now out, then this element is not the problem.
Continue with step 3.

3. Reinsert the cable. Then unplug the cable at the other end.

4. In-sert a wrap plug with an adapter onto the cable end. See [Figure 87 on page|
199

a. Is the bypass light still on? Replace the cable. The procedure is complete.

b. If the bypass light is now out, then this element is not the problem.
Continue with step 5.
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Y
Y
Y
[

2
ﬂ FAStT500

Unplug here

®

I IH\

HH— j—

DDDDD 0000 [eNe] o] o OO0 0 0 g o] °
0000 00 ) @@ | a0
o0

0o
%%‘Zgg : O 00 EXPs00
00O
e O -@ OO000
Replug cable DOD 1n o BSSSS

j Insert Wrap with adapter onto cable end

4“@\

\ Wrap plug

' Adapter

Figure 87. Insert wrap plug with adapter on cable end

5. As was shown in step 4, insert the wrap plug into the element from which the
cable was removed in step 3. See|Figure 88 on page 200}
a. Is the bypass light still on? Replace the element (for example, an SFP or a
GBIC). The procedure is complete.

b. If the bypass light is now out, then this element is not the problem. In this
fashion, keep moving through the loop until everything is replugged or
until there are no more bypass or link down conditions.
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Since the Bypass is now off, the cable should be replaced /

Bypass off %
/
i\\m i N -
AoorD [T a o=y coce qpo o= °
HHoE = ==
EXP500
00
. © Ooog
%SQ qujp JEnjpi=s 05000
Oooo
o LI ° ° 0oo0d

Figure 88. Insert wrap plug into element

Troubleshooting FC copper cables
Use this procedure to troubleshoot the connections between the ESM and controller
and between ESMs.

1. Unplug one end of the FC copper cable in the loop element that has the bypass
indicator light on. You can start at either cable end. For this example, start by
unplugging the end that connects to the controller. See

I T T ]
o000 B o o
e By 1 EEE k=
= — O BS FASIT600
10
o) o) ooog
0o O pae WpOe |poooo
Ooo0d
o HI i f 00000
Etart by unplugging here
[e]
1 0
() Ug| EXP700
0
R
000
oo
(i

Bypass LED on

Figure 89. Copper cable and bypass light
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2. Insert the FC copper cable wrap plug into the unplugged cable end. See
Figure 90| Record the state of the port bypass light on the end where the FC
copper cable is still inserted.

m T T i I
00000 O NN
‘DDDDD HEHURSES B R HRAER I m Sy
Aoo8 F— o o U == O SB FAStT600
0o 0ood
© %% ©
0o O = | 0| {WIPES |ooooo
U0 g - 00000
o © i Oo0o0
~ . e
‘ﬂ .l T T 1L i i
Looo ocoo @ oo 0oo0oo B oo o
ooooo| M0 [ o o 1 e ||™ oo
= — Q 00l EXP700
[
= @O |
1 ©¢ | o000
o 1 o 3 00000
Ty N o000

Record status of bypass light after wrap plug is inserted.

Figure 90. Inserting a wrap plug onto a copper cable

3. Remove the wrap plug and reinsert the FC copper cable into the port slot that
you removed it from in Step 1 (in this example, the controller). Unplug the
other end of the FC copper cable (in this example, the end that is inserted into
the ESM).

Insert the FC copper cable wrap plug into the unplugged cable end. Record the

state of the port bypass light on the end where the FC copper cable is still
inserted.

5. Use the following table to determine which component of the drive loop link is
causing the error. "A” and "B” stand for your hardware components. (In this
example, A is the controller and B is the ESM; in some cases both A and B will
be ESM).

Table 20. Diagnostic error condition truth table for copper cables

Bypass LED at

Case No. |A Bypass LED at B Cause

1 On On Cable

2 On Off The controller is malfunctioning.
3 Off On The ESM is malfunctioning.

4 Off Off 1. Check all of the links in the

failing drive loops.

2. If no bad components were
found, call IBM support to help
troubleshoot marginal
components.
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Indicator lights and problem indications

The following figures show the indicator lights for each unit on the device side (for
the mini-hub, the host side is also shown). The table following each figure shows
the normal and problem indications.

FAStT200 RAID controller
shows the controller indicator lights for a FAStT200 controller.

Fault Cache active Expansion port bypass

T
Controller

rFault H g:: FC-Expansion

FC-Host B

Host loop 10BT 100BT  Battery Expansion loop

Figure 91. FAStT200 controller indicator lights

Table 21. FAStT200 controller indicator lights

Normal Problem Possible condition indicated by the
Icon Indicator Light | Color Operation |Indicator problem indicator

Fault Amber Off On The RAID controller failed

Host Loop Green On Off .

Hy

The host loop is down, not turned on, or
not connected

* GBIC failed, is loose, or not occupied
* The RAID controller circuitry failed or
the RAID controller has no power.

- Expansion Green On Off The RAID controller circuitry failed or the
Loop RAID controller has no power.

Expansion Port | Amber Off On .

Expansion port not occupied
== Bypass

* FC cable not attached to an expansion
unit
» Attached expansion unit not turned on

¢ GBIC failed, FC cable or GBIC failed in
attached expansion unit

FAStT500 RAID controller

[Figure 92 on page 203| shows the mini-hub indicator lights for the FAStT500 RAID
controller.
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Mini-hub indicator lights

Fault

4
y @

Bypass
(upper port)
Loop

good
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H $1n0
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(lower port)

&HEIIIE

G [[e

212 2191810
Jid = gss W
00 & i

Figure 92. FAStT500 RAID controller mini-hub indicator lights
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s s

Table 22. FAStT500 mini-hub indicator lights

Indicator Normal Problem Possible condition indicated by the problem
Icon Light Color Operation |Indicator indicator

Fault Amber Off On Mini-hub or GBIC failed.

Note: If a host-side mini-hub is not
connected to a controller, this fault light is
always on.

-t

Bypass Amber Off On + Upper mini-hub port is bypassed

== (upper port) * Mini-hub or GBIC failed, is loose, or is
missing

¢ Fiber-optic cables are damaged

Note: If the port is unoccupied, the light is
on.

Loop good Green On Off * The loop is not operational

* Mini-hub failed or a faulty device might be
connected to the mini-hub

* Controller failed
Note: If a host-side mini-hub is not

connected to a controller, the green light is
always off and the fault light is always on.

Bypass Amber Off On * Lower mini-hub port is bypassed

== (lower port) * Mini-hub or GBIC failed, is loose, or is
missing

* Fiber-optic cables are damaged

Note: If the port is unoccupied, the light is
on.
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FAStT700 RAID controller
shows the host-side indicator lights on the FAStT700 storage server.

Speed @
Link rate o)
interface switch ———f) 2e
Fault —O !
out
Bypass nd
(upper port) ——o =2
Loop good o
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: .
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(Ioweryzort)iqg -
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M=) il ]| @] o == || Bls| f]s| 2]
ouT | |35 8% 85| 5 et e S e I (RS
0] @]« D)« D& = | D6 ple Bl B«
o= o= o= o= %%% o= o= o= o=
|

‘B %o[

:
[
o
[
o

Mini-hub indicator
lights

Figure 93. Type 1742 FAStT700 storage server mini-hub indicator lights

Table 23. Type 1742 FAStT700 storage server host-side and drive-side mini-hub indicator lights

Icon

Indicator light

Color

Normal
operation

Problem
indicator

Possible condition indicated by
the problem indicator

Speed

Green

On for 2 Gb
Off for 1 Gb

Light on indicates data transfer
rate of 2 Gb per second.
Light off indicates data transfer
rate of 1 Gb per second.

Fault

Amber

Off

Mini-hub or SFP module failed
Note: If a host-side mini-hub is
not connected to a controller, this
fault light is always lit.

Bypass
(upper port)

Amber

Off

* Upper mini-hub port is
bypassed

e Mini-hub or SFP module
failed, is loose, or is missing

* Fiber-optic cables are damaged

Note: When there are two
functioning SFP modules
installed into the mini-hub ports
and there are no fibre channel
cables connected to them, the
bypass indicator is lit.

If there is only one functioning
SFP module installed in a
host-side mini-hub port and there
are no fibre channel cables
connected to it, the indicator light
will not be lit.

However, the drive-side mini-hub
bypass indicator light will be lit
when there is one SFP module
installed in the mini-hub and the
mini-hub has no fibre channel
connection.
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Table 23. Type 1742 FAStT700 storage server host-side and drive-side mini-hub indicator lights (continued)

Icon

Indicator light

Color

Normal
operation

Problem
indicator

Possible condition indicated by
the problem indicator

e

Loop good

Green

On

Off

* The loop is not operational, no
devices are connected

* Mini-hub failed or a faulty
device is connected to the
mini-hub

* If there is no SFP module
installed, the indicator will be
lit

* If one functioning SFP module
is installed in the host-side
mini-hub port and there is no
fibre channel cable connected
to it, the loop good indicator
light will not be lit.

If one functioning SFP module
is installed in the drive-side
mini-hub port and there is no
fibre channel cable connected
to it, the loop good indicator
light will be lit.

* Drive enclosure failed
(drive-side mini-hub only)

Bypass
(lower port)

Amber

Off

* Lower mini-hub port is
bypassed; there are no devices
connected

e Mini-hub or SFP module failed
or is loose

* Fiber-optic cables are damaged

Note: When there are two
functioning SFP modules
installed into the mini-hub port
and there are no fibre channel
cables connected to them, the
bypass indicator light is lit.

If there is only one functioning
SFP module installed in a
host-side mini-hub and there are
no fibre channel cables connected
to it, the indicator light is not lit.

However, the drive-side mini-hub
bypass indicator light will be lit
when there is one functioning
SFP module installed in the
mini-hub port and the mini-hub
has no fibre channel cables
connected to it.

FAStT900 RAID controller

[Figure 94 on page 206| shows the host-side indicator lights.
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Figure 94. Type 1742 FAStT900 storage server mini-hub indicator lights

describes the indicator light status when there are fibre channel
connections between host-side and drive-side mini-hubs.

Table 24. Type 1742 FAStT900 storage server host-side and drive-side mini-hub indicator lights

Icon

Indicator light

Color

Normal
operation

Problem
indicator

Possible condition indicated by
the problem indicator

Speed

Green

On for 2 Gb
Off for 1 Gb

Light on indicates data transfer
rate of 2 Gb per second.
Light off indicates data transfer
rate of 1 Gb per second.

Fault

Amber

Off

Mini-hub or SFP module failed
Note: If a host-side mini-hub is
not connected to a controller, this
fault light is always lit.

Bypass
(upper port)

Amber

Off

* Upper mini-hub port is
bypassed

* Mini-hub or SFP module
failed, is loose, or is missing

* Fiber-optic cables are damaged

Note: When there are two
functioning SFP modules
installed into the mini-hub ports
and there are no fibre channel
cables connected to them, the
bypass indicator is lit.

If there is only one functioning
SFP module installed in a
host-side mini-hub port and there
are no fibre channel cables
connected to it, the indicator light
will not be lit.

However, the drive-side mini-hub
bypass indicator light will be lit
when there is one SFP module
installed in the mini-hub and the
mini-hub has no fibre channel
connection.
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Table 24. Type 1742 FAStT900 storage server host-side and drive-side mini-hub indicator lights (continued)

Icon

Indicator light

Color

Normal
operation

Problem
indicator

Possible condition indicated by
the problem indicator

e

Loop good

Green

On

Off

* The loop is not operational, no
devices are connected

* Mini-hub failed or a faulty
device is connected to the
mini-hub

* If there is no SFP module
installed, the indicator will be
lit

* If one functioning SFP module
is installed in the host-side
mini-hub port and there is no
fibre channel cable connected
to it, the loop good indicator
light will not be lit.

If one functioning SFP module
is installed in the drive-side
mini-hub port and there is no
fibre channel cable connected
to it, the loop good indicator
light will be lit.

* Drive enclosure failed
(drive-side mini-hub only)

Bypass
(lower port)

Amber

Off

* Lower mini-hub port is
bypassed; there are no devices
connected

e Mini-hub or SFP module failed
or is loose

* Fiber-optic cables are damaged

Note: When there are two
functioning SFP modules
installed into the mini-hub port
and there are no fibre channel
cables connected to them, the
bypass indicator light is lit.

If there is only one functioning
SFP module installed in a
host-side mini-hub and there are
no fibre channel cables connected
to it, the indicator light is not lit.

However, the drive-side mini-hub
bypass indicator light will be lit
when there is one functioning
SFP module installed in the
mini-hub port and the mini-hub
has no fibre channel cables
connected to it.
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FAStT EXP500 ESM
shows the indicator lights for the FAStT EXP500 ESM.

FC-AL

1 x10 ‘ x1 ‘ ‘
Tray Number

Input Bypass LED Fault LED Output Bypass LED
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@ ~
N (-]
e
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O

Figure 95. FASIT EXP500 ESM indicator lights

Table 25. EXP500 ESM indicator lights

Indicator Normal Problem Possible condition indicated by the problem
Icon Light Color Operation Indicator indicator
Fault Amber Off On ESM failure
Note: If fault is on, both In and Out should be
in bypass.
] Input Bypass | Amber Off On Port empty
¢ Mini-hub or GBIC failed, is loose, or is
missing
* Fiber-optic cables are damaged
* No incoming signal detected
—t— Output Amber Off On « Port empty
Bypass ¢ Mini-hub or GBIC failed, is loose, or is
missing
* Fiber-optic cables are damaged
* No incoming signal detected, is loose, or is
missing

FAStT EXP700 ESM
The FAStT EXP700 ESMs and user controls are shown in [Figure 96 on page 209}
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Figure 96. ESMs and user controls
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The following table provides diagnostic information on the ESM indicator lights.

Table 26. EXP700 indicator lights

Problem
indicator Component Possible cause Possible solutions
Amber LED is lit |Drive CRU Drive failure Replace failed drive.
Fan CRU Fan failure Replace failed fan.
ESM Subsystem is Check fans for faults. Replace

over-temperature
LED

overheated

failed fan if necessary.

Environment is too
hot

Check the ambient temperature
around the expansion unit. Cool
as necessary.

Defective LED or
hardware failure

If you cannot detect a fan failure
or overheating problem, replace
the ESM.

ESM Fault LED

ESM failure

Replace the ESM. See your
controller documentation for
more information.

ESM Bypass LED

No incoming
signal detected

Reconnect the SFP modules and
Fibre Channel (Fibre Channel)
cables. Replace input and output
SFP modules or cables as
necessary.

ESM failure

If the ESM Fault LED is lit,
replace the ESM.

Front panel

General machine
fault

A Fault LED is lit somewhere on
the expansion unit (check for
Amber LEDs on CRUs).

SFP transmit fault

Check that the CRUs are
properly installed. If none of the
amber LEDs are lit on any of
the CRUs, this indicates an SFP
module transmission fault in the
expansion unit. Replace the
failed SFP module. See your
storage-manager software
documentation for more
information.

Amber LED is lit
and green LED is
off

Power-supply
CRU

The power switch
is turned off or
there is an ac
power failure

Turn on all power-supply
switches.

Amber and green
LEDs are lit

Power-supply
CRU

Power-supply
failure

Replace the failed power-supply
CRU.
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Table 26. EXP700 indicator lights (continued)

Problem
indicator Component Possible cause Possible solutions
All green LEDs All CRUs Subsystem power | Check that all expansion-unit
are off is off power cables are plugged in and
the power switches are on. If
applicable, check that the main
circuit breakers for the rack are
powered on.
AC power failure | Check the main circuit breaker
and ac outlet.
Power-supply Replace the power supply.
failure
Midplane failure | Contact an IBM
technical-support representative
to service the expansion unit.
Amber LED is Drive CRUs Drive rebuild or No corrective action needed.

flashing

identity is in
process

One or more
green LEDs are
off

Power supply
CRUs

Power cable is
unplugged or
switches are
turned off

Make sure the power cable is
plugged in and the switches are
turned on.

All drive CRUs

Midplane failure

Replace the midplane (contact
an IBM technical-support
representative).

Several CRUs

Hardware failure

Replace the affected CRUs. If
this does not correct the
problem, have the ESMs
replaced, followed by the
midplane. Contact an IBM
technical-support representative.

Front panel

Power-supply
problem

Make sure that the power cables
are plugged in and that the
power supplies are turned on.

Hardware failure

If any other LEDs are lit, replace
the midplane. Contact an IBM
technical-support representative.

Intermittent or
sporadic power
loss to the
expansion unit

Some or all CRUs

Defective ac power
source or
improperly
connected power
cable

Check the ac power source.
Reseat all installed power cables
and power supplies. If
applicable, check the power
components (power units or
UPS). Replace defective power
cables.

Power-supply
failure

Check the power supply Fault
LED on the power supply. If the
LED is lit, replace the failed
CRU.

Midplane failure

Have the midplane replaced.
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Table 26. EXP700 indicator lights (continued)

Problem
indicator

Component

Possible cause

Possible solutions

Unable to access
drives

Drives and Fibre
Channel loop

Incorrect
expansion unit ID
settings

Ensure that the Fibre Channel
optical cables are undamaged
and properly connected. Check
the expansion unit ID settings.
Note: Change switch position
only when your expansion unit
is powered off.

ESM failure

Have one or both ESMs
replaced.

Random errors

Subsystem

Midplane feature

Have the midplane replaced.

Read Link Status (RLS) Diagnostics

A fibre channel loop is an interconnection topology used to connect storage
subsystem components and devices. The FAStT Storage Manager Version 8 or later
software uses the connection between the host machine and each controller in the
storage subsystem to communicate with each component and device on the loop.

212

During communication between devices, Read Link Status (RLS) error counts are
detected within the traffic flow of the loop. Error count information is accumulated
over a period of time for every component and device including:

* Drives
e ESMs

* Fibre channel ports

Error counts are calculated from a baseline, which describes the error count values
for each type of device in the fibre channel loop. Calculation occurs from the time
when the baseline was established to the time at which the error count information

is requested.

The baseline is automatically set by the controller. However, a new baseline can be
set manually through the Read Link Status Diagnostics dialog box. For more
information, see [“How to set the baseline” on page 214/

Overview

Read Link Status error counts refer to link errors that have been detected in the
traffic flow of a fibre channel loop. The errors detected are represented as a count
(32-bit field) of error occurrences accumulated over time. The errors help to
provide a coarse measure of the integrity of the components and devices on the

loop.

The Read Link Status Diagnostics dialog box retrieves the error counts and
displays the controllers, drives, ESMs, and fibre channel ports in channel order.

By analyzing the error counts retrieved, it is possible to determine the components
or devices within the fibre channel loop which might be experiencing problems
communicating with the other devices on the loop. A high error count for a
particular component or device indicates that it might be experiencing problems,
and should be given immediate attention.
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Error counts are calculated from the current baseline and can be reset by defining a
new baseline.

Analyzing RLS Results

Analysis of the RLS error count data is based on the principle that the device
immediately "downstream” of the problematic component should see the largest
number of Invalid Transmission Word (ITW) error counts.

Note: Because the current error counting standard is vague about when the ITW
count is calculated, different vendors’ devices calculate errors at different
rates. Analysis of the data must take this into account.

The analysis process involves obtaining an ITW error count for every component
and device on the loop, viewing the data in loop order, and then identifying any
large jumps in the ITW error counts. In addition to the ITW count, the following
error counts display in the Read Link Status Diagnostics dialog box:

Error Count Type

Definition of error

Link Failure (LF)

When detected, link failures indicate that there has been a failure within the media
module laser operation. Link failures might also be caused by a link fault signal, a loss of
signal or a loss of synchronization.

Loss of Synchronization
(LOS)

Indicates that the receiver cannot acquire symbol lock with the incoming data stream,
due to a degraded input signal. If this condition persists, the number of Loss of Signal
errors increases.

Loss of Signal (LOSG)

Indicates a loss of signal from the transmitting node, or physical component within the
fibre channel loop. Physical components where a loss of signal typically occurs include
the gigabit interface connectors, and the fibre channel fibre optic cable.

Primitive Sequence
Protocol (PSP)

Refers to the number of N_Port protocol errors detected, and primitive sequences
received while the link is up.

Link Reset Response
(LRR)

A Link Reset Response (LRR) is issued by another N_Port in response to a link reset.

Invalid Cyclic
Redundancy Check
(ICRC)

Indicates that a frame has been received with an invalid cyclic redundancy check value.
A cyclic redundancy check is performed by reading the data, calculating the cyclic
redundancy check character, and then comparing its value to the cyclic check character
already present in the data. If they are equal, the new data is presumed to be the same as
the old data.

If you are unable to determine which component or device on your fibre channel
loop is experiencing problems, save the RLS Diagnostics results and forward them
to IBM technical support for assistance.

Running RLS Diagnostics

To start RLS Diagnostics, select the storage subsystem from the Subsystem
Management Window; then, either click Storage Subsystem -> Run Read Link
Status Diagnostics from the main menu or right-click the selected subsystem and
click Run Read Link Status Diagnostics from the pop-up menu. The Read Link
Status Diagnostics dialog box displays, showing the error count data retrieved. The
following data displays:

Devices
A list of all the devices on the fibre channel loop. The devices display in
channel order, and within each channel they are sorted according to the
devices position within the loop.
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Baseline Time

The date and time of when the baseline was last set.

Elapsed Time

The elapsed time between when the Baseline Time was set, and when the
read link status data was gathered using the Run option.

ITW  The total number of Invalid Transmission Word (ITW) errors detected on

LF

the fibre channel loop from the baseline time to the current date and time.
ITW might also be referred to as the Received Bad Character Count.

Note: This is the key error count to be used when analyzing the error
count data.

The total number of Link Failure (LF) errors detected on the fibre channel
loop from the baseline time to the current date and time.

LOS  The total number of Loss of Synchronization (LOS) errors detected on the

fibre channel loop from the baseline time to the current date and time.

LOSG The total number of Loss of Signal (LOSG) errors detected on the fibre

channel loop from the baseline date to the current date and time.

PSP  The total number of Primitive Sequence Protocol (PSP) errors detected on

the fibre channel loop from the baseline date to the current date and time.

ICRC The total number of Invalid Cyclic Redundancy Check (ICRC) errors

detected on the fibre channel loop, from the baseline date to the current
date and time.

How to set the baseline

Error counts are calculated from a baseline (which describes the error count values
for each type of device in the fibre channel loop), from the time when the baseline
was established to the time at which the error count information is requested.

The baseline is automatically set by the controller; however, a new baseline can be
set manually through the Read Link Status Diagnostics dialog box using the
following steps:

Note: This option establishes new baseline error counts for ALL devices currently

1.
2.

3.
4.

initialized on the loop.
Click Set Baseline. A confirmation dialog box displays.

Click Yes to confirm baseline change. If the new baseline is successfully set, a
success message displays that indicates that the change has been made.

Click OK. The Read Link Status Diagnostics dialog box displays.
Click Run to retrieve the current error counts.

How to interpret results

To interpret RLS results, perform the following actions:

1.
2.

Open the Read Link Status Diagnostics dialog box.

Review the ITW column in the Read Link Status Diagnostics dialog box and
identify any unusual increase in the ITW counts.

Example:

The following shows the typical error count information displayed in the Read
Link Status Diagnostics dialog box. In this example, the first screen displays the
values after setting the baseline. The RLS diagnostic is run a short while later
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and the result shows an increase in error counts at Controller B. This is
probably due to either the drive right before (2/9), or more likely the ESM
(Drive enclosure 2).

shows the RLS Status after setting the baseline.

% Read Link Status Diagnostics [ %]
Select Run to gather the read link status data. The data displayved will show the change in the various error counts from the time
when the baseline was last set. [fyou want to set a new baseline hefore gathering the data, select Set Baseline. For information on
analyzing the data, refer ta the online help.
Data gathered on {contraller time): 1101 4/01 3:08:45 P
Devices |  BaselinaTime | samplingintsrval] ma | LF | Los | Lose | pse | icre |
Drive Channel 4 =
! Cantroller in slot A 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
Dirive [2,1] 1114001 3:08:40 PM 00:00:05 0 0 0 0 0 0
Drive [2,2] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
Drive [2,3] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
Dirive [2,4] 11114001 3:08:40 PM 00:00:05 0 0 0 0 0 0
Drive [2,5] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
Dirive [2,8] 11114/01 3:08:40 PM 00:00:05 0 0 0 0 0 0
Drive [2,7] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
Drive [2,8] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
M Drive [2,9] 11114401 3:08:40 P 000005 1} 1} 1} 1} 1} 1}
. Drive enclosure 2, E.. 114501 3:08:40 PM 00:00:05 1] 1] 1] 1] 1] 1]
! Cantrallerin slotB 11/14/01 3:08:40 PM 00:00:08 2 0 0 0 0 0=
SetBaseline... Save As... | Close | Help |
Figure 97. RLS Status after setting baseline
Figure 98 shows the RLS Status after running the diagnostic.
% Read Link Status Diagnostics E
Select Run to gather the read link status data. The data displayed will show the change in the various errar counts from the time
when the baseline was last set. Ifyou wantto set a new haseline before gathering the data, select Set Baseline. Forinformation on
analyzing the data, refer ta the online help.
Data gathered on {controller time): 11514501 3:10:01 P
Devices |  BaselineTime | Samplinginterval| ma | LF | Los | Lose | psP | icre |
Drive Channel 4 =
! Controller in slot A 1111401 3:08:40 PM 0o:01:21 1785 0 0 0 0 0
Drive [2,1] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
Dirive [2,2] 11014701 3:08:40 PM 00:01:21 0 0 0 0 0 0
Drive [2,3] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
Drive [2,4] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
Dirive [2,5] 11014501 3:08:40 PM 00:01:21 0 0 0 0 0 0
Drive [2,6] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
Drive [2,7] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
Dirive [2,8] 1114501 3:08:40 PM 00:01:21 0 0 0 0 0 0
Drive [2,59] 1111401 3:08:40 PM 0o:01:21 0 0 0 0 0 0
. Drive enclosure 2, E... 114501 3:08:40 PM 00:01:21 32 1] 1] 1] 1] 1]
! Cantrallerin slat B 11014501 3:08:40 PM 00:01:21 1814 0 0 0 0 0=
Set Baseline... Save As.. | Close | Help |

Figure 98. RLS status after diagnostic

Note: This is only an example and is not applicable to all situations.
Important: Because the current error counting standard is vague about when
the ITW error count is calculated, different vendor’s devices calculate at
different rates. Analysis of the data must take this into account.

the problematic devices. If you are unable to determine which component is
problematic, save your results and forward them to IBM technical support.
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How to save Diagnostics results

For further troubleshooting assistance, save the Read Link Status results and
forward them to technical support for assistance.

1. Click Save As. The Save As dialog box displays.

2. Select a directory and type the file name of your choice in the File name text
box. You do not need to specify a file extension.

3. Click Save. A comma-delimited file containing the read link status results is
saved.
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Chapter 13. PD hints: Hubs and switches

You should be referred to this chapter from a PD map or indication. If this is not
the case, refer back to [Chapter 2, “Problem determination starting points,” on page|

After you have read the relevant information in this chapter, return to the PD map
that directed you here, either [‘Hub/Switch PD map 2” on page 17|or ["Common|
[Path PD map 2” on page 25/

Unmanaged hub

The unmanaged hub is used only with the type 3526 controller. This hub does not
contain any management or debugging aids other than the LEDs that give an
indicator of port up or down.

Switch and managed hub

The switch and managed hub are used with the type 3552, 3542, and 1742
controllers. The following sections describe tests that can be used with the switch
and managed hub.

Running crossPortTest

The crossPortTest verifies the intended functional operation of the switch and
managed hub by sending frames from the transmitter for each port by way of the
GBIC or fixed port and external cable to another port’s receiver. By sending these
frames, the crossPortTest exercises the entire path of the switch and managed
hub.

A port can be connected to any other port in the same switch or managed hub,
provided that the connection is of the same technology. This means that ShortWave
ports can only be connected to ShortWave ports; LongWave ports can be connected
only to LongWave ports.

Note: An error condition will be shown for any ports that are on the switch or
managed hub but that are not connected. If you want more information on
the crossPortTest and its options, see the Installation and Service Guide for
the switch or managed hub you are using.

To repeat the results in the following examples, run the tests in online mode and
with the singlePortAlso mode enabled. The test will run continuously until your
press the Return key on the console being used to perform Ethernet connected
management of the switch or managed hub.

To run, the test must find at least one port with a wrap plug or two ports
connected to each other. If one of these criteria is not met, the test results in the
following message in the telnet shell:

Need at least 1 port(s) connected to run this test.

The command syntax is crossPortTest <nFrames>, <0 or 1> where <nFrames>
indicates the number of frames to run.
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With <nFrames> set to O, the test runs until you press Return.

With the second field set to 0, no single port wrap is allowed and two ports must
be cross-connected. [Figure 99 shows the preferred option, which works with either
wrap or cross-connect. [Figure 100 on page 219|shows the default parms, which
work only with cross-connect.

mghub tadming crossPortTest 0.1

Funning Crozs Port Test . ..ee..

Diag=: (Qiwit,. (Clontinue, (Sratsz. (Llog: =

Diagnostics Status: Thu A 17 1d:0d:17 2000
port#: 0 1 2 5 B 7
diags: 0Ok 0Ok 0K Ok /0K 0K Ok 0K
state; UP UP UP U UP IOW UP DM

ImQy: 45035906 FAT1E frRx 280 LLI_err=.

Iml; 40920918 404591 frix 431 LLI_err=.

ImZ: 543083200 frix 2317360 frix 26 LLI_err=.

Im3: frix FA106 frRx 15 LLI_err=,

lmd: 0 frix 0 frix —errE T ———

Inie; 599 frlx 599 frREx C 0 LLI_errs., <looped-6> O
- e

Total Diag Frames Tx: 12804
Total Hi RFxi 2404

Return pressed

Wrapped port

Figure 99. crossPortTest - Wrap or cross-connect
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myhub fadmin® crossPortTest

Funning Cross Port Test o ..eees

Diagz: (Qiuit. Clontinue. (Sitatz. Liog: =

Diagnostics Status: Thu Aug 17/14:45:35 2000
port# o] 1 2 32 4

disg=: OK 0O O O O 2K O Ok
state; UP UFP UP UF UFP /P UF DM

ImOy 48042814 frTx 801024 frix 280 LLI_err=s,

Imls 40922700 frTx d0RZSE Fri 481 LI _err=,

Im2: B4316812 frTx 2326086 frix 26 LLI_err=s,

Im3: 23820416 106 frREx 15 LLI_errs=.

Imels o frT 0 frRE= 0 LLI e

Im5y 43 48 frRx 0 LLI_errs, <looped-&
Ikt 48 43 frRx 0 LLI_err= g <looped-5

Central Memory OK
Total Diag Frameg Twxi 2265
Total Diag Framgs Fwx: 2865

Diagsz: (Qiuif. Clontinue. (Sitats,. (Liog:

Return pressed Port 6 connected by cable to port 5

Figure 100. crossPortTest - Cross-connect only

Alternative checks

In some rare cases, you might experience difficulty in locating the failed
component after you have checked a path. This section gives alternative checking
procedures to help resolve the problem.

Some of these checks require plugging and unplugging components. This could
lead to other difficulties if, for instance, a cable is not plugged back completely.
Therefore, when the problem is resolved, you should perform a path check to
make sure that no other problems have been introduced into the path. Conversely,
if you started with a problem and, after the unplugging and replugging, you end
up at a non-failing point in the PD maps without any repairs or replacement, then
the problem was probably a bad connection. You should go back to the original
check, such as FAStT MS]J, and rerun the check. If it now runs correctly, you can
assume that you have corrected the problem (but it is a good idea to keep checking
the event logs for further indications of problems in this area).

[Figure 101 on page 220|shows a typical connection path.
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S
—f—- FAStT500 RAID Controller Unit
X Managed H u b Host side Drive side

FC host adapter &

-4/ | ooo oooo | /'—b Mini-hub| Ctrl
[Vinthwb] A | Mini-hub
N -_)/—‘ Mini-hub
= Mini-hub
o _ Yy

* Mini-hub | Ctrl

. [ Minihub | B

Switch
s [ s Y s |

||:I|:I|:I|:I

Figure 101. Typical connection path

In the crossPortTest, data is sourced from the managed hub or switch and travels
the path outlined by the numbers 1, 2, and 3 in For the same path, the
sendEcho function is sourced from the RAID controller and travels the path 3, 2, 1.
Using both tests when problems are hard to find (for example, if the problems are
intermittent) offers a better analysis of the path. In this case, the duration of the
run is also important because enough data must be transferred to enable you to

see the problem.

Managed Hub FAStT500 RAID Controller Unit
| oooooooo | Host side Drive side
X @ _
Mini-hub | Ctrl
\ - Minihub | A Mini-hub
——L/ 4 Mini-hub
® ® Mini-hub
Minchie ] Ctrl _Mini-hubj
crossPortTest path Mini-hub | B
(single port mode)

Figure 102. crossPortTest data path

Running crossPortTest and sendEcho path to and from the
controller

In the case of wrap tests with the wrap plug, there is also dual sourcing capability
by using sendEcho from the controller or crossPortTest from the managed hub or
switch. [Figure 103 on page 221|shows these alternative paths.

Managed Hub

I:II:IEIEIEIEIEIEI|

crossPortTest path with wrap plug at cable end
(single port mode)
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FAStT500 RAID Controller Unit

Host side
—v [Wrwe] Ctrl
< Vinthib] A
W
&
~N
Mini-hub | Ctrl
| Mini-hub | B

Drive side

Mini-hub
Mini-hub
' Mini-huby

Mini-hub;

sendEcho path with wrap plug
at cable end

Figure 103. sendEcho and crossPortTest alternative paths
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Chapter 14. PD hints: Wrap plug tests

You should be referred to this chapter from a PD map or indication. If this is not
the case, refer back to [Chapter 2, “Problem determination starting points,” on page|

After you have read the relevant information in this chapter, return to
[Fail PD map 1” on page 22)

The following sections illustrate the use of wrap plugs.

Running sendEcho and crossPortTest path to and from controller

Failed path of read/write buffer test

FAStT500 RAID Controller Unit

Host side Drive side
Mini-hub | Ctrl
Mini-hub | A Mini-hub
Install wrap plug to GBIC on mini-hub Mini-hub
of controller A 1 Mini-hub)
| v
Mini-hub
Mini-hub | Ctr| e
Mini-hub | B

Figure 104. Install wrap plug to GBIC
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Failed path of read/write buffer test

&;& 3526 Controller Unit

Ctrl
\ Ar all | | ‘

Install wrap plug to MIA on controller A

Figure 105. Install wrap plug to MIA

Alternative wrap tests using wrap plugs

There is dual sourcing capability with wrap tests using wrap plugs. Use sendEcho
from the controller or crossPortTest from the managed hub or switch. See
[“Hub/Switch PD map 1” on page 15 for the information on how to run the
crossPortTest. |[Figure 106 and [Figure 107 on page 225 show these alternative
paths.

FAStT500 RAID Controller Unit

Host side Drive side
Mini-hub) C ﬂl’
Mini-hub
A Mini-hub|
Mini-hub]
Mini-hub
: Mini-hub
Mini-hub) C ﬂl‘
sendEcho path with wrap plug  |Minihul B

at cable end

Figure 106. sendEcho path
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Managed Hub

EIEIEIEIEIEIEIEI|

g 7

7/

=" \_~

crossPortTest path with wrap plug at cable end
(single port mode)

Figure 107. crossPortTest path
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Chapter 15. Heterogeneous configurations

You should be referred to this chapter from a PD map or indication. If this is not
the case, refer back to [Chapter 2, “Problem determination starting points,” on page|

FAStT Storage Manager Version 7 or later provides the capability to manage
storage in an heterogeneous environment. This does introduce increased
complexity and the potential for problems. This chapter shows examples of
heterogeneous configurations and the associated configuration profiles from the
FAStT Storage Manager. These examples can assist you in identifying improperly
configured storage by comparing the customer’s profile with those supplied,
assuming similar configurations.

It is very important that the Storage Partitioning for each host be assigned the
correct host type (see . If not, the host will not be able to see its
assigned storage. The host port identifier that you assign a host type to is the HBA
WW node name.

Topoloogy Wiew
% Storage Subsystam Flute_2
Default Host Group
=- f] HostFe-PDC
B Host Pan FC-PDCI
B Host PR FC-POIC2
=[] HostMODEA
B Host Part MODEA1
B9 Host Port NODEAZ Right-click on Host

S8 3 HostMODEB x|

& Host Port HODEB \ Linet NODES

B Host Port MODEB2

Hast port identifier: Hast port name:
[z0fdone0EaZ0Z 3R =| |noDEBS3 =]
Host type:
[Linux =]

Add Close | Help ‘

Figure 108. Host information

Configuration examples

Following are examples of heterogeneous configurations and the associated
configuration profiles for FAStT Storage Manager Version 7.10 and above. For more
detailed information, see the FAStT Storage Manager Concept guides for your
respective SM version.

Windows cluster
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FASIT EXPS00
Disk Enclosure
(3560-1RLY
(FC 36LB209)

FASITS00 FC
Contraller
(3552-1RLN

[BM FLC
Switch
(2109516)

Hosts

Management
otation
Windows 2000
Arhvanced
Server

Figure 109. Windows cluster

Table 27. Windows cluster configuration example

FAStTZ200
starage

subsystem
(354 2-2RL)

W oy Wi owes
NT-4 NT-4
M S PSC S

Network Management Type

Partition

Storage Partitioning Topology

Host A |Client Direct attached Windows 2000 AS Host Port Al Type=Windows 2000
Non-Clustered
Host Port A2 Type=Windows 2000
Non-Clustered

Host B Host Agent Attached Windows NT Cluster Host Port B1 Type=Windows Clustered (SP5 or

later)

Host Port B2 Type=Windows Clustered (SP5 or
later)
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Table 27. Windows cluster configuration example (continued)

Network Management Type |Partition Storage Partitioning Topology
Host C Host Agent Attached Windows NT Cluster Host Port C1 Type=Windows Clustered (SP5 or
higher)
Host Port C2 Type=Windows Clustered (SP5 or
higher)
Heterogeneous configuration
FASIT EXPS00
Dizk Enclosure
(3560-1RUY
(FC 36L5209)
_____________ FAStT200
Storage
""""""" Subsystern
: (3542-2RU)
FAStTS00 FC !
Controller ¢
(3552-1R L)
1BM FC IBM FC
Switch Switch
(2109516) (2109516)
Hosts
Mag?é;tliaurger‘lt WngDDWS WiandDDD\vVS Metware Linux Wir[lld_l_ows
Windows 2000
Advanced MSCS MSCS
SErver
Figure 110. Heterogeneous configuration
Table 28. Heterogeneous configuration example
Network Management Type |Partition Storage Partitioning Topology
Host A |Client Direct attached Windows 2000 AS Host Port A1l Type=Windows 2000
Non-Clustered
Host Port A2 Type=Windows 2000
Non-Clustered
Host B Host Agent Attached Windows 2000 Cluster | Host Port B1 Type=Windows Clustered
Host Port B2 Type=Windows Clustered
Host C Host Agent Attached Windows 2000 Cluster |Host Port C1 Type=Windows Clustered
Host Port C2 Type=Windows Clustered
Host D |Host Agent Attached Netware Host Port D1/ Type=Netware
Host Port D2/Type=Netware
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Table 28. Heterogeneous configuration example (continued)

Network Management Type |Partition Storage Partitioning Topology

Host E Host Agent Attached Linux Host Port E1/ Type=Linux

Host Port E2/Type=Linux

Host F Host Agent Attached Windows NT Host Port F1/Type=Windows NT

Host Port F2/ Type=Windows NT
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Chapter 16. Using IBM Fast!UTIL

This chapter provides detailed configuration information for advanced users who
want to customize the configuration of the following adapters:

* IBM fibre-channel PCI adapter (FRU 01K7354)
* IBM FAStT host adapter (FRU 09N7292)

+ IBM FAStT FC2-133 (FRU 24P0962) and FC2-133 Dual Port (FRU 38P9099) host
bus adapters

For more information about these adapters, see the IBM TotalStorage FAStT
Hardware Maintenance Manual.

You can configure the adapters and the connected fibre channel devices using the
Fast!UTIL utility.

Starting Fast!UTIL

To access Fast!UTIL, press Ctrl+Q (or Alt+Q for 2100) during the adapter BIOS
initialization (it might take a few seconds for the Fast!UTIL menu to display). If
you have more than one adapter, Fast!UTIL prompts you to select the adapter you
want to configure. After changing the settings, Fast!UTIL restarts your system to
load the new parameters.

Important: If the configuration settings are incorrect, your adapter will not
function properly. Do not modify the default configuration settings unless you are
instructed to do so by an IBM support representative or the installation
instructions. The default settings are for a typical Microsoft Windows installation.
See the adapter driver readme file for the appropriate operating system for
required NVRAM setting modifications for that operating system.

Fast!UTIL options

This section describes the Fast!UTIL options. The first option on the Fast!UTIL
Options menu is Configuration Settings. The settings configure the fibre-channel
devices and the adapter to which they are attached.

Note: If your version of Fast!UTIL has settings that are not discussed in this
section, then you are working with down-level BIOS or non-supported
BIOS. Update your BIOS version.

Host adapter settings

You can use this option to modify host adapter settings. The current default
settings for the host adapters are described in this section.

Note: All settings for the IBM fibre-channel PCI adapter (FRU 01K7354) are
accessed from the Host Adapter Settings menu option (see [Table 29 on page]|
[232). The FASHT host adapter (FRU 09N7292) and the FAStT FC2-133 host
bus adapters (FRU 24P0962, 38P9099) offer additional settings available from
the Advanced Adapter Settings menu option (see [Table 30 on page 232 and
[Table 31 on page 232). Any settings for the fibre-channel PCI adapter (FRU
01K7354) not described in this section are described in “Advanced adapter
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[settings” on page 233

Table 29. IBM fibre-channel PCI adapter (FRU 01K7354) host adapter settings

Setting Options Default
Host adapter BIOS Enabled or Disabled Disabled
Enable LUNs Yes or No Yes
Execution throttle 1-256 256
Drivers load RISC code Enabled or Disabled Enabled
Frame size 512, 1024, 2048 2048

IOCB allocation 1-512 buffers 256 buffers
Loop reset delay 0-15 seconds 8 seconds
Extended error logging Enabled or Disabled Disabled
Port down retry count 0-255 30

Table 30. FAStT host adapter (FRU 09N7292) host adapter settings

Setting Options Default
Host adapter BIOS Enabled or Disabled Disabled
Frame size 512, 1024, 2048 2048
Loop reset delay 0-15 seconds 5 seconds
Adapter hard loop ID Enabled or Disabled Enabled
Hard loop ID 0-125 125

Table 31. FASIT FC2-133 host bus adapters (FRU 24P0962, 38P9099) host adapter

settings

Setting Options Default
Host adapter BIOS Enabled or Disabled Disabled
Frame size 512, 1024, 2048 2048
Loop reset delay 0-60 seconds 5 seconds
Adapter hard loop ID Enabled or Disabled Enabled
Hard loop ID 0-125 125

Spin up delay Enabled or Disabled Disabled

Host adapter BIOS
When this option is set to Disabled, the ROM BIOS code on the adapter is
disabled, freeing space in upper memory. This setting must be enabled if
you are starting from a fibre channel hard disk that is attached to the
adapter. The default is Disabled.

Frame size
This setting specifies the maximum frame length supported by the adapter.
The default size is 2048. If you are using F-Port (point-to-point)
connections, the default is best for maximum performance.

Loop reset delay
After resetting the loops, the firmware does not initiate any loop activity
for the number of seconds specified in this setting. The default is 5
seconds.
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Adapter hard loop ID
This setting forces the adapter to use the ID specified in the Hard loop ID
setting. The default is Enabled. (For FAStT host adapter [FRU 09N7292)]
and FAStT FC2-133 host bus adapters [FRU 24P0962, 38P9099] only.)

Hard loop ID
When the adapter hard loop ID is set to Enabled, the adapter uses the ID
specified in this setting. The default ID is 125.

Spin up delay
When this setting is Enabled, the BIOS code waits up to 5 minutes to find
the first drive. The default is Disabled.

Note: Adapter settings and default values might vary, based on the version of
BIOS code installed for the adapter.

Selectable boot settings

When you set this option to Enabled, you can select the node name from which
you want to start up (boot). When this option is set to Enabled, the node will start
from the selected fibre channel hard disk, ignoring any IDE hard disks attached to
your server. When this option is set to Disabled, the Boot ID and Boot LUN
parameters have no effect.

The BIOS code in some new systems supports selectable boot, which supersedes
the Fast!UTIL selectable boot setting. To start from a fibre channel hard disk
attached to the adapter, select the attached fibre channel hard disk from the system
BIOS menu.

Note: This option applies only to disk devices; it does not apply to CDs, tape
drives, and other nondisk devices.

Restore default settings
You can use this option to restore the adapter default settings.

Note: The default NVRAM settings are the adapter settings that were saved the
last time an NVRAM update operation was run from the BIOS Update
Utility program (option U or command line /U switch). If the BIOS Update
Utility program has not been used to update the default NVRAM settings
since the adapter was installed, the factory settings are loaded.

Raw NVRAM data

This option displays the adapter nonvolatile random access memory (NVRAM)
contents in hexadecimal format. This is a troubleshooting tool; you cannot modify
the data.

Advanced adapter settings

You can use this option to modify the advanced adapter settings. The current
default settings for the adapter are described in this section.

Note: The Advanced Adapter Settings menu option is available only for the
FAStT host adapter (FRU 09N7292) (see [Table 32 on page 234) and the FAStT
FC2-133 host bus adapters (FRU 24P0962, 38P9099) (see [Table 33 on page]
. All settings for the IBM fibre-channel PCI adapter (FRU 01K7354) are
accessed from the Host Adapter Settings menu option.
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Table 32. FASIT host adapter (FRU 09N7292) advanced adapter settings

Setting Options Default
Execution throttle 1-256 256

Fast command posting Enabled or Disabled Enabled
>4GByte addressing Enabled or Disabled Disabled
LUNSs per target 0, 8, 16, 32, 64, 128, 256 0

Enable LIP reset Yes or No No
Enable LIP full login Yes or No Yes
Enable target reset Yes or No Yes
Login retry count 0-255 30

Port down retry count 0-255 30
Drivers load RISC code Enabled or Disabled Enabled
Enable database updates Yes or No No
Disable database load Yes or No No
IOCB allocation 1-512 buffers 256 buffers
Extended error logging Enabled or Disabled Disabled

Table 33. FAStT FC2-133 host bus adapters (FRU 24P0962, 38P9099) advanced adapter

settings

Setting Options Default
Execution throttle 1-256 256
>4GByte addressing Enabled or Disabled Disabled
LUNSs per target 0, 8, 16, 32, 64, 128, 256 0

Enable LIP reset Yes or No No
Enable LIP full login Yes or No Yes
Enable target reset Yes or No Yes
Login retry count 0-255 30

Port down retry count 0-255 30

IOCB allocation 1-512 bulffers 256 buffers
Extended error logging Enabled or Disabled Disabled

Execution throttle
This setting specifies the maximum number of commands running on any
one port. When a port reaches its execution throttle, Fast!UTIL does not
run any new commands until the current command is completed. The
valid options for this setting are 1 through 256. The default (optimum) is
256.

Fast command posting
This setting decreases command execution time by minimizing the number
of interrupts. The default is Enabled for the FAStT host adapter (FRU
09N7292).

>4GByte addressing
Enable this option when the system has more than 4 GB of memory
available. The default is Disabled.
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LUNs per target (for IBM fibre-channel PCI adapter [FRU 01K7354])
This setting specifies the number of LUNs per target. Multiple logical unit
number (LUN) support is typically for redundant array of independent
disks (RAID) enclosures that use LUNs to map drives. The default is 8. For
Netware, set the number of LUNs to 32.

LUNSs per target (for FAStT host adapter [FRU 09N7292] and FAStT FC2-133 host
bus adapters [FRU 24P0962, 38P9099])
This setting specifies the number of LUNs per target. Multiple logical unit
number (LUN) support is typically for redundant array of independent
disks (RAID) enclosures that use LUNs to map drives. The default is 0. For
Netware, set the number of LUNSs to 32.

Enable LIP reset
This setting determines the type of loop initialization process (LIP) reset
that is used when the operating system initiates a bus reset routine. When
this option is set to Yes, the device driver initiates a global LIP reset to
clear the target device reservations. When this option is set to No, the
device driver initiates a global LIP reset with full login. The default is No.

Enable LIP full logon
This setting instructs the ISP chip to log into all ports after any LIP. The
default is Yes.

Enable target reset
This setting enables the device drivers to issue a Target Reset command to
all devices on the loop when a SCSI Bus Reset command is issued. The
default is Yes.

Login retry count
This setting specifies the number of times the software tries to log in to a
device. The default is 30 retries.

Port down retry count
This setting specifies the number of times the software retries a command
to a port that is returning port-down status. The default is 30 retries.

Drivers load RISC code:
When this option is set to Enabled, the adapter uses the RISC firmware
that is embedded in the software device driver. When this option is set to

Disabled, the software device driver loads the RISC firmware found in the
adapter BIOS code. The default is Enabled.

Note: To load the embedded device driver software, the device driver
being loaded must support this setting. If the device driver does not
support this setting, the result is the same as if this option is set to
Disabled, regardless of the setting. Leaving this option enabled
ensures a certified combination of software device driver and RISC
firmware.

Enable database updates
When this option is set to Enabled, the software can save the loop

configuration information in flash memory as the system powers down.
The default is No.

Disable database load
When this option is set to Enabled, the device database is read from the
Registry during driver initialization. When this option is set to Disabled,
the device database is created dynamically during device driver
initialization. The default is No.
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Note: This option usually applies to the Windows NT and Windows 2000
operating system environments.

IOCB allocation
This option specifies the maximum number of buffers from the firmware
buffer pool that are allocated to any one port. The default setting is 256
buffers.

Extended error logging
This option provides additional error and debugging information to the
operating system. When this option is set to Enabled, events are logged
into the Windows NT Event Viewer or Windows 2000 Event Viewer
(depending on the environment you are in). The default is Disabled.

Extended firmware settings

You can use this option to modify the extended firmware settings. The current
default settings for the host adapter are listed in and are described in this
section.

Note: The Extended Firmware Settings menu option is available only for the
FAStT host adapter (FRU 09N7292) and the FAStT FC2-133 host bus
adapters (FRU 24P0962, 38P9099). Extended firmware settings are not
available for the IBM fibre-channel PCI adapter (FRU 01K7354).

Table 34. Extended firmware settings for FAStT host adapter (FRU 09N7292) and FAStT
FC2-133 host bus adapters (FRU 24P0962, 38P9099)

Setting Options Default
RIO operation mode 0,5 0
Connection Options [for 0,1,2,3 3
FAStT host adapter (FRU

09N7292)]

Connection Options [for 0,1,2 2

FAStT FC2-133 host bus
adapters (FRU 24P0962,

38P9099)]

Fibre channel tape support | Enabled or Disabled Disabled
Interrupt delay timer 0-255 0

Data rate [for FAStT FC2-133 (0, 1, 2 2

host bus adapters (FRU
24P0962, 38P9099) only]

RIO operation mode
This setting specifies the reduced interrupt operation (RIO) modes, if
supported by the software device driver. RIO modes enable posting
multiple command completions in a single interrupt (see . The
default is 0.

Table 35. RIO operation modes for FAStT host adapter (FRU 09N7292) and FAStT FC2-133
host bus adapters (FRU 24P0962, 38P9099)

Option Operation mode
0 No multiple responses
5 Multiple responses with minimal interrupts
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Connection options
This setting defines the type of connection (loop or point-to-point) or

connection preference (see [Table 36). The default is 3 for the FAStT host
adapter (FRU 09N7292) or 2 for the FAStT FC2-133 host bus adapters (FRU

24P0962, 38P9099).

Table 36. Connection options for FAStT host adapter (FRU 09N7292) and FAStT FC2-133
host bus adapters (FRU 24P0962, 38P9099)

Option Type of connection

0 Loop only

1 Point-to-point only

2 Loop preferred; otherwise, point-to-point
3 (for FAStT host adapter Point-to-point; otherwise, loop

[FRU 09N7292] only)

Fibre channel tape support
This setting is reserved for fibre channel tape support. The default is

Disabled.

Interrupt delay timer
This setting contains the value (in 100-microsecond increments) used by a

timer to set the wait time between accessing (DMA) a set of handles and
generating an interrupt. The default is 0.

Data rate (for FAStT FC2-133 host bus adapters [FRU 24P0962, 38P9099] only):
This setting determines the data rate (see[Table 3§|). When this field is set to
2, the FAStT FC2-133 host bus adapters determines what rate your system
can accommodate and sets the rate accordingly. The default is 2.

Table 37. Data rate options for FAStT FC2-133 host bus adapters (FRU 24P0962, 38P9099)

Option Data Rate
0 1 Gbps

1 2 Gbps

2 Auto select

Scan fibre channel devices

Use this option to scan the fibre channel loop and list all the connected devices by
loop ID. Information about each device is listed, for example, vendor name,
product name, and revision. This information is useful when you are configuring
your adapter and attached devices.

Fibre channel disk utility

Attention: Performing a low-level format removes all data on the disk.

Use this option to scan the fibre channel loop bus and list all the connected devices
by loop ID. You can select a disk device and perform a low-level format or verify
the disk media.

Loopback data test

Use this option to verify the adapter basic transmit and receive functions. A fibre
channel loop back connector option must be installed into the optical interface
connector on the adapter before starting the test.
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Select host adapter

Use this option to select, configure, or view a specific adapter if you have multiple
adapters in your system.

ExitFast!UTIL

After you complete the configuration, use the ExitFast!UTIL option to exit the
menu and restart the system.
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Chapter 17. Frequently asked questions about FAStT Storage
Manager

This chapter contains answers to frequently asked questions (FAQs) in the
following areas:

+ |“Global Hot Spare (GHS) drives’|
* [“Auto Code Synchronization (ACS)” on page 242]
» |“Storage partitioning” on page 245

* |"Miscellaneous” on page 246|

Global Hot Spare (GHS) drives
What is a Global Hot Spare?

A Global Hot Spare is a drive within the storage subsystem that has been defined
by the user as a spare drive. The Global Hot Spare is to be used in the event that a
drive that is part of an array with redundancy (RAID 1, 3, 5 array) fails. When the
fail occurs, and a GHS drive is configured, the controller will begin reconstructing
to the GHS drive. Once the reconstruction to the GHS drive is complete, the array
will be promoted from the Degraded state to the Optimal state, thus providing full
redundancy again. When the failed drive is replaced with a good drive, the
copy-back process will start automatically.

What is reconstruction and copy-back?

Reconstruction is the process of reading data from the remaining drive (or drives)
of an array that has a failed drive and writing that data to the GHS drive.
Copy-back is the process of copying the data from the GHS drive to the drive that
has replaced the failed drive.

What happens during the reconstruction of the GHS?

During the reconstruction process, data is read from the remaining drive (or
drives) within the array and used to reconstruct the data on the GHS drive.

How long does the reconstruction process take?

The time to reconstruct a GHS drive will vary depending on the activity on the
array, the size of the failed array, and the speed of the drives.

What happens if a GHS drive fails while sparing for a failed drive?

If a GHS drive fails while it is sparing for another drive, and another GHS is
configured in the array, a reconstruction process to another GHS will be done.

If a GHS fails, and a second GHS is used, and both the originally failed drive

and the failed GHS drive are replaced at the same time, how will the copy-back
be done?
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The controller will know which drive is being spared by the GHS, even in the
event that the first GHS failed and a second GHS was used. When the original
failed drive is replaced, the copy-back process will begin from the second GHS.

If the size of the failed drive is 9Gbyte, but only 3Gbytes of data have been
written to the drive, and the GHS is an 18Gbyte drive, how much is
reconstructed?

The size of the array determines how much of the GHS drive will be used. For
example, if the array has two 9Gbyte drives, and the total size of all logical drives
is 18Gbyte, then 9Gbytes of reconstruction will occur, even if only 3Gbytes of data
exist on the drive. If the array has two 9Gbyte drives, and the total size of all
logical drives is 4Gbytes, then only 2Gbytes of reconstruction will be done to the
GHS drive.

How can you determine if a Global Hot Spare (GHS) is in use?

The Global Hot Spare is identified in FAStT Storage Manager by the following
icon:

r

If a drive fails, which GHS will the controller attempt to use?

The controller will first attempt to find a GHS on the same channel as the failed
drive; the GHS must be at least as large as the configured capacity of the failed
drive. If a GHS does not exist on the same channel, or if it is already in use, the
controller will check the remaining GHS drives, beginning with the last GHS
configured. For example, if the drive at location 1:4 failed, and if the GHS drives
were configured in the following order, 0:12, 2:12, 1:12, 4:12, 3:12, the controller will
check the GHS drives in the following order, 1:12, 3:12, 4:12, 2:12, 0:12.

Will the controller search all GHS drives and select the GHS drive closest to the
configured capacity of the failed drive?

No. The controller will use the first available GHS that is large enough to spare for
the failed drive.

Can any size drive be configured as a GHS drive?

At the time a drive is selected to be configured as a GHS, it must be equal or
larger in size than at least one other drive in the attached drive enclosures that is
not a GHS drive. However, it is strongly recommended that the GHS have at least

the same capacity as the target drive on the subsystem.

Can a GHS that is larger than the drive that failed act as a spare for the smaller
drive?

Yes.

Can a 9Gbyte GHS drive spare for an 18Gbyte failed drive?
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A GHS drive can spare for any failed drive, as long as the GHS drive is at least as
large as the configured capacity of the failed drive. For example, if the failed drive
is an 18Gbyte drive with only 9Gbyte configured as part of an array, a 9Gbyte
drive can spare for the failed drive.

However, to simplify storage management tasks and to prevent possible data loss
in case a GHS is not enabled because of inadequate GHS capacity, it is strongly
recommended that the GHS have at least the same capacity as the target drive on
the subsystem.

What happens if the GHS drive is not large enough to spare for the failed drive?

If the controller does not find a GHS drive that is at least as large as the
configured capacity of the failed drive, a GHS will not be activated, and,
depending on the array state, the LUN will become degraded or failed.

What action should be taken if all drives in the array are now larger than the
GHS drive?

Ideally, the GHS drive will be replaced with a drive as large as the other drives in
the array. If the GHS drive is not upgraded, it will continue to be a viable spare as
long as it is as large as the smallest configured capacity of at least one of the
configured drives within the array.

The previous two questions describe what might happen in this case. It is strongly
recommended that you upgrade the GHS to the largest capacity drive.

How many GHS drives can be configured in an array?

The maximum number of GHS drives for FAStT Storage Manager Versions 7 or
later is fifteen per subsystem.

How many GHS drives can be reconstructed at the same time?

Controller firmware versions 3.x and older will only allow for one reconstruction
process per controller to occur at the same time. An additional requirement is that
in order for two reconstruction processes to occur at the same time, the LUNs
affected cannot be owned by the same controller. For example, if a drive in LUN_1
and a drive in LUN-4 fail, and both LUNs are owned by Controller_A, then only
one reconstruction will occur at a time. However, if LUN-1 is owned by
Controller_A, and LUN-4 is owned by Controller_B, then two reconstruction
process will occur at the same time. If multiple drives fail at the same time, the
others will be queued after the currently-running reconstruction completes.

Once the GHS reconstruction has started, and the failed drive is replaced, does
the reconstruction of the GHS stop?

The reconstruction process will continue until complete, and then begin a
copy-back to the replaced drive.

What needs to be done to a GHS drive that has spared for a failed drive after
the copy-back to the replaced drive has been completed?

Once the copy-back to the replaced drive is complete, the GHS drive will be
immediately available as a GHS. There is no need for the user to do anything.
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Does the GHS have to be formatted before it can be used?

No. The GHS drive will be reconstructed from the other drive (or drives) within
the LUN that had a drive fail.

What happens if a GHS drive is moved to a drive-slot that is part of LUN, but
not failed?

When the GHS drive is moved to a drive-slot that is not failed and is part of a
LUN, the drive will be spun up, marked as a replacement of the previous drive,
and reconstruction started to the drive.

Can a GHS drive be moved to a drive-slot occupied by a faulted drive that is
part of a LUN?

Yes. In this case, the GHS drive will now be identified as a replacement for the
failed drive, and begin a copy-back or reconstruction, depending on whether a
GHS drive was activated for the faulted drive.

What happens if a GHS drive is moved to an unassigned drive-slot, and the
maximum GHS drives are already configured?

Once the maximum number of GHS drives have been configured, moving a GHS
drive to an unassigned drive-slot will cause the GHS drive to become an

unassigned drive.

What happens if a drive from a LUN is accidentally inserted into a GHS drive
slot?

Once a drive is inserted into a slot configured as a GHS, the newly inserted drive
will become a GHS, and the data previously on the drive will be lost. Moving
drives in or out of slots configured as GHS drives must be done very carefully.

How does the controller know which drive slots are GHS drives?

The GHS drive assignments are stored in the dacStore region of the Sundry drives.

Auto Code Synchronization (ACS)
What is ACS?

ACS is a controller function that is performed during the controller Start-Of-Day
(SOD) when a foreign controller is inserted into an array, at which time the
Bootware (BW) and Appware (AW) versions will be checked and synchronized if
needed.

What versions of FW support ACS?

ACS was first activated in controller FW version 3.0.x, but the LED display was
added to controller FW version 03.01.x and later.

How to control if ACS is to occur?
ACS will occur automatically when a foreign controller is inserted, or during a
power-on, if bit 1 is set to 0 (zero) and bit 2 is set to 1 (one) in NVSRAM byte

offset 0x29. If these bits are set appropriately, the newly inserted controller will
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check the resident controller BW and AW versions with its own, and if different,
will begin the synchronization process.

Bit1=0 Auto Code Synchronization will occur only if the newly inserted
controller is a foreign controller (a different controller from the one that
was previously in the same slot).

Bit2=1 Enable Automatic Code Synchronization (ACS)

What is a resident controller and what is a foreign controller?

A controller is considered to be resident if it is the last controller to have
completed a SOD in that slot and has updated the dacStore on the drives. A
foreign controller is one that is not recognized by the array when powered on or
inserted.

Example A: In a dual controller configuration that has completed SOD, both
controllers are considered to be resident. If the bottom controller is removed, and a
new controller is inserted, the new controller will not be known by the array and
will be considered foreign, because it is not the last controller to have completed a
SOD in that slot.

Example B: In a dual controller configuration that has completed SOD, both
controllers are considered to be resident. If controller Y is removed from the
bottom slot, and controller Z is inserted into the bottom slot, controller Z will be
considered foreign until it has completed the SOD. If controller Z is then removed
and controller Y is reinserted, controller Y will be considered foreign because it is
not the last controller to have completed the SOD in that slot.

What happens if a single controller configuration is upgraded to dual controller?

If a controller is inserted into a slot that has not previously held a controller since
the array was cleared, ACS will not be invoked. This is because there is no
previous controller information in the dacStore region to use for evaluating the
controller as being resident or foreign.

When will ACS occur?

Synchronization will occur only on power cycles and controller insertion, not on
resets. During the power-on, the foreign controller will send its revision levels to
the resident controller and ask if ACS is required. The resident controller will
check NVSRAM settings and, if ACS is enabled, will then check the revision
numbers. A response is then sent to the foreign controller, and if ACS is not
required, the foreign controller will continue its initialization. If ACS is required, a
block of RPA cache will be allocated in the foreign controller and the ACS process
will begin.

Which controller determines if ACS is to occur?

The NVSRAM bits of the resident controller will be used to determine whether
synchronization is to be performed. The controller being swapped in will always
request synchronization, which will be accepted or rejected based on the NVSRAM

bits of the resident controller.

What is compared to determine if ACS is needed?
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The entire code revision number will be used for comparison. Both the BW and
AW versions will be compared, and, if either are different, both the BW and AW
will be erased and rewritten. The number of separate loadable partitions is also
compared; if different, the code versions are considered to be different without
considering the revision numbers.

How long will the ACS process take to complete?

The ACS process will begin during the Start-Of-Day process, or between 15 and 30
seconds after power-up or controller insertion. The ACS process for Series 3
controller code will take approximately three minutes to complete. As the code size
increases, the time to synchronize will also increase. Once ACS is complete, do not
remove the controllers for at least three minutes, in case NVSRAM is also
synchronized during the automatic reset.

What will happen if a reset occurs before ACS is complete?

It is important that neither of the controllers are reset during the ACS process. If a
reset occurs during this process, it is likely that the foreign controller will no
longer boot or function correctly, and it might have to be replaced.

Is NVSRAM synchronized by ACS?

NVSRAM synchronization is not part of ACS, but is checked with dacStore on the
drives every time the controller is powered on. The synchronization is not with the
alternate controller, but with the NVSRAM as written to dacStore for the controller
slot. Each controller, slot-A and slot-B, have individual NVSRAM regions within
dacStore. The update process takes approximately five seconds, does not require a
reset, and synchronizes the following NVSRAM regions: UserCfg, NonCfg,
Platform, HostData, SubSys, DrvFault, InfCfg, Array, Hardware, FCCfg, SubSysID,
NetCfg, Board.

Note: No LED display will be seen during the synchronization of the NVSRAM.
What is the order of the synchronization?

Both the BW and AW are synchronized at the same time. NVSRAM will be
checked and synchronized during the automatic reset following the ACS of the
controller code.

Will the controller LEDs flash during ACS?

The function to flash the LEDs during ACS was first enabled in controller
Firmware version 03.01.01.01. If the foreign controller has a release prior to
03.01.01.01, the LED display will not be seen during ACS. The controller being
updated controls the LED synchronization display.

What is the LED display sequence?

If the foreign controller has a Firmware version equal to or newer than 03.01.01.01,
the LEDs will be turned on from right to left, and then turned off left to right. This
sequence will continue until the ACS process is complete.

Is a reset required after ACS is complete?

When the ACS process is complete, the controller will automatically reset.
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What is the ACS sequence for controllers with AW prior to 03.01.01.01?

If the foreign controller has AW prior to 03.01.01.01, the LED display will not be
displayed. In this case, the controllers should not be removed or reset for at least
15 minutes. Once the foreign controller has reset, the controller will be ready for
use within two minutes.

Will ACS occur if the controller is cold swapped?
Yes, providing the NVSRAM bits are set to allow ACS to occur.
What happens if both controllers are cold swapped?

If both controllers are cold swapped (that is, if both are foreign), the controller with
the higher FW version number will be loaded onto the alternate controller. This is
simply a numerical comparison. For example, if controller A is 03.01.01.08, and
controller B is 03.01.01.11, then controller A will be upgraded to 03.01.01.11. The
NVSRAM will be updated from dacStore.

What sequence of events should be expected during ACS?

If ACS is enabled, the process will begin about 30 seconds after the controller is
inserted or powered on. When ACS begins, the SYM1000 and the foreign controller
fault lights will begin to flash, and the controller LEDs will begin to turn on one at
a time from right to left, then off left to right. This process will continue for
approximately three minutes until the ACS process is complete. Once the ACS
process is complete, the foreign controller will reset automatically and during the
reset, the NVSRAM will be checked, and updated if needed. The entire process
will take approximately five minutes to complete.

Storage partitioning

Does the Storage Partitions feature alleviate the need to have clustering software
at the host end?

No. Clustering software provides for the movement of applications between hosts
for load balancing and failover. Storage Partitions just provides the ability to
dedicate a portion of the storage to one or more hosts. Storage partitions should
work well with clustering in that a cluster of hosts can be grouped as a Host
Group to provide access to the same storage as needed by the hosts in that cluster.

If T have two hosts in a host group sharing the same logical drives, and both
hosts trying to modify the same data on the same logical drive, how are conflicts
resolved?

This is one of the primary value adds of clustering software. Clustering software
comes in two flavors:

* Shared Nothing - In this model, clustered hosts partition the storage between the
hosts in the cluster. In this model, only one host at a time obtains access to a
particular set of data. In the event load balancing or a server failure dictates, the
cluster software manages a data ownership transition of the set of data to
another host. Microsoft MSCS is an example.
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* Shared Clustering - In this model, clustered hosts all access the same data
concurrently. The cluster software provides management of locks between hosts
that prevents two hosts from accessing the same data at the same time. Sun
Cluster Server is an example.

Note: In the FAStT Storage Manager 7 client, you cannot change the default host
type until the Write Storage Partitioning feature is disabled.

How many partitions does the user really get?

By default, the user has one partition always associated with the default host
group. Therefore, when the user enables (up to 4) or (up to 8) partitions, they are
technically getting 4 or 8 partitions in addition to the "default” partition. However,
there is a caveat for leaving any logical drives in the Default Host Group (see next
question).

Why wouldn’t I use the default host group’s partition?

You can potentially run into logical drive/LUN collisions if you replace a host port
in a host without using the tools within the Definitions Window to associate the
new host port with the host.

Furthermore, there is no read/write access control on logical drives that are located
in the same partition. For operating systems running Microsoft Windows, data
corruption will occur if a logical drive is mounted on more than two systems
without the presence of middleware, such as Cluster Service, to provide read/write
access locking.

Example: You have Host 1 mapped to logical drive Fred using LUN 1. There is
also a logical drive George, which is still part of the Default Host Group that uses
LUN 1. If you replace a host adapter in Host 1 without associating the new host
adapter with Host 1, then Host 1 will now have access to logical drive George,
instead of logical drive Fred, through LUN 1. Data corruption could occur.

Miscellaneous

What is the best way to identify which NVSRAM file version has been installed
on the system when running in the controller?

In FAStT Storage Manager, use the profile command. The NVSRAM version is
included in the board/controller area.

Alternatively, in the subsystem management window, right-click in the storage
subsystem and select Download -> NVSRAM. The NVSRAM version displays.

When using arrayPrintSummary in the controller shell, what does synchronized
really mean and how is it determined?

The term synchronized in the shell has nothing to do with firmware or NVSRAM.
Simply put, synchronized usually means the controllers have successfully completed
SOD in an orderly manner and have synchronized cache. A semaphore is passed
back and forth between the controllers as one or more of the controllers are going
through SOD. If this semaphore gets stuck on one controller, or if a controller does
not make it through SOD, the controllers will not come up synchronized.
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One way the semaphore can get stuck is if a LUN or its cache cannot be
configured. In addition, if a controller has a memory parity error, the controllers
will not be synchronized. There have been cases where one controller states the
controllers are synchronized while its alternate states that they are not. One cause
of this is that a LUN might be ‘locked” by the non-owning controller; this can
sometimes be fixed by turning off bit 3 of byte 0x29 in NVSRAM (Reserve and
Release).

FAStT Storage Manager shows the nodes in the enterprise window with either
IP address or machine name. Why is this not consistent?

FAStT Storage Manager tries to associate a name with each host node, but if one is
not found, then the IP address is used. The inconsistency occurs because the client
software cannot resolve the IP address to a name, or the user has manually added
a host node by IP address.

Why do you see shared fibre drives twice during text setup of NT/W2K? The
UTM does not seem protected (because you can create/delete the partition).

The UTM is only necessary if the Agent software is installed on a host. If you are
direct-attached (network-attached) to a module, you do not need the Agent. This,
in turn, means you do not need the UTM LUN. RDAC is what ’hides’ the UTM
from the host and creates the failover nodes. If RDAC is not installed on an
operating system, then the UTM will appear to be a normal disk (either 20 Mbytes
or 0 MBytes) to the operating system. However, there is no corresponding data
space "behind” the UTM; the controller code write-protects this region. The
controller will return an error if an attempt is made to write to this non-existent
data region. The error is an ASC/ASCQ of 21/00 - Logical block address out of
range, in the Event Viewer.

For Linux operating systems, the UTM LUN is not required and should not be
present for a Linux Host.

If RDAC is not installed on a host, and NVSRAM offset 0x24 is set to 0, then you
will see each LUN twice (once per controller). This is necessary because most
HBASs need to see a LUN 0 on a controller in order for the host to come up. You
should only be able to format one of the listed devices by using the node name
which points to the controller that really owns the disk. You will probably get an
error if you try to format a LUN through the node pointing to the non-owning
controller. The UTM is "owned"” by both controllers as far as the controller code is
concerned, so you will probably be able to format or partition the UTM on either
node.

In short, if RDAC is not installed, the UTM will appear to be a regular disk to the
host. Also, you will see each disk twice. In this case, it is up to the user to know
not to partition the UTM, and to know which of the two nodes for each device is
the true device.

How can you determine from the MEL which node has caused problems (that is,
which node failed the controller)?

You cannot tell which host failed a controller in a multi-host environment. You
need to use the host Event Log to determine which host is having problems.
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When RDAC initiates a Path failure and sets a controller to passive, why does
the status in the enterprise window of FAStT Storage Manager shows the
subsystem as optimal?

This is a change in the design from older code which should prove to be a useful
support tool once we get used to it. A “failed” controller which shows as passive in
the EMW window, but which has been failed by RDAC, indicates that no hardware
problem could be found on the controller. This type of state implies that we have a
problem in the path to the controller, not with the controller itself. In short, a bad
cable, hub, GBIC, and so on, on the host side is probably why the failover
occurred. Hopefully, this will minimize the number of controllers which are
mistakenly returned as bad.

(NT/W2K) What is the equivalent for symarray (NT) with FAStT Storage
Manager W2K?

rdacfltr is the "equivalent” of symarray. However, symarray was a class driver,
whereas rdacfltr is a Low level filter driver. rdacfltr will report Event 3
(configuration changes) and Event 18 (failover events) information. Any errors
which are not of this type (such as check conditions) will be reported by W2K'’s
class driver. These errors will be logged by the (disk) class driver. ASC/ASCQ
codes and SRB status information should appear in the same location in these
errors. The major difference is this break up of errors in W2K, but the error
information should be available under one of these two sources in the Event Log.
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Chapter 18. pSeries supplemental problem determination
information

If a problem occurs in the Fibre Channel environment, you will need a number of
pieces of information to successfully correct the problem. This chapter discusses
Fibre Channel environment-specific problems on IBM pSeries servers and 6228
HBAs. If problems are experienced with the AIX® system, see your AIX
documentation.

Note: For more detailed information about using and troubleshooting problems
with the FC 6228 2 Gigabit fibre channel adapter in IBM @server pSeries
AIX hosts, see Fibre Channel Planning and Integration: User’s Guide and Service
Information, SC23-4329.

The Fibre Channel environment can be complex, and because of the potential
distances between components of the system, and the diverse nature of these
components, additional information will be required to aid in problem
determination. The information is available from several sources:

* Gigabit Fibre Channel PCI Adapter Service LEDs

The Gigabit Fibre Channel PCI Adapter has two LEDs located near the
connectors. These can be used to determine the state of the adapter.

¢ AIX System Problem Determination Information

The AIX system provides problem determination information from its operator
display codes, error logging facilities, and application messages.

e Fibre Channel Director Problem Determination Information

The Fibre Channel Director provides problem determination information from its
operator panel, LED indicators on the port cards, and the Enterprise Fabric
Connectivity Management Terminal.

¢ Problem Determination Information from other devices

Other Fibre Channel devices, including disk storage subsystems, provide
problem determination information in various ways, such as status LEDs,
operator panels, and logout information.

Nature of Fibre Channel Environment Problems

In the complex and diverse Fibre Channel environment, a wide variety of problems
can be encountered. These problems may include, but are by no means limited to:

* A Gigabit Fibre Channel PCI Adapter in an AIX system has a hardware defect.
* A Gigabit Fibre Channel PCI Adapter has been incorrectly configured.

* The device driver for a Gigabit Fibre Channel PCI Adapter has been incorrectly
installed or is exhibiting incorrect behavior.

A Fibre Channel SCSI I/O Controller Protocol Device is not properly configured.
* Alogical hard disk in the AIX system is not properly configured.
* A port adapter in a Fibre Channel switch has a hardware defect.
* A port in a Fibre Channel switch is incorrectly zoned or blocked.

* Ports in a Fibre Channel switch have been soft-rezoned and the cfgmgr
command has not been run to set up the new configuration parameters.

© Copyright IBM Corp. 2004 249



* Host-to-switch cabling has been changed or swapped and the cfgmgr AIX
command has not been run to update the configuration attributes. In this case,
results of commands such as Isattr -El will not yield the correct information for
attributes such as the scsi_id field.

* A port adapter in a Fibre Channel hub has a hardware defect.

* A Fibre Channel port adapter in a SAN Data Gateway has a hardware defect.
* A SCSI port adapter in a SAN Data Gateway has a hardware defect.

* A port adapter in a Disk Storage Subsystem has a hardware defect.

* A disk drive in a Disk Storage Subsystem has a hardware defect.

* A Fibre Channel jumper cable is defective.

* A Fibre Channel cable connector is not properly seated or is dirty.

* A Fibre Channel trunk has a defective fiber.

* A patch panel connection is defective or incorrectly plugged.

* A host or device has defective logic, memory, or control circuitry, or a defective
power or cooling system.

* Optical components somewhere in the environment are defective and are
causing intermittent failures.

As can be seen in the above list, problems can be encountered anywhere
throughout the Fibre Channel configuration. Sometimes the problem is distinctly
reported by, and at the failing component. Often however, the AIX system host, as
the initiator, detects and reports the error condition. As a result, Fibre Channel
errors reported by the AIX system must be analyzed carefully to determine the
true origin of the failure.

Note: You must not pursue problem determination by Field Replaceable Unit
(FRU) replacement in the AIX system unless the problem is actually isolated
to this host component.

Fibre Channel Environment Problem Determination Procedures

250

This section provides basic problem-determination procedures for the Fibre
Channel environment. These procedures are intended to help isolate the problem
and provide information needed to resolve it.

It should be noted that because of the complexity of the environment, a single
Fibre Channel problem can result in a large volume of error reports in the AIX
system. In such a case, it is necessary to carefully analyze these logged errors to
find the one which represents the original, root cause.

In addition, while Fibre Channel environment problems are often reported by the
AIX system, indiscriminate replacement of the Gigabit Fibre Channel PCI Adapter
is not the recommended problem-determination procedure.

Requirements Before Starting Problem Determination

A knowledgeable person is needed to perform the problem determination
procedures. Someone with skills in Fibre Channel basics, AIX operations and
RS/6000® hardware, Storage Area Network (SAN) basics, Disk Storage Subsystems,
Tape Subsystems, and Fibre Channel Switch basics is required. In addition, for
some configurations, a knowledge of SCSI interfaces and the SAN Data Gateway is
required.
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Also, the following skills and information will likely be required and must be
available as required:

An AIX system administrator

An AIX system operator with root user authority.

A chart showing the Fibre Channel cabling scheme, including location of patch
panels and trunk cables.

A list of hardware, microcode, and device driver levels for the Gigabit Fibre
Channel PCI Adapter and all devices in the Fibre Channel configuration.

Service manuals for all Fibre Channel devices in the environment. For
information on these manuals, refer to the appropriate appendix for each device.
Each device’s appendix contains a section called "Publications and Other Sources
of Information.” This section contains a list of publications and Web sites that
provide device-specific instructions and information needed for servicing that
device.

In addition, the following publications will be helpful in isolating link failures:
— Link Fault Isolation, SY22-9533

— §/390° Fiber Optic Links (ESCON®, FICON®, Coupling Links, and Open system
Adapters), SY27-2597
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Start of PDP PD0010 - Start of Call

252

Start here to troubleshoot the Fibre Channel environment.

Step 0010-1

Determine if the Fibre Channel adapter is available in the AIX system. Run the
following AIX command:

Tsdev -C | grep fcs

The results should be similar to the following (assuming three adapters are
installed in slots 14-08, 21-08, and 2A-08):

fcsO Available 14-08 FC Adapter
fcsl Available 21-08 FC Adapter
fcs2 Available 2A-08 FC Adapter

Is the adapter available?

NO Go to [Step 0020-1
YES  Go to [Step 0010-2

Step 0010-2

Determine if the Fibre Channel SCSI I/O Controller Protocol Device is available in
the AIX system. Run the following AIX command:

Isdev -C | grep fscsi

The results should be similar to the following (using the same assumptions as in
Step 0010-1, above):

fscsi0 Available 21-08-01 FC SCSI I/0 Controller Protocol Device
fscsil Available 14-08-01 FC SCSI I/0 Controller Protocol Device
fscsi2 Available 2A-08-01 FC SCSI I/0 Controller Protocol Device

Note: The instance number of the FC SCSI I/O Controller Protocol Device does
not necessarily match its corresponding FC Adapter instance number. That
is, fscsi0 may or may not correspond to fcs0. Either condition is valid.

Is the SCSI 1/0 Controller Protocol Device available?

NO Go to[Step 0030-1
YES Go to[Step 0010-3
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Step 0010-3

Determine if the logical hard disks (hdisks) associated with the Fibre Channel
adapter are available in the AIX system.

Note: If there are no disk devices in the configuration, skip this step.

Run the following AIX command:

Isdev -C | grep hdisk | pg

The result should be similar to the following (assuming the adapter under test is

adapter zero in slot 20-70, hdisk4 is one of the hard disks that has been configured,
and the Disk Subsystem is an EMC Symmetrix Storage System):

hdisk4 Available 20-70-01 EMC Symmetrix FCP Disk

There should be an entry in the above output for each hdisk defined for this
adapter.

Note: See the AIX system administrator for this installation for assistance in
identifying which hdisks have been assigned to this adapter.

Are the appropriate logical hard disks available?

NO Go to [Step 0040-1
YES Go to [Step 0010-4
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Step 0010-4

Determine if the logical tape drives associated with the Fibre Channel adapter are
available in the AIX system.

Note: If there are no tape drives in the configuration, skip this step.

Run the following AIX command:

1sdev -Cc tape | pg

The result should be similar to the following (assuming the adapter under test is

adapter zero in slot 20-70, rmtl is one of the tape drives that has been defined, and
the tape drive is a 3590).

rmtl Available 20-70-01 3590 Tape Drive

There should be an entry in the above output for each tape drive defined for this
adapter.

Note: See the AIX System Administrator for this installation for assistance in
identifying which tape drives have been defined for this adapter.

Are the appropriate logical tape drives available?

NO Go to [Step 0050-1
YES Go to [Step 0010-5
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Step 0010-5

Determine if there are errors reported by or associated with a disk storage
subsystem.

The number of possible indications that a problem may exist in a Disk Storage
subsystem include:

The AIX application reports data or other errors associated with a specific disk
device.

The Disk Storage Subsystem displays error LEDs for one or more disk devices
associated with this adapter.

The Disk Storage Subsystem displays error LEDs for one or more Fibre Channel
ports connected in the Fibre Channel path for this adapter.

The Disk Storage Subsystem displays error LEDs that indicate power or cooling
faults.

The AIX error log has entries associated with this adapter or Fibre Channel SCSI
1/0 Controller Protocol Device whose Probable Causes list includes the Device.

Configuration attributes do not reflect the current configuration. For example,
the Isattr -El command yields an incorrect scsid_id field. Run the cfgmgr AIX
command to update configuration attributes. This will likely resolve the
problem.

Are there errors reported by or associated with a disk storage subsystem?

NO Go to [Step 0010-6

YES  Refer to the Service Manual for the disk storage subsystem and continue

problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the cfgmgr AIX
command to restore the Fibre Channel environment to a functional state.

Done
Note: If the problem is not resolved using the Service Manual information

for this device, return to this problem-determination procedure and
continue with the next step.
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Step 0010-6

Determine if there are errors reported by or associated with a tape subsystem.

The number of possible indications that a problem may exist in a tape subsystem
include:

e The AIX application reports data or other errors associated with a specific tape
device.

* The tape device displays error messages on its LCD Display.

* The AIX error log has entries associated with this adapter or Fibre Channel SCSI
1/0 Controller Protocol Device whose Probable Causes list includes the device.

Are there errors reported by or associated with a tape subsystem?

NO  Go tofiep 0010

YES  Refer to the Service Manual for the tape subsystem and continue
problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done
Note: If the problem is not resolved using the Service Manual information

for this device, return to this problem-determination procedure and
continue with the next step.
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Step 0010-7

Determine if there are errors reported by or associated with a Fibre Channel
Switch.

Note: If there is no Fibre Channel Switch in the configuration, skip this step.

The number of possible indications that a problem may exist in the Fibre Channel
Switch include:

The AIX application reports link or protocol errors associated with the path
which includes the Fibre Channel Switch.

The Fibre Channel Switch displays error LEDs for one or more Fibre Channel
ports connected in the Fibre Channel path for this adapter.

The Fibre Channel Switch displays error conditions through its Enterprise Fabric
Connectivity Management Terminal.

The Fibre Channel Switch indicates power or cooling faults.

The AIX error log has entries associated with this adapter or Fibre Channel SCSI
1/0 Controller Protocol Device whose Probable Causes list includes the Fibre
Channel Switch.

Soft rezoning has not yielded the expected results. Run the cfgmgr AIX
command to set up the new configuration parameters. This will likely resolve
the problem.

Configuration attributes do not reflect the current configuration. For example,
the Isattr -El command yields an incorrect scsid_id field. Run the AIX cfgmgr
command to update configuration attributes. This will likely resolve the
problem.

Are there errors reported by or associated with a Fibre Channel Switch?

NO Go to [Step 0010-8

YES Refer to the Service Manual for the Fibre Channel Switch and continue

problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the cfgmgr AIX
command to restore the Fibre Channel environment to a functional state.

Done
Note: If the problem is not resolved using the Service Manual information

for this device, return to this problem-determination procedure and
continue with the next step.
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Step 0010-8

Determine if there are errors reported by or associated with a SAN Data Gateway:.
Note: If there is no SAN Data Gateway in the configuration, skip this step.

The number of possible indications that a problem may exist in a SAN Data

Gateway include:

* The AIX application reports data or other errors associated with a SCSI Tape
Device or SCSI Disk Storage Subsystem connected to the Fibre Channel
configuration through a SAN Data Gateway, and you have already eliminated
the tape or disk device as the point of failure.

* The AIX error log has entries associated with this adapter or Fibre Channel SCSI
I/0 Controller Protocol Device whose Probable Causes list includes a device
connected through a SAN Data Gateway, and the device has been eliminated as
the point of failure.

* The SAN Data Gateway’s Fibre Channel Port, SCSI Port, or Power Status LEDs
indicate a error.

Are there errors reported by or associated with a SAN Data Gateway?

NO Go to [Step 0010-9

YES  Refer to the Service Manual for the SAN Data Gateway and continue
problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done
Note: If the problem is not resolved using the Service Manual information

for this device, return to this problem-determination procedure and
continue with the next step.
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Step 0010-9

Determine if there are errors reported by or associated with a Fibre Channel
Storage Hub.

Note: If there is no Fibre Channel Storage Hub in the configuration, skip this step.

Go to Btep 0060-1]

The number of possible indications that a problem may exist in a Fibre Channel

Storage Hub include:

* The AIX application reports data or other errors associated with a Disk Storage
Subsystem connected to the Fibre Channel configuration through a Fibre
Channel Storage Hub, and you have already eliminated the Disk Storage
Subsystem and its devices as the point of failure.

* The AIX error log has entries associated with this adapter or Fibre Channel SCSI
I/0 Controller Protocol Device whose Probable Causes list includes a device
connected through a Fibre Channel Storage Hub, and the device has already
been eliminated as the point of failure.

* The Fibre Channel Storage Hub’s Port Status LEDs indicate an error.

Are there errors reported by or associated with a Fibre Channel Storage Hub?

NO Go to [Step 0060-1

YES  Refer to the Service Manual for the Fibre Channel Storage Hub and
continue problem-determination procedures using the information
provided therein. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

Note: If the problem is not resolved using the Service Manual information
for this device, return to this problem-determination procedure and

continue with [Step 0060-1}
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Start of PDP PD0020 - Fibre Channel Adapter not Available

260

Step 0020-1

Determine if the Fibre Channel adapter is defined (recognized) in the AIX system.
Run the following AIX command:

Tsdev -C | grep fcs

Note: If the Gigabit Fibre Channel PCI Adapter is a vendor-solution adapter, the
Isdev command might not recognize the adapter.

The result should be similar to the following (assuming the adapter under test is
adapter zero, and in slot 20-70):

fcsO Defined 20-70 FC Adapter

Is the adapter defined?

NO Go to [Step 0020-2
YES Go to [Step 0020-3

Step 0020-2

Verify that the Fibre Channel adapter is physically installed and properly seated in
the AIX system.

Is the Fibre Channel adapter installed in the AIX system?

NO  Follow the proper procedures for your system to have the Gigabit Fibre
Channel PCI Adapter installed.

Done

YES Go to [Step 0020-3
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Step 0020-3

Attempt to configure the Channel adapter by running Configuration Manager. Run
the following AIX command:

cfgmgr
After the cfgmgr command has completed, run the following AIX command:
Isdev -C | grep fcs

Is the adapter defined or available now?

NO  Go toftep 0020-4

YES Done

Step 0020-4

Determine if the device drivers for the Fibre Channel adapter are properly installed
on the AIX system. Run the following AIX command:

Tslpp -1 | grep df1000f

The result should be similar to the following:

devices.pci.df1000f7.com 4.3.3.0 COMMITTED Common PCI FC Adapter Device
devices.pci.df1000f7.diag 4.3.3.0 COMMITTED PCI FC Adapter Device
devices.pci.df1000f7.rte 4.3.3.0 COMMITTED PCI FC Adapter Device Software
devices.pci.df1000f7.com 4.3.3.0 COMMITTED Common PCI FC Adapter Device
Notes:

1. The above data is for the Gigabit Fibre Channel PCI Adapter (FC 6227, Type
4-S). If you are troubleshooting the 2 Gigabit Fibre Channel Adapter for 64-bit
PCI Bus (FC 6228, Type 4-W), the data displayed will show df1000f9 instead of

df1000f7.

2. If no data displays on the screen, or if some of the above components are
missing, the device drivers are not properly installed.

Are the device drivers properly installed?

NO Reinstall the device drivers.

Done

YES  Go to [Step 0020-5
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Step 0020-5

Run diagnostics on the Fibre Channel adapter.

Did the diagnostics fail?

NO  Go toftep 0070-1

YES  Follow the correct procedure to have the Gigabit Fibre Channel Adapter
replaced.

Done
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Start of PDP PD0030 - Fibre Channel SCSI I/0 Controller Protocol
Device not Available

Step 0030-1

Determine if the device drivers for the Fibre Channel adapter are properly installed
on the AIX system. Run the following AIX command:

Tslpp -1 | grep df1000f

The result should be similar to the following:

devices.pci.df1000f7.com 4.3.3.0 COMMITTED Common PCI FC Adapter Device
devices.pci.df1000f7.diag 4.3.3.0 COMMITTED PCI FC Adapter Device
devices.pci.df1000f7.rte 4.3.3.0 COMMITTED PCI FC Adapter Device Software
devices.pci.df1000f7.com 4.3.3.0 COMMITTED Common PCI FC Adapter Device

Notes:

1. The above data is for the Gigabit Fibre Channel PCI Adapter (FC 6227, Type
4-S). If you are troubleshooting the 2 Gigabit Fibre Channel Adapter for 64-bit
PCI Bus (FC 6228, Type 4-W), the data displayed will show df1000f9 instead of
daf1000f7.

2. If no data displays on the screen, or if some of the above components are
missing, the device drivers are not properly installed.

Are the device drivers properly installed?
NO Reinstall the device drivers.

Done

YES  Go to|[Step 0070-1
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Start of PDP PD0040 - Logical Hard Disks Not Available
Step 0040-1

Determine that the disk storage subsystem is operational, online, and correctly set
up.

Perform the following steps:
1. Ensure that the applicable disk storage subsystem is powered on.

2. Ensure that its appropriate Fibre Channel (or SCSI, if connected through a SAN
Data Gateway) port(s) are correctly cabled and enabled.

3. Ensure that the disk storage subsystem is properly configured, that is, the
correct number of LUNSs are assigned to the applicable port(s).

4. Examine the AIX system’s error log for entries associated with this failure
whose Probable Causes list includes the disk storage subsystem.

5. Using the Service Manual for the disk storage subsystem, verify (run
diagnostics, and so on) that the subsystem is fully operational.

Is the disk storage subsystem operational, online and correctly set up?

NO  Refer to the Service Manual for the disk storage subsystem and continue
problem-determination procedures using the information provided therein.
After the problem is resolved, you might need run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done

Note: If the problem is not resolved using the Service Manual information
for this device, return to this problem-determination procedure and
continue with the next step.

YES  Go to|[Step 0040-2
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Step 0040-2

Determine that the SAN Data Gateway is operational, online, and correctly set up.
Note: If there is no SAN Data Gateway in the configuration, skip this step.

Perform the following steps:

1. Ensure that the SAN Data Gateway is powered on.

2. Ensure that its appropriate Fibre Channel port(s) are cabled correctly.
3. Ensure that its appropriate SCSI port(s) are cabled correctly.
4.

Using the Service Manual for the SAN Data Gateway, verify that the SAN Data
Gateway is fully operational.

Is the SAN Data Gateway operational, online, and correctly set up?

NO Refer to the Service Manual for the SAN Data Gateway and continue
problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done

Note: If the problem is not resolved using the Service Manual information
for this device, return to this problem-determination procedure and
continue with the next step.

YES Go to [Step 0040-3
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Step 0040-3
Determine that the Fibre Channel Switch is operational, online, and correctly set
up.

Note: If there is no Fibre Channel Switch in the configuration, skip this step. Go to

Perform the following steps:

1. Ensure that the Fibre Channel Switch is powered on.

2. Ensure that its appropriate Fibre Channel port(s) are cabled.
3. Ensure that its appropriate Fibre Channel port(s) are enabled.
4

. Ensure that the Fibre Channel Switch is properly configured, that is, it is
correctly zoned and the applicable ports are not blocked.

5. Examine the AIX system’s error log for entries associated with this failure
whose Probable Causes list includes the Fibre Channel Switch.

6. Using the Service Manual for the Fibre Channel Switch, verify (run diagnostics,
and so on) that the Switch is fully operational.

7. Determine if ports on the switch have been soft-rezoned recently. If so, run the
AIX cfgmgr command to set up the new configuration parameters. This will
likely resolve the problem.

8. Determine if host-to-switch cabling has been changed or swapped recently. If
so, run the AIX cfgmgr command (unless you ran it above) to update the
configuration attributes. If these attributes are not updated, results of
commands such as the Isattr -El will not yield the correct information for
attributes such as the scsi_id field. Running the cfgmgr AIX command will
likely resolve the problem.

Is the Fibre Channel Switch operational, online, and correctly set up?

NO  Refer to the Service Manual for the Fibre Channel Switch and continue
problem-determination procedures using the information provided therein.
After the problem is resolved, you might have to run the cfgmgr AIX
command to restore the Fibre Channel environment to a functional state.

Done

Note: If the problem is not resolved using the Service Manual information
for this device, return to this problem-determination procedure and

continue with [Step 0060-1}
YES Go to [Step 0060-1
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Start of PDP PD0050 - Logical Tape Drives Not Available
Step 0050-1

Determine if the logical tape drives associated with the Fibre Channel adapter are
defined (recognized) in the AIX system. Run the following AIX command:

Tsdev -Cc tape | pg

The result should be similar to the following (assuming the adapter under test is
adapter zero in slot 20-70, rmtl is one of the tape drives that has been configured,
and the tape drive is a 3590).

rmtl Defined 20-70-01 3590 Tape Drive

There should be an entry in the above output for each tape drive defined for this
adapter.

Are the appropriate logical tape drives defined?

NO  Refer to the Installation Manual for the Tape Drives and, using SMIT,
define the appropriate tape drive(s) to be associated with the Fibre
Channel Adapter. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to [Step 0050-2
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Step 0050-2

Determine that the tape drive(s) are operational, online and correctly set up.
Perform the following steps:

1.
2.

Ensure that the applicable tape drive(s) are powered on.

Ensure that the appropriate SCSI interfaces from the SAN Data Gateway, if
present, are correctly cabled and enabled.

Ensure that the Fibre Channel interfaces, if applicable, are correctly cabled and
enabled.

Ensure that the tape drive(s) are properly configured, that is, the correct port
and device addresses are set up.

Examine the AIX system’s error log for entries associated with this failure
whose Probable Causes list includes the tape drives(s).

Using the Service Manual for the tape drives, verify that the tape drive(s) are
fully operational.

Are the tape drives operational, online and correctly set up?

NO  Refer to the Service Manual for the tape drives and continue

problem-determination procedures using the information provided therein.
After the problem is resolved, you might need to run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done
Note: If the problem is not resolved using the Service Manual information

for this device, return to this problem determination-procedure and
continue with the next step.

YES  Go to [Step 0050-3
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Step 0050-3

Determine that the SAN Data Gateway is operational, online, and correctly set up.

Note: If there is no SAN Data Gateway in the configuration, skip this step. Go to

Perform the following steps:

1. Ensure that the SAN Data Gateway is powered on.

2. Ensure that its appropriate Fibre Channel port(s) are cabled correctly.

3. Ensure that its appropriate SCSI port(s) are cabled correctly.

4. Using the Service Manual for the SAN Data Gateway, verify that the SAN Data

Gateway is fully operational.
Is the SAN Data Gateway operational, online, and correctly set up?

NO  Refer to the Service Manual for the SAN Data Gateway and continue
problem determination-procedures using the information provided therein.
After the problem is resolved, you might need to run the AIX cfgmgr
command to restore the Fibre Channel environment to a functional state.

Done

Note: If the problem is not resolved using the Service Manual information
for this device, return to this problem-determination procedure and

continue with [Step 0060-1).
YES Go to [Step 0060-1
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Start of PDP PD0060 - Fiber Path Failures

270

Step 0060-1

Determine that the fiber jumpers, trucks, patch panels, and any other devices (such
as hubs) in this configuration provide a complete signal path from the AIX System
Fibre Channel Adapter to the disk storage subsystem or tape drive.

The number of possible indications that a problem may exist in the signal path to

the disk storage subsystem or tape drive include:

* The AIX error log has entries associated with this adapter or Fibre Channel
device whose Probable Causes list includes Cables and Connectors.

e The Hard Disks cannot be configured (made Available) and the Disk Storage
Subsystem and intervening switches or SAN Data Gateway have been
eliminated as the cause of failure.

* The AIX application reports link or protocol errors associated with the path
which includes a specific device, and that device and intervening switches or
SAN Data Gateway have been eliminated as the cause of failure.

* A Fibre Channel device displays error LEDs for one or more Fibre Channel
ports, indicating a link problem.

* A Fibre Channel Switch displays link error conditions through its Enterprise
Fabric Connectivity Management Terminal.

* The AIX application reports data or other errors associated with a specific Fibre
Channel device, and that device has been eliminated as the cause of failure.

* The AIX error log has entries associated with this failure whose Probable Causes
list includes a Fibre Channel device, and that device has been eliminated as the
cause of failure.

* You were sent to this step from anywhere else in the problem-determination
procedures, or there are other reasons to suspect fiber cabling or connector
problems.

Is there any reason to suspect problems associated with fiber jumpers, trucks,
patch panels, or any other devices (such as hubs) in this configuration?

NO Go to [Step 0070-1
YES Go to [Step 0060-2
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Step 0060-2

Determine that the fiber jumper from the AIX System Fibre Channel Adapter
provides a complete signal path to the disk storage subsystem, tape drive, patch
panel, or other device (such as a hub) to which it is connected.

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the fiber jumper connector is clean and properly plugged into the
Fibre Adapter in the AIX system.

2. Ensure that the connector at the other end of this fiber jumper is clean and
properly plugged into the patch panel, Switch, SAN Data Gateway, hub, disk
storage subsystem, or tape drive as intended.

3. Ensure that the fiber jumper is not defective.

Does the fiber jumper from the AIX System Fibre Channel Adapter provide a
complete signal path to the disk storage subsystem, tape drive, patch panel, or
other device (such as a hub, etc) to which it is connected?

NO  Correct the fault. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to [Step 0060-3
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Step 0060-3

Determine that the patch panels and interconnecting trunk or jumpers in this
configuration provide a complete end-to-end signal path.

Note:
* If this path does not include a patch panel, skip this step.

* If this configuration contains more than one patch panel/trunk set, use
the following procedure to check all of them, regardless of whether they
exist in the configuration:

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the correct truck fibers or interconnecting jumper is plugged into
the correct, clean patch-panel connection.

2. Ensure that the trunk fibers or interconnecting jumpers deliver the light
properly to the patch panel at the other end.

3. Ensure that these truck fibers or interconnecting jumper is plugged into the
correct, clean patch-panel connection at the other end.

4. Ensure that the fiber jumper connector at this patch-panel is clean and correctly
connected.

Do the patch-panels and interconnecting trunk or jumper in this configuration
provide a complete end-to-end signal path?

NO  Correct the fault. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES Go to [Step 0060-4
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Step 0060-4

Determine that the fiber jumpers plugged into the Fibre Channel Switch in this
configuration provide a complete signal path through the switch.

Note: If this path does not include a Fibre Channel Switch, skip this step.

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the connectors in both the inbound and outbound ports are clean
and properly plugged into the correct ports.

2. Ensure that both the inbound and outbound fiber jumpers are not defective.

3. Ensure that the Fibre Channel Switch is properly configured and does not
indicate any port failures.

4. Determine if host-to-switch cabling has been changed or swapped recently. If
so, run the AIX cfgmgr command to update the configuration attributes. If
these attributes are not updated, results of commands such as the Isattr -El will
not yield the correct information for attributes such as the scsi_id field.
Running the AIX cfgmgr command will likely resolve the problem.

Do the fiber jumpers plugged into the Fibre Channel Switch in this
configuration provide a complete signal path through the switch?

NO  Correct the fault. After the problem is resolved, you might need to run the
cfgmgr AIX command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to [Step 0060-5
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Step 0060-5

Determine that the fiber jumper and SCSI interface cables plugged into the SAN
Data Gateway in this configuration provide a complete signal path through the
gateway.

Note: If this path does not include a SAN Data Gateway, skip this step.

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the fiber jumper connector is clean and properly plugged into the
correct Fibre Channel port.

Ensure that the SCSI interface is correctly cabled.
Ensure that the fiber jumper is not defective.
Ensure that the SCSI interface cables are not defective.

A

Ensure that the SAN Data Gateway does not indicate a port or interface failure.

Do the fiber jumper and SCSI interface cables plugged into the SAN Data
Gateway in this configuration provide a complete signal path through the
gateway?

NO Correct the fault. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to [Step 0060-6
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Step 0060-6

Determine that the fiber jumpers plugged into the hub in this configuration
provide a complete signal path through the hub.

Note: If this path does not include a hub, skip this step.

Using an accurate fiber-cabling chart, perform the following steps:

1.

5.

Ensure that the inbound fiber jumper connector is clean and properly plugged
into the correct hub port.

Ensure that the outbound fiber jumper connector is clean and properly plugged
into the correct hub port.

Ensure that the both inbound and outbound fiber jumpers are not defective.

Ensure that all other fiber jumpers plugged into ports on this hub have good
connections and are not defective.

Ensure that all open (unplugged) ports are correctly bypassing the signal.

Do the fiber jumpers plugged into the hub in this configuration provide a
complete signal path through the Hub?

NO Correct the fault. After the problem is resolved, you may need to run the

AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to [Step 0060-7
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Step 0060-7

Determine that the fiber jumpers plugged into any other Fibre Channel device in
this configuration provide a complete signal path through the device.

Note:

¢ If this path has no other devices prior to the disk storage subsystem or
tape drive, skip this step.

¢ If this configuration contains more than one device not covered in
previous steps, use the following procedure to check all of them,
regardless of whether they exist in the configuration:

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the inbound fiber jumper connector is clean and properly plugged
into the correct port.

2. Ensure that the outbound fiber jumper connector is clean and properly plugged
into the correct port.

3. Ensure that the both inbound and outbound fiber jumpers are not defective.
Do the fiber jumpers plugged into this device provide a complete signal path
through this device?

NO  Correct the fault. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES Go to [Step 0060-8

Step 0060-8

Determine that the fiber jumper plugged into the disk storage subsystem or tape
drive provides a complete signal path to it.

Using an accurate fiber-cabling chart, perform the following steps:

1. Ensure that the fiber jumper connector is clean and properly plugged into the
correct port.

2. Ensure that the fiber jumper is not defective.
Does the fiber jumper plugged into this device provide a complete signal path
to it?

NO  Correct the fault. After the problem is resolved, you might need to run the
AIX cfgmgr command to restore the Fibre Channel environment to a
functional state.

Done

YES  Go to[Step 0070-1]
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Start of PDP PD0070 - Other Failures
Step 0070-1

Perform the following steps:
1. Start the Device Driver Trace on the AIX system.

2. If the problem you are investigating involves an application, refer to the
documentation for the application and start the application trace, if available,
on the AIX system.

3. Reproduce the failing scenario.

4. Stop all traces.

5. Have the following information available:
 All trace data gathered above.
¢ Any errpt data in the AIX Error Log.
* Any errors reported by the application.

* Any error data present in any of the Fibre Channel Devices, including LED
indicators.

* A detailed description of the Fibre Channel cabling scheme.

e Hardware, microcode, and device driver levels for the Fibre Channel PCI
Adapter and all Fibre Channel devices in the failing configuration.

* A detailed description of the error, failure, or problem.
6. Call AIX Support.

Done
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Chapter 19. MEL data format

After you have read the relevant information in this chapter, return to “RAID Controller Passive

PD Map” on page 11.

Note: This chapter details MEL data formats for controller firmware versions 5.33 and 5.42. If

data are applicable only to storage management version 5.33 or 5.42, they are noted as such.

The following table lists all the critical events for controller firmware releases 5.33 and 5.42.
These critical events are logged in the Event Log in the Array Management Window of the

storage management software. In addition, the critical events are also sent via email and/or SNMP

depending on the alert notification set-up that the user performed within the Enterprise
Management Window of the storage management software. See Event descriptions|for more

information about these events. The critical events throughout [Event descriptions|are highlighted

with a gray shade.

Critical Event Number

Critical Event Description (SYMsm Description)

0x1001 Channel failed

0x1010 Impending drive failure (PFA) detected

0x1207 Fibre channel link errors - threshold exceeded

0x1208 Data rate negotiation failed

0x150E Controller loop-back diagnostics failed

0x150F Channel miswire

0x1510 ESM miswire

0x1513 Degraded drive channel (5.42 only)

0x1600 Uncertified drive detected (5.42 only)

0x1601 Reserved blocks on ATA drives cannot be discovered (5.42 only)
0x200A Data/parity mismatch on volume

0x202E Read drive error during interrupted write

0x2109 Controller cache not enabled — cache sizes do not match
0x210C Controller cache battery failed

0x210E Controller cache memory recovery failed after power cycle or reset
0x2110 Controller cache memory initialization failed

0x2113 Controller cache battery nearing expiration

0x211B Batteries present but NVSRAM file configured for no batteries
0x2229 Drive failed by controller

0x222D Drive manually failed

0x2247 Data lost on volume during unrecovered interrupted write
0x2248 Drive failed — write failure
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Critical Event Number

Critical Event Description (SYMsm Description)

0x2249 Drive capacity less than minimum

0x224A Drive has wrong block size

0x224B Drive failed — initialization failure

0x224D Drive failed — no response at start of day

0x224E Drive failed — initialization/reconstruction failure
0x2250 Volume failure

0x2251 Drive failed — reconstruction failure

0x2252 Drive marked offline during interrupted write
0x2255 Volume definition incompatible with ALT mode — ALT disabled
0x2602 Automatic controller firmware synchronization failed
0x2801 Storage Array running on UPS battery

0x2803 UPS battery — two minutes to failure

0x2807 ESM Failed

0x2808 Tray ID not unique

0x280A Controller tray component removed

0x280B Controller tray component failed

0x280D Drive tray component failed or removed

0x280E Standby power source not fully charged

0x280F ESM - loss of communication

0x2813 Mini-hub canister failed

0x2815 GBIC failed

0x2816 Tray ID conflict — duplicate IDs across drive trays
0x2818 Tray ID mismatch — duplicate IDs in same drive tray
0x281B Nominal temperature exceeded

0x281C Maximum temperature exceeded

0x281D Temperature sensor removed

0x281E ESM firmware mismatch

0x2821 Incompatible mini-hub canister

0x2823 Drive by-passed

0x2827 Controller inadvertently replaced with an ESM
0x2828 Unsupported drive tray detected

0x2829 Controller redundancy lost

0x282B Drive tray path redundancy lost

0x282D Drive path redundancy lost

0x282F (5.42 only)

Unsupported LHA SATA ESM detected
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Critical Event Number | Critical Event Description (SYMsm Description)

0x3019 Volume ownership changed due to failover

0x4011 Volume not on preferred path due to AVT/RDAC failover

0x5005 Place controller offline

0x5038 Storage array 10-minute lockout; maximum incorrect passwords attempted

0x5602 This controller’s alternate failed — timeout waiting for results

0x560B Diagnostics rejected — CtlrDiag task cannot obtain Mode Select lock

0x560C Diagnostics rejected — CtlrDiag task on controller’s alternate cannot obtain Mode
Select lock

0x560D Diagnostics read test failed on controller

0x560E This controller’s alternate failed diagnostics read test

0x560F Diagnostics write test failed on controller

0x5610 This controller’s alternate failed diagnostics write test

0x5616 Diagnostics rejected — configuration error on controller

0x5617 Diagnostics rejected — configuration error on this controller’s alternate

0x6101 Internal configuration database full

0x6200 Snapshot repository volume capacity — threshold exceeded

0x6201 Snapshot repository volume capacity — full

0x6202 Snapshot volume failed

0x6400 Dual primary volume conflict

0x6401 Dual secondary volume conflict

0x6402 Data on mirrored pair unsynchronized

0x6503 Communication to remote volume - down

0x6505 Failed to communicate storage array’s world-wide name

0x6600 Volume copy operation failed
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MEL data format

The SYMsm8 event viewer formats and displays the most meaningful fields of major event log
entries from the controller. The data displayed for individual events varies with the event type and
is described in the Events Description section. The raw data contains the entire major event data
structure retrieved from the controller subsystem. The event viewer displays the raw data as a
character string. Fields that occupy multiple bytes may appear to be byte swapped depending on
the host system. Fields that may appear as byte swapped are noted in the table below.

7 6 5 4 3 2 1 0
Byte Constant Data Fields
0-3 (MSB) Signature
(LSB)
4-7 (MSB) Version (Value of 2)- (byte swapped)
(LSB)
8-15 (MSB) Sequence Number - (byte swapped)
(LSB)
16-19 (MSB) Event Number - (byte swapped)
(LSB)
20-23 (MSB) Timestamp - (byte swapped)
(LSB)
24-27 (MSB) Location Information - (byte swapped)
(Channel & Device or Tray & Slot Number) (LSB)
28-31 (MSB) IOP ID - (byte swapped)
(LSB)
32-33 I/O Origin - (byte swapped)
34-35 Reserved
36-39 | (MSB) LUN/Volume Number - (byte swapped)
(LSB)
40-43 Controller Number- (byte swapped)
44-47 Category- (byte swapped)
48-51 Component Type- (byte swapped)
52-119 Component Location- (byte swapped)
120- Location Valid- (byte swapped)
123
124 Number of Optional Fields Present (M)
125 Total Length of Optional Field (N)
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6 5 4 3 2 1 0

Byte Constant Data Fields
126 - Pad (unused)
127
Optional Field Data
128 Data Length (L)
129 Pad (unused)
130 — Data Field Type - (byte swapped)
131
132 — Data
132+L
Last Optional Field Data Entry
Note:

If the log entry field does not have a version number, the format will be as shown below.

Byte Constant Data Fields
0-7 Sequence Number

8-11 Event Number

12-15 Time Stamp

16-19 Device

20-23 1D

24-25 Origin

26-27 LUN Number
28 Controller Number
29 Number Data Fields
30 Data Field Length

If the log entry field contains Version 1, the format will be as shown below.

Byte Constant Data Fields
0-3 Signature
4-7 Version (Value is 1)
8-15 Sequence Number
16-19 Event
20-23 Time Stamp
24-27 Device
28-31 Id
32-33 Origin
34-35 Reservedl
36-39 LUN Number
40 Controller Number
41 Number of Data Fields
42 Data Field Length
43 Reserved?2
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Constant data fields

Signature (Bytes 0-3)
The Signature field is used internally by the controller. The current value is ‘MELH”.

Version (Bytes 4-7)
When the Version field is present, the value should be 1 or 2, depending on the format of the
MEL entry.

Sequence Number (Bytes 8-15)
The Sequence Number field is a 64 bit incrementing value starting from the time the system log
was created or last initialized. Resetting the log does not affect this value.

Event Number (Bytes 16-19)
The Event Number is a 4 byte encoded value that includes bits for drive and controller inclusion,
event priority and the event value. The Event Number field is encoded as follows:

7 6 5 4 3 2 1 0
19 Internal Flags Log Group Priority
18 Event Group Component
17 (MSB) Event Value
16 (LSB)

Internal Flags
The Internal Flags are used internally within the controller firmware for events that require
unique handling, the host application ignores these values:

Flag Value
Mod Controller 0x2
Number

Flush immediate 0x1

Log Group
The Log Group field indicates what kind of event is being logged. All events are logged in the
system log. The values for the Log Group Field are describes as follows:

Log Group Value
System Event 0x0
Controller Event 0x1
Drive Event 0x2
Priority
The Priority field is defined as follows:
Priority Value
Informational 0x0
Critical 0x1
Reserved 0x2 - OxF
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Event Group

Event Group Value

Unknown 0x0

Error 0x1

Failure 0x2

Command 0x3

Notification 0x4

State 0x5

Host 0x6

General 0x7

Reserved 0x8-0xF

Component

Component Value
Unknown/Unspecified 0x0
Drive 0x1
Power Supply 0x2
Cooling Element 0x3
Minihub 0x4
Temperature Sensor 0x5
Channel 0x6
Environmental Services 0x7
Electronics (ESM)
Controller Electronics 0x8
Nonvolatile Cache (RPA Cache 0x9
Battery)
Enclosure 0xA
Uninterruptible Power Supply 0xB
Chip - I/O or Memory 0xC
Volume 0xD
Volume Group 0xE
1/0 Port CRU OxF

Timestamp (Bytes 20-23)

The Timestamp field is a 4 byte value that corresponds to the real time clock on the controller.
The real time clock is set (via the boot menu) at the time of manufacture. It is incremented every
second and started relative to January 1, 1970.

Location Information (Bytes 24-27)
The Location Information field indicates the Channel/Drive or Tray/Slot information for the
event. Logging of data for this field is optional and is zero when not specified.

IOP ID (Bytes 28-31)

The IOP ID is used by MEL to associate multiple log entries with a single event or I/0. The IOP
ID is guaranteed to be unique for each I/O. A valid IOP ID may not be available for certain MEL
entries and some events use this field to log other information. The event descriptions will
indicate if the IOP ID is being used for unique log information.

Logging of data for this field is optional and is zero when not specified.
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I/0 Origin (Bytes 32-33)
The I/0 Origin field specifies where the I/O or action originated that caused the event. It uses one
of the Error Event Logger defined origin codes:

Value Definition
0 Active Host
1 Write Cache
2 Hot Spare
3 Other Internal

A valid I/O Origin may not be available for certain MEL entries and some events use this field to
log other information. The event descriptions will indicate if the I/O Origin is being used for
unique log information. Logging of data for this field is optional and is zero when not specified.

When decoding MEL events, additional FRU information can be found in the Software Interface
Specification.

LUN/Volume Number (Bytes 36-39)
The LUN/Volume Number field specifies the LUN or volume associated with the event being
logged. Logging of data for this field is optional and is zero when not specified.

Controller Number (Bytes 40-43)

The Controller Number field specifies the controller associated with the event being logged.

Value Definition

0x01 Controller with Drive side SCSI ID 6 (normally the
bottom controller in the subsystem)

0x00 Controller with Drive side SCSI ID 7 (normally the
top controller in the subsystem)

Logging of data for this field is optional and is zero when not specified.

Category Number (Bytes 44-47)

This field identifies the category of the log entry. This field is identical to the event group field
encoded in the event number.

Event Group Value
Unknown 0x0
Error 0x1
Failure 0x2
Command 0x3
Notification 0x4
State 0x5
Host 0x6
General 0x7
Reserved 0x8-0xF
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Component Type (Bytes 48-51)

Identifies the component type associated with the log entry. This is identical to the Component

Group list encoded in the event number.

Component

Value

Unknown/Unspecified

0x0

Drive

0x1

Power Supply

0x2

Cooling Flement

0x3

Minihub

0x4

Temperature Sensor

0x5

Channel

0x6

Electronics (ESM)

Environmental Services

0x7

Controller Electronics

0x8

Battery)

Nonvolatile Cache (RPA Cache

0x9

Enclosure

0xA

Uninterruptible Power Supply

0xB

Chip - I/O or Memory

0xC

Volume

0xD

Volume Group

0xE

1/0 Port CRU

0xF

Component Location (Bytes 52-119)
The first entry in this field identifies the component based on the Component Type field listed
above. The definition of the remaining bytes is dependent on the Component Type.

Component Value Location Data
Unknown/Unspecified 0x0 None
Drive 0x1 Tray Number 4 bytes
Slot Number 4 bytes
Power Supply 0x2 Tray Number 4 bytes
Cooling Element 0x3 Tray Number 4 bytes
Minihub 0x4 Minihub Type 1 Host, 2 Drive
Channel Number 4 bytes
Slot Number 4 bytes
Temperature Sensor 0x5 Tray Number 4 bytes
Channel 0x6 Channel Type 0 host, 1 Drive
Index 4 bytes
Slot Number 4 bytes
Environmental Services Electronics (ESM) 0x7 Tray Number 4 bytes
Controller Electronics 0x8 Tray Number 4 bytes
Nonvolatile Cache (RPA Cache Battery) 0x9 Tray Number 4 bytes
Enclosure 0xA Tray Number 4 bytes
Uninterruptible Power Supply 0xB Tray Number 4 bytes
Chip - I/O or Memory 0xC Tray Number 4 bytes
Slot Number 4 bytes
Volume 0xD Label Length 4 bytes
Label Value 60 bytes maximum
Volume Group 0xE Volume group number 4 bytes
1/O Port CRU OxF Tray Number 4 bytes

Chapter 19. MEL data format



Location Valid (Bytes 120-123)
This field contains a value of 1 if the component location field contains valid data. If the
component location data is not valid or cannot be determined the value is 0.

Number of Optional Fields Present (Byte 124)
The Number of Optional Fields Present specifies the number (if any) of additional data fields that
follow. If this field is zero then there is no additional data for this log entry.

Optional field data
The format for the individual optional data fields follows:
0-1 Data Length (L)
2-3 Data Field Type
4 Data
L

Data Length (Byte 128)
The length in bytes of the optional field data (including the Data Field Type).

Data Field Type (Bytes 130-131)
See Chapter 4. Data Field Types for the definitions for the various optional data fields.

Data (Byte 132)
Optional field data associated with the Data Field Type. This data may appear as byte swapped
when using the event viewer.

Event descriptions

The following sections contain descriptions for all events. Note that some events may not be
logged in a given release. The critical events are highlighted with a gray shade. These critical
events are logged in the Event Log in the Array Management Window of the storage management
software. In addition, the critical events are also sent via email and/or SNMP depending on the
alert notification set-up that the user performed within the Enterprise Management Window of the
storage management software.
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Destination Driver events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Channel Failure: (SYMsm Description - Channel failed)

Logged when the parallel SCSI destination driver detects a channel failure.

Controller Critical Failure Chip 0x1001 | Device: FRU info
(0x1) (0x1) (0x2) (0xC) Origin: FRU info
Channel Revival: (SYMsm Description - Channel revived)
Currently Not Logged.
Controller Informational Notification Chip 0x1002
(0x1) (0x0) (0x4) (0XC)
Tally Exceeded: (SYMsm Description - Drive error tally exceeded threshold)
Currently Not Logged.
Drive Informational Notification Drive 0x1003
(0x2) (0x0) (0x4) (0x1)

Open Error: (SYMsm Description — Error on drive open)

Logged for any error that causes the open sequence to terminate without the drive being opened.

System
(0x0)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x1004

Id:

11: The mode sense to determine
the initial value of the QERR bit
failed.

12: Either the mode select to
change the QERR bit failed or the
mode sense to verify the value of
the bit after the mode select
indicates that the bit is still set.

13 The mode sense used to verify
the mode select to change the
QERR bit failed.

21 The mode sense to determine
the initial value of the WCE bit
failed.

22 Either the mode select to
change the WCE bit failed or the
mode sense to verify the value of
the bit after the mode select
indicates that the bit is still set.

23: The mode sense used to verify
the mode select to change the

WCE bit failed.
Read Failure: (SYMsm Description - Drive read failure - retries exhausted)
Currently Not Logged.
Drive Informational Error Drive 0x1005
(0x2) (0x0) (0x1) (0x1)
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number

Write Failure: (SYMsm Description - Drive write failure - retries exhausted)

Currently Not Logged.
Drive Informational Error Drive 0x1006
(0x2) (0x0) (0x1) (0x1)

No Memory: (SYMsm Description - Controller out of memory)

Logged when memory allocation failed.

System Informational Error Controller 0x1007 | Id: 0: SCSI Device Structure
(0x0) (0x0) (0x1) (0x8) 1: SCSI_Op NCE Structure
2: SCSI_Op NCE Structure
(non-cache)
3: SCSI Ops
Data Field Type: 0x0206

Unsupported Chip: (SYMsm Description: Unsupported SCSI chip)

Currently Not Logged.
Controller Informational Error Chip 0x1008
(0x1) (0x0) (0x1) (0xC)

Memory Parity Error: (SYMsm Description: Controller memory parity error)

Logged when a memory parity error is detected by the destination driver.

Controller Informational Error Controller 0x1009
(0x1) (0x0) (0x1) (0x8)

Drive Check Condition: (SYMsm Description: Drive returned CHECK CONDITION)

Logged when the driver was unable to recover the specified device returned a check condition to the driver and
driver retries have been exhausted.

Drive Informational Error Drive 0x100A | Data Field Type: 0x010D
(0x2) (0x0) (0x1) (0x1)

Destination SOD Error: (SYMsm Description: Start-of-day error in destination driver)

Logged when the destination driver can't complete SOD initialization successfully.

Controller Informational Error Controller 0x100B | Origin: Indicates the structure that
(0x1) (0x0) (0x1) (0x8) couldn't be allocated.

1: Call to VKI_ REBOOT_HOOK

failed.

2: Status byte structure allocation

failed

3: Data phase tag ptrs structure

allocation failed

4: Invalid Reselect data structure

allocation failed

Data Field Type: 0x0206

Destination Hardware Error: (SYMsm Description: Hardware error on drive side of controller)

Currently Not Logged.
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Controller Informational Error Controller 0x100C
(0x1) (0x0) (0x1) (0x8)

Destination Timeout: (SYMsm Description: Timeout on drive side of controller)

Logged when a command from controller to drive or ESM takes longer than expected.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x100D

Unexpected Interrupt: (SYMsm Description: Unexpected interrupt on controller)

Logged due to an unexpected interrupt with no active device on chip.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x100E

Data Field Type: 0x0201

Bus Parity Error: (SYMsm Description: Bus parity error on controller)

Logged when a Bus Parity error is detected by the destination driver.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x100F

Drive PFA: (SYMsm Description: Impending drive failure (PFA) detected)

The logged device generated a PFA condition.

Controller Critical Error Drive 0x1010 | None
(0x1) (0x1) (0x1) (0x1)
Chip Error: (SYMsm Description: Chip error)
Currently Not Logged.
Controller Informational Error Chip 0x1011
(0x1) (0x0) (0x1) (0XC)

Destination Driver: (SYMsm Description: Destination driver error)

Logged when the destination driver has an unrecovered error from the drive.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x1012

Origin: Contains the low level
destination driver internal error.

Id: Contains the raw error logger
error number.

Destination Diagnostic Failure: (SYMsm Description: Destination driver level 0 diagnostic failed)

Logged when destination driver level 0 diagnostics failed for the specified channel.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1013

Id: Contains diagnostic test that
failed.

1: Read/Write registers
2: 64 byte FIFO
3: DMA FIFO

Data Field Type: 0x010B
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Destination Reassign Block: (SYMsm Description: Destination driver successfully issued reassign blocks

command)

Logged when the destination driver issues a reassign block to the drive due to a write failure.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1014

Origin: Block List

Bad Mode Parameters: (SYMsm Description: Incorrect mode parameters modified and saved on drive)

Logged when the controller has successfully modified and saved mode page settings on a drive.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1015

Origin: FRU info
Id:

1: The QERR bit (mode pagel0)
was successfully cleared.

2: The WCE bit (mode page 8)
was successfully cleared.

Drv Medium Err: (SYMsm Description: Hardware error — Unrecoverable read error on drive)

Logged when an unrecoverable read error is detected on a drive.

Controller Informational Error Drive 0x1016
(0x1) (0x0) (0x1) (0x1)
Dst Channel Down: (SYMsm Description: Fibre Channel Link Down)
Logged when the destination channel is down.
Controller | Informational | Notification Channel 0x1017
(Ox1) (0x0) (0x4) (0x6)
Dst Channel Up: (SYMsm Description: Fibre Channel Link Up)
Logged when the destination channel is up.
Controller | Informational | Notification Channel 0x1018
(Ox1) (0x0) (0x4) (0x6)
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SCSI Source Driver events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

SCSI Chip: (SYMsm Description: SRC driver detected exception on SCSI chip)

Logged when the SRC driver detects an exception condition from the SCSI chip.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1101

Device: Base address of the SCSI
chip

Id: Register offset where exception
was detected possible values are:

0xC dstat register
0x42  SISTO REG
0x43  SIST1_REG

Origin: Value of the register

Host Bus Reset: (SYMsm Description: Host bus reset asserted)

Logged when the source SCSI driver asserts the RESET signal on the host SCSI bus. This is usually done as a
response to have a host bus reset propagated to it by the alternate controller in a Wolfpack environment.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x1102

None

Host Bus Reset Received: (SYMsm Description: Host bus reset received)

Logged when a host bus reset was received and the controller is going to propagate it to the alternate controller
in a wolf pack environment. Log entries for Host Bus Reset Received and Host Bus Reset should always appear
in pairs in the system log.

System Informational Notification Controller 0x1103 | None
(0x0) (0x0) (0x4) (0x8)
Unknown Interrupt: (SYMsm Description: Unknown interrupt)
Logged when the source SCSI driver detects an unknown interrupt.
Controller Informational Error Controller 0x1104 | Device: Base address of the SCSI
(0x1) (0x0) (0x1) (0x8) chip

Origin: Value in the interrupt
register.
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3.3 Fibre Channel Source Driver events

Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number

LIP Reset Received: (SYMsm Description: Fibre channel - LIP reset received)
Logged when a selective LIP reset (LipPdPs) is received.

Controller Informational Error Controller 0x1201 | Id: Internal Checkpoint Code
(0x1) (0x0) (0x1) (0x8) Origin: 0 = Source Side FC
LUN: Channel number

Target Reset Received: (SYMsm Description: Fibre channel - TGT reset received)

Logged when a Target Reset if received.

Controller Informational Error Controller 0x1202 | Id: Internal Checkpoint Code
(0x1) (0x0) (0x1) (0x8) Origin: 0 = Source Side FC
LUN: Channel number

Third Party Logout Reset Received: (SYMsm Description: Fibre channel - TPRLO reset received)

Logged when a Third Party Logout with the Global Logout bit set. This is treated as a Target Reset by the
controller.

Controller Informational Error Controller 0x1203 | Id: Internal Checkpoint Code
(0x1) (0x0) (0x1) (0x8) Origin: 0 = Source Side FC
LUN: Channel number

Initialization Error: (SYMsm Description: Fibre channel - driver detected error after initialization)

Logged when a controller is unable to initialize an internal structure.

Controller Informational Error Controller 0x1204 | Id: Internal Checkpoint Code
(0x1) (0x0) (0x1) (0x8) Origin: 0 = Source Side FC
LUN: Channel number

General Error: (SYMsm Description: Fibre channel - driver detected error during initialization)

Logged when an internal error (e.g. unable to obtain memory, unable to send frame) occurs.

Controller Informational Error Controller 0x1205 | Id: Internal Checkpoint Code
(0x1) (0x0) (0x1) (0x8) Origin: 0 = Source Side FC
LUN: Channel number

Link Error Threshold: (SYMsm Description: Fibre channel link errors continue)
Logged when Link Error count exceeds the threshold value after the initial notification.

Controller Informational Error Channel 0x1206 | Dev: Link Error Information
(0x1) (0x0) (0x1) (0x6) Id: Internal Checkpoint Code
LUN: Channel number
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Link Error Threshold Critical: (SYMsm Description: Fibre channel link errors - threshold exceeded)
Logged when Link Error count exceeds the threshold the first time.

Controller
(0x1)

Critical
(0x1)

Error
(0x1)

Channel
(0x6)

0x1207

Dev: Link Error Information
Id: Internal Checkpoint Code
LUN: Channel number

FC Speed Neg Failure: (SYMsm Description: Data rate negotiation failed)

Logged when the data rate negotiation fails.

Controller
(0x1)

Critical
(0x1)

Error
(0x1)

Channel
(0x6)

0x1208
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Fibre Channel Destination Driver events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Init Error: (SYMsm Description: Channel initialization error)

Logged when a controller is unable to initialize hardware or an internal structure.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1500

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Drive Reset: (SYMsm Description: Selective LIP reset issued to drive)

Logged when the fibre channel driver resets a device.

Drive
(0x2)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x1501

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
O0B=Replay Bad Alpa

Alt Controller Reset: (SYMsm Description: Selective LIP reset issued to alternate controller)

Logged when the fibre channel driver resets the alternate controller.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1502

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
OB=Replay Bad Alpa

296 |BM TotalStorage FASLT: Problem Determination Guide




Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Enclosure Reset: (SYMsm Description: Selective LIP reset issued to ESM)

Logged when the fibre channel driver resets an enclosure.

System
(0x0)

Informational
(0x0)

Error
(0x1)

ESM
(0x7)

0x1503

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
O0B=Replay Bad Alpa

Drive Enable: (SYMsm Description: Loop port enable (LPE) issued to drive)

Logged when the fibre channel driver enables a drive.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x1504

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Alternate Enclosure Enable: (SYMsm Description: Loop port enable (LPE) issued to alternate controller)

Logged when the alternate contr

oller enables an

enclosure.

Controller
(0x1)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x1505

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
OB=Replay Bad Alpa
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Enclosure Enable: (SYMsm Description: Loop port enable (LPE) issued to ESM)
Logged when the fibre channel driver enables an enclosure.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x1506

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Drive Bypass: (SYMsm Description: Loop port bypass (LPB) issued to drive)

Logged when the fibre channel driver bypasses a device.

Drive
(0x2)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x1507

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Alternate Controller Bypass: (SYMsm Description: Loop port bypass (LPB) issued to alternate controller)

Logged when the alternate controller is bypassed by the fibre channel driver.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x1508

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
OB=Replay Bad Alpa
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Enclosure Bypass: (SYMsm Description: Loop port bypass (LPB) issued to ESM)

Logged when an enclosure is bypassed by the fibre channel driver.

System
(0x0)

Informational
(0x0)

Error
(0x1)

ESM
(0x7)

0x1509

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Drive Missing: (SYMsm Description: Unresponsive drive (bad AL _PA error))

Logged when the fibre channel driver detects that a drive is missing.

Drive
(0x2)

Informational
(0x0)

Error
(0x1)

Drive
(0x1)

0x150A

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
O0B=Replay Bad Alpa

Alternate Controller Missing: (SYMsm Description: Unresponsive alternate controller (bad AL PA error))

Logged when the fibre channel driver detects that the alternate controller is missing.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x150B

Enclosure Missing: (SYMsm Description: Unresponsive ESM (bad AL_PA error))

Logged when the fibre channel driver detects that an enclosure is missing.

System
(0x0)

Informational
(0x0)

Error
(0x1)

ESM
(0x7)

0x150C

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
OB=Replay Bad Alpa
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Channel Reset: (SYMsm Description: Channel reset occurred)
Logged when a fibre channel port is reset.
System Informational | Notification Channel oxisop | D
(0x0) (0x0) (0x4) (0x6) 01=Chip Init

02=SGB Allocation

03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset

07=Device Bypass
08=Device Enable

09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Loop Diagnostic Failure: (SYMsm Description: Controller loop-back diagnostics failed)

Logged when loop or minihub diagnostics detect that the controller is the bad device on the loop.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x150E

ID:

01=Chip Init

02=SGB Allocation
03=Spy SGB Allocation
04=0p Allocation
05=Channel Reset
06=Device Reset
07=Device Bypass
08=Device Enable
09=Build SGL Special
0A=Target Write SGL Reply
0B=Replay Bad Alpa

Channel Miswire: (SYMsm Description: Channel miswire)

Logged when two channels are connected with one or more ESMs in between.

System
(0x0)

Critical
(0x1)

Error
(0x1)

Channel
(0x6)

0x150F

ESM Miswire: (SYMsm Description: ESM miswire)

Logged when two ESMs of the same tray are seen on the same channel.

System
(0x0)

Critical
(0x1)

Error
(0x1)

ESM
(0x7)

0x1510
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Channel Miswire Clear: (SYMsm Description: Channel miswire resolved)

Logged when the channel miswire is cleared.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Channel
(0x6)

Ox1511

ESM Miswire Clear: (SYMsm Description: ESM miswire resolved)

Logged when the ESM miswire is cleared.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x1512

Channel Failover: (SYMsm Description: Individual drive - Degraded path)

Logged when drive fails.

System
(0x0)

Critical
(0x1)

Error
(0x1)

Channel
(0x6)

0x1513
(5.42
only)

Channel Failback: (SYMsm Description: Drive channel change

Logged when drive channel is active.

d to optimal)

System Informational Notification Channel Ox1514
(0x0) (0x0) (0x4) (0x6) (5.42
only)
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Drive Signature Validation Failure events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Drive Signature mismatch: (SYMsm Description: Uncertified drive detected)

The signature was read successfully from the drive but the signature string was incorrect.

Drive
(0x2)

Critical
(0x1)

Error
(0x1)

Drive
(0x01)

0x1600
(5.42
only)

ID:
04=signature mismatch

Drive Signature read failure: (SYMsm Description: Reserved blocks on ATA drives cannot be discovered)

Unable to read a valid signature sector from the drive.

Drive
(0x2)

Critical
(0x1)

Error
(0x1)

Drive
(0x1)

0x1601
(5.42
only)

ID:

0l=create signature failed
02=disk read failed
03=format code 520
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VDD events

Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Repair Begin: (SYMsm Description: Repair started)
Logged when a repair operation is started for the specified unit.
System Informational Notification Volume 0x2001 | None
(0x0) (0x0) (0x4) (0xD)
Repair End: (SYMsm Description: Repair completed)
Currently Not Logged.
System Informational Notification Volume 0x2002 | Data Field Type: 0x0613
(0x0) (0x0) (0x4) (0xD)
Interrupted Write Begin: (SYMsm Description: Interrupted write started)
Currently Not Logged.
System Informational Notification Volume 0x2003
(0x0) (0x0) (0x4) (0xD)
Interrupted Write End: (SYMsm Description: Interrupted write completed)
Currently Not Logged.
System Informational Notification Volume 0x2004
(0x0) (0x0) (0x4) (0xD)

Fail Vdisk: (SYMsm Description: Virtual disk failed - interrupted write)

Logged when the specified LUN is internally failed.

System Informational Failure Volume 0x2005 | Origin: LBA of the detected failure
(0x0) (0x0) (0x2) (0xD)
Fail Piece: (SYMsm Description: Piece failed)
Currently Not Logged.
System Informational Failure Drive 0x2006
(0x0) (0x0) (0x2) (0x1)
Fail Piece Delay: (SYMsm Description: Fail piece delayed)
Currently Not Logged.
System Informational Failure Drive 0x2007
(0x0) (0x0) (0x2) (0x1)
DEAD LUN Reconstruction: (SYMsm Description: Failed volume started reconstruction)
Currently Not Logged.
System Informational Notification Drive 0x2008
(0x0) (0x0) (0x4) (0x1)
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

RAID 0 Write Fail: (SYMsm Description: RAID 0 write failures)

Currently Not Logged.
System Informational Error Drive 0x2009
(0x0) (0x0) (0x1) (0x1)

Data Parity Mismatch: (SYMsm Description: Data/parity mismatch on volume)

Logged when a data/parity mismatch is detected during data scrubbing.

System Critical Error Volume 0x200A | Data Field Type: 0x0706
(0x0) (0x1) (0x1) (0xD)
Unrecovered Deferred Error: (SYMsm Description: Unrecovered deferred error on volume)
Currently Not Logged.
System Informational Error Volume 0x200B
(0x0) (0x0) (0x1) (0xD)
Recovered Error: (SYMsm Description: Recovered error on volume)
Currently Not Logged.
System Informational Notification Volume 0x200C
(0x0) (0x0) (0x4) (0xD)
I/O Aborted: (SYMsm Description: I/O aborted on volume)
Currently Not Logged.
System Informational Error Volume 0x200D
(0x0) (0x0) (0x1) (0xD)
VDD Reconfigure: (SYMsm Description: Virtual disk driver reconfigured)
Currently Not Logged.
System Informational Notification Controller 0x200E
(0x0) (0x0) (0x4) (0x8)

VDD Synchronize Begin: (SYMsm Description: Cache synchronization started)

Logged when cache synchronization is begun from an external (to VDD) source. Defined but not logged in this

release.
System Informational Notification Controller 0x200F | Data Field Type: 0x0706
(0x0) (0x0) (0x4) (0x8) 0's in Number of blocks filed

indicate entire LUN will be
synchronized.

VDD Synchronize End: (SYMsm Description: Cache synchronization completed)

Logged when cache synchronization for the specified unit completes. Defined but not logged in this release.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2010

Device: Contains ending error
status
Origin: Contains buf flags value
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

VDD Purge Begin: (SYMsm Description: Cache flush started)

Logged when an operation to flush cache for the specified unit is begun. Defined but not logged in this release.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2011

None

VDD Purge End: (SYMsm Description: Cache flush completed)

Logged when an operation to flush cache for the specified unit has completed. Defined but not logged in this

release.
System Informational Notification Controller 0x2012 | None
(0x0) (0x0) (0x4) (0x8)

VDD Cache Recover: (SYMsm Description: Unwritten data/parity recovered from cache)

Logged when unwritten data and parity is recovered from cache at start-of-day or during a forced change in LUN
ownership between the controllers.

System Informational Notification Controller 0x2013 | Origin: Contains the number of
(0x0) (0x0) (0x4) (0x8) cache blocks recovered.
VDD Error: (SYMsm Description: VDD logged an error)
Logged when VDD logs an error.
System Informational Notification Controller 0x2014 | Data Field Type: 0x0707
(0x0) (0x0) (0x4) (0x8)

Uncompleted Write Count: (SYMsm Description: Uncompleted writes detected in NVSRAM at start-of-day)

Logged at start-of-day when uncompleted writes are detected in NVSRAM.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2015

Origin: Contains the number of
uncompleted writes found

Write Count: (SYMsm Description: Interrupted writes processed)

Logged when VDD processes interrupted writes for the specified unit.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2016

Origin: Number of interrupted
writes processed.

Log Write Count: (SYMsm Description: Interrupted writes detected from checkpoint logs)

Logged when VDD creates a list of interrupted writes from the data/parity checkpoint logs.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2017

Origin: Number of interrupted
writes processed.

VDD Wait: (SYMsm Description: I/O suspended due to no pre-allocated resources)

Logged when an I/O is suspended because of no preallocated resources. This event is logged once per resource.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2018

Data Field Type: 0x0700

Data: First 4 characters of the
resource name.
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

VDD Long I/O: (SYMsm Description: Performance monitor: I/O's elapsed time exceeded threshold)

Logged if performance monitoring is enabled and an I/Os elapsed time equal to or exceeds the threshold limit.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2019

Origin: Contains the elapsed time
for the I/O

Device: Contains the threshold
value.

VDD Restore Begin: (SYMsm Description: VDD restore started)

Logged at the beginning of a RAID 1 or RAID 5 VDD restore operation.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x201A

Data Field Type: 0x0612

VDD Restore End: (SYMsm D

Logged at the end of a restore operation.

escription: VDD restore completed)

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x201B

Data Field Type: 0x0613

VDD Recover Begin: (SYMsm Description: VDD recover started)

Logged at the beginning of a RAID 1 or RAID 5 VDD recover operation.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x201C

Data Field Type: 0x0617

VDD Recover End: (SYMsm Description: VDD recover completed)

Logged at the end of a recover operation.

System Informational Notification Controller 0x201D | Data Field Type: 0x0613
(0x0) (0x0) (0x4) (0x8)
VDD Repair Begin: (SYMsm Description: VDD repair started)
Logged at the beginning of a repair operation.
System Informational Notification Controller 0x201E | None
(0x0) (0x0) (0x4) (0x8)

VDD Repair End: (SYMsm Description: VDD repair completed)

Logged at the end of a repair operation.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x201F

Data Field Type: 0x0613

Interrupted Write Fail Piece: (SYMsm Description: Piece failed during interrupted write)

Logged when a piece is failed during an interrupted write operation.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2020

Data Field Type: 0x0612
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Interrupted Write Fail Vdisk: (SYMsm Description: Virtual disk failed during interrupted write)

Logged when a virtual disk is failed as part of a interrupted write operation.

System Informational Notification Controller 0x2021 | Origin: LBA of the LUN that
(0x0) (0x0) (0x4) (0x8) caused the failure.
Scrub Start: (SYMsm Description: Media scan (scrub) started)
Logged when scrubbing is started for the specified unit.
System Informational Notification Volume 0x2022 | None
(0x0) (0x0) (0x4) (0xD)

Scrub End: (SYMsm Description: Media scan (scrub) completed)

Logged when scrubbing operations for the specified unit have completed.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2023

Data Field Type: 0x0618

Scrub Resume: (SYMsm Description: Media scan (scrub) resumed)

Logged when scrubbing operations are resumed for the specified unit.

System Informational Notification Volume 0x2024 | None
(0x0) (0x0) (0x4) (0xD)
Reconstruction Begin: (SYMsm Description: Reconstruction started)
Logged when reconstruction operations are started for the specified unit.
System Informational Notification Volume 0x2025 | None
(0x0) (0x0) (0x4) (0xD)

Reconstruction End: (SYMsm Description: Reconstruction completed)

Logged when reconstruction operations for the specified unit have completed.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2026

Data Field Type: 0x0613

Reconstruction Resume: (SYMsm Description: Reconstruction resumed)

Logged when reconstruction operations are resumed for the specified unit.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2027

None

Reconfiguration Begin: (SYMsm Description: Modification (reconfigure) started)

Logged when reconfiguration operations are started for the specified unit.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2028

None
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Event Group
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Event
Number

Optional Data

Reconfiguration End: (SYMsm Description: Modification (reconfigure) completed)

Logged when reconfiguration operations for the specified unit have completed.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2029

Data Field Type: 0x0613

Reconfiguration Resume: (SYMsm Description: Modification (reconfigure) resumed)

Logged when reconfiguration operations are resumed for the specified unit.

System Informational Notification Volume 0x202A | None
(0x0) (0x0) (0x4) (0xD)
Parity Scan Begin: (SYMsm Description: Redundancy check started)
Logged when parity scan operations are started for the specified unit.
System Informational Notification Volume 0x202B | None
(0x0) (0x0) (0x4) (0xD)
Parity Scan End: (SYMsm Description: Redundancy check completed)
Logged when parity scan operations for the specified unit have completed
System Informational Notification Volume 0x202C | None
(0x0) (0x0) (0x4) (0xD)
Parity Scan Resume: (SYMsm Description: Redundancy check resumed)
Logged when parity scan operations are resumed for the specified unit.
System Informational Notification Volume 0x202D | None
(0x0) (0x0) (0x4) (0xD)

Miscorrected Data: (SYMsm Description: Read drive error during interrupted write)

Logged when an Unrecoverable Read Error is detected.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x202E

Origin: LBA of the LUN that
caused the failure.

Auto LUN Transfer End: (SYMsm Description: Automatic volume transfer completed)

Logged when an auto lun transfer operation has completed.

System Informational Notification Controller 0x202F | None
(0x0) (0x0) (0x4) (0x8)
Format End: (SYMsm Description: Initialization completed on volume)
Logged when a volume format has completed.
System Informational Notification Volume 0x2030 | None
(0x0) (0x0) (0x4) (0xD)
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Format Begin: (SYMsm Description: Initialization started on volume)
Logged when a volume format has begun.
System Informational Notification Volume 0x2031 | None
(0x0) (0x0) (0x4) (0xD)
Format Resume: (SYMsm Description: Initialization resumed on volume)
Logged when a volume format has resumed.
System Informational Notification Volume 0x2032 | None
(0x0) (0x0) (0x4) (0xD)
Parity Repair: (SYMsm Description: Parity reconstructed on volume)
Logged when parity has been reconstructed on a volume.
System Informational Notification Volume 0x2033 | None
(0x0) (0x0) (0x4) (0xD)

HSTSCANMismatch: (SYMsm Description: Data/parity mismatch detected on volume)

Logged when a data/parity mismatch is detected on a volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2034

None
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Cache Manager events

Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Late Check In: (SYMsm Description: Alternate controller checked in late )
Logged when the alternate controller checked in late.
System Informational Notification Controller 0x2101 | None
(0x0) (0x0) (0x4) (0x8)

Mirror Out Of Sync: (SYMsm Description: Cache mirroring on controllers not synchronized)

The mirror is out of sync with the alternate controllers mirror.

System Informational Notification Controller 0x2102 | None
(0x0) (0x0) (0x4) (0x8)
UPS: (SYMsm Description: UPS battery is fully charged)
Currently Not Logged.
System Informational Notification UPS 0x2103
(0x0) (0x0) (0x4)
Synchronize and Purge: (SYMsm Description: Controller cache synchronization/purge event)
Currently Not Logged.
System Informational Notification Controller 0x2104
(0x0) (0x0) (0x4) (0x8)
Reconfigure Cache: (SYMsm Description: Controller cache reconfigure event)
Currently Not Logged.
System Informational Notification Controller 0x2105
(0x0) (0x0) (0x4) (0x8)

Set Configuration: (SYMsm Description: Update requested on controller cache manager's DACSTORE)

A request to update the cache managers DACSTORE area was received.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2106

None

Clear Configuration: (SYMsm Description: Clear requested on controller cache manager's DACSTORE)

A request to clear the cache manager’s DACSTORE area was received.

System Informational Notification Controller 0x2107 | None
(0x0) (0x0) (0x4) (0x8)
Cache Manager Errors: (SYMsm Description: Controller cache manager experiencing errors)
Currently Not Logged.
System Informational Notification Controller 0x2108
(0x0) (0x0) (0x4) (0x8)
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

CCM Hardware Mismatch: (SYMsm Description: Controller cache not enabled - cache sizes do not match)

Write back cache could not be enabled due to different cache sizes of the controllers in the subsystem.

ASC/ASCQ value of 0xA1/0x00 is also logged with this event.

(0x0)

Critical
(0x1)

(0x1)

Controller
(0x8)

0x2109

None

Cache Disabled Internal: (SYMsm Description: Controller cache not enabled or was internally disabled)

Write back cache could not be enabled or was internally disabled. The ASC/ASCQ value of 0xA0/0x00 is also
logged with this event.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x210A

None

Cache Synchronize Failed: (SYMsm Description: Cache between controllers not synchronized)

Cache synchronization between the controllers failed. The ASC/ASCQ value of 0x2A/0x01 is also logged with

this event.
System Informational Notification Controller 0x210B | None
(0x0) (0x0) (0x4) (0x8)
Cache Battery Failure: (SYMsm Description: Controller cache battery failed)

Cache battery has failed. ASC/ASCQ of 0x0C/0x00 is also logged with this event.

System Critical Notification Battery 0x210C | None
(0x0) (0x1) (0x4) (0x9)
Deferred Error: (SYMsm Description: Controller deferred error)
Currently Not Logged.
System Informational Notification Controller 0x210D
(0x0) (0x0) (0x4) (0x8)
Cache Data Loss: (SYMsm Description: Controller cache memory recovery failed after power cycle or
reset)
Logged by cache manager when cache blocks can't be successfully recovered. Companion to an ASC/ASCQ
status of 0x0C/0x81.
Controller Critical Error Controller 0x210E | The LUN and LBA(in Id field) are
(0x1) (0x1) (0x1) (0x8) logged in the event data if they are
available. An unavailable LUN is
logged as OXFF. An unavailable
LBA is logged as 0. No additional
data is logged.
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number

Memory Parity Error Detected: (SYMsm Description: Controller cache memory parity error detected)

Logged when a memory parity error is detected.

Controller Informational Error Controller 0x210F | Device: 0 = Processor Memory
(0x1) (0x0) (0x1) (0x8) 1 =RPA Memory

2 = Spectra Double Bit
Error

3 = Spectra Multi-Bit
Error

4 = Spectra PCI Error

5 = RPA PCI Error

Cache Memory Diagnostic Fail: (SYMsm Description: Controller cache memory initialization failed)

Logged when a persistent RPA Memory Parity error is detected.

System Critical Failure Controller 0x2110
(0x0) (0x1) (0x2) (0x8)
Cache Task Fail: (SYMsm Description: Controller cache task failed)
Currently Not Logged.
System Informational Failure Controller 0x2111
(0x0) (0x0) (0x2) (0x8)

Cache Battery Good: (SYMsm Description: Controller cache battery is fully charged)
Logged when the cache battery has transitioned to the good state.

System Informational Notification Battery 0x2112 | None
(0x0) (0x0) (0x4) (0x9)

Cache Battery Warning: (SYMsm Description: Controller cache battery nearing expiration)

Logged when the cache battery is within the specified number of weeks of failing. The ASC/ASCQ value of
0x3F/0xD?9 is also logged with this event.

System Critical Error Battery 0x2113
(0x0) (0x1) (0x1) (0x9)

Alternate Cache Battery Good: (SYMsm Description: Alternate controller cache battery is fully charged)

Logged when the alternate controller’s cache battery has transitioned to the good state.

System Informational Notification Battery 0x2114 | None
(0x0) (0x0) (0x4) (0x9)

Alternate Cache Battery Warning: (SYMsm Description: Alternate controller cache battery nearing
expiration)

Currently Not Logged.
System Informational Error Battery 0x2115
(0x0) (0x0) (0x1) (0x9)
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Log Group

Priority

Event Group
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Event
Number

Optional Data

Alternate Cache Battery Fail: (SYMsm Desription: Alternate controller cache battery failed)

Logged when the alternate controller’s cache battery has transitioned to the failed state.

System
(0x0)

Informational
(0x0)

Failure
(0x2)

Battery
(0x9)

0x2116

None

CCM Error Cleared: (SYMsm Description: Controller cache manager error cleared)

On occasion CCM may log an error prematurely and then clear it later. For example errors may be logged when
the alternate controller is removed from the subsystem. If the controller is replaced before a write is done CCM
will cancel the errors logged since the controller is replaced and functioning normally.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2117

Id: Contains the event that is being
cleared

Memory Parity ECC Error: (SYMsm Description: Memory parity ECC error)

Logged when a memory parity error occurs and information on the error is available.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x2118

Data Field Type: 0x0111

Recovered Data Buffer Memory Error: (SYMsm Description: Recoverable error in data buffer memory
detected/corrected)

Logged when the controller has detected and corrected a recoverable error in the data buffer memory.

Controller
(0x1)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2119

Cache Error Was Corrected: (SYMsm Description: Cache corrected by using alternate controller's cache)

Logged when the cache manager has corrected using the alternate controller’s cache memory.

Controller
(0x1)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x211A

None

OCB Setting Conflict: (SYMsm: Batteries present but NVSRAM file configured for no batteries)

Logged when a conflict is detected between the NVSRAM setting and the presence of batteries.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x211B

None
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Configuration Manager events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Mark LUN Optimal: (SYMsm Description: Volume marked optimal)

Currently Not Logged.
System Informational Notification Volume 0x2201
(0x0) (0x0) (0x4) (0xD)
Add Vdisk: (SYMsm Description: Volume added)
Logged when a LUN is added to the subsystem.
System Informational Notification Volume 0x2202 | Data Field Type: 0x0612
(0x0) (0x0) (0x4) (0xD)

Delete Vdisk: (SYMsm Description: Volume group or volume deleted)

Logged when the specified virtual disk is deleted.

System Informational Notification Volume 0x2203 | None
(0x0) (0x0) (0x4) (0xD)
Resume I/0: (SYMsm Description: I/O is resumed)
Logged when vdResumelo is called for specified device.
System Informational Notification Volume 0x2204 | None
(0x0) (0x0) (0x4) (0xD)

Fail Copy Source: (SYMsm Description: Source drive failed during copy operation)

Logged when the source drive of a copy type operation fails.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2205

None

CFG Reconstruction Device Complete: (SYMsm Description: Reconstruction completed)

Logged when CFG manager has completed reconfiguring the specified device successfully.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2206

None

CFG Copy Device Complete: (SYMsm Description: Device copy complete)

Logged when the configuration manager has completed the copy process to the specified device.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2207

None

CFG Reconfiguration Setup: (SYMsm Description: Modification (reconfigure) started)

Logged by the configuration manager when it has set up the specified unit and device number for reconfiguration

and is going to call VDD to start the reconfiguration.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2208

Data Field Type: 0x0612
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

CFG Reconfiguration: (SYMsm Description: Modification (reconfigure) completed)

Logged when the LUN has finished reconfigure process the new LUN state is in origin.

System Informational Notification Volume 0x2209 | None
(0x0) (0x0) (0x4) (0xD)
CFG Copyback Start: (SYMsm Description: Copyback started)
Logged when copy task is started.
System Informational Notification Drive 0x220A | None
(0x0) (0x0) (0x4) (0x1)
CFG Copyback Restart: (SYMsm Description: Copyback restarted)
Logged when copy task is restarted.
System Informational Notification Drive 0x220B | None
(0x0) (0x0) (0x4) (0x1)

CFG Fail Delayed: (SYMsm Description: Device failed during interrupted write processing)

Logged when the specified device or LUN is failed during interrupted write processing. SK/ASC/ASCQ =
0x06/0x3F/0x8E will be reported for the device that is failed. SK/ASC/ASCQ = 0x06/0x3F/0xE0 will be
reported for each LUN that is goes dead.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x220C

None

CFG Scrub Enabled: (SYMsm Description: Media scan (scrub) enabled)

Logged when the configuration manager enables scrubbing for the specified device.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x220D

Origin: 0 — Scrub & parity check
are turned off

1 - Scrub is enabled

2 - Parity check is enabled

3 - Scrub & parity check enabled

CFG Scrub Start: (SYMsm Description: Media scan (scrub) started)

Logged when a scrub operation is started for the specified unit.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x220E

Origin: Actual buf address

CFG Scrub Complete: (SYMsm Description: Media scan (scrub) completed)

Logged when a scrub operation is completed for the specified unit.

System Informational Notification Volume 0x220F | None
(0x0) (0x0) (0x4) (0xD)
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

CFG Restore Begin: (SYMsm Description: Restore started)

Logged when cfg manager begins a restore operation on specified unit and device number.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2210

None

CFG Restore End: (SYMsm Description: Restore completed)

Logged when cfg manager successfully completes a restore operation. If an error occurred during the restore this
entry may not appear.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2211

None

CFG Parity Scan Restore: (SYMsm Description: Parity repaired)

Logged when the configuration manager repairs the parity of specified unit and device.

System Informational Notification Controller 0x2212 | Origin: Starting LBAs for the LUN
(0x0) (0x0) (0x4) (0x8)
Zero LUN: (SYMsm Description: Volume initialized with zeros)
Logged when zeros are written to the specified LUN.
System Informational Notification Volume 0x2213 | Data Field Type: 0x0706
(0x0) (0x0) (0x4) (0xD)

CFG Copy Sundry: (SYMsm Description: One or more Sundry regions created)

Logged when configuration manager creates 1 or more sundry drives.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x2214

Origin: The number of sundry
drives created

CFG Post Fail: (SYMsm Description: Drive marked failed)

Logged when configuration manager posts a UA/AEN for a failed drive.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2215

Piece Out of Service (O0S): (SYMsm Description: Piece taken out of service)

Logged when the configuration manager take a piece of the specified LUN out of service.

System Informational Notification Drive 0x2216 | Origin: New LUN state
(0x0) (0x0) (0x4) (0x1)
Piece Fail: (SYMsm Description: Piece failed)
Logged when a piece of specified LUN is failed.
System Informational Notification Drive 0x2217 | Origin: Piece number
(0x0) (0x0) (0x4) (0x1)
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Piece Fail Delay: (SYMsm Description: Piece failed during uncompleted write processing)

Logged when a piece of specified LUN is failed during uncompleted write processing.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2218

Origin: Piece number

Piece Removed: (SYMsm Description: Piece removed from volume)

Logged when a piece of specified LUN has been removed.

System Informational Notification Drive 0x2219 | Origin: LUN State
(0x0) (0x0) (0x4) (0x1)
Piece Replace: (SYMsm Description: Piece replaced)
Logged when a piece of specified LUN has been replaced.
System Informational Notification Drive 0x221A | Origin: LUN State
(0x0) (0x0) (0x4) (0x1)

Piece In Service: (SYMsm Description: Piece placed in service)

Logged when the configuration manager places a LUN piece in service.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x221B

None

Drive Group Offline: (SYMsm Description: Volume group placed offline)

Logged when an entire drive group is placed online the first 16 devices of the drive group are recorded in the

data buffer.
System Informational Notification Volume 0x221C | Data Field Type: 0x0603
(0x0) (0x0) (0x4) Group (0xE)

Drive Group Online: (SYMsm Description: Volume group placed online)

Logged when an entire drive group is placed online.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
Group (0xE)

0x221D

Data Field Type: 0x0603

LUN Initialized: (SYMsm Description: Volume group or volume initialized)

Logged when a LUN has been created.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x221E

Device: Contains the LUN number
initialized

IAF LUN Initialized: (SYMsm Description: Immediate availability initialization (IAF) completed on volume)

Logged when the volume completes the Immediate Availability Format.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x221F

Device: Contains the LUN number
initialized
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Log Group Priority Event Group Component Event Optional Data
Number
GHS Added: (SYMsm Description: Hot spare drive added to hot spare list)
Logged when a drive is added to the global hot spare list.
System Informational Notification Drive 0x2220 | None
(0x0) (0x0) (0x4) (0x1)

GHS Removed: (SYMsm Description: Hot spare drive removed from hot spare list)

Logged when a drive is removed from the hot spare list.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2221

None

Change Unit Number: (SYMsm Description: Logical unit number for volume reassigned)

Logged when a new rank has a duplicate unit number as an existing LUN.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2222

Origin: New unit number
LUN: Old unit number

Duplicate Physical Device: (SYMsm Description: Duplicate data structure exists for two devices)

Logged when cfg mgr discovers a duplicate data structure exists for two devices.

System Informational Notification Drive 0x2223 | Origin: Device id of first device
(0x0) (0x0) (0x4) (0x1) Device: Device id of second
device
CFG Reconstruction Start: (SYMsm Description: Reconstruction started)
Logged when reconstruction is started for the specified device.
System Informational Notification Drive 0x2224 | None
(0x0) (0x0) (0x4) (0x1)

CFG Reconstruction Restart: (SYMsm Description: Reconstruction restarted)

Logged when reconstruction is restarted for the specified device.

System Informational Notification Drive 0x2225 | None
(0x0) (0x0) (0x4) (0x1)
CFG Spin Down: (SYMsm Description: Drive spun down)
Logged when the specified drive is spun down.
System Informational Notification Drive 0x2226 | None
(0x0) (0x0) (0x4) (0x1)
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Set Device Operational: (SYMsm Description: Drive marked optimal)

Logged when the routine cfgSetDevOper (external interface) is called from the shell, by the format command

handler, or by the mode select command handler.

Drive (0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2227

None

Delete Device: (SYMsm Description: Drive deleted)

Logged when cfgDelDrive (external interface) or cfgDriveDeleted is called. This interface can be called from the

shell or mode select command handler.

Drive (0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2228

None

Ctl Fail Drive: (SYMsm Description: Drive failed by controller)

Logged when the configuration manager internally fails the device.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x2229

Origin: Reason for failure
0x91: Locked Out
0xA3: User Failed via Mode
Select

Mark Drive GHS: (SYMsm Description: Hot spare drive assigned)

Logged when an unassigned drive is specified as a global hot spare.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x222A

None

CFG Cold Replaced: (SYMsm Description: Drive replaced when Storage Array was turned off)

Logged when the configuration manager finds a drive that has been cold replaced. i.e. Replaced when the
controller & subsystem were powered off.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x222B

None

Device Unassigned: (SYMsm Description: Drive marked unassigned)

Logged when a drive is to be marked unassigned, also Logged if an unknown drive that was part of a LUN is to
be brought online.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x222C

None

Device Fail: (SYMsm Description: Drive manually failed)

Logged when cfgFailDrive (external interface) or cfgDriveFailed is called.

Drive Critical Notification Drive 0x222D | Origin: Reason for the device
(0x2) (0x1) (0x4) (0x1) failure (contents unspecified)
Device Removed: (SYMsm Description: Mark drive removed)
Logged when a drive is to be marked removed.
Drive Informational Notification Drive 0x222E | None
(0x2) (0x0) (0x4) (0x1)
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Device Replace: (SYMsm Description: Drive marked replaced)

Logged when a notification is received that a failed drive is to be replaced and that data reconstruction on this
device should begin.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x222F

None

Device Manager Fail: (SYMsm Description: Drive failed by device manager)

Logged when the configuration manager state machine has been called to fail the device. This is an additional
event that indicates the configuration manager has determined that processing has to be done in order to fail the
device. Appearance of this entry depends on the drive’s previous state prior to being failed.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2230

Origin: Reason for Failure

Device Manager Removed: (SYMsm Description: Drive marked removed)

Logged when the configuration manager state machine is going t

o mark a dr

ive removed.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2231

None

Device Manager Removed 1: (SYMsm Description: Removed drive marked removed)

Logged when the configuration manager is called to remove a drive that has already been removed.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2232

None

Device Manager Removed 2: (

Logged when an unassigned drive has been marked as removed by the confi

SYMsm Description: Unassigned drive marked removed)

guration manager.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2233

None

Device Manager Removed 3: (SYMsm Description: Reconstructing drive marked removed)

Logged when a drive has been removed that hasn't finished reconstruction, usually happens when a drive that is
waiting for reconstruction to begin is removed.

Drive (0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2234

None

Device Manager Removed 4: (

Logged when an optimal or replaced drive has been removed.

SYMsm Description: Optimal/Replaced drive marked removed)

Drive (0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2235

None
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Device Manager Copy Done: (SYMsm Description: Hot spare drive copy completed)

Logged by the configuration manager state machine when a copy operation has completed on a global hot spare

drive.
Drive Informational Notification Drive 0x2236 | Origin: Internal device flags
(0x2) (0x0) (0x4) (0x1) managed by the configuration

manager, definition is unspecified.

Device Manager Copy Done 1: (SYMsm Description: Replaced drive completed reconstruction)

Copy Done: Logged when a replaced drive has finished reconstruction.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2237

None

Device Manager New: (SYMsm Description: Drive added in previously unused slot)

Logged when a drive has been inserted in a previously unused slot in the subsystem.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2238

None

Device Manager GHS Unassig

Logged when an unassigned drive is marked as a global hot spare internally.

ned: (SYMsm Description: Hot spare drive

assigned internally)

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2239

None

Device Manager Delete: (SYMsm Description: Drive marked deleted)

Logged when a drive is to be marked as deleted. Previously the drive was unassigned or failed.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223A

None

Device Manager Replace: (SYMsm Description: Failed/Replaced drive marked replaced)

Logged when a failed or replaced drive is marked as replaced.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223B

None

Device Manager Replace 1: (SYMsm Description: Drive reinserted)

Logged when a removed optimal drive or replaced drive has been reinserted or when a failed drive is reinserted.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223C

Origin: Location where event is
logged, value unspecified

Device Manager Replace 2: (SYMsm Description: Unassigned drive replaced)

Logged when an unassigned drive has been replaced.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223D

Origin: Location where event is
logged, value is unspecified
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Device Manager Operational: (SYMsm Description: Drive marked optimal)

Logged when a drive has been marked operational.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223E

None

Device Manager Operational: (SYMsm Description: Partially reconstructed drive marked optimal)

Logged when a optimal drive that hasn't completed reconstruction is marked operational.

Drive
(0x2)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x223F

None

Device Manager No DACSTORE Unassigned: (SYMsm Description: DACSTORE created for unassigned or

hot spare drive)

Logged when an unassigned drive or unassigned global hot spare has no DACSTORE and a DACSTORE has

been created.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2240

None

Device Manager No DACSTORE Fail: (SYMsm Description: Unassigned drive with no DACSTORE failed)

Logged when an unassigned drive without a DACSTORE has been failed.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2241

None

Device Manager No DACSTORE Delete: (SYMsm Description: Unassigned drive with no DACSTORE

deleted)

Logged when an unassigned drive without a DACSTORE has been deleted.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2242

None

Device Manager No DACSTORE Remove: (SYMsm Description: Unassigned drive with no DACSTORE

removed)

Logged when an unassigned drive without a DACSTORE has been removed.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2243

None

Device Manager Unassigned: (SYMsm Description: Unknown drive marked unassigned)

Logged when an unknown drive is marked unassigned.

System Informational Notification Drive 0x2244 | None
(0x0) (0x0) (0x4) (0x1)
CFG Scrub Stop: (SYMsm Description: Media scan (scrub) stopped)
Logged when a scrub operation is stopped for the specified unit.
System Informational Notification Volume 0x2245 | None
(0x0) (0x0) (0x4) (0xD)
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CFG Scrub Resume: (SYMsm Description: Media scan (scrub) resumed)

Logged when a scrub operation is resumed for the specified unit or drive group.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2246

None

CFG Unrecovered Interrupted Write: (SYMsm Description: Data lost on volume during unrecovered
interrupted write)

Logged when a LUN is marked DEAD due to a media error failure during SOD. An error occurred during
Interrupted Write processing causing the LUN to transition to the DEAD State. SK/ASC/ASCQ =

0x06/0x3F/0XxEB will be offloaded for this error.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Volume
(0xD)

0x2247

None

CFG Unrecovered Write Failure: (SYMsm Description: Drive failed — write failure)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x80 indicating the
controller set the drive state to “Failed — Write Failure”.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Drive
(0x1)

0x2248

Origin: FRU info

CFG Drive Too Small: (SYMsm Description: Drive capacity less than minimum)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x8B indicating the
controller set the drive state to “Drive Capacity < Minimum”.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x2249

Origin: FRU info

Wrong Sector Size: (SYMsm Description: Drive has wrong block size)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x8C indicating the
controller set the drive state to “Drive has wrong blocksize”.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x224A

Origin: FRU info

Drive Format Failed: (SYMsm Description: Drive failed - initialization failure)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x86 indicating the
controller set the drive state to “Failed — Format failure”.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x224B

Origin: FRU info

Wrong Drive: (SYMsm Description: Wrong drive removed/replaced)
Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x89 indicating the

controller set the drive state to “Wrong drive removed/replaced”.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x224C

Origin: FRU info
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Drive No Response: (SYMsm Description: Drive failed - no response at start of day)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x85 indicating the
controller set the drive state to “Failed — No Response”.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x224D

Origin: FRU info

Reconstruction Drive Failed: (SYMsm Description: Drive failed - initialization/reconstruction failure)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x82 indicating the
controller set the drive state to “Failed” be it was unable to make the drive usable after replacement.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Drive
(0x1)

0x224E

Origin: FRU info

Partial Global Hot Spare: (SYMsm Description: Hot spare capacity not sufficient for all drives)

Logged when a defined Global Hot Spare device is not large enough to cover all of the drives in the subsystem.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x224F

None

LUN Down: (SYMsm Description: Volume failure)
Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0xEOQ indicating Logical Unit

Failure.
System Critical Failure Volume 0x2250 | None
(0x0) (0x1) (0x2) (0xD)

CFG Read Failure: (SYMsm Description: Drive failed - reconstruction failure)

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x8E indicating that the

drive failed due to a reconstruction failure at SOD.

System
(0x0)

Critical
(0x1)

State
(0x5)

Drive
(0x1)

0x2251

Origin: FRU info

Fail Vdisk Delayed: (SYMsm Description: Drive marked offline during interrupted write)

Logged when the specified device is failed during interrupted write processing. SK/ASC/ASCQ =
0x06/0x3F/0x98 will be offloaded for each failing device.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(0x1)

0x2252

None

LUN Modified: (SYMsm Description: Volume group or volume modified (created or deleted))

Logged when the configuration manager posts an UA/AEN of ASC/ASCQ = 0x3F/0x0E indicating that
previous LUN data reported via a Report LUNs command has changed (due to LUN creation/deletion or
controller hot swap.

Volume 0x2253 | None

(0xD)

Notification
(0x4)

Informational
(0x0)

System
(0x0)
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Not Used 0x2254

Bad LUN Definition: (SYMsm Description: Volume definition incompatible with ALT mode-ALT disabled)

Logged when there is an improper LUN definition for Auto-LUN transfer. The controller will operate in normal
redundant controller mode without performing Auto-LUN transfers.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Volume
(0xD)

0x2255

None

Copyback Operation Complete: (SYMsm Description: Copyback completed on volume)

Logged when copyback is completed on volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2256

None

Volume Reconfiguration Start: (SYMsm Description: Modification (reconfigure) started on volume)

Logged when reconfiguration is started on volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2257

None

Volume Reconfiguration Completed: (SYMsm Description: Modification (reconfigure) completed on volume)

Logged when reconfiguration is completed on volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2258

None

LUN Initialization Start: (SYMsm Description: Initialization started on volume)

Logged when initialization is started on volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x2259

None

Immediate Availability Format Start: (SYMsm Description: Immediate availability initialization (IAF) started

on volume

Logged when IAF started on volume.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Volume
(0xD)

0x225A

None

HLYV Cleared: (SYMsm Description: Premium feature not supported — snapshot volumes and mirror
relationships deleted)

Logged when a user attempts to import a drive tray/volume group and the premium features are not supported.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x225B

None
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Hot Swap events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

HSM Drive Removed: (SYMsm Description: Hot swap monitor detected drive removal)

Logged in the system log when the hot swap monitor detects that a drive has been removed from the system.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2400

Device: Device number of the
removed drive

HSM Drive Inserted: (SYMsm Description: Hot swap monitor detected drive insertion)

Logged in the system log when the hot swap monitor detects that a drive has been inserted in the system.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x2401

Device: Device number of the
inserted drive

Controller: (SYMsm Description: Controller inserted or removed)

Logged when a controller is inserted or removed.

System Informational Notification Controller 0x2500
(0x0) (0x0) (0x4) (0x8)
Mode Switch Active: (SYMsm Description: Controller mode changed to active)
Currently Not Logged.
System Informational State Controller 0x2501
(0x0) (0x0) (0x5) (0x8)
Icon Error: (SYMsm Description: Controller icon chip error)
Currently Not Logged.
System Informational Error Controller 0x2502
(0x0) (0x0) (0x1) (0x8)

Mode Switch Active/Passive: (SYMsm Description: Controller mode changed to passive)

Logged on successful completion of an Active/Passive mode switch.

System
(0x0)

Informational
(0x0)

State
(0x5)

Controller
(0x8)

0x2503

Origin: Local and alternate mode
information

Mode Switch Dual Active: (SYMsm Description: Controller mode changed to active)

Logged on successful completion of a Dual Active mode switch.

System Informational State Controller 0x2504 | Origin: Local and alternate mode
(0x0) (0x0) (0x5) (0x8) information
Mode Switch: (SYMsm Description: Controller mode switch occurred)
Currently Not Logged.
System Informational State Controller 0x2505
(0x0) (0x0) (0x5) (0x8)
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Start of Day events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

ACS Download Start: (SYMsm Description: Automatic control

Logged when an ACS Download is started.

ler firmwar

Controller
(0x1)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x2600

ACS Download Completed: (SYMsm Description: Automatic controller firmware synchronization completed)

Logged after the controller has been rebooted after auto code synchronization has been preformed. An

ASC/ASCQ value of 0x29/0x82 is also logged with this event.

Controller Informational Notification Controller 0x2601 | Origin: Non-zero indicated
(0x1) (0x0) (0x4) (0x8) download failure
ACS Error: (SYMsm Description: Automatic controller firmware synchronization failed)

Logged when auto code synchronization failed.

System
(0x0)

Critical
(0x1)

Error
(Ox1)

Controller
(0x8)

0x2602

Default LUN Created: (SYMsm Description: Default volume created)
Logged when the default LUN was created at SOD.

System
(0x0)

Informational
(0x0)

State
(0x5)

Volume
(0xD)

0x2603

None

Persistent Memory Parity Error: (SYMsm Description: Persistent controller memory parity error)

Logged when SOD detects that the persistent memory parity error state has been set.

Controller
(0x1)

Informational
(0x0)

Error
(0x1)

Controller
(0x8)

0x2604

None

Start of Day Completed: (SYMsm Description: Start-of-day routine completed)

Logged when the controller has completed initialization.

Controller Informational Notification Controller 0x2605 | None
(0x1) (0x0) (0x4) (0x8)
Start of Day Begun: (SYMsm Description: Start-of-day routine begun)
Logged when the controller begins the start-of-day routine.
Controller Informational Notification Controller 0x2606 | None
(0x1) (0x0) (0x4) (0x8)
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

RPA Parity Error: (SYMsm Description: Controller RPA memory parity error detected)

Logged during ccmlnit during start of day if a parity error is found in RPA memory.

Controller Informational Error Controller 0x2700 | Id: Error block
(0x1) (0x0) (0x1) (0x8) Device: 1 = RPA Memory
PCI Parity Error: (SYMsm Description: PCI controller parity error)
Currently Not Logged.
Controller Informational Error Controller 0x2701
(0x1) (0x0) (0x1) (0x8)

RPA Unexpected Interrupt: (SYMsm Description: Controller unexpected RPA interrupt detected)

Logged when an unexpected RPA Interrupt is detected.

Controller Informational Notification Controller 0x2702 | Data Field Type: 0x0110
(0x1) (0x0) (0x4) (0x8)
Recovered Processor DRAM Error: (SYMsm Description: Recoverable error in processor memory
detected/corrected)
Logged when the controller has encountered recoverable processor DRAM ECC errors (below the maximum
threshold).
Controller Informational Notification Controller 0x2703
(0x1) (0x0) (0x4) (0x8)
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Subsystem Monitor events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Power Supply: (SYMsm Description: Power supply state change detected)

Logged when a power supply changes state.

System Informational Notification Power 0x2800 | Id: Power Supply Status:
(0x0) (0x0) (0x4) Supply 0 = Failed
(0x2) 1 = Good
On Battery: (SYMsm Description: Storage Array running on UPS battery)
Logged when the UPS battery starts to supply power to the subsystem.
System Critical Notification Battery 0x2801 | None
(0x0) (0x1) (0x4) (0x9)

UPS Battery Good: (SYMsm Description: UPS battery is fully charged)

Logged when the UPS battery has charged and transitioned to the good state.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Battery
(0x9)

0x2802

None

UPS Battery 2 Minute Warning: (SYMsm Description: UPS battery - two minutes to failure)

Logged when the UPS battery has transitioned and given the 2 minute warning. The UPS has signaled that it has
2 minutes of power left before failing. The controllers will flush any dirty data in their caches and turn off data
caching.

System Critical Notification Battery 0x2803 | None
(0x0) (0x1) (0x4) (0x9)
Not Used 0x2804

Line State Change: (SYMsm Description: Controller tray component change detected)

Logged when a discreet line state change is detected and an AEN is posted. This can either be a good to bad
transition or bad to good. This does not include the cache battery line. Cache battery events are logged by the
cache manager.

Unknown
(0x0)

Notification 0x2805

(0x4)

Informational
(0x0)

System
(0x0)

Data Field Type: 0x0704

Drive Enclosure: (SYMsm Description: Tray component change)

Logged when SSM has detected a change in an enclosure device, other than a drive status.

Notification
(0x4)

Informational
(0x0)

System
(0x0)

ESM 0x2806 | Data Field Type: 0x0705
(0x7)
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Enclosure Fail: (SYMsm Description: ESM Failed)
Logged when an ESM fails.
System Critical Failure ESM 0x2807
(0x0) (0x1) (0x2) (0x7)

Enclosure ID Not Unique: (SYMsm Description: Tray ID not unique)

Logged when the controller determines that there are multiple sub-enclosures with the same ID value selected.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x2808

Device: Sub-enclosure ID in
conflict

Line Good: (SYMsm Description: Controller tray component changed to optimal)

Logged when a subsystem line has transitioned to the Good state.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Enclosure
(0xA)

0x2809

Device: Line number that has
changed state

Line Missing: (SYMsm Description: Controller tray component removed)

Logged when an expected subsystem line is removed.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Enclosure
(0xA)

0x280A

Device: Line number that is
removed

Line Failed: (SYMsm Description: Controller tray component failed)

Logged when a subsystem line has transitioned to the Failed state.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Unknown
(0x0)

0x280B

Device: Line number that has
changed state

Enclosure Good: (SYMsm Description: Drive tray component changed to optimal)

Logged when an enclosure has transitioned to the Good state.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x280C

Device: Enclosure ID
Origin: FRU Info

Enclosure Fail: (SYMsm Description: Drive tray component failed or removed)

Logged when an enclosure has transitioned to the Failed state.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x280D

Device: Enclosure ID
Origin: FRU Info

Battery Low: (SYMsm Description: Standby power source not fully charged)

Logged when the battery charge is low.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Battery
(0x9)

0x280E
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Redundancy Loss: (SYMsm Description: ESM - loss of communication)

Logged when a redundant path is not available to devices.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x280F

Device: Enclosure ID

Origin: FRU Group Qualifier for
Sub-enclosure group (Byte 27) or
drive slot

Redundancy Restored: (SYMsm Description: ESM - communication restored)

Logged when a redundant path to devices is restored.

System Informational Notification ESM 0x2810 | Device: Enclosure ID
(0x0) (0x0) (0x4) (0x7) Origin: FRU Group Qualifier for
Sub-enclosure group (Byte 27) or
drive slot
Not Used
0x2811

Minihub Normal: (SYMsm Description: Mini-hub canister changed to optimal)

Logged when Mini-hub canister is changed to optimal.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Minihub
(0x4)

0x2812

ID = Type/Channel

Type = 1: Host Side
Type = 2: Drive Side

Minihub Failed: (SYMsm Description: Mini-hub canister failed)

Logged when Mini-hub canister is failed.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Minihub
(0x4)

0x2813

ID = Type/Channel

Type = 1: Host Side
Type = 2: Drive Side

GBIC Optimal: (SYMsm Description: GBIC/SFP changed to optimal)

Logged when GBIC/SFP is changed to optimal.

System Informational Notification Minihub 0x2814 | ID = Type/Channel
(0x0) (0x0) (0x4) (0x4) Type = 1: Host Side
Type = 2: Drive Side
GBIC Failed: (SYMsm Description: GBIC/SFP failed)
Logged when GBIC/SFP is failed.
System Critical Notification Minihub 0x2815 | ID = Type/Channel
(0x0) (0x1) (0x4) (0x4)

Type = 1: Host Side
Type = 2: Drive Side
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Enclosure ID Conflict: (SYMsm Description: Tray ID conflict - duplicate IDs across drive trays)

Logged when the controller detects duplicate drive tray IDs in the subsystem.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x2816

None

Enclosure ID Conflict Cleared: (SYMsm Description: Tray ID conflict resolved)

Logged when the controller detects that an enclosure ID conflict no longer exists.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x2817

None

Enclosure ID Mismatch: (SYMsm Description: Tray ID mismatch — duplicate IDs in same drive tray)

Logged when the controller detects that the two ESM boards in the same drive tray have different IDs.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x2818

None

Enclosure ID Mismatch Cleared: (SYMsm Description: Tray ID mismatch resolved)

Logged when the controller detects that the drive tray ESM board ID mismatch has been cleared.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x2819

None

Temperature Sensor Good: (SYMsm Description: Temperature changed to optimal)

Logged when the controller detects that a temperature sensor has transitioned to a good status.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Temp
Sensor (0x5)

0x281A

Data Field Type: 0x0800

Temperature Sensor Warning: (SYMsm Description: Nominal temperature exceeded)

Logged when the controller detects that a temperature sensor has transitioned to a warning status.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Temp
Sensor (0x5)

0x281B

Data Field Type: 0x0800

Temperature Sensor Failed: (SYMsm Description: Maximum temperature exceeded)

Logged when the controller detects that a temperature sensor has transitioned to a failed status.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Temp
Sensor (0x5)

0x281C

Data Field Type: 0x0800

Temperature Sensor Missing: (SYMsm Description: Temperature sensor removed)

Logged when the controller detects that a temperature sensor is missing.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Temp
Sensor (0x5)

0x281D

Data Field Type: 0x0800
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Event: Event Description

Event
Number

Log Group Priority Event Group Component Optional Data

ESM Version Mismatch: (SYMsm Description: ESM firmware mismatch)

Logged when the controller detects that two ESMs do not have the same version of firmware running

Notification
(0x4)

Critical
(0x1)

System
(0x0)

ESM 0x281E | Data Field Type: 0x0800
(0x7) The tray number appears in the
device field and as extra data.

ESM Version Mismatch Clear: (SYMsm: ESM firmware mismatch resolved)

Logged when the controller detects that the firmware mismatch has been cleared

Notification 0x281F

(0x4)

Informational
(0x0)

System
(0x0)

ESM Data Field Type: 0x0800
(0x7) The tray number appears in the
device field and as extra data.

Controller Report Warning: (SYMsm: Two controllers present but NVSRAM (offset 0x35, bit 6) set for NOT
reporting a missing second controller)

Logged when two controllers are present even though the NVSRAM bit for not reporting a missing second

controller is set.

System Informational Notification Controller 0x2820 | None
(0x0) (0x0) (0x4) (0x8)
Mini Hub Unsupported: (SYMsm: Incompatible mini-hub canister)
Logged when an incompatible mini-hub canister is detected.
System Critical Notification MiniHub 0x2821 | None
(0x0) (0x1) (0x4) (0x4)
Not Used 0x2822 | None
Bypass Generic: (SYMsm: Drive by-passed)
Logged when the drive is bypassed on both ports.
System Critical Failure Drive 0x2823 | None
(0x0) (0x1) (0x2) (0x1)
Bypass Corrected: (SYMsm: Drive by-passed condition resolved)
Logged when the drive is available on at least one port.
System Informational Notification Drive 0x2824 | None
(0x0) (0x0) (0x4) (0x1)
Tray Harness Removed: (SYMsm: Tray ID harness removed)
Logged when the Tray ID harness is removed.
System Informational Notification Enclosure 0x2825 | None
(0x0) (0x0) (0x4) (0xA)
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Tray Harness Corrected: (SYMsm: Tray ID harness replaced)
Logged when the Tray ID harness is replaced.
System Informational Notification Enclosure 0x2826 | None
(0x0) (0x0) (0x4) (0xA)

Alternate Slot Has ESM (SYMsm: Controller inadvertently replaced with an ESM)

Logged at Start of Day if the user inadvertently replaces a controller with an ESM canister.

System Critical Notification Controller 0x2827 | None
(0x0) (0x1) (0x4) (0x8)
Unsupported Encl (SYMsm: Unsupported drive tray detected)
Logged when an unsupported drive tray is detected.
System Critical Notification ESM 0x2828 | None
(0x0) (0x1) (0x4) (0x7)

Cont Redundancy Loss (SYMsm: Controller redundancy lost)

Logged when the array determines that one controller is in a failed mode.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x2829

Device: Tray number
Origin: FRU

Cont Redundancy Restored (SYMsm: Controller redundancy restored)

Logged when the array determines that the controller has been restored to optimal.

System Informational Notification Controller | 0x282A | Device: Tray number
(0x0) (0x0) (0x4) (0x8) Origin: FRU
Tray Redundancy Loss (SYMsm: Drive tray path redundancy lost)
Logged when a drive tray path fails.
System Critical Notification ESM 0x282B | Device: Tray number
(0x0) (0x1) (0x4) (0x7)

Tray Redundancy Restored (SYMsm: Drive tray path redundancy restored)

Logged when the drive tray path is restored.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

ESM
(0x7)

0x282C

Device: Tray number

Drive Redundancy Loss (SYMsm: Drive path redundancy lost)

Logged when the array determines that a loss of drive path redundancy is a persistent condition.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Drive
(Ox1)

0x282D

Device: Tray number
Origin: Slot number

Drive Redundancy Restored (SYMsm: Drive path redundancy restored)

Logged when the array determines that the loss of redundancy condition is no longer present.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Drive
(0x1)

0x282E

Device: Tray number
Origin: Slot number
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Unsupported LHA SATA ESM Detected (SYMsm: Unsupported LHA SATA ESM)

Logged when a firmware download to an ESM fails because the ESM firmware is not compatible with
the version of controller firmware on the storage array.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

ESM
(0x7)

0x282F
(5.42
only)

Device: Tray number
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Command Handler events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Format Unit: (SYMsm Description: Format unit issued)

Logged when the controller processes a format command. The LUN value indicates the LUN that the controller

is formatting.

System Informational Command Volume 0x3000 | ID field: Indicates the status of the
(0x0) (0x0) (0x3) (0xD) format command :

0 - Write zeros is being done to
the unit

1 - The configuration manager is
initializing the LUN and controller
data structures used.

2 - The entire format operation
has successfully completed, status
has been returned to the host.

Quiesce: (SYMsm Description: Quiescence issued)

Logged for the quiescence command.
System Informational Command Controller 0x3001 | Id field: Indicates the state of the
(0x0) (0x0) (0x3) (0x8) quiesce command :

0 - Quiescence is stopped.
1 - Quiescence was started.

Reassign Blocks: (SYMsm Description: Reassign blocks issued from host)

Logged for a reassign blocks command that has been issued from the host.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x3002

Id: Total number of blocks to be
reassigned.

Data Field Type: 0x0208

Reserve: (SYMsm Description: Reserve issued)

Logged for the reserve command. Defined but not logged in this release.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x3003

LUN: LUN being reserved.

Id: Indicates the reserving host
Device: If non-zero, Third party
reservation information. The high
order byte indicates that a 3rd
party reservation was done the low
order byte is the third party id.
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Release: (SYMsm Description: Release issued)

Logged for the release command. Defined but not logged in this release.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x3004

LUN: LUN being released.

Id: Indicates the reserving host
Device: If non-zero, Third party
reservation information. The high
order byte indicates that a 3rd
party reservation was done the low
order byte is the third party id.

Synchronize

Logged when controllers begins

Cache: (SYMsm Description: Syn

execution of Synchronize Cache.

chronize controller cache issued)

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x3005

None

Safe Pass Through: (SYMsm Description: Safe pass-through issued)

These log entries are made by the set pass through and save pass through command handlers respectively before
the pass through command is sent to the drive. The following passed through commands are not logged: Test
Unit Ready, Read Capacity, Inquiry, Mode Sense. All other commands are logged regardless of their success or

failure.
System Informational Command Drive 0x3006 | Data Field Type: 0x0614
(0x0) (0x0) (0x3) (0x1)

Mode Select 1: (SYMsm Description: Mode select for page 1 received)

Logged when Mode Select for Page 0x01 is received and the Post Error bit value has changed from the value

stored in NVSRAM.
System Informational Command Volume 0x3007 | Id: Contains new post error (PER)
(0x0) (0x0) (0x3) (0xD) bit value

Mode Select 2: (SYMsm Description: Mode select for page 2 received)

Logged when mode select for Page 0x02 is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x3008

Data Field Type: 0x0608

Data buffer length = 16
Data: Page 0x02 Mode Select data
sent to the controller in SCSI format.

Mode Select 8: (SYMsm Description: Mode for caching page 8 received)

Logged when Mode Select Page 0x08 (Caching page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x3009

Data Field Type: 0x0608

Data buffer length = 12
Data: Page 0x08 Mode Select data
sent to the controller in SCSI format.
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Mode Select A: (SYMsm Description: Mode select for control mode page A received)

Logged when Mode Select Page 0x0A (Control mode page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x300A

Data Field Type: 0x0608

Data buffer length = 8

Data: Page 0x0A Mode Select data
sent to the controller in SCSI
format

Mode Select 2A: (SYMsm Description: Mode select for array physical page 2A received)

Logged when Mode Select Page 0x2A (Array physical page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x300B

Data Field Type: 0x060C

Mode Select 2B: (SYMsm Description: Mode select for array logical page 2B received)

Logged when Mode Select Page 0x2B (Logical Array page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x300C

Data Field Type: 0x0608

Data buffer length = 132

Data: Page 0x2B Mode Select data
sent to the controller in SCSI
format.

Mode Select 2C: (SYMsm Description: Mode select for redundant controller page 2C received)

Logged when Mode Select Page 0x2C (Redundant controller page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x300D

Data Field Type: 0x0608

Data buffer length: = 106

Data: Page 0x2C Mode Select data
sent to the controller in SCSI
format.

Mode Select

Logged when Mode Select Page

2E: (SYMsm Description: Mode select for vendor-unique cache page 2E received)

0x2E - (Vendor unique cache page) is recei

ved.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x300E

Data Field Type: 0x0608

Data buffer length = 30

Data: Page 0x2E Mode Select data
sent to the controller in SCSI
format.

Mode Select 2F: (SYMsm Description: Mode select for time page 2F received)

Logged when Mode Select Page 0x2F (Time page) is received.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x300F

Device: Contains the time passed

to the controller

338 IBM TotalStorage FASLT: Problem Determination Guide




Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Mode Select 3A: (SYMsm Description: Mode select for hot spare page 3A received)

Logged when Mode Select Page 0x3A (The global hot spare page) is received.

System Informational Command Controller 0x3010 | Id: Action code specified in the
(0x0) (0x0) (0x3) (0x8) page data
Device: Hot spare device specified
in the page data
Defect List: (SYMsm Description: Defect list received)
Currently Not Logged.
System Informational Command Controller 0x3011
(0x0) (0x0) (0x3) (0x8)
Write Buffer: Write buffer received
Logged when Write Buffer is received to the following buffer ids:
0xE8 — SubSystem Identifier
0xE9 — Subsystem Fault
0XxEA — Drive Fault
0xED — Host Interface Parameters
O0xEE - User configuration options
0xFO - BootP Storage
System Informational Command Controller 0x3012 | Origin: contains the buffer id.
(0x0) (0x0) (0x3) (0x8) Data Field Type: 0x0612

Controller Firmware Download: (SYMsm Description: Download controller firmware issued)

Logged when controller firmware download is started.

Controller Informational Command Controller 0x3013 | Device: 0 = Download to drive
(0x1) (0x0) (0x3) (0x8) started
1 = Download had
completed
Origin: Error value on
completion of
download
0 = Download Success
Other = Error occurred,
value of internal
controller status
Drive Firmware Download Start: (SYMsm Description: Drive firmware download started)
Logged when drive firmware download has started.
Drive Informational Command Drive 0x3014
(0x2) (0x0) (0x3) (0x1)
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Pass Through: (SYMsm Description: Drive pass-through issued)
Currently Not Logged.
Drive Informational Command Drive 0x3015
(0x2) (0x0) (0x3) (0x1)
Alternate Controller: (SYMsm Description: Alternate controller transition issued)
Currently Not Logged.
System Informational Command Controller 0x3016
(0x0) (0x0) (0x3) (0x8)

Set Pass Through: (SYMsm Description: Set pass-through issued)

Currently Not Logged

These log entries are made by the set pass through and save pass through command handlers respectively before
the pass through command is sent to the drive. The following passed through commands are not logged: Test
Unit Ready, Read Capacity, Inquiry, Mode Sense. All other commands are logged regardless of their success or

failure.
System Informational Command Drive 0x3017
(0x0) (0x0) (0x3) (0x1)
Set Pass Command: (SYMsm Description: Set pass command issued)
Currently Not Logged.
System Informational Command Drive 0x3018
(0x0) (0x0) (0x3) (0x1)

Mode Select Active/Passive Mode: (SYMsm Description: Volume ownership changed due to failover)

Logged when a Mode Select command to make the controller Active is received.

System
(0x0)

Critical
(0x1)

Command
(0x3)

Controller
(0x8)

0x3019

Drive Firmware Download Fail: (SYMsm Description: Drive firmware download failed)

Logged when drive firmware download has failed.

Drive
(0x2)

Informational
(0x0)

Command
(0x3)

Drive
(0x1)

0x301A

Drive Firmware Download Co

Logged when drive firmware do

wnload has completed successfu

1ly.

mplete: (SYMsm Description: Drive firmware download completed)

Drive
(0x2)

Informational
(0x0)

Command
(0x3)

Drive
(0x1)

0x301B

ESM Firmware Download Start: (SYMsm Description: ESM firmware download started)

Logged when ESM firmware download has started.

Drive
(0x2)

Informational
(0x0)

Command
(0x3)

ESM
(0x7)

0x301C

Lun: Tray ID of tray containing
ESM
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

ESM Firmware Download Fail: (SYMsm Description: ESM firmware download failed)

Logged when ESM firmware download has failed.

Drive Informational Command ESM 0x301D | Lun: Tray ID of tray containing
(0x2) (0x0) (0x3) (0x7) ESM

ESM Firmware Download Complete: (SYMsm Description: ESM firmware download completed)

Logged when ESM firmware download has successfully completed.
Drive Informational Command ESM 0x301E | Lun: Tray ID of tray containing
(0x2) (0x0) (0x3) (0x7) ESM

PR Insuff Resources: (SYMsm Description: Unable to register a volume due to insufficient resources)

Logged when a volume is unable to be registered due to insufficient resources.

System
(0x0)

Informational
(0x0)

Command

Controller

(0x3)

(0x8)

0x301F
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EEL events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

AEN Posted: (SYMsm Description: AEN posted for recently logged event)

Logged when the controller posts an AEN.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x3101

Data Field Type: 0x0100

Data: Sense data of the AEN as
defined in the Software Interface
Specification.

EEL Deferred Error: (SYMsm Description: Deferred error (EEL))

Currently Not Logged
System Informational Error Controller 0x3102
(0x0) (0x0) (0x1) (0x8)

VKI Common Error: (SYMsm Description: VKI commom error)

Logged when VKI_ CMN_ERROR is called with the error level set to ERROR. Calls made with a level of
CONTINUE or NOTE will not be logged

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x3200

Data Field Type: 0x0700

VKI Panic: (SYMsm Description: VKI panic)

Logged when VKI_ CMN_ERROR is called with the error level set to PANIC. Calls made with a level of
CONTINUE or NOTE will not be logged.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x3201

Data Field Type: 0x0700
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RDAC, Quiescence and ICON Manager events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

SysWipe: (SYMsm Description: Sys wipe request sent to controller)

Logged when a sys wipe request is sent to the controller. This routine is not called by the controller SW or FW
currently. If logged it means the command was entered through the shell interface. If this entry is seen a
corresponding entry of MEL _EV _ICON_SYS WIPE ALT should also be logged by the alternate controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4000

None

NVSRAM Clear: (SYMsm Description: NVSRAM clear request sent to alternate controller)

Logged when an NVSRAM clear message is sent to the alternate controller. This is normally logged as part of a
mode select command to the RDAC mode page 0x2C. The companion entry of
MEL EV ICON NV _CLR_ALT should also be seen in the event log along with this entry.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4001

None

SysWipe Alternate: (SYMsm Description: Sys wipe request received by alternate controller)

Logged when a sys wipe request is received by the alternate controller. This is an unexpected log entry that is

logged when the routine iconMgrSendSysWipe is executed from the shell of the alternate controller. This routine
is not called by the controller SW. The companion entry of MEL _EV _ICON_SYS WIPE should also be logged
if this entry is seen.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4002

None

NVSRAM Clear Alternate: (SYMsm Description: NVSRAM clear request received by alternate controller)

Logged when an NVSRAM clear message is received from the alternate controller. No additional data is logged.
The companion entry of MEL EV_ICON_NV_CLR should also be seen in the event log along with this entry.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4003

None

Quiesce Message Received: (SYMsm Description: Alternate controller quiescence message received)

Logged when a quiescence manager message was received from the alternate controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4004

Id: Message that was received:

0 = Start controller level
quiescence and return
Done when completed.

1 = Stop controller level
quiescence.

2 = The alternate controller
has quiesced.

3 = Release the controller
from quiescence.
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Controller Quiesce Begin: (SYMsm Description: Controller quiescence started)

Logged when a controller level quiescence was begun on the controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4005

Id: Value of the forceOption
parameter that was passed to the
routine.

Alternate Controller Quiesce Begin: (SYMsm Description: Alternate controller quiescence started)

Logged when a controller level quiescence was begun on the alternate controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4006

Id: Value of the forceOption
parameter that was passed to the
routine.

Subsystem Quiesce Begin: (SYMsm Description: Subsystem quiescence started)

Logged when a subsystem level quiescence was begun.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4007

Id: Value of the forceOption
parameter that was passed to the
routine.

Controller Quiesce Abort: (SYMsm Description: Controller quiescence ha

Logged when a controller level quiescence is aborted.

Ited)

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4008

Id: Quiescence state of controller
at beginning of the abort.

Controller Quiesce Release: (SYMsm Description: Controller quiescence released)

Logged when a controller level quiescence is released.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x4009

Id: Quiescence state of controller
at beginning of release.

Alternate Controller Quiesce Release: (SYMsm Description: Alternate controller quiescence released)

Logged when a controller level quiescence on alternate is released.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x400A

Id: Quiescence state of alternate
controller at beginning of release.

Reset All Channels: (SYMsm Description: All channel reset detected)

Logged when the controller detects that the alternate controller has been removed or replaced.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x400B

Alternate Controller Reset Hold: (SYMsm Description: Controller placed offline)

Logged when the controller successfully puts the alternate controller in the reset/hold state.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x400C
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number

Alternate Controller Reset Release: (SYMsm Description: Controller placed online)

Logged when the controller successfully releases the alternate controller from the reset/failed state.

System Informational Notification Controller 0x400D
(0x0) (0x0) (0x4) (0x8)

Auto Volume Transfer: (SYMsm Description: Automatic volume transfer started)

Logged when an Auto Volume Transfer is initiated.

System Informational Notification Controller 0x400E | Lun: Number of Volumes being
(0x0) (0x0) (0x4) (0x8) transferred
Origin: 0 = Normal AVT
1 =Forced AVT (LUN will
be zero)

Alternate controller has been reset: (SYMsm Description: Controller reset by its alternate)

Logged when the alternate controller was reset. The controller number in the event reflects the controller that
was held in reset.

System Informational Notification Controller 0x400F | None
(0x0) (0x0) (0x4) (0x8)

Controller Reset: (SYMsm Description: Controller reset)

Logged when the controller is going to reset itself through the controller firmware. This event is not logged when
the controller is reset because of hardware errors (such as watchdog timeout conditions). The controller number
reflects the controller number of the board that was reset.

System Informational Notification Controller 0x4010 | None
(0x0) (0x0) (0x4) (0x8)

Vol Xfer Alert: (SYMsm Description: Volume not on preferred path due to AVT/RDAC failover)

Logged when a “volume not on preferred path” condition persists longer than the alert delay period.

System Critical Error Controller 0x4011 | None
(0x0) (0x1) (0x1) (0x8)
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SYMbol Server events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Assign Volume Group Ownership: (SYMsm Description: Assign volume group ownership)

Logged on entry to assignVolumeGroupOwnership 1.

System Informational Command Volume 0x5000 | Data Field Type: 0x0603 &
(0x0) (0x0) (0x3) Group (0xE) 0x0803
Create Hotspare: (SYMsm Description: Assign hot spare drive)
Logged on entry to assignDriveAsHotSpares 1.
System Informational Command Unknown 0x5001 | Data Field Type: 0x0804 or
(0x0) (0x0) (0x3) (0x0) 0x0805
Create Volume: (SYMsm Description: Create volume)
Currently Not Logged
System Informational Command Unknown 0x5002
(0x0) (0x0) (0x3) (0x0)

Delete Hotspare: (SYMsm Description: De-assign hot spare drive)

Logged on entry to deassignDriveAsHotSpares_1.

System Informational Command Unknown 0x5003 | Data Field Type: 0x0805
(0x0) (0x0) (0x3) (0x0)
Delete Volume: (SYMsm Description: Delete volume)
Logged on entry to deleteVolume 1.
System Informational Command Volume 0x5004 | LUN: Volume be deleted
(0x0) (0x0) (0x3) (0xD)

Set Controller Failed: (SYMsm Description: Place controller offline)

Logged on entry to setControllerToFailed 1.

System Critical Command Controller 0x5005 | Data Field Type: 0x0813
(0x0) (0x1) (0x3) (0x8)
Set Drive Failed: (SYMsm Description: Fail drive)
Logged on entry to setDriveToFailed 1.
System Informational Command Drive 0x5006 | None
(0x0) (0x0) (0x3) (0x1)

Start Volume Format: (SYMsm Description: Initialize volume group or volume)

Logged on entry to startVolumeFormat 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5007

None
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Initialize Drive: (SYMsm Description: Initialize drive)
Logged on entry to initializeDrive 1.
System Informational Command Drive 0x5008 | None
(0x0) (0x0) (0x3) (0x1)

Controller Firmware Start: (SYMsm Description: Controller firmware download started)

Logged when a controller firmware download starts.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5009

Load Drive Firmware: (SYMsm Description: Download drive firmware issued)

Logged when a Download drive firmware is issued

System
(0x0)

Informational
(0x0)

Command
(0x3)

Drive
(0x1)

0x500A

Controller NVSRAM Start: (SYMsm Description: Controller NVSRAM download started)
Logged when a controller NVSRAM download starts.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x500B

Set Volume Group Offline: (SYMsm Description: Place volume group offline)

Logged on entry to setVolumeGroupToOffline 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume

Group (0xE)

0x500C

Data Field Type: 0x0603

Set Volume Group Online: (SYMsm Description: Place volume group online)

Logged on entry to setVolumeGroupToOnline 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume

Group (0xE)

0x500D

Data Field Type: 0x0603

Start Drive Reconstruction: (SYMsm Description: Reconstruct drive/volume)

Logged on entry to startDriveReconstruction_1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Drive
(0x1)

0x500E

None

Start Volume Group Defragment: (SYMsm Description: Start volume group defragment)

Logged on entry to startVolumeGroupDefrag 1.

System Informational Command Volume 0x500F | Data Field Type: 0x0603
(0x0) (0x0) (0x3) Group (0xE)
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Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Start Volume Group Expansion: (SYMsm Description: Add free capacity to volume group)

Logged on entry to startVolumeGroupExpansion_1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
Group (0xE)

0x5010

Data Field Type: 0x0603 &
0x0809

Start Volume RAID Migration: (SYMsm Description: Change RAID level of volume group)

Logged on entry to startVolumeRAIDMigration 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
Group (0xE)

0x5011

Data Field Type: 0x0603 &
0x080A

Start Volume Segment Sizing: (SYMsm Description: Change segment size of volume)

Logged on entry to startVolumeSegmentSizing 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5012

Data Field Type: 0x0802

Set Controller To Passive: (SYMsm Description: Change controller to passive mode)

Logged on entry to setControllerToPassive 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5013

Data Field Type: 0x0813

Set Controller To Active: (SYMsm Description: Change controller to active mode)

Logged on entry to setControllerToActive 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5014

Data Field Type: 0x0813

Set Storage Array Cache Parameters: (SYMsm Description: Update cache parameters of Storage Array)

Logged on entry to setSACacheParams_1. Instructs the SYMbol Server’s controller to propagate a controller
cache change to all controllers in the storage array.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5015

Data Field Type: 0x080B

Set Storage Array User Label: (SYMsm Description: Change name of Storage Array)

Logged on entry to setSAUserLabel 1. Instructs the controller to change the shared storage array name.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5016

Data Field Type: 0x080C
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Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Set Controller Time: (SYMsm Description: Synchronize controller clock)
Logged on entry to setControllerTime 1.
System Informational Command Controller 0x5017 | Data Field Type: 0x080D
(0x0) (0x0) (0x3) (0x8)
Set Volume Cache Parameters: (SYMsm Description: Change cache parameters of volume)
Logged on entry to setVolumeCacheParams_1.
System Informational Command Volume 0x5018 | Data Field Type: 0x080E
(0x0) (0x0) (0x3) (0xD)
Set Volume Parameters: (SYMsm Description: Change parameters of volume)
Logged on entry to setVolumeParams_1.
System Informational Command Volume 0x5019 | Data Field Type: 0x080F
(0x0) (0x0) (0x3) (0xD)
Set Volume User Label: (SYMsm Description: Change name of volume)
Logged on entry to setVolumeUserLable 1.
System Informational Command Volume 0x501A | Data Field Type: 0x0801
(0x0) (0x0) (0x3) (0xD)
Set Controller To Optimal: (SYMsm Description: Place controller online)
Logged on entry to setControllerToOptimal 1.
System Informational Command Controller 0x501B | Data Field Type: 0x0813
(0x0) (0x0) (0x3) (0x8)
Set Drive To Optimal: (SYMsm Description: Revive drive)
Logged on entry to setDriveToOptimal 1.
System Informational Command Drive 0x501C | None
(0x0) (0x0) (0x3) (0x1)
Force Volume To Optimal: (SYMsm Description: Revive volume)
Logged on entry to forceVolumeToOptimal 1.
System Informational Command Volume 0x501D | None
(0x0) (0x0) (0x3) Group (0xE)

Set Storage Array Tray Positions: (SYMsm Description: Chan

Logged on entry to setSATrayPositions 1.

ge positions of trays in physical view)

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x501E

Data Field Type

: 0x0810

Set Volume Media Scan Parameters: (SYMsm Description: Change media scan (scrub) settings of volume)

Logged on entry to setVolumeMediaScanParameters_1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x501F

Data Field Type

1 0x0811
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Log Group
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Event Group
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Event
Number
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Set Storage Array Media Scan Rate: (SYMsm Description: Change media scan (scrub) settings of Storage

Array)

Logged on entry to setSAMediaScanRate 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5020

Data Field Type: 0x0812

Clear Storage Array Configuration: (SYMsm Description: Reset configuration of Storage Array)

Logged on entry to clearSAConfiguration 1. Clears the entire array configuration, deleting all volumes and

returning to a clean initial state.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5021

None

Auto Storage Array Configuration: (SYMsm Description: Automatic configuration on Storage Array)

Logged on exit from to autoSAConfiguration 1.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5022

None

RPC Function Return Code: (SYMsm Description: Controller return status/function call for requested

operation)

Logged on the return from RPC function returning ReturnCode.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5023

Data Field Type: 0x0814

Write Download Checkpoint: (SYMsm Description: Internal download checkpoint)

Logged whenever the download checkpoint is updated.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5024

Data Field Type: 0x0815

Controller Firmware Download Fail: (SYMsm Description: Controller firmware download failed)

Logged when a controller firmware download fails.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5025

Controller Firmware Download Complete: (SYMsm Description: Controller firmware download completed)

Logged when a controller firmware download successfully completes.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5026

Controller NVSRAM Download Fail: (SYMsm Description: Controller NVSRAM download failed)
Logged when a controller NVSRAM download fails.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5027
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Controller NVSRAM Download Complete: (SYMsm Description: Controller NVSRAM download completed)

Logged when a controller NVSRAM download successfully completes.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Controller
(0x8)

0x5028

Battery Update: (SYMsm Description: Reset controller battery age)

Logged when the battery parameters are updated.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x5029

Data Field Type: 0x0816

Assign Volume Ownership: (SYMsm Description: Assign volume ownership)

Logged when volume ownership is modified.

System Informational Command Volume 0x502A | None
(0x0) (0x0) (0x3) (0xD)
Volume Expand: (SYMsm Description: Increase volume capacity)
Logged when volume capacity is increased
System Informational Command Volume 0x502B | None
(0x0) (0x0) (0x3) (0xD)

Snap Params Set: (SYMsm Description: Change parameters of snapshot repository volume)

Logged when the snapshot parameters are changed.

System Informational Command Volume 0x502C | None
(0x0) (0x0) (0x3) (0xD)
Recreate Snap: (SYMsm Description: Re-create snapshot volume)
Logged when the snapshot is recreated (restarted).
System Informational Command Volume 0x502D | None
(0x0) (0x0) (0x3) (0xD)
Disable Snap: (SYMsm Description: Disable snapshot volume)
Logged when the snapshot has been disabled (stopped).
System Informational Command Volume 0x502E | None
(0x0) (0x0) (0x3) (0xD)
Delete Ghost: (SYMsm Description: Delete missing volume)
Logged when a missing volume is deleted.
System Informational Command Volume 0x502F | None
(0x0) (0x0) (0x3) (0xD)
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Log Group
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Event Group

Component

Event
Number
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RVM Activated (SYMsm Description: Activate remote volume mirroring)

Logged when the Remote Volume Mirroring feature has been activated on the local array. Activation causes the
controller host-ports to be configured for mirroring.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Channel
(0x6)

0x5030

None

RVM Deactivated: (SYMsm Description: Deactivate remote volume mirroring)

Logged when the Remote Volume Mirroring feature has been deactivated on the local array. Deactivation
restores normal host-port functionality.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Channel
(0x6)

0x5031

None

Mirror Sync Changed: (SYMsm Description: Change synchronization priority)

Logged when the synchronization priority of a mirrored volume is changed.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5032

None

Mirror Start Sync: (SYMsm Description: Start mirror synchronization)

Logged when a mirror relationship is created. The event is only propagated on the primary mirror storage array.

System Informational Command Volume 0x5033 | None
(0x0) (0x0) (0x3) (0xD)
Not Used 0x5034
Not Used 0x5035
Not Used 0x5036

SYMbol Auth Fail Incorrect Password: (SYMsm Description: Incorrect password attempted)

Logged when an authentication failure has occurred, but the lockout state has not yet been entered.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5037

None

SYMbol Auth Fail Cont Lockout: (SYMsm Description: Storage array 10-minute lockout; maximum incorrect
passwords attempted)

Logged when the lockout state has been entered.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x5038

None

SYMbol Vceopy Params Set: (SYMsm Description: Change parameters of volume copy pair)

Logged when the parameters are changed on a volume copy pair.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5039

None

352 IBM TotalStorage FAStT: Problem Determination Guide




Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

SYMbol Veopy Start Copy: (SYMsm Description: Start volume copy operation)

Logged when processing a user request (via SYMbol) to start a copy. This does not necessarily match the actual
start of data movement because the copy may be queued.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x503A

None

SYMbol Veopy Stop Copy: (SYMsm Description: Stop volume copy operation)

Logged when processing a user request (via SYMbol) to stop a copy.

System Informational Command Volume 0x503B | None
(0x0) (0x0) (0x3) (0xD)
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Storage Partitions Manager events

Event: Event Description

Log Group Priority Event Group Component Event Optional Data
Number
Create Cluster: (SYMsm Description: Create host group)
Logged on entry to spmCreateCluster.
System Informational Command Unknown 0x5200 | Data Field Type: 0x0900
(0x0) (0x0) (0x3) (0x0)
Delete Cluster: (SYMsm Description: Delete host group)
Logged on entry to spmDeleteCluster.
System Informational Command Unknown 0x5201 | Data Field Type: 0x0901
(0x0) (0x0) (0x3) (0x0)
Rename Cluster: (SYMsm Description: Rename host group)
Logged on entry to spmRenameCluster.
System Informational Command Unknown 0x5202 | Data Field Type: 0x0903
(0x0) (0x0) (0x3) (0x0)
Create Host: (SYMsm Description: Create host)
Logged on entry to spmCreateHost.
System Informational Command Unknown 0x5203 | Data Field Type: 0x0907
(0x0) (0x0) (0x3) (0x0)
Delete Host: (SYMsm Description: Delete host)
Logged on entry to spmDeleteHost.
System Informational Command Unknown 0x5204 | Data Field Type: 0x0901
(0x0) (0x0) (0x3) (0x0)
Rename Host: (SYMsm Description: Rename host)
Logged on entry to spmRenameHost.
System Informational Command Unknown 0x5205 | Data Field Type: 0x0903
(0x0) (0x0) (0x3) (0x0)
Move Host: (SYMsm Description: Move host)
Logged on entry to spmMoveHost.
System Informational Command Unknown 0x5206 | Data Field Type: 0x0902
(0x0) (0x0) (0x3) (0x0)
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Create Host Port: (SYMsm Description: Create host port)
Logged on entry to spmCreateHostPort.
System Informational Command Unknown 0x5207 | Data Field Type: 0x0904
(0x0) (0x0) (0x3) (0x0)
Delete Host Port: (SYMsm Description: Delete host port)
Logged on entry to spmDeleteHostPort.
System Informational Command Unknown 0x5208 | Data Field Type: 0x0901
(0x0) (0x0) (0x3) (0x0)
Rename Host Port: (SYMsm Description: Rename host port)
Logged on entry to spmRenameHostPort.
System Informational Command Unknown 0x5209 | Data Field Type: 0x0905
(0x0) (0x0) (0x3) (0x0)
Move Host Port: (SYMsm Description: Move host port)
Logged on entry to spmMoveHostPort.
System Informational Command Unknown 0x520A | Data Field Type: 0x0902
(0x0) (0x0) (0x3) (0x0)
Set Host Port Type: (SYMsm Description: Set host port type)
Logged on entry to spmSetHostPortType.
System Informational Command Unknown 0x520B | Data Field Type: 0x0906
(0x0) (0x0) (0x3) (0x0)

Create SAPort Group: (SYMsm Description: Create Storage Array port group)

Logged on entry to spmCreateSAPortGroup.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Unknown
(0x0)

0x520C

Data Field Type: 0x0900

Delete SAPort Group: (SYMsm Description: Delete Storage Array port group)

Logged on entry to spmDeleteSAPortGroup.

System Informational Command Unknown 0x520D | Data Field Type: 0x0900
(0x0) (0x0) (0x3) (0x0)
Move SA Port: (SYMsm Description: Move Storage Array port)
Logged on entry to spmMoveSAPort.
System Informational Command Unknown 0x520E | Data Field Type: 0x0902
(0x0) (0x0) (0x3) (0x0)
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Create LUN Mapping: (SYMsm Description: Create volume-to-LUN mapping)

Logged on entry to spmCreateLUNMapping.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x520F

Data Field Type: 0x0908

Delete LUN Mapping: (SYMsm Description: Delete volume-to-LUN mapping)

Logged on entry to spmDeleteLUNMapping.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5210

Data Field Type: 0x0901

Move LUN Mapping: (SYMsm Description: Change volume-to-LUN mapping)

Logged on entry to spmMoveLUNMapping.

System
(0x0)

Informational
(0x0)

Command
(0x3)

Volume
(0xD)

0x5211

Data Field Type: 0x0909

Write DACSTORE Error: (SYMsm Description: Error writing configuration)

Logged when an error occurs when attempting to update the SPM DASCSTORE region.

System
(0x0)

Informational
(0x0)

Error
(0x1)

Unknown
(0x0)

0x5212

Data Field Type: 0x090A

SPM Cleared (SYMsm Description: Premium feature not supported — storage partitions deleted)

Logged if a user attempts to import a drive tray/volume group and the premium features are not supported.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x5213

None
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Feature Enabled: (SYMsm Description: Premium feature enabled)

Logged when a feature is successfully enabled.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x5400

Id: Feature Code

Feature Disabled: (SYMsm Description: Premium feature disabled)

Logged when a feature is successfully disabled.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x5401

Id: Feature Code

Non-Compliance: (SYMsm Description: Premium feature out of compliance)

Logged when there are features enabled that have not been purchased.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x5402

Id: Features not in compliance

Tier Non-Compliance: (SYMsm Description: Premium feature exceeds limit)

Logged when the limits of a premium feature have been exceeded (e.g. 6 storage partitions when 4 have been

purchased).
System Informational Notification Unknown 0x5403 | Id: Features not in tier compliance
(0x0) (0x0) (0x4) (0x0)

ID Changed: (SYMsm Description: Feature Enable Identifier changed)

Logged when a new SAFE ID is successfully generated and stored.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Unknown
(0x0)

0x5404
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Runtime Diagnostic events

Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

Runtine Diagnostics OK: (SYMsm Description: Controller passed diagnostics)

Logged when controller successfully passed runtime diagnostics.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5600

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Alternate controller runtime diagnostics OK: (SYMsm Description: This controller’s alternate passed

diagnostics.)

Logged when alternate controller successfully passed diagnostics.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5601

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime diagnostics timeout: (SYMsm Description: This controller’s alternate failed — timeout waiting for

results)

Logged when alternate controller failed due to timeout waiting for diagnostic results.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Controller
(0x8)

0x5602

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Diagnostics in progress: (SYM
Logged when Runtime Diagnostics request rejec

sm Description:

Diagnostics rejected - already in progress)
ted because already in progress.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5603

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

No alternate present for diagnostic execution: (SYMsm Description: Diagnostics rejected — this controller’s
alternate is absent or failed)

Logged when Runtime Diagnostics request rejected because the alternate controller is either absent, failed, or in

passive mode.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5604

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

ICON error during runtime diagnostics: (SYMsm Description: Diagnostics rejected — error occurred when
sending the Icon message)

Logged when Runtime Diagnostics request failed because an error occurred when sending the ICON message.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5605

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.
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Runtime diagnostic initialization error: (SYMsm Description: Diagnostics rejected - ctlrDiag task unable to
queue DIAG_INIT_MSG message)

Logged when Runtime Diagnostics request failed because ctlrDiag task was unable to queue the

DIAG_INIT MSG message.

Informational
(0x0)

System
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5606

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — unknown return value: (SYMsm Description: Diagnostics returned unknown

ReturnCode)

Logged when Runtime Diagnostics status unknown because of unknown ReturnCode.

Informational
(0x0)

System
(0x0)

Unknown
(0x0)

Controller
(0x8)

0x5607

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — bad test ID: (SYMsm Description: Diagnostics rejected - test ID is incorrect)

Logged when Runtime Diagnostics request rejected because test ID is invalid.

Informational
(0x0)

System
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5608

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — d

Logged when Runtime Diagnostics unable to sel

ect a drive to use for I/O.

rive error: (SYMsm Description: Diagnostics unable to select a drive for 1/0)

Informational
(0x0)

System
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5609

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — UTM not enabled: (SYMsm Description: Diagnostics rejected — access volume

Logged when Runtime Diagnostics request rejected because UTM is not enabled.

(UTM)is not enabled)
System Informational
(0x0) (0x0)

Notification
(0x4)

Controller
(0x8)

0x560A

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — lock error: (SYMsm Description: Diagnostics rejected - CtlrDiag task cannot

obtain Mode Select lock)

Logged when Runtime Diagnostics request failed because the ctlrDiag task was unable to obtain the Mode Select

lock.
System Critical Failure Controller 0x560B | Id: I if user initiated
(0x0) (0x1) (0x2) (0x8) Data Field Type : 0x0A00

Data Field Value: ID of test
requested. 0 — all tests.
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Runtime Diagnostics error — lock error on alternate: (SYMsm Description: Diagnostics rejected — CtlrDiag
task on controller’s alternate cannot obtain Mode Select lock)

Logged when Runtime Diagnostics request failed because the ctlrDiag task on the alternate controller was unable

to obtain the Mode Select lock.

System
(0x0)

Critical
(0x1)

(0x2)

Controller
(0x8)

0x560C

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Diagnostic read test failed: (SYMsm Description: Diagnostics read test failed on

controller)

Logged when Runtime Diagnostics Read test failed on this controller.

System
(0x0)

Critical
(0x1)

(0x2)

Controller
(0x8)

0x560D

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Diagnostic read failure on alternate controller: (SYMsm Description: This

controller’s alternate failed diagnostics read test)

Logged when Runtime Diagnostics Read test failed on the alternate controller.

System
(0x0)

Critical
(0x1)

(0x2)

Controller
(0x8)

0x560E

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Diagnostic write test failed: (SYMsm Description: Diagnostics write test failed

on controller)

Logged when Runtime Diagnostics Write test failed on this controller.

System
(0x0)

Critical
(0x1)

(0x2)

Controller
(0x8)

0x560F

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Diagnostic write test failed on alternate controller: (SYMsm Description: This

controller’s alternate failed diagnostics write test)

Logged when Runtime Diagnostics Write test failed on the alternate controller.

System
(0x0)

Critical
(0x1)

(0x2)

Controller
(0x8)

0x5610

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — loopback error: (SYMsm Description: Controller passed diagnostics, but
loopback test identified an error on loop(s))

Logged when this controller passed diagnostics, but the loopback test identified an error on one or more of the

loops.
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System Informational Notification Controller 0x5611 | Id: 1 if user initiated
(0x0) (0x0) (0x4) (0x8) Data Field Type : 0x0A00

Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — loopback error on alternate: (SYMsm Description: This controller’s alternate
passed diagnostics, but loopback test identified an error on loop(s))

Logged when the alternate controller passed diagnostics, but the loopback test identified an error on one or more

of the loops.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5612

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — bad channel: (SYMsm Description: Diagnostics loopback test identified bad
destination channel(s))

Logged when the specified destination channels were identified as bad during the Runtime Diagnostics

Loopback Data test.
System Informational Notification Controller 0x5613 | Id: 1 if user initiated
(0x0) (0x0) (0x4) (0x8) Data Field Type : 0x0A02

Data Field Value: Number of bad
channels

Runtime Diagnostics error — Source link down: (SYMsm Description: A host-side port (link) has been
detected as down)

Logged when this controller passed diagnostics, but the specified source link was down.

System Informational Notification Channel 0x5614 | Id: 1 if user initiated
(0x0) (0x0) (0x4) (0x6) Data Field Type : 0x0A01
Data Field Value: Channel ID
Not Used 0x5615

Runtime Diagnostics error — Configuration error: (SYMsm Description: Diagnostics rejected — configuration
error on controller)

Logged when configuration error on this controller for running diagnostics.

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Controller
(0x8)

0x5616

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Alternate controller configuration error: (SYMsm Description: Diagnostics
rejected - configuration error on this controller’s alternate)

System
(0x0)

Critical
(0x1)

Failure
(0x2)

Controller
(0x8)

0x5617

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.
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Runtime Diagnostics error — No memory: (SYMsm Description: Diagnostics rejected - no cache memory on

controller)

Logged when there is no cache memory on controller for running diagnostics.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5618

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error -No memory on alternate controller: (SYMsm Description: Diagnostics rejected
- no cache memory on this controller’s alternate)

Logged when there is no cache memory on the alternate controller for running diagnostics.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x5619

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Controller not quiesced: (SYMsm Description: Diagnostics rejected - data
transfer on controller is not disabled (quiesced))

Logged when Runtime Diagnostics request rejected because controller is not quiesced.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561A

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics error — Alternate Controller not quiesced: (SYMsm Description: Diagnostics rejected —
data transfer on this controller’s alternate is not disabled (quiesced))

Logged when Runtime Diagnostics request rejected because the alternate controller is not quiesced.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561B

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics Mode Error: (SYMsm Description: Diagnostics rejected — both controllers must be in

active mode)

Logged when Runtime Diagnostics request rejected because both controllers must be in active mode.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561C

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics — Begin Initialization Controller: (SYMsm Description: Diagnostics initiated from this

controller)

Logged when Runtime Diagnostics is initiated from this controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561D

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.
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Runtime Diagnostics — Begin Diagnostics Controller: (SYMsm Description: Running diagnostics on this

controller)

Logged when Runtime Diagnostics is started on this controller.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561E

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.

Runtime Diagnostics — Download in Progress: (SYMsm Description: Diagnostics rejected — download is in

progress)

Logged when Runtime Diagnostics request is rejected because download is in progress.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x561F

Id: 1 if user initiated

Data Field Type : 0x0A00
Data Field Value: ID of test
requested. 0 — all tests.
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Event: Event Description

Log Group

Priority

Event Group

Component

Event
Number

Optional Data

SSTOR Database Creation: (SYMsm Description: Internal configuration database created)

Logged when an internal configuration database is created.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6000

None

SSTOR Database Merge: (SYMsm Description: Internal configuration database merged)

Logged when an internal configuration database is merged.

System Informational Notification Controller 0x6001 | None
(0x0) (0x0) (0x4) (0x8)
Not Used
0x6002

SSTOR To Few Sundry: (SYMsm Description: Internal configuration database — not enough optimal drives

available)

Logged when there are not enough optimal drives available.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6003

None

SSTOR Re Synchronize: (SYMsm Description: Internal configuration database is being resynchronized)

Logged when the internal configuration database is being resynchronized.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6004

None

SSTOR SS 10 Failed: (SYMsm Description: Internal configuration database read or write operation failed)

Logged when an internal configuration database read or write operation fails.

System
(0x0)

Informational
(0x0)

(0x4)

Controller
(0x8)

0x6005

None

SSTOR Merge Failed: (SYMsm Description: Internal configuration database — merge failed)

Logged when a stable storage database merge operation fails.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6006

None
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Log Group
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Event Group
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Event
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DBM Config DB Cleared: (SYMsm Description: Internal configuration database cleared)

Logged when an internal configuration database is cleared.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6100

None

DBM Config DB Full: (SYMsm Description: Internal configuration database full)

Logged when an internal configuration database is full.

System
(0x0)

Critical
(0x1)

Notification
(0x4)

Controller
(0x8)

0x6101

None

DBM Config DB Expanded: (SYMsm Description: Internal configuration database size increased)

Logged when there is a drive mismatch on an internal configuration database.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6102

None

DBM HCK ALTCTL Reset: (SYMsm Description: This controller’s alternate was reset)

Logged when this controller’s alternate is reset.

System
(0x0)

Informational
(0x0)

Notification
(0x4)

Controller
(0x8)

0x6103

None

DBM HCK ALTCTL Failed: (SYMsm Description: This controller’s alternate was failed)

Logged when this controller’s alternate is failed